©2009 Blackbaud, Inc. This publication, or any part thereof, may not be reproduced or transmitted in any form or by any means, electronic, or mechanical, including photocopying, recording, storage in an information retrieval system, or otherwise, without the prior written permission of Blackbaud, Inc.

The information in this manual has been carefully checked and is believed to be accurate. Blackbaud, Inc., assumes no responsibility for any inaccuracies, errors, or omissions in this manual. In no event will Blackbaud, Inc., be liable for direct, indirect, special, incidental, or consequential damages resulting from any defect or omission in this manual, even if advised of the possibility of damages.

In the interest of continuing product development, Blackbaud, Inc., reserves the right to make improvements in this manual and the products it describes at any time, without notice or obligation.

The Raiser’s Edge, MatchFinder, ParaGon, RE:Alum, RE:Event, RE:Member, RE:Queue, RE:Tribute, RE:Volunteer, RE:Zip, RE:Open, and Blackbaud are registered trademarks of Blackbaud, Inc.

All other products and company names mentioned herein are trademarks of their respective holder.

RE7.82-Reports-2012
## Contents

**WHAT IS IN THIS GUIDE?** ................................................................. VII

**REPORT DESCRIPTIONS** ............................................................ 1

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Reports</td>
<td>6</td>
</tr>
<tr>
<td>Analytical Reports</td>
<td>10</td>
</tr>
<tr>
<td>Campaigns, Funds, and Appeals Reports</td>
<td>22</td>
</tr>
<tr>
<td>Custom Reports</td>
<td>32</td>
</tr>
<tr>
<td>Demographic and Statistical</td>
<td>32</td>
</tr>
<tr>
<td>Event Management Reports</td>
<td>41</td>
</tr>
<tr>
<td>Financial Reports</td>
<td>48</td>
</tr>
<tr>
<td>Membership Reports</td>
<td>64</td>
</tr>
<tr>
<td>Pivot Reports</td>
<td>74</td>
</tr>
<tr>
<td>Pledge And Recurring Gift Reports</td>
<td>74</td>
</tr>
<tr>
<td>Profiles, Lists, and Directories</td>
<td>90</td>
</tr>
<tr>
<td>Prospect Research Reports</td>
<td>93</td>
</tr>
<tr>
<td>Tribute Reports</td>
<td>96</td>
</tr>
<tr>
<td>Volunteer Reports</td>
<td>99</td>
</tr>
</tbody>
</table>

**REPORT BASICS** ..................................................................... 105

<table>
<thead>
<tr>
<th>Report Type</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigating in Reports</td>
<td>107</td>
</tr>
<tr>
<td>User Options for Reports</td>
<td>115</td>
</tr>
<tr>
<td>Business Rules for Reports</td>
<td>116</td>
</tr>
<tr>
<td>Creating and Running Reports</td>
<td>116</td>
</tr>
<tr>
<td>Editing a Report</td>
<td>119</td>
</tr>
<tr>
<td>Previewing a Report</td>
<td>122</td>
</tr>
<tr>
<td>Printing a Report</td>
<td>125</td>
</tr>
<tr>
<td>Exporting a Report</td>
<td>127</td>
</tr>
<tr>
<td>Sending a Report using E-Mail</td>
<td>130</td>
</tr>
<tr>
<td>Deleting a Report using E-Mail</td>
<td>133</td>
</tr>
</tbody>
</table>

**PARAMETER TABS** ............................................................... 135

<table>
<thead>
<tr>
<th>Parameter Tab</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes Tab</td>
<td>141</td>
</tr>
<tr>
<td>Availability Tab</td>
<td>143</td>
</tr>
<tr>
<td>Columns Tab</td>
<td>144</td>
</tr>
<tr>
<td>Expense Calculation Tab</td>
<td>146</td>
</tr>
</tbody>
</table>
INDEX ................................................................. 365
What Is In This Guide?

In the Reports Guide, you learn to create reports using the report parameter screen. You can also learn about the following.

- “Report Descriptions” on page 1
- “Creating and Running Reports” on page 116
- “Editing a Report” on page 119
- “Exporting a Report” on page 127
- “Sending a Report using E-Mail” on page 130
- “Parameter Tabs” on page 135
- “Custom Reports” on page 335

How Do I Use These Guides?

The Raiser's Edge user guides contain examples, scenarios, procedures, graphics, and conceptual information. To find help quickly and easily, you can access the Raiser's Edge documentation from several places.

User Guides. You can access PDF versions of the guides by selecting Help, User Guides from the shell menu bar or by clicking Help on the Raiser's Edge bar in the program. You can also access the guides on our Web site at www.blackbaud.com. From the menu bar, select Support, User Guides.

In a PDF, page numbers in the Table of Contents, Index, and all cross-references are hyperlinks. For example, click the page number by any heading or procedure on a Table of Contents page to go directly to that page.

Help File. In addition to user guides, you can learn about The Raiser’s Edge 7 by accessing the help file in the program. Select Help, The Raiser's Edge Help Topics from the shell menu bar or press F1 on your keyboard from anywhere in the program.

Narrow your search in the help file by enclosing your search in quotation marks on the Search tab. For example, instead of entering Load Defaults, enter “Load Defaults”. The help file searches for the complete phrase in quotes instead of individual words.
# Report Descriptions

**Action Reports** ................................................... 6  
Action Detail Report .................................................. 6  
   Action Detail Report Columns .................................. 6  
Action Summary Report ............................................... 7  
   Action Summary Report Columns .................................. 7  
Advocacy Detail Report ............................................... 8  
   Advocacy Detail Report Columns .................................. 8  
Tickler Report ....................................................... 9  
   Tickler Report Columns ............................................ 9  

**Analytical Reports** ............................................... 10  
Actual vs. Target Report ........................................... 10  
   Actual vs. Target Report Columns ............................... 10  
Alumni Class Analysis ............................................. 11  
   Alumni Class Analysis Columns ................................. 11  
Appeals Analysis ................................................... 13  
   Appeals Analysis Columns ........................................ 13  
Comparative Report .................................................. 13  
   Comparative Report Columns ..................................... 13  
Consecutive Years Report ........................................... 14  
   Consecutive Years Report Columns ............................... 14  
Donor Category Report ............................................... 14  
   Donor Category Report Columns ................................. 14  
First/Greatest/Latest Gift Report .................................. 15  
   First/Greatest/Latest Gift Report Columns ...................... 15  
Giving Score Control Report ....................................... 16  
LYBUNT Report ...................................................... 16  
   LYBUNT Report Columns .......................................... 16  
New Donors Report .................................................. 16  
   New Donors Report Columns ....................................... 16  
Non-Contributors Report ........................................... 17  
   Non-Contributors Report Columns ............................... 17  
Parent Class Analysis ............................................... 17  
   Parent Class Analysis Columns .................................. 17  
Solicitor Comparison Report ....................................... 19  
   Solicitor Comparison Report Columns ........................... 19  
Solicitor Goal Summary ............................................. 19  
   Solicitor Goal Summary Report Columns ........................ 19  
Solicitor Performance Analysis .................................... 20  
   Solicitor Performance Analysis Report Columns ............... 20  
SYBUNT Report ...................................................... 20  
   SYBUNT Report Columns ........................................... 20  
Top Donors Report .................................................. 21  
   Top Donors Report Columns ....................................... 21  
Consecutive Years Report Columns ................................ 14  
Appeals Analysis Columns .......................................... 13  
Comparative Report Columns ....................................... 13  
Consecutive Years Report Columns ................................ 14  
Donor Category Report Columns .................................... 14  
First/Greatest/Latest Gift Report Columns ......................... 15  
Giving Score Control Report Columns ............................. 16  
LYBUNT Report Columns .............................................. 16  
New Donors Report Columns ......................................... 16  
Non-Contributors Report Columns .................................. 17  
Parent Class Analysis Columns .................................... 17  
Solicitor Comparison Report Columns ............................. 19  
Solicitor Goal Summary Columns ................................... 19  
Solicitor Performance Analysis Columns .......................... 20  
SYBUNT Report Columns .............................................. 20  
Top Donors Report Columns ......................................... 21
VSE Survey Report ................................................................. 21
Campaigns, Funds, and Appeals Reports .................................. 22
Appeal Comparison Summary .................................................. 22
Appeal Comparison Summary Columns ...................................... 22
Appeal Cost Breakdown .......................................................... 23
Appeal Cost Breakdown Columns .............................................. 23
Appeal Detail Report .............................................................. 23
Appeal Detail Report Columns ................................................ 23
Appeal Goal Summary ............................................................ 24
Appeal Goal Summary Columns ............................................... 24
Appeal Performance Analysis ................................................... 25
Appeal Performance Analysis Columns ...................................... 25
Appeal Summary List .............................................................. 25
Appeal Summary List Columns ............................................... 25
Campaign Comparison Summary ............................................. 26
Campaign Comparison Summary Columns ................................. 26
Campaign Detail Report .......................................................... 26
Campaign Detail Report Columns ............................................. 26
Campaign Goal Summary ........................................................ 27
Campaign Goal Summary Columns .......................................... 27
Campaign Performance Analysis .............................................. 27
Campaign Performance Analysis Columns ................................ 27
Campaign Progress Report ...................................................... 28
Campaign Progress Report Columns ........................................ 28
Campaign Summary List .......................................................... 29
Campaign Summary List Columns ............................................ 29
Fund Comparison Summary ...................................................... 29
Fund Comparison Summary Columns ....................................... 29
Fund Detail Report ................................................................. 29
Fund Detail Report Columns ................................................... 29
Fund Goal Summary ............................................................... 30
Fund Goal Summary Columns ................................................ 30
Fund Performance Analysis ...................................................... 31
Fund Performance Analysis Columns ....................................... 31
Fund Summary List ............................................................... 31
Fund Summary List Columns ................................................... 31
Demographic and Statistical ..................................................... 32
Advocacy Tallies ................................................................. 32
Advocacy Tallies Columns ........................................................ 32
Comparisons and Summaries .................................................... 33
Comparisons and Summaries Columns ...................................... 33
Recurring Gift Statistical Report ............................................. 34
Recurring Gift Statistical Report Columns ................................. 34
Statistical Reports ................................................................. 40
Statistical Report Columns ...................................................... 40
Tallies ................................................................................. 41
Tallies Columns ................................................................. 41
Event Management Reports ..................................................... 41
Dinner Preferences ............................................................... 41
Dinner Preferences Columns ................................................... 41
Event Expense Report ........................................................... 42
Event Expense Report Columns ............................................. 42
Event Income Report ............................................................ 43
Event Income Report Columns ............................................... 43
Event Lists .......................................................... 43
  Event Lists Columns ........................................ 43
Event Summary Report ....................................... 44
  Event Summary Report Columns ......................... 44
Lodging Information ......................................... 45
  Lodging Information Columns ........................... 45
Registration Fees Due Report ............................. 45
  Registration Fees Due Columns ....................... 45
Seating Arrangements ..................................... 46
  Seating Arrangements Columns ....................... 46
Seating Validation Report ................................ 46
  Seating Validation Report Columns ................ 47
Sporting Event Roster ...................................... 47
  Sporting Event Roster Columns ....................... 47
Financial Reports ........................................... 48
  Account Distribution Report .......................... 48
    Account Distribution Report Columns ............ 48
Adjusted Gift Report ...................................... 48
  Adjusted Gift Report Columns ....................... 48
Annual Statement Report ................................ 49
  Annual Statement Report Columns .................. 49
Cash Receipts Journal ..................................... 50
  Cash Receipts Journal Columns ..................... 50
Constituent Giving History ............................... 52
  Constituent Giving History Columns ............... 52
EFT Participation Report .................................. 53
  EFT Participation Report Columns .................. 53
Expected Maturity Year Report ........................ 54
  Expected Maturity Year Report Columns .......... 54
EFT Participation Report Columns ...................... 53
  EFT Participation Report Columns .................. 53
General Ledger Audit Report ............................ 54
  General Ledger Audit Report Columns ............. 54
Gift Detail and Summary Report ......................... 55
  Gift Detail and Summary Report Columns .......... 55
Gift Entry Validation ...................................... 57
  Gift Entry Validation Columns ...................... 57
Gifts-in-Kind Report ....................................... 59
  Gifts-in-Kind Report Columns ....................... 59
Matching Gift Report ...................................... 59
  Matching Gift Report Columns ..................... 59
Online Vs. Offline Giving Report ....................... 60
Planned Gifts Report ....................................... 60
  Planned Gifts Report Columns ....................... 60
Other Gifts Report ......................................... 63
  Other Gifts Report Columns .......................... 63
Stock Gain/Loss Report .................................... 63
  Stock Gain/Loss Report Columns .................... 63
Membership Reports ........................................ 64
  Comparative Membership Statistics .................. 64
    Comparative Membership Statistics Columns .... 64
Dropped Member Report ................................... 65
  Dropped Members Report Columns .................. 65
Expired Membership Report ............................. 65
  Expired Membership Report Columns ............... 65
Joint Member/Card List Report .......................... 66
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Renewal Projection Report</td>
<td>73</td>
</tr>
<tr>
<td>Rejoin Report</td>
<td>72</td>
</tr>
<tr>
<td>Cash Flow Report</td>
<td>77</td>
</tr>
<tr>
<td>New Member Report</td>
<td>71</td>
</tr>
<tr>
<td>Membership Given By Report</td>
<td>68</td>
</tr>
<tr>
<td>Membership List/Directory</td>
<td>69</td>
</tr>
<tr>
<td>Membership Statistics by Category</td>
<td>69</td>
</tr>
<tr>
<td>Month/Year Statistical Analysis</td>
<td>70</td>
</tr>
<tr>
<td>New Member Report Columns</td>
<td>71</td>
</tr>
<tr>
<td>Rejoin Report Columns</td>
<td>72</td>
</tr>
<tr>
<td>Renewal Projection Report Columns</td>
<td>73</td>
</tr>
<tr>
<td>Renewal Report Columns</td>
<td>73</td>
</tr>
<tr>
<td>Pivot Reports</td>
<td>74</td>
</tr>
<tr>
<td>Pledge And Recurring Gift Reports</td>
<td>74</td>
</tr>
<tr>
<td>Activity Report</td>
<td>74</td>
</tr>
<tr>
<td>Campaign Report</td>
<td>76</td>
</tr>
<tr>
<td>Campaign Report Columns</td>
<td>76</td>
</tr>
<tr>
<td>Cash Flow Report</td>
<td>77</td>
</tr>
<tr>
<td>Cash Flow Report Columns</td>
<td>77</td>
</tr>
<tr>
<td>Journal</td>
<td>78</td>
</tr>
<tr>
<td>Not Paid Report</td>
<td>79</td>
</tr>
<tr>
<td>Past Due Report</td>
<td>80</td>
</tr>
<tr>
<td>Past Due Report Columns</td>
<td>80</td>
</tr>
<tr>
<td>Pledge Status Report</td>
<td>81</td>
</tr>
<tr>
<td>Pledge Status Report Columns</td>
<td>82</td>
</tr>
<tr>
<td>Recurring Gift Amendment Report</td>
<td>85</td>
</tr>
<tr>
<td>Recurring Gift Amendment Report Columns</td>
<td>85</td>
</tr>
<tr>
<td>Recurring Gift Missed Payment Report</td>
<td>86</td>
</tr>
<tr>
<td>Recurring Gifts Missed Payment Report Columns</td>
<td>87</td>
</tr>
<tr>
<td>Written-Off Report</td>
<td>89</td>
</tr>
<tr>
<td>Write-Off Report Columns</td>
<td>89</td>
</tr>
<tr>
<td>Profiles, Lists, and Directories</td>
<td>90</td>
</tr>
<tr>
<td>Alumni Class List</td>
<td>90</td>
</tr>
<tr>
<td>Appeal Profile</td>
<td>90</td>
</tr>
<tr>
<td>Target Analytics Scores List</td>
<td>90</td>
</tr>
<tr>
<td>Constituent Directory</td>
<td>91</td>
</tr>
<tr>
<td>Constituent Profile</td>
<td>91</td>
</tr>
<tr>
<td>Campaign Profile</td>
<td>91</td>
</tr>
<tr>
<td>Event Profile</td>
<td>91</td>
</tr>
<tr>
<td>Fund Profile</td>
<td>91</td>
</tr>
<tr>
<td>Grandparent Directory</td>
<td>92</td>
</tr>
<tr>
<td>Honor/Memorial Profile</td>
<td>92</td>
</tr>
</tbody>
</table>
Individual Profile .............................................................................................................. 92
MatchFinder Organization Summary .................................................................................. 92
Membership Category Profile ............................................................................................ 92
Organization Profile ......................................................................................................... 93
Parent Directory .................................................................................................................. 93
Professional Directory ....................................................................................................... 93
**Prospect Research Reports** ............................................................................................ 93
Outstanding Proposal Report ............................................................................................. 94

Proposal Analysis Report .................................................................................................. 94
Proposal Analysis Report Columns .................................................................................... 94
Proposal Follow-Up Report ................................................................................................ 95
Proposal Follow-Up Report Columns ................................................................................ 95
Proposal Pipeline Summary ................................................................................................ 96
Proposal Pipeline Summary Columns .................................................................................. 96
**Tribute Reports** ............................................................................................................. 96
Honor/Memorial Contributors List ....................................................................................... 97
Honor/Memorial Contributors List Columns ......................................................................... 97
Honor/Memorial Directory .................................................................................................... 97
Honor/Memorial Directory Columns ..................................................................................... 97
Honor/Memorial Gift Report .................................................................................................. 97
Honor/Memorial Gift Report Columns .................................................................................. 98
Honor/Memorial Summary List ............................................................................................. 98
Honor/Memorial Summary List Columns .............................................................................. 98
**Volunteer Reports** ......................................................................................................... 99
Courses and Training Report ............................................................................................... 99
Courses and Training Report Columns ................................................................................. 99
Future Awards Report .......................................................................................................... 100
Future Awards Columns ....................................................................................................... 100
Job Assignment Summary ................................................................................................... 100
Job Assignment Summary Columns ..................................................................................... 100
Time Sheet Report ................................................................................................................ 100
Time Sheet Report Columns ................................................................................................ 101
Volunteer Awards Report ..................................................................................................... 101
Volunteer Awards Columns ................................................................................................ 101
Volunteer Job Assignment Schedule .................................................................................... 102
Volunteer Job Assignments Columns .................................................................................... 102
Volunteer Match List ............................................................................................................ 103
Volunteer Match List Columns ............................................................................................. 103
Volunteer Skills and Experience ............................................................................................ 103
Volunteer Skills and Experience Columns ............................................................................. 103
Volunteer Summary .............................................................................................................. 104
Volunteer Summary Columns .............................................................................................. 104
The Raiser's Edge 7 includes many standard reports to help you retrieve specific information from your database. These reports give you information to help you stay up to date with every aspect of your organization. You can analyze the giving trends of your constituents, evaluate the financial position of your organization, track all information about pledges, and generate demographic profiles.

The standard reports are comprised of a series of parameter tabs. You must complete each tab, selecting the specific information you want to include in your report. For information about each tab and the fields, buttons, checkboxes, and options available on each tab, see “Parameter Tabs” on page 135.

Reporting tasks are grouped in report categories. This chapter describes each category available in The Raiser's Edge.

### Action Reports

Actions are the specific steps you take toward securing a donation from a constituent. They may include meetings, mailings, telephone calls, and e-mail messages. Actions allow you to build a history of the contacts and communications involved in creating a successful relationship with a constituent. In addition to tracking meetings, phone calls, and mailings, The Raiser's Edge can automatically remind you days, weeks, or months before an action is scheduled to occur.

You can assign an action to a specific constituent. If you have the optional module Event Management, you can also assign an action for an event. When you assign an action, you create a new action record. This action record holds a variety of action information, including constituent or event name, action category, action type, date, solicitor, status, and priority. You can also link action records together into an action track, which is a sequence of related actions.

**Action Reports** track information entered on the action records. You can produce a list of actions assigned to users or solicitors, produce summaries of constituents assigned a particular action type, or print a detailed constituent action history.

### Action Detail Report

The Action Detail Report generates detailed information about selected or all actions in your database. Based on your parameter tab settings, an Action Detail Report can include constituents and solicitors involved in actions, dates of the actions, action categories, action types, the status of each action type, action priorities, action progress, campaign and fund information, and user contact information. You can also determine how the information is arranged on your report. This report is a great tool for tracking the effectiveness of your actions.

**Action Detail Report Columns**

- **Action Priority.** This column displays the priority selected (High, Normal, or Low) on the General tab of the action record.
- **Action Progress.** This column displays information based on the Action completed on checkbox/field on the General tab of the action record.
- **Action Status.** This column displays the status as recorded in the Status field on the General tab of the action record. The status appears beneath the action type on the report.
- **Action Type.** This column displays the type recorded in the Action Type field on the General tab of the action record.
- **Alert Title.** This column displays the title of any advocacy action alerts.
Campaign. This column displays the campaign recorded the Campaign field on the General tab of the action record.

Category. The action category, as selected on the General tab of the action record, appears beneath the date.

Completion Date. This optional column displays the date entered in the Action completed on field on the General tab of the action record.

Note: Remember, contact information is available only for organization constituents.

Contact. This column displays the information recorded in the Contact field on the General tab of the action record. (The Contact field is available on the Action record only when an organization is selected as the constituent.)

Date. This column displays the date recorded in the Action Date field on the General tab of the action record.

Detail. This optional column displays varying information, depending on the category selected on the General tab of the action record. For example, if you select the category of Meeting, details that appear are the information recorded in the Location field on the tab. If you select Mailing, details are the information recorded in the Letter field.

End Time. This optional column displays the time recorded in the End time field on the General tab of the action record appears beneath the start time.

Fund. This column displays the fund recorded in the Fund field on the General tab of the action record. The fund appears beneath the campaign on the report.

Issue. This optional column displays any advocacy issue on which a constituent acted. For example, if a constituent contacted a congressman in support of a child welfare law your organization supports, “Child Welfare” displays as the issue.

Name/ID. This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters. It can also display an event or appeal.

Notified User. This column displays the name recorded in the Auto-Remind frame on the General tab of the action record.

Note: A Proposal column prints only if you have the optional module Prospect Research Management.

Proposal. This column displays the name recorded in the Proposal field on the General tab of the action record.

Solicitor or User. This column displays whether the solicitor or the user is the name added to the gift record. It appears beneath the constituent name on the report.

Start Time. This optional column displays the time recorded in the Start time field on the General tab of the action record.

Action Summary Report

Note: For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

The Action Summary Report generates a list of action categories entered in your database along with a count of constituents associated with each action category. Because this report is a summary, constituent names do not appear. The report simply lists all your action categories with the total number of constituents associated with each. The exact data included depends on your parameter tab settings.
Action Summary Report Columns

**Action Status.** This column displays the status as recorded in the Status field on the General tab of the action record. The status appears beneath the action type on the report.

**Action Type.** This column displays the type recorded in the Action type field on the General tab of the action record.

**Appeals.** This column displays the appeal associated with the action. The appeal information is pulled from the Appeal field on the General tab of the action record.

**Campaign.** This column displays the campaign recorded the Campaign field on the General tab of the action record.

**Category.** The action Category, as selected on the General tab of the action record, appears beneath the date.

**Constituent/Appeal/Event.** This column displays any of the following: constituent names in the format selected on the Format tab; appeals associated with the action; events associated with the action.

**Count.** This column displays the total number of each action type in the report. This report shows counts based on up to two of the several fields listed.

**Fund.** This column displays the fund recorded in the Fund field on the General tab of the action record. The fund appears beneath the campaign on the report.

**Notified User.** This column displays the user name added to the gift record. It appears beneath the constituent name on the report.

**Proposal.** This column displays the name recorded in the Proposal field on the General tab of the action record.

**Solicitor.** This column displays the solicitor name added to the gift record. It appears beneath the constituent name on the report.

**Solicitor or User.** This column displays whether the solicitor or the user is the name added to the gift record. It appears beneath the constituent name on the report.

---

Advocacy Detail Report

**Note:** A proposal column prints only if you have the optional module Prospect Research Management.

**Proposal.** This column displays the name recorded in the Proposal field on the General tab of the action record.

**Solicitor.** This column displays the solicitor name added to the gift record. It appears beneath the constituent name on the report.

**Solicitor or User.** This column displays whether the solicitor or the user is the name added to the gift record. It appears beneath the constituent name on the report.

---

Advocacy Detail Report Columns

**Alert Title.** This default column displays the title of the alert.

**Appeal.** This optional column displays the appeal, if any, associated with the advocacy action. The appeal information is pulled from the Appeal field on the General tab of the action record.

**Campaign.** This optional column displays the campaign, if any, associated with the advocacy action. The campaign information is pulled from the Campaign field on the General tab of the action record.

**Constituent Name.** This default column displays the constituent name in the format selected on the Format tab.

**Date.** This default column displays the Action Date entered on the General tab of the action record.

---

The Advocacy Detail Report generates a detailed list of selected advocacy actions. You can break the report down based on constituent, date, recipient, alert title, or issue information.
Delivery Method. This default column displays how the advocacy action was delivered. For example, if the constituent sent an email message to a congressman in support of a child welfare law your organization supports, “Email” displays as the delivery method. This information is pulled from the Delivery Method field on the General tab of the action record.

Fund. This optional column displays the fund, if any, associated with the advocacy action. The fund is recorded in the Fund field on the General tab of the action record.

Issue. This default column displays the advocacy issue on which the constituent acted. For example, if the constituent contacted a congressman in support of a child welfare law your organization supports, “Child Welfare” displays as the issue.

Recipient. This default column displays the recipient of the advocacy action. For example, if the constituent contacted a congressman in support of a child welfare law your organization supports, the congressman’s name displays as the recipient. This information is pulled from the Recipient Name field on the General tab of the action record.

Solicitor. This optional column displays the name of the solicitor, if any, associated with the advocacy action. This information is pulled from the Solicitor button on the General tab of the action record.

Tickler Report

Note: If you choose to include only records saved in an action query, the constituent appears one time for each action. For example, if the constituent has five actions, he appears five times in the query.

The goal of the Tickler Report is to help you keep track of the individuals responsible for the actions in your database. This report can be arranged based on solicitors or other users notified about an action. In addition to the solicitor or notified user name, this report can include constituent or contact names, action start and end times, action types, the status of each action type, action priorities, action progress, and proposal information. The exact data included depends on your parameter tab settings.

“Tickler Report Columns” on page 9

Tickler Report Columns

Action Priority. This column displays the priority (High, Normal, or Low) as selected on the General tab of the action record.

Action Progress. This column displays the information appearing in the label (completed, not completed) on the action record. This appears beneath the action priority on the report.

Note: In reports allowing phone numbers, an indicator (“~”) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

Action Status. This column displays the status as recorded in the Status field on the General tab of the action record. The status appears beneath the action type on the report.

Action Type. This column displays the type recorded in the Action type field on the General tab of the action record.

Attributes. This column displays attribute information entered in the Attributes tab of the action record.

Attribute Category. This optional column displays information entered in the Category column in the grid on the Attributes tab of the action record.

Contact. This column displays the information recorded in the Contact field on the General tab of the action record. (The Contact field is available on the Action record only when an organization is selected as the constituent.)
Category. The action Category, as selected on the General tab of the action record, appears beneath the date.

Comments. This column displays information entered in the Comments column in the grid on the Attributes tab of the action record.

Description. This optional column displays information entered in the Description column in the grid on the Attributes tab of the action record.

Name/ID. This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name.

Date. The first Date column, displays the date recorded in the Action date field on the General tab of the action record. The second Date column displays information entered in the Date column in the grid on the Attributes tab of the action record.

Detail. This column displays varying information, depending on the category selected on the General tab of the action record. For example, if you select the category of Meeting, details that appear are the information recorded in the Location field on the tab. If you select Mailing, details are the information recorded in the Letter field.

End Time. The time recorded in the End time field on the General tab of the action record appears beneath the start time.

Proposal. This column displays the name recorded in the Proposal field on the General tab of the action record.

Short Desc. This optional column displays information entered in the Short Desc column in the grid on the Attributes tab of the action record.

Solicitor or User. This column displays whether the solicitor or the user is the name added to the gift record. You can group by either of these fields, and the other will not be included on the report.

Start Time. This column displays the time recorded in the Start time field on the General tab of the action record.

Analytical Reports

Note: For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

Analytical Reports focus on component parts of your database, helping you analyze the giving habits of your constituents, the performance of your solicitors, and the effectiveness of your appeals. Each analytical report provides very specific information on a selected subject. For example, the Non-Contributors Report finds constituents in your database who are not donating to your organization. The Solicitor Performance Analysis helps you monitor the results of your solicitors’ efforts.

Actual vs. Target Report

Note: For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

The Actual vs. Target Report compares the target amount and the total amount donors actually gave during the time period you define. The report compares the actual donations a constituent gave with the target amounts entered on the constituent record. If you enter no target amount, the word “Unknown” appears in the Target column. This report provides target and actual giving information for all constituents, selected constituents, or just one constituent. The report displays the constituent name and address, target amount, and actual amount donated. You can also include telephone numbers. The exact data included depends on your parameter tab settings.
Actual vs. Target Report Columns

**Amount Given.** This column displays the total amount donated for each constituent listed; in the UK this takes into account the net or gross option set in User Options for cash gifts.

**Constituent Name.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

**Target.** The target amount from the constituent record displays. If you enter no target amount, the word “Unknown” appears in the Target column.

Alumni Class Analysis

**Note:** The Alumni Class Analysis is available only if you have the optional module Alumni Tracking.

The Alumni Class Analysis provides alumni class giving information either by constituents within a class or by the class itself. The report provides alumni giving information for all constituents, selected constituents, or just one constituent. The detail report lists the constituent name by class year with the individual amounts donated or total amounts donated during the time period you select. The summary report shows each class year with the total donations, number of gifts, and percentage of participation. To appear on the Alumni Class Analysis, Primary alumni information on the education record must be checked. The exact data included depends on your parameter tab settings.

**Note:** In reports allowing phone numbers, an indicator (”) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

Alumni Class Analysis Columns

The Detail report type displays the following columns:

**Amount.** This column displays the amount raised by selected alumni. The column names and the gift types calculated are based on your selections on the Gift Types tab of the report parameter screen.

The gift type columns default as follows:

- **Column 1 - Amount** - Summing gift amounts with gift type of: Cash, Pay-Cash, MG Pay-Cash, Stock/Property, Stock/Property (Sold), Pay-Stock/Property, Pay-Stock Property (Sold), MG Pay-Stock/Property, MG Pay-Stock/Property (Sold), Gift-in-Kind, Pay-Gift-in-Kind, MG Pay-gift-in-Kind, Other, Pay-Other, MG Pay-Other, Recurring Gift Pay-Cash.

- **Column 2 - Pledge** - Summing gift amounts with gift type of: Pledge, MG Pledge.

- **Column 3 Pledge Balance** - Summing gift balance amounts with gift type of: Pledge, MG Pledge.

**Class.** This column displays a list of alumni classes.

**Constituent Name.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

**Pledge.** The pledge amount made by alum. The column names and the gift types calculated are based on your selections on the Gift Types tab of the report parameter screen.

The gift type columns default as follows:
• **Column 1 - Amount** - Summing gift amounts with gift type of: Cash, Pay-Cash, MG Pay-Cash, Stock/Property, Stock/Property (Sold), Pay-Stock/Property, Pay-Stock Property (Sold), MG Pay-Stock/Property, MG Pay-Stock/Property (Sold), Gift-in-Kind, Pay-Gift-in-Kind, MG Pay-gift-in-Kind, Other, Pay-Other, MG Pay-Other, Recurring Gift Pay-Cash.

• **Column 2 - Pledge** - Summing gift amounts with gift type of: Pledge, MG Pledge.

• **Column 3 Pledge Balance** - Summing gift balance amounts with gift type of: Pledge, MG Pledge.

**Pledge Balance.** The balance remaining on any pledge made by the alum. The column names and the gift types calculated are based on your selections on the Gift Types tab of the report parameter screen.

The gift type columns default as follows:

• **Column 1 - Amount** - Summing gift amounts with gift type of: Cash, Pay-Cash, MG Pay-Cash, Stock/Property, Stock/Property (Sold), Pay-Stock/Property, Pay-Stock Property (Sold), MG Pay-Stock/Property, MG Pay-Stock/Property (Sold), Gift-in-Kind, Pay-Gift-in-Kind, MG Pay-gift-in-Kind, Other, Pay-Other, MG Pay-Other, Recurring Gift Pay-Cash.

• **Column 2 - Pledge** - Summing gift amounts with gift type of: Pledge, MG Pledge.

• **Column 3 Pledge Balance** - Summing gift balance amounts with gift type of: Pledge, MG Pledge.

The Summary report type displays the following columns:

**Amount.** This column displays the amount raised by selected alumni. The column names and the gift types calculated are based on your selections on the Gift Types tab of the report parameter screen.

The gift type columns default as follows:

• **Column 1 - Amount** - Summing gift amounts with gift type of: Cash, Pay-Cash, MG Pay-Cash, Stock/Property, Stock/Property (Sold), Pay-Stock/Property, Pay-Stock Property (Sold), MG Pay-Stock/Property, MG Pay-Stock/Property (Sold), Gift-in-Kind, Pay-Gift-in-Kind, MG Pay-gift-in-Kind, Other, Pay-Other, MG Pay-Other, Recurring Gift Pay-Cash.

• **Column 2 - Pledge** - Summing gift amounts with gift type of: Pledge, MG Pledge.

• **Column 3 Pledge Balance** - Summing gift balance amounts with gift type of: Pledge, MG Pledge.

**Class.** This column displays a list of alumni classes.

**Donors.** This column displays the number of donors from the selected alumni class.

**No. Of Gifts.** The summation of the number of gifts given per column/gift type. There are three per report, each totaling the number of gifts in the previous column.

**Out Of.** The total number of constituents per class year excluding those who, based on filters, do not meet the report criteria.

**Pledge.** The pledge amount made by the selected alumni class. The column names and the gift types calculated are based on your selections on the Gift Types tab of the report parameter screen.

The gift type columns default as follows:

• **Column 1 - Amount** - Summing gift amounts with gift type of: Cash, Pay-Cash, MG Pay-Cash, Stock/Property, Stock/Property (Sold), Pay-Stock/Property, Pay-Stock Property (Sold), MG Pay-Stock/Property, MG Pay-Stock/Property (Sold), Gift-in-Kind, Pay-Gift-in-Kind, MG Pay-gift-in-Kind, Other, Pay-Other, MG Pay-Other, Recurring Gift Pay-Cash.

• **Column 2 - Pledge** - Summing gift amounts with gift type of: Pledge, MG Pledge.

• **Column 3 Pledge Balance** - Summing gift balance amounts with gift type of: Pledge, MG Pledge.

**Pledge Balance.** The balance remaining on any pledge made by the selected alumni class. The column names and the gift types calculated are based on your selections on the Gift Types tab of the report parameter screen.

The gift type columns default as follows:
- **Column 1 - Amount** - Summing gift amounts with gift type of: Cash, Pay-Cash, MG Pay-Cash, Stock/Property, Stock/Property (Sold), Pay-Stock/Property, Pay-Stock Property (Sold), MG Pay-Stock/Property, MG Pay-Stock/Property (Sold), Gift-in-Kind, Pay-Gift-in-Kind, MG Pay-gift-in-Kind, Other, Pay-Other, MG Pay-Other, Recurring Gift Pay-Cash.

- **Column 2 - Pledge** - Summing gift amounts with gift type of: Pledge, MG Pledge.

- **Column 3 Pledge Balance** - Summing gift balance amounts with gift type of: Pledge, MG Pledge.

**Percent.** The percentage of donors from the specified alumni class over the number of constituents on the alumni class.

### Appeals Analysis

The **Appeals Analysis** provides names of donors and the amount donated so you can analyze the financial success of your appeals.

**Note:** If you select **Individual** in the **Gift Reporting** frame, constituent names also print.

This report includes appeal performance information for all constituents, selected constituents, or just one constituent. It lists the information by appeal name. By viewing the appeals constituents have responded to, you can ascertain the success of your appeals. The detail report includes constituent name, gift date, fund name, amount donated, reference, percentage of those giving, amount over/under the goal, and the goal for each appeal. The summary report includes appeal name, amount donated, goal, amount over/under goal, number of donors, donors out of number solicited, and percentage donating. Both formats provide totals. The exact data included depends on your parameter tab settings.

### Appeals Analysis Columns

**Note:** In reports allowing phone numbers, an indicator (") appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

The Detail report type displays the following columns:

- **Amount.** The amount generated by the appeal.
- **Appeal.** This column displays the list of appeals selected for the report.
- **Constituent Name.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.
- **Pledge Balance.** The balance remaining on any pledge generated by the appeal.

The Summary report type displays the following columns:

- **Amount.** The amount generated by the appeal.
- **Appeal.** This column displays a list of appeals selected for the report.
- **Donors.** For each individual appeal, this is the number of constituents with the selected appeal on a gift record. The total at the end of the report represents the total number of constituents with the appeal on a gift record.
- **Goal.** This column displays the goal of each appeal. The amount comes from the appeal record.
- **Over/Under.** how much the total given to the appeal is over or under the set goal.
- **Out Of.** For each individual appeal, this is the number of constituents with the selected appeal on the Appeals tab or on a gift record. The total at end of report represents the total number of constituents with any appeal on the constituent tab or constituents with the appeal on a gift record.
Percentage. The number of donors who gave gifts to the appeal over the total number of donors on the appeal record.

Pledge Balance. The balance remaining on any pledge generated by the appeal.

Comparative Report

Note: For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

The Comparative Report provides a comparison of information contained in two date ranges, helping you determine whether constituent giving increased, decreased, or remained the same. This may prove useful in identifying your better donors. Or you can choose to show only decreased giving and identify donors for solicitation. You can also run the report to show both increases and decreases. The report can include the constituent name, total donated for each time period, and the variance in either dollar or percentage format. The exact data included depends on your parameter tab settings.

Comparative Report Columns

Constituent Name. This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

Currency Variance/% Variance. You can view the difference or variance between the gift periods included in your report. In the Detail category of the Format tab, you can select how you want variance information displayed. To view the currency variance as a dollar amount, select Currency in the Display Variance As frame. To view the currency variance as a percentage, select Percentage in the Display Variance As frame. You can also select to display Both, the dollar amount and the percentage.

Total Given. The total given appears for each of the two gift periods you selected on the General tab of the Comparative Report parameter tabs. In the UK this takes into account the net or gross option set in User Options for cash gifts.

Consecutive Years Report

Note: The Donor Category Report can also create totals within a category based on the constituent code. For example, it can show that 12 alumni gave $50,000 or 10 trustees gave $85,000.

The Consecutive Years Report provides an analysis of the number of years in a row constituents donated. For example, to create a report of donors who gave for the past five years, use the current date and select the five consecutive previous years. This report can provide giving information for all constituents, constituents in a selected query, or one constituent. The report includes constituent name, consecutive years of giving, total donated, and average amount donated per year. The date range defines the starting point from which you want to look back, not the number of years to consider. The exact data included depends on your parameter tab settings.

Consecutive Years Report Columns

Average Given Per Year. An average of the total amounts the constituent gave each of the consecutive years; in the UK this takes into account the net or gross option set in User Options for cash gifts.

Consecutive Years. The number of consecutive years the constituent donated.

Constituent Name. This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.
Total Given. The total amount the constituent gave in the consecutive years period.

**Donor Category Report**

*Note:* For information about defining donor categories, see the Donor Category Tables section in the Configuration chapter of the Configuration & Security Guide.

The **Donor Category Report** provides a list of giving clubs (for example, benefactor, patron, friend) based on the total donated during a time period you select. You define donor categories in *Configuration*. The detail report lists constituent names with the amount donated per constituent. The summary report lists the number of constituents in each category and the total donated. Both report types provide the total amount donated. The exact data included depends on your parameter tab settings.

**Donor Category Report Columns**

The detail report type displays the following columns:

- **Constituent Name.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

- **The donor category.** In the **Donor Category Report**, you can base your report on donor category tables you established in *Configuration*. These tables reflect different cumulative giving award categories for your donors and specify a minimum amount a donor must give to become a member of this category. To base your report on a donor category table, select the table number in the **Use donor category table** field in the **Detail** category of the Format tab.

*Note:* In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

The summary report type displays the following columns:

- **Donor Category.** All donor categories included in the donor category table you selected in the **Use donor category table** field in the **Detail** category of the Format tab appear. You established donor category tables in *Configuration*.

- **Level.** The minimum amount a donor must give to become a member of this category.

- **No. Constituents.** The number of constituents who gave at each donor category.

**First/Greatest/Latest Gift Report**

The **First/Greatest/Latest Gift Report** provides information about the first donation a constituent made, their largest donation, and their most recent donation during a selected period of time. You can include any or all three pieces of information.

*Warning:* If you are creating a detail report, at least one of the gift column checkboxes in the **Detail** section must be selected for the report to run.

The report can include the first gift amount and date, the largest gift amount and date, the latest gift amount and date, or all three. It can also include the constituent name and address and the date and amount of gifts you select. The exact data included depends on your parameter tab settings.
**First/Greatest/Latest Gift Report Columns**

**Constituent Name.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

**First/Date.** If, in the Detail category on the Format tab, you marked Include First Gift column, a First column appears, displaying the amount of the constituent’s first gift. The Date column displays the date of the first gift.

**Greatest/Date.** If, in the Detail category on the Format tab, you marked Include Greatest Gift column, a Greatest column appears, displaying the amount of the constituent’s largest gift. The Date column displays the date of the greatest gift.

**Latest/Date.** If, in the Detail category on the Format tab, you marked Include Latest Gift column, a Latest column appears, displaying the amount of the constituent’s most recent gift. The Date column displays the date of the most recent gift.

**Giving Score Control Report**

The Giving Score Control Report provides a summary of how Target Analytics scored your data for the Giving Score. It breaks down the number of individuals given a prospect rating of VIP, Fan, Acquaintance, or Long-Shot, and provides the number of records in your database that were scored and not scored. The report also includes the date you last updated your data for the Giving Score and a description of each rating.

On the General tab of the New Giving Score Control Report screen, you can select to view the report for the most recent date your data was scored or for a previous date.

**LYBUNT Report**

The LYBUNT Report (last year but unfortunately not this) provides a list of constituents who donated last year but did not donate during the time period you specify as the current year. This report can include the constituent name with the last gift donated and the gift date.

**Note:** For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

For example, if you use 01/01/2004 - 12/31/2004 for the date range, the report includes donors who gave between 01/01/2003 and 12/31/2003 but have not donated between 01/01/2004 and 12/31/2004. If you use 06/01/2005 - 12/31/2005, the report includes the period 06/01/2004 - 12/31/2004. The exact data included depends on your parameter tab settings.

**LYBUNT Report Columns**

**Constituent Name.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

**Date.** This column displays the date of the last gift given by the constituent.

**Fund(s).** This optional column displays the fund(s) to which the last gift was given.

**Last Gift.** This column displays the amount of the last gift given by the constituent.

**Total Given Last Yr.** This optional column displays the total amount the constituent gave last year.
New Donors Report

The **New Donors Report** provides a list of first-time donors (donors who have not given before but did donate during a time period you select). The report includes the constituent name, information about the gift, and the related fund and appeal. The exact data included depends on your parameter tab settings.

**Note:** In reports allowing phone numbers, an indicator (‘*’) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

**New Donors Report Columns**

- **Amount.** This column displays the amount of the gift given by the new donor; in the UK this takes into account the net or gross option set in User Options.
- **Appeal(s).** This column displays the appeal(s) that generated the new donor gift.
- **Constituent Name.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.
- **Date.** This column displays the date of the gift given by the new donor.
- **Fund(s).** This column displays the fund(s) to which the new donor gave.
- **Package(s).** This optional column displays benefit packages the new donor received for the gift.
- **Type.** The type of gift given (cash, pledge, stock/property, etc.).

Non-Contributors Report

**Note:** For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

The **Non-Contributors Report** provides a list of constituents who did not donate during a time period you select. The report can include the constituent name, address, and telephone number. The total number of constituents on the list appears at the bottom of the report. The exact data included depends on your parameter tab settings.

**Non-Contributors Report Columns**

- **Constituent Name.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

Parent Class Analysis

**Note:** A parent-child relationship must be established in the constituent record for information to appear on the **Parent Class Analysis**.

The **Parent Class Analysis** tracks donations made by the parents of alumni. The detail report lists each parent name by class year with the individual amounts donated or the total donated during a time period you select. The summary report lists parent donors by class year. If you choose to create an output query, you can use it later to generate mailing lists. The exact data included depends on your parameter tab settings.
Parent Class Analysis Columns

The Detail report type displays the following columns:

**Amount.** The amount the parents of the selected class raised. The column names and the gift types calculated are based on your selections on the Gift Types tab of the report parameter screen.

The gift type columns default as follows:

- **Column 1 - Amount** - Summing gift amounts with gift type of: Cash, Pay-Cash, MG Pay-Cash, Stock/Property, Stock/Property (Sold), Pay-Stock/Property, Pay-Stock Property (Sold), MG Pay-Stock/Property, MG Pay-Stock/Property (Sold), Gift-in-Kind, Pay-Gift-in-Kind, MG Pay-gift-in-Kind, Other, Pay-Other, MG Pay-Other, Recurring Gift Pay-Cash.

- **Column 2 - Pledge** - Summing gift amounts with gift type of: Pledge, MG Pledge.

- **Column 3 Pledge Balance** - Summing gift balance amounts with gift type of: Pledge, MG Pledge.

**Note:** In reports allowing phone numbers, an indicator ("~") appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

**Class.** This column displays a list of class years included in the report.

**Constituent Name.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

**Pledge.** The pledge amount made by the parents of the selected class. The column names and the gift types calculated are based on your selections on the Gift Types tab of the report parameter screen.

The gift type columns default as follows:

- **Column 1 - Amount** - Summing gift amounts with gift type of: Cash, Pay-Cash, MG Pay-Cash, Stock/Property, Stock/Property (Sold), Pay-Stock/Property, Pay-Stock Property (Sold), MG Pay-Stock/Property, MG Pay-Stock/Property (Sold), Gift-in-Kind, Pay-Gift-in-Kind, MG Pay-gift-in-Kind, Other, Pay-Other, MG Pay-Other, Recurring Gift Pay-Cash.

- **Column 2 - Pledge** - Summing gift amounts with gift type of: Pledge, MG Pledge.

- **Column 3 Pledge Balance** - Summing gift balance amounts with gift type of: Pledge, MG Pledge.

**Pledge Balance.** The balance remaining on any pledge made by the parents of the selected class. The column names and the gift types calculated are based on your selections on the Gift Types tab of the report parameter screen.

The gift type columns default as follows:

- **Column 1 - Amount** - Summing gift amounts with gift type of: Cash, Pay-Cash, MG Pay-Cash, Stock/Property, Stock/Property (Sold), Pay-Stock/Property, Pay-Stock Property (Sold), MG Pay-Stock/Property, MG Pay-Stock/Property (Sold), Gift-in-Kind, Pay-Gift-in-Kind, MG Pay-gift-in-Kind, Other, Pay-Other, MG Pay-Other, Recurring Gift Pay-Cash.

- **Column 2 - Pledge** - Summing gift amounts with gift type of: Pledge, MG Pledge.

- **Column 3 Pledge Balance** - Summing gift balance amounts with gift type of: Pledge, MG Pledge.

The Summary report type displays the following columns:

**Amount.** The amount the parents of the selected class raised. The column names and the gift types calculated are based on your selections on the Gift Types tab of the report parameter screen.

The gift type columns default as follows:

- **Column 1 - Amount** - Summing gift amounts with gift type of: Cash, Pay-Cash, MG Pay-Cash, Stock/Property, Stock/Property (Sold), Pay-Stock/Property, Pay-Stock Property (Sold), MG Pay-Stock/Property, MG Pay-Stock/Property (Sold), Gift-in-Kind, Pay-Gift-in-Kind, MG Pay-gift-in-Kind, Other, Pay-Other, MG Pay-Other, Recurring Gift Pay-Cash.
• **Column 2 - Pledge** - Summing gift amounts with gift type of: Pledge, MG Pledge.

• **Column 3 Pledge Balance** - Summing gift *balance amounts* with gift type of: Pledge, MG Pledge.

**Class.** This column displays a list of class years included in the report.

**Donors.** The number of parent donors from the selected class.

**No. Of Gifts.** The summation of the number of gifts given per column/gift type. There are three per report, each totaling the number of gifts in the previous column.

**Out Of.** The number of parents listed on the class record.

**Percent.** The percentage of parent donors from the specified class over the number of parents on the class record.

**Pledge.** The pledge amount made by the parents of the selected class. The column names and the gift types calculated are based on your selections on the Gift Types tab of the report parameter screen.

The gift type columns default as follows:

• **Column 1 - Amount** - Summing gift amounts with gift type of: Cash, Pay-Cash, MG Pay-Cash, Stock/Property, Stock/Property (Sold), Pay-Stock/Property, Pay-Stock Property (Sold), MG Pay-Stock/Property, MG Pay-Stock/Property (Sold), Gift-in-Kind, Pay-Gift-in-Kind, MG Pay-gift-in-Kind, Other, Pay-Other, MG Pay-Other, Recurring Gift Pay-Cash.

• **Column 2 - Pledge** - Summing gift amounts with gift type of: Pledge, MG Pledge.

• **Column 3 Pledge Balance** - Summing gift *balance amounts* with gift type of: Pledge, MG Pledge.

**Pledge Balance.** The balance remaining on any pledge made by the parents of the selected class. The column names and the gift types calculated are based on your selections on the Gift Types tab of the report parameter screen.

The gift type columns default as follows:

• **Column 1 - Amount** - Summing gift amounts with gift type of: Cash, Pay-Cash, MG Pay-Cash, Stock/Property, Stock/Property (Sold), Pay-Stock/Property, Pay-Stock Property (Sold), MG Pay-Stock/Property, MG Pay-Stock/Property (Sold), Gift-in-Kind, Pay-Gift-in-Kind, MG Pay-gift-in-Kind, Other, Pay-Other, MG Pay-Other, Recurring Gift Pay-Cash.

• **Column 2 - Pledge** - Summing gift amounts with gift type of: Pledge, MG Pledge.

• **Column 3 Pledge Balance** - Summing gift *balance amounts* with gift type of: Pledge, MG Pledge.

**Solicitor Comparison Report**

The **Solicitor Comparison Report** lists gift information for all or selected solicitors in your database. You can compare the total gift amount, the number of gifts, the number of donors, and the average gift amount credited to each solicitor for a specific date range. You can also view gift details for each column. The exact data included depends on your parameter tab settings.

**Solicitor Comparison Report Columns**

**Report Periods columns.** User-defined columns from the Report Periods tab. You can include up to seven report periods and enter column heading information.

**Note:** In reports allowing phone numbers, an indicator (‘~’) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

**Solicitor.** The solicitor’s name.
Solicitor Goal Summary

The Solicitor Goal Summary provides an overview of your solicitors’ fund-raising efforts. The report can include the type of goal, goals versus actual gifts received, and percentages of goals and responses. You can also include information for a campaign, fund, unspecified goal, or combination of these goals. The exact data included depends on your parameter tab settings.

Solicitor Goal Summary Report Columns

<table>
<thead>
<tr>
<th>Solicitor</th>
<th>The solicitor’s name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign/Fund/Category</td>
<td>This column lists the specific campaigns and funds for which each solicitor has applicable goals, grouped by their category (Campaign Goals or Fund Goals) for each solicitor.</td>
</tr>
<tr>
<td>Goal</td>
<td>The amount the solicitor must raise for each individual campaign or fund.</td>
</tr>
<tr>
<td>Actual</td>
<td>The total amount of gifts given toward the corresponding goal. Gifts included are based on report parameters.</td>
</tr>
<tr>
<td>Over/(Under)</td>
<td>The actual gift minus the goal. Amounts under the goal are in parentheses</td>
</tr>
<tr>
<td>Percent</td>
<td>The actual gift divided by the goal, displayed as a percentage.</td>
</tr>
<tr>
<td>Donors</td>
<td>The number of constituents who gave one or more gifts toward a solicitor’s goal.</td>
</tr>
<tr>
<td>Out Of</td>
<td>The number of constituents assigned to the solicitor.</td>
</tr>
</tbody>
</table>

Solicitor Performance Analysis

Note: For the gift to appear on the Solicitor Performance Analysis, the solicitor must be recorded on the gift record.

The Solicitor Performance Analysis tracks the progress of your solicitors toward meeting their assigned goals. The detail report can include solicitors assigned to constituents, the constituent names, the amount donated by each constituent, the total amount generated per solicitor, and the solicitor progress toward goal. The summary report provides similar information but with no constituent names. The exact data included depends on your parameter tab settings.

Solicitor Performance Analysis Report Columns

The Detail report type displays the following columns:

| Amount | The amount of the gifts given by each assigned constituent. Gifts included are based on the report parameters. |
| Constituent | The constituents who are assigned to each applicable solicitor, grouped under the solicitor’s name. |
| Pledge Balance | The balance owed on pledges given by the constituent. |

The Summary report type displays the following columns:

| Amount | The total amount of the gifts given by the constituents assigned to the solicitor. |
| Donors | The number of donors who gave applicable gifts and are assigned to the corresponding solicitor. |
| Goal | The goal amount set for the corresponding solicitor. |
| Out Of | The number of donors assigned to the corresponding solicitor. |
| Over/Under | How much the corresponding solicitor is over or under the set goal. |
| Pledge Balance | The balance owed on pledges raised by the corresponding solicitor. |
**Solicitor.** The names of solicitors selected for this report.

**Percent.** The number of donors crediting the corresponding solicitor for their Gifts, divided by the number of donors on the corresponding solicitor’s record, and displayed as a percentage.

---

**SYBUNT Report**

**Note:** In the phrase “Some Year But Unfortunately Not This,” “This” means the period specified by the start date and end date.

The **SYBUNT Report** (some years but unfortunately not this) provides a list of constituents who donated at some time in the history of your organization but did not donate during the time period you specify. The last gift donated and the date of the gift appear with the constituent name. Because last year is also “some year,” donors appearing on the **LYBUNT Report** can also appear on the **SYBUNT Report**. The exact data included depends on your parameter tab settings.

**SYBUNT Report Columns**

- **Constituent Name.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.
- **Date.** This column displays the date of the last gift given by the constituent.
- **Fund(s).** This optional column displays the fund(s) to which the last gift was given.
- **Last Gift.** This column displays the amount of the last gift given by the constituent.
- **Total Amount Given.** This optional column displays the total amount the constituent has given your organization.

---

**Top Donors Report**

**Note:** The number you enter in **Top Donor Criteria** frame in the **Detail** category of the Format tab, defaults into the report title. For example, if you select 10, the report title reads, “Top 10 Donors Report.” You can select up to 99 top donors.

The **Top Donors Report** provides a list of the top donors during a time period you define. You can include as many donors as you want (for example, top 10% of your donors, top five donors, top 99 donors). The report ranks and displays the total number of gifts, the total amount donated, and provides giving level information alphabetically or by gift size. The report title changes automatically to reflect whether you are reporting by count or percentage. The exact data included depends on your parameter tab settings.

**Top Donors Report Columns**

- **Amount Given.** The total amount given by the donor to your organization.
- **Constituent Name.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

**Note:** In reports allowing phone numbers, an indicator (“~”) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.
No. Gifts. The number of gifts given by the donor.

Rank. Where the donor ranks in the list of top donors.

VSE Survey Report

The VSE Survey Report is used to calculate certain sections of the Voluntary Support of Education Survey. Please note that not all sections of the survey are calculated in The Raiser’s Edge. Also, not all gift types are calculated. For example, The Raiser’s Edge does not include calculation for deferred gifts such as planned giving. For official sample reports and supplemental information, see the VSE Web site at www.cae.org.

Note: This report is only available if you have the optional module Alumni Tracking.

The VSE Survey Report collects detailed information from colleges, universities, and private elementary and secondary schools on private gifts and grants received from alumni, parents, other individuals, foundations, corporations, and other organizations. In addition to gift income, the survey gathers data on enrollment, endowment market value, and educational and general expenditures from each institution. Independent schools are asked to provide a total advancement program expenditure figure as well.

Note: For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.


Note: Once a constituent has been counted as an Alumnus, they are not counted again under any other constituent code selection.

The VSE Survey Report category that donors and their gifts fall under is determined by the constituent codes on the Bio 2 tab of the constituent’s record. Constituent codes attached to the gift record do not determine the category. The constituent code Alumnus takes precedence over any other code. If Alumnus is not listed first in a record’s list of constituent codes, but is present on the list, the donor is still counted as an Alumnus in the report. Section IV of the report can track multiple alumni codes. If a constituent has multiple codes, for example Alumni-Graduate and Alumni-Undergraduate, the first alumni code in the list determines the code associated with the constituent. The exact data included depends on your parameter tab settings.

Campaigns, Funds, and Appeals Reports

Campaigns, funds, and appeals are the foundation on which your successful fund raising efforts are built. Although separate records, they are closely related. Campaigns are your overall objectives for raising money; funds are the specific financial purposes of gifts; and appeals are the solicitations and promotions that bring in gifts. When you begin fund raising, you specify a purpose for the funds you intend to raise, define a monetary goal to achieve, and develop a structured plan to realize your goals. When you begin receiving gifts, you can track your progress and evaluate the cost-effectiveness of your efforts. The Raiser’s Edge also assists you in assigning and managing solicitors for your campaigns and funds and setting goals for a campaign, fund, or appeal.

Campaign, Funds, & Appeals Reports track information entered on your campaign, fund, and appeal records. With these reports, you can analyze the success of your fund-raising activities. For example, the Campaign Progress Report and the Fund Performance Analysis show how your campaigns and funds are performing.
Appeal Comparison Summary

The Appeal Comparison Summary compares different appeals. You can use the report to review the effectiveness of appeals. You can also produce a graph of the report results. The report lists appeals with the amount generated for each report period you define. Totals also appear for each report period, so you can compare appeals or report periods. The exact data included depends on your parameter tab settings.

Appeal Comparison Summary Columns

- **Appeal.** This column displays the name of the appeal.
- **Package.** This optional column displays any package information associated with the corresponding appeal.
- **Report Periods columns.** User-defined columns from the Report Periods tab. You can include up to eight report periods and enter column heading information.

Appeal Cost Breakdown

The Appeal Cost Breakdown provides details about expenditures related to an appeal. This is particularly useful in tracking total costs of an appeal and determining the appeal’s success. You can produce a graph of the report results. This report includes the appeal ID and description, expense description, comments, date, subtotals, and grand totals of costs. You can choose to report on cost information for all appeals or selected appeals. The exact data included depends on your parameter tab settings.

Appeal Cost Breakdown Columns

- **Amount.** This column displays the amount entered in the Amount column in the Expenses grid on the Attributes/Expenses tab of the appeal record.
- **Appeal ID.** This column displays the appeal ID entered in the Appeal ID field on the General tab of the appeal record.
- **Comment.** This column displays information entered in the Comment column in the Expenses grid on the Attributes/Expenses tab of the appeal record.
- **Date.** This column displays the date entered in the Date column in the Expenses grid on the Attributes/Expenses tab of the appeal record.
- **Description.** This column displays the appeal description entered in the Description field on the General tab of the appeal record.
- **Expense Description.** This column displays information entered in the Expense column in the Expenses grid on the Attributes/Expenses tab of the appeal record.
- **Packages.** This optional column displays package information entered on the Packages tab of the appeal record.

Appeal Detail Report

The Appeal Detail Report provides a basic description of information entered in the appeal record. You can include a list of your appeals with appeal ID, goal, start and end dates, default campaign and fund, number solicited during the appeal, and notes about the appeal. You can also choose to display each appeal on a separate page. The exact data included depends on your parameter tab settings.
Appeal Detail Report Columns

**Actions.** This optional column displays any actions associated with the appeal based on information entered on the Actions tab of the appeal record.

**Appeal ID.** This column displays the appeal ID entered in the Appeal ID field on the General tab of the appeal record.

**Attributes.** This optional column displays attribute information entered in the Attributes grid on the Attributes/Expenses tab of the appeal record.

**Campaigns.** This column displays the campaigns associated with the appeal based on selections made on the Campaigns tab of the appeal record.

**Description.** This column displays the appeal description entered in the Description field on the General tab of the appeal record.

**End date.** This column displays the end date of the appeal entered in the End date field on the General tab of the appeal record.

**Funds.** This column displays the funds associated with the appeal based on selections made on the Funds tab of the appeal record.

**Goal.** This column displays the appeal goal entered in the Overall goal field on the General tab of the appeal record.

**No. Solicited.** This column displays information entered in the No. solicited field on the General tab of the appeal record.

**Notes.** This optional column displays any notes entered in the Notes field on the General tab of the appeal record.

**Packages.** This optional column displays package information entered on the Packages tab of the appeal record.

**Start date.** This column displays the start date of the appeal entered in the Start date field on the General tab of the appeal record.

**Total Expenses.** This optional column displays the total expenses associated with the appeal based on information entered in Expenses grid on the Attributes/Expenses tab of the appeal record.

Appeal Goal Summary

**Note:** A goal is the total amount of money you want a solicitor, a campaign, a fund, or other category to bring into your organization.

The Appeal Goal Summary compares your goals to the actual gifts received. It also includes responses to appeals and other statistical information about relationships among your campaigns, funds, and appeals. You can produce a graph of the report results. You can also view the number of constituents solicited by an appeal and the number who actually contributed. The cost of the appeal divided by the amount raised indicates the overall effectiveness of your appeal. The exact data included depends on your parameter tab settings.

**Appeal Goal Summary Columns**

% of Goal. The actual amount/overall goal displayed as a percent.

% Resp. The no. donors/no. solicited displayed as a percent.

Actual. This column displays the actual amount raised by the appeal.

Appeal. This column displays the appeal description entered in the Description field on the General tab of the appeal record.

Cost/$ Raised. What your cost was for each dollar raised.
**No. Donors.** This column displays the number of donors to the appeal.

**No. Solicited.** This column displays information entered in the No. solicited field on the General tab of the appeal record.

**Overall Goal.** This column displays the appeal goal entered in the Overall goal field on the General tab of the appeal record.

**Over (Under).** This column displays how much the appeal amount is over or under the overall goal amount (actual amount - overall goal).

**Appeal Performance Analysis**

The Appeal Performance Analysis tracks the success of an appeal. You can run the report for more than one appeal and compare grand totals and donors. This report is especially helpful for comparing results obtained from different types of appeals. The report includes the number of constituents solicited, number of gifts and donors, percentage responding, total donated, average size of gift, average gift per donor, amount over/under goal, total cost of the appeal, and cost of the appeal per dollar donated and per donor. You can produce a graph of the report results. The exact data included depends on your parameter tab settings.

**Appeal Performance Analysis Columns**

**% Resp.** The no. donors/no. solicited displayed as a percent.

**Appeal.** This column displays the appeal description entered in the Description field on the General tab of the appeal record.

**Avg/Gift.** This column displays the average donated per gift. The program divides the total amount given by the number of gifts to arrive at the average.

**Avg/Donor.** This column displays the average donated per donor. The program divides the total amount given by the number of donors to arrive at the average.

**Cost/Gift or Cost/Donor.** This column displays the cost of the appeal as a cost per gift generated from the appeal or as a cost per donor from the number of donors responding to the appeal.

**Donors.** This column displays the number of donors to the appeal.

**Gifts.** This column displays the number of gifts generated by the appeal.

**Goal.** This column displays the appeal goal entered in the Overall goal field on the General tab of the appeal record.

**No. Sols.** This column displays information entered in the No. solicited field on the General tab of the appeal record.

**Over (Under).** This column displays how much the appeal amount is over or under the overall goal (actual amount - overall goal).

**Package.** This optional column displays package information entered on the Packages tab of the appeal record.

**Total Cost.** This column displays the total cost of the appeal. The number is the sum of the dollar amounts entered in the Amount column in the Expenses grid on the Attributes/Expenses tab of the appeal record.

**Total Given.** This column displays the total amount given to the appeal.
Appeal Summary List

The Appeal Summary List provides an overview of an appeal and the campaigns to which it is associated. The report does not show any gift amounts or expenses. You can include summary information about all of your appeals, selected appeals, or just one appeal. The report includes the appeal ID and description, starting and ending dates, the goal, and names of the associated campaign. The exact data included depends on your parameter tab settings.

Appeal Summary List Columns

**Appeal ID.** This column displays the appeal ID entered in the Appeal ID field on the General tab of the appeal record.

**Default Campaign ID.** This column displays the campaign ID of the campaign marked as the default on the Campaigns tab of the appeal record.

**Description.** This column displays the appeal description entered in the Description field on the General tab of the appeal record.

**End date.** This column displays the end date of the appeal entered in the End date field on the General tab of the appeal record.

**Goal.** This column displays the appeal goal entered in the Overall goal field on the General tab of the appeal record.

**Packages.** This optional column displays package information entered on the Packages tab of the appeal record.

**Start date.** This column displays the start date of the appeal entered in the Start date field on the General tab of the appeal record.

Campaign Comparison Summary

The Campaign Comparison Summary compares campaign performances. The summary lists selected campaigns and provides the total amount of gifts donated to each. You can produce a graph of the report results. The exact data included depends on your parameter tab settings.

Campaign Comparison Summary Columns

**Campaign.** This column displays the campaign description entered in the Description field on the General tab of the campaign record.

**Report Periods columns.** User-defined columns from the Report Periods tab. You can include up to eight report periods and enter column heading information.

Campaign Detail Report

**Note:** For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

The Campaign Detail Report provides a basic description of information entered in the campaign record. It produces a list of your campaigns with ID, goal, and start and end dates. You can also display each campaign on a separate page. The exact data included depends on your parameter tab settings.
Campaign Detail Report Columns

**Actions.** This optional column displays any appeal or event actions associated with the campaign through the Appeals tab and/or the Events tab of the campaign record.

**Appeals.** This column displays the appeals associated with the campaign based on selections made on the Appeals tab of the campaign record.

**Attributes.** This optional column displays attribute information entered in the Attributes grid on the Attributes tab of the campaign record.

**Campaign ID.** This column displays the campaign ID entered in the Campaign ID field on the General tab of the campaign record.

**Description.** This column displays the campaign description entered in the Description field on the General tab of the campaign record.

**End date.** This column displays the end date of the campaign entered in the End date field on the General tab of the campaign record.

**Events.** This column displays the events associated with the campaign based on selections made on the Events tab of the campaign record.

**Funds.** This column displays the funds associated with the campaign based on selections made on the Funds tab of the campaign record.

**Goal.** This column displays the campaign goal entered in the Overall goal field on the General tab of the campaign record.

**Notes.** This optional column displays any notes entered in the Notes field on the General tab of the campaign record.

**Start date.** This column displays the start date of the campaign entered in the Start date field on the General tab of the campaign record.

Campaign Goal Summary

**Note:** You can also run a Campaign Summary and a Goal Summary from the View menu in the campaign record. For more information, see the Summaries Guide.

The Campaign Goal Summary compares campaign goals to actual gifts received. The difference between the goal and the amount received is presented as a dollar amount and as a percentage. You can also view the number of constituents solicited for a campaign and the number who actually contributed. The cost of the campaign divided by the amount raised indicates the overall effectiveness of your campaign. You can produce a graph of the report results. The exact data included depends on your parameter tab settings.

Campaign Goal Summary Columns

**% of Goal.** The actual amount/overall goal displayed as a percent.

**% Resp.** The no. donors/no. solicited displayed as a percent.

**Actual.** This column displays the actual amount raised by the campaign.

**Campaign.** This column displays the campaign description entered in the Description field on the General tab of the campaign record.

**Cost/$ Raised.** What your cost was for each dollar raised.

**No. Donors.** This column displays the number of donors to the campaign.

**No. Solicited.** This column displays the number solicited through appeals for the campaign. This information is based on data entered in the No. solicited field on the General tab of the appeal record.
Overall Goal. This column displays the campaign goal entered in the **Overall goal** field on the General tab of the campaign record.

Over (Under). This column displays how much the campaign amount is over or under the overall goal (actual amount - overall goal).

**Campaign Performance Analysis**

The **Campaign Performance Analysis** compares the campaign goal, the number of donors, and gifts donated to the campaign. This report does not include constituent names. You can produce a graph of the report results. The exact data included depends on your parameter tab settings.

**Campaign Performance Analysis Columns**

% of Goal. The actual amount raised/overall goal displayed as a percent.

Avg/Donor. This column displays the average donated per donor. The program divides the total amount given by the number of donors.

Avg/Gift. This column displays the average donated per gift. The program divides the total amount given by the number of gifts to arrive at the average.

Campaign. This column displays the campaign description entered in the **Description** field on the General tab of the campaign record.

Goal. This column displays the campaign goal entered in the **Overall goal** field on the General tab of the campaign record.

No. Donors. This column displays the number of donors to the campaign.

No. Gifts. This column displays the number of gifts generated by the campaign.

Over (Under). This column displays how much the campaign amount is over or under the overall goal.

Total Given. This column displays the total amount given to the campaign.

**Campaign Progress Report**

---

**Note:** The overall goal for each campaign is the campaign goal.

The **Campaign Progress Report** tracks a campaign’s progress toward its goal. Only “new dollars” donated during the time period you select are reported as income. Pledge payments made outside the date range of the report are not considered new dollars. The program summarizes information based on constituent codes. The report shows you the number of donors, outstanding pledges, number of donors pledging, and an overall total with income and outstanding pledges. You can produce a graph of the report results. The exact data included depends on your parameter tab settings.

**Campaign Progress Report Columns**

% Partic. The **Donors Total/Constits Solicited**.

Campaign Totals. This column displays the total amount raised by all campaigns included in the report along with the amount over or under the target amount, and the percentage of the target amount.

Constituent Codes. This column displays the constituent codes associated with donors to the campaign. The report is summarized based on the constituent codes. This information is pulled from the Constituent Codes grid on the Bio 2 tab of the constituent record associated with the campaign gift.

Constits Solicited. This is the number of constituents in the database who have a code on their record or the number of gifts in the database that meet the report parameters for each constituent code.
**Donors Pledged.** This column displays the number of donors who have an outstanding balance. If a donor has more than one pledge outstanding to the same constituent code, they are not counted twice.

**Donors Total.** The sum of the No. Donors Who Gave and No. Donors Pledged columns.

**Donors Who Gave.** This column counts the constituents whose gifts appear in the Income Column. If a donor gave more than one gift and the gifts are based on the same constituent code, the donor is not counted twice.

**Fund Totals.** This column displays the total amount raised by all funds included in the report along with the amount over or under the target amount, and the percentage of the target amount.

**Income.** This column displays income generated by the campaign. All gift types included in the report are counted. Pledges are not included in this column. If an amount given falls into two categories (for example, Alumnus and Employee) the number is not counted twice.

**Outstanding Pledges.** This column includes only outstanding pledge balances. If the donor has more than one constituent code, the outstanding pledge balance is not counted twice.

**Total Inc + Plg.** The sum of the Income and Outstanding Pledges columns.

### Campaign Summary List

The **Campaign Summary List** provides an overview of a campaign, including a description of the campaign, its start and end dates, goal, and funds associated with the campaign. You can include summary information about all of your campaigns, selected campaigns, or just one campaign. The exact data included depends on your parameter tab settings.

#### Campaign Summary List Columns

- **Campaign ID.** This column displays the campaign ID entered in the Campaign ID field on the General tab of the campaign record.
- **Default Fund.** This column displays the fund marked as the default fund on the Funds tab of the campaign record.
- **Description.** This column displays the campaign description entered in the Description field on the General tab of the campaign record.
- **End date.** This column displays the end date of the campaign entered in the End date field on the General tab of the campaign record.
- **Goal.** This column displays the campaign goal entered in the Overall goal field on the General tab of the campaign record.
- **Start date.** This column displays the start date of the campaign entered in the Start date field on the General tab of the campaign record.

### Fund Comparison Summary

The **Fund Comparison Summary** compares different funds. The summary lists selected funds and provides the total amount of gifts donated to each. You can produce a graph of the report results. The exact data included depends on your parameter tab settings.

#### Fund Comparison Summary Columns

- **Fund.** This column displays the fund description entered in the Description field on the General tab of the Fund record.
- **Report Periods columns.** User-defined columns from the Report Periods tab. You can include up to eight report periods and enter column heading information.
Fund Detail Report

The Fund Detail Report displays basic information entered on the fund record. It prints a list of your funds with the ID, goal, start and end dates, and notes. It also gives you information about any restrictions on the fund and a summary of the General Ledger account distribution associated with the selected funds. You can display each fund on a separate page. The exact data included depends on your parameter tab settings.

Fund Detail Report Columns

Appeals. This column displays the appeals associated with the fund based on selections made on the Appeals tab of the fund record.

Attributes. This optional column displays attribute information entered in the Attributes grid on the Attributes tab of the fund record.

Campaign. This column displays the campaign associated with the fund based on selections made on the Appeals tab of the fund record.

Category. This column displays the fund category entered in the Category field on the General tab of the fund record.

Description. This column displays the fund description entered in the Description field on the General tab of the fund record.

End date. This column displays the end date of the fund entered in the End date field on the General tab of the fund record.

Fund ID. This column displays the fund ID entered in the Fund ID field on the General tab of the fund record.

General Ledger Accounts. This column displays any general ledger information associated with the fund, such as gift type, credit account numbers, and debit account numbers.

Goal. This column displays the fund goal entered in the Overall goal field on the General tab of the fund record.

Notes. This optional column displays any notes entered in the Notes field on the General tab of the fund record.

Restricted. This column displays “Yes” if the Fund is restricted checkbox on the General tab of the fund record is marked. The columns displays “No” if the checkbox is not marked.

Start date. This column displays the start date of the fund entered in the Start date field on the General tab of the fund record.

Fund Goal Summary

Note: You can also run a Fund Summary and a Goal Summary from the View menu in the fund record. For more information, see the Summaries Guide.

The Fund Goal Summary compares fund goals to the actual gifts received. The difference between the goal and the amount received is presented as a dollar amount and as a percentage. You can include the total amount raised for each goal, the number of constituents solicited for a fund, and how many actually contributed. The cost of the fund divided by the amount raised indicates the overall effectiveness of your fund. You can produce a graph of the report results. The exact data included depends on your parameter tab settings.

Fund Goal Summary Columns

% of Goal. The actual amount/overall goal displayed as a percent.

% Resp. The no. donors/no. solicited displayed as a percent.

Actual. This column displays the actual amount raised by the fund.
**Cost/$ Raised.** What your cost was for each dollar raised.

**Fund.** This column displays the fund description entered in the Description field on the General tab of the fund record.

**No. Donors.** This column displays the number of donors to the fund.

**No. Solicited.** This column displays the number solicited through appeals for the fund. This information is based on data entered in the No. solicited field on the General tab of the appeal record.

**Overall Goal.** This column displays the fund goal entered in the Overall goal field on the General tab of the fund record.

**Over (Under).** This column displays how much the fund amount is over or under the overall goal (actual amount - overall goal).

### Fund Performance Analysis

The Fund Performance Analysis helps you analyze the success or performance of a fund over a given time period. The report includes the number of donors, average given per donor, number and average size of gifts donated, total donated, and percentage of the goal met. The analysis can include information for all or selected constituents. You can produce a graph of the report results. The exact data included depends on your parameter tab settings.

### Fund Performance Analysis Columns

- **% of Goal.** The actual amount raised/goal displayed as a percent.
- **Avg/Donor.** This column displays the average donated per donor. The program divides the total amount given by the number of donors.
- **Avg/Gift.** This column displays the average donated per gift. The program divides the total amount given by the number of gifts to arrive at the average.
- **Fund.** This column displays the fund description entered in the Description field on the General tab of the fund record.
- **Goal.** This column displays the fund goal entered in the Overall goal field on the General tab of the fund record.
- **No. Donors.** This column displays the number of donors to the fund.
- **No. Gifts.** This column displays the number of gifts donated to the fund.
- **Over (Under).** This column displays how much the fund amount is over or under the overall goal.
- **Total Given.** This column displays the total amount given to the fund.

### Fund Summary List

**Note:** For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

The Fund Summary List generates an overview of a fund, the campaign to which it is assigned, start and end dates, and the fund category. The exact data included depends on your parameter tab settings.

### Fund Summary List Columns

- **Default Campaign.** This column displays the campaign marked as the default campaign on the Campaigns tab of the fund record.
Description. This column displays the fund description entered in the Description field on the General tab of the fund record.

End date. This column displays the end date of the fund entered in the End date field on the General tab of the fund record.

Fund Category. This column displays the fund category entered in the Category field on the General tab of the fund record.

Fund ID. This column displays the fund ID entered in the Fund ID field on the General tab of the fund record.

Goal. This column displays the fund goal entered in the Overall goal field on the General tab of the fund record.

Rest. This column displays “Yes” if the Fund is restricted checkbox on the General tab of the fund record is marked. The columns displays “No” if the checkbox is not marked.

Start date. This column displays the start date of the fund entered in the Start date field on the General tab of the fund record.

Custom Reports

Custom Reports make it easy for you to share report files you create using Seagate Crystal Reports. Using Custom Reports, you can link a Crystal Reports file with its Raiser’s Edge export file. You then save the linked report in your database, where all users have access.

For more information, see “Custom Reports” on page 335.

Demographic and Statistical

Demographic and Statistical Reports summarize information useful in determining how, when, and where gifts were raised. The reports provide summary totals, percentages, and averages of gifts or donors based on the fields you select to include in the report. With Demographic and Statistical Reports, for example, you can find out the day or month that produced the greatest income, the ZIP Code with the highest average of giving per constituent, or a geographic breakdown of where your constituents live. You can further analyze the progress of a campaign by looking at the new income generated.

Advocacy Tallies

The Advocacy Tallies Report counts the number of advocates, communications sent, and actions taken based on records with specific field values. Use this report to help analyze your advocates. The exact data included depends on your parameter tab settings.

Advocacy Tallies Columns

Number of Advocates. This column displays a subset of the number of constituents who have actions satisfying the following criteria:

Note: In reports allowing phone numbers, an indicator (‘~’) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

- Any action considered must have a category of ‘Advocacy’ assigned
- If an action query is specified, the action must be in the query
- Action date must be in the date range entered on the General tab
• Recipient name, Alert title, Issue, and Delivery method must meet the criteria on the Filters tab
• The action is included/excluded based on the actions included/excluded criteria on the Attributes tab.

**Number of Communications Sent.** This is the number of constituents satisfying the following criteria:

• If a constituent query is used, the constituent must be in the specified query.
• Inactive constituents are included if marked on the General tab.
• Deceased constituents are included if marked on the General tab.
• Constituents with no valid addresses are included if marked on the General tab.
• Constituent codes based on selections on the Filters tab.
• Include/exclude criteria entered for constituent attributes on the Attributes tab. The include/exclude criteria entered for action attributes does not affect the Number of constituents.
• If the Field to use is not an advocacy action field, the constituent is included in the correct column based on the value present on the constituent record. The action criteria is not used when determining the number of constituents. For example, if Gender is selected and the constituent is male, the constituent appears in the Male column.
• If an advocacy action field is the field selected to group, the constituent is included in the column if he has an action with that value. In this case, the constituent is included if he has any advocacy action with that value that meets the action criteria entered on the parameter tabs.

**Number of Constituents.** This column displays the total number of constituent records satisfying the criteria you select on the General tab.

**Number of Times Action Taken.** This field is the distinct count of actions for each constituent based on message ID (constituent + message ID, not just message ID). This is a distinct count based on the message ID of the number of actions satisfying the criteria defined under ‘Number of advocates’. A blank message ID is not considered a match when determining the distinct count. Each advocacy action with a blank message ID is counted as one.

**Percent of Advocacy Participation.** This column displays the total number of advocates divided by the number of constituents and displays as a percentage.

**Comparisons and Summaries**

In **Comparisons and Summaries**, you can compare two time periods or view a summary of up to five time periods. Both report types include the variance, or difference, between the time periods as either a percentage or a dollar amount. You can select one or two fields, such as age group or gift size, to compare or summarize. The exact data included depends on your parameter tab settings.

**Comparisons and Summaries Columns**

**Average Given Per Donor.** This optional column displays the average amount donated by constituents. This is the total amount given divided by the number of donors.

**Average Given Per Gift.** This optional column displays the average amount of gifts donated. This is the total amount given divided by the number of gifts.

**Number of Constituents.** This optional column displays the total number of constituent records satisfying the Field value you select on the Fields tab.

**Number of Donors.** This optional column displays the total number of constituents satisfying the Field value you select on the Fields tab and who also have donated a gift falling within the parameters you selected on the Gift Types tab.

**Number of Gifts.** This optional column displays the total number of gifts falling within the parameters you selected on the Gift Types tab. These are gifts donated by constituents satisfying the Field value you selected on the Fields tab.
Number of Members, Total Membership Dues, and Total Membership Dues Paid columns print only if you have the optional module *Membership Management.*

**Number of Members.** This optional column displays the total number of members satisfying the Field value you select on the Fields tab.

**Number of Memberships.** This optional column displays the total number of memberships satisfying the Field value you select on the Fields tab.

**Percent of Participation.** This optional column displays the level of participation as a percentage calculated by dividing the number of donors by the total number of constituents.

**Percent of Total Gifts.** This optional column displays the ratio of the gift amounts in the corresponding category to the total amount of gifts donated, displayed as a percentage.

**Report Period.** The report period(s) you define on the Report Periods tab. The column heading is determined by the Heading information you enter on this tab.

**Total Given.** This optional column displays the total amount of gifts donated. (Comparisons and Summaries, Statistical Reports)

**User-defined column.** On the Fields tab of the Comparisons and Summaries reports you select the Field you want to use in the summary. For example, if you select “Gender”, Gender appears as a column on the summary report.

### Recurring Gift Statistical Report

The *Recurring Gift Statistical Report* can help you find the regular supporters you have lost and help you better target future donors. You can determine statistics such as how many donors were lost per month; which gender or age group is giving the most money; which gender or age group is less likely to continue giving; or from which region you are receiving the highest donations.

The report processes information for the gift date you decide to use (Gift date or GL post date) and gifts on a specific date or during a specified date range. You can select to use all the fields you normally use on a *Raiser’s Edge* statistical report, with the addition of Gift payment method, Gift frequency, and Gift package. You can filter by fund(s), appeal(s), constituent code(s), campaign(s), and payment type(s). You can select a maximum of 10 columns, such as number of constituents, number of constituents with an active recurring gift, number of active recurring gifts, total number of recurring gifts cancelled/terminated, number of recurring gifts cancelled/terminated with or without payments, total number of new recurring gifts, number of new recurring gifts with or without payments, average payments given for new recurring gifts, total number of recurring gift payments, total amount of missed recurring gift payments, total number of amended recurring gifts, number of recurring gifts that were upgraded downgraded or remained the same, and number of cancelled/terminated recurring gifts/number of active recurring gifts. You can also set report limits based on certain factors. To help explain complicated data, you can also produce a bar or pie graph of the report results.

### Recurring Gift Statistical Report Columns

**Average given for recurring gift payments.** The average of the gifts used when calculating Total Amount of Payments.

**Avg. payments given for new recurring gifts.** The average of the gifts used when calculating Total Given for New.

**No. of active recurring gifts.** If a constituent field is selected, this number is determined as follows:

- Recurring gifts given by constituents who meet the specified constituent criteria
- AND
- Have the specified field value (for the row) on the constituent record
- AND
• Satisfy the specified gift criteria or has a recurring gift payment that meets the specified gift criteria or the recurring gift that meets the specified gift criteria except the date range criteria with a status of active and gift date less than or equal to the end of the date range.

If a gift field is selected, the number of active recurring gifts is determined as follows:

• Given by a constituent who meets the specified constituent criteria
  AND

• That meets the specified gift criteria and contains the specified field value (for the row) or has a recurring gift payment that meets the specified gift criteria and contains the specified value (for the row) or the recurring gift meets the specified gift criteria except the date range criteria and contains the specified value (for the row) and with a status of active and gift date less than or equal to the end of the date range.

**No. of cancelled recurring/terminated gifts/No. of active recurring gifts.** The number of cancelled/terminated recurring gifts divided by the number of active recurring gifts. The values are displayed as a percent.

**No. of constituents.** If a constituent field is selected, the number of constituents is determined as follows:

• The number of constituents who meet the specified constituent criteria
  AND

• The number of constituent that have the specified field value (for the row) on their constituent record

If a gift field is selected, the number of constituents is determined as follows:

• The number of constituents who meet the specified constituent criteria
  AND

• Constituents who have at least one recurring gift that meets the specified gift criteria and contains the specified field value (for the row)

**No. of constituents with an active recurring gift.** If a constituent field is selected, this number is determined as follows:

• The number of constituents who meet the specified constituent criteria
  AND

• The number of constituents who have the specified field value (for the row) on their constituent record
  AND

• The number of constituents who have at least one recurring gift that meets the specified gift criteria or a recurring gift payment that meets the specified gift criteria or a recurring gift that meets the specified gift criteria except the date range criteria with a status of active and gift date less than or equal to the end of the date range

If a gift field is selected, the number of constituents is determined as follows:

• The number of constituents who meet the specified constituent criteria
  AND

• Constituents who have at least one recurring gift that meets the specified gift criteria and contains the specified field value (for the row) or a recurring gift payment that meets the specified gift criteria or a recurring gift that meets the specified gift criteria except the date range criteria with a status of active and gift date less than or equal to the end of the date range

**No. of downgraded recurring gifts.** If a constituent field is selected, this number is determined as follows:

• Given by a constituent who meets the specified constituent criteria
  AND

• Has the specified field value (for the row) on their constituent record
  AND
• Meets the specified gift criteria (except the date range criteria) and has a downgrade amendment in the date range. In this case, the date criteria is applied to the amendment, not the recurring gift.

If a gift field is selected, this number is determined as follows:
• Given by a constituent who meets the specified constituent criteria
  AND
• Meets the specified gift criteria (except the date range criteria), has the specified field value (for the row), and has a downgrade amendment in the date range. In this case, the date criteria is applied to the amendment, not the recurring gift.

No. of new recurring gifts with no payments. If a constituent field is selected, this number is determined as follows:
• Recurring gifts given by constituents who meet the specified constituent criteria
  AND
• Have the specified field value (for the row) on their constituent record
  AND
• Have at least one recurring gift that meets the specified gift criteria and that has no payments applied regardless of the time frame, regardless of the current status of the gift. It just indicates that the gift date of the recurring gift falls into the specified date range.

If a gift field is selected, this number is determined as follows:
• Given by a constituent who meets the specified constituent criteria
  AND
• Meets the specified gift criteria and contains the specified field value (for the row) and has no payments applied regardless of the time frame, regardless of the current status of the gift. It just indicates that the gift date of the recurring gift falls into the specified date range.

No. of new recurring gifts with payments. If a constituent field is selected, this number is determined as follows:
• Recurring gifts given by constituents who meet the specified constituent criteria
  AND
• Have the specified field value (for the row) on their constituent record
  AND
• Have at least one recurring gift that meets the specified gift criteria and that has at least one payment applied regardless of the time frame, regardless of the current status of the gift. It just indicates that the gift date of the recurring gift falls into the specified date range.

If a gift field is selected, this number is determined as follows:
• Given by a constituent who meets the specified constituent criteria
  AND
• Meets the specified gift criteria and contains the specified field value (for the row) and has at least one payment applied regardless of the time frame, regardless of the current status of the gift. It just indicates that the gift date of the recurring gift falls into the specified date range.

No. of recurring gifts cancelled/terminated with no payments. If a constituent field is selected, this number is determined as follows:
• Recurring gifts given by constituents who meet the specified constituent criteria
  AND
• Have the specified field value (for the row) on their constituent record
  AND
• Have at least one recurring gift that meets the specified gift criteria except the date range criteria (in this case, we are using the date range for the gift status, not the recurring gift) and has a status of ‘Cancelled’ or ‘Terminated’ and a status date within the date range and has no payments applied (regardless of the time frame)

If a gift field is selected, this number is determined as follows:
• Given by a constituent who meets the specified constituent criteria
  AND
• Meets the specified gift criteria except the date range criteria (in this case, we are using the date range for the gift status, not the recurring gift) with a status of ‘Cancelled’ or ‘Terminated’ and a status date that within the date range that contains the specified field value (for the row) and has no payments applied (regardless of the time frame)

No. of recurring gifts cancelled/terminated with payments. If a constituent field is selected, this number is determined as follows:
• Recurring gifts given by constituents who meet the specified constituent criteria
  AND
• Have the specified field value (for the row) on their constituent record
  AND
• Have at least one recurring gift that meets the specified gift criteria except the date range criteria (in this case, we are using the date range for the gift status, not the recurring gift) and has a status of ‘Cancelled’ or ‘Terminated’ and a status date within the date range and has at lease one payment applied (regardless of the time frame)

If a gift field is selected, this number is determined as follows:
• Given by a constituent who meets the specified constituent criteria
  AND
• Meets the specified gift criteria except the date range criteria (in this case, we are using the date range for the gift status, not the recurring gift) with a status of ‘Cancelled’ or ‘Terminated’ and a status date that within the date range that contains the specified field value (for the row) and has at least one payment applied (regardless of the time frame)

No. of same recurring gifts. If a constituent field is selected, this number is determined as follows:
• Given by a constituent who meets the specified constituent criteria
  AND
• Has the specified field value (for the row) on their constituent record
  AND
• Meets the specified gift criteria except the date range criteria) and has a same amendment in the date range. In this case, the date criteria is applied to the amendment, not the recurring gift.

If a gift field is selected, this number is determined as follows:
• Given by a constituent who meets the specified constituent criteria
  AND
• Meets the specified gift criteria (except the date range criteria) and that have the specified field value (for the row) and has a same amendment in the date range. In this case, the date criteria is applied to the amendment, not the recurring gift.

No. of upgraded recurring gifts. If a constituent field is selected, this number is determined as follows:
• Given by a constituent who meets the specified constituent criteria
  AND
• Has the specified field value (for the row) on their constituent record
AND

• Meets the specified gift criteria (except the date range criteria) and has an upgrade amendment in the date range. In this case, the date criteria is applied to the amendment, not the recurring gift.

If a gift field is selected, this number is determined as follows:

• Given by a constituent who meets the specified constituent criteria

AND

• Meets the specified gift criteria (except the date range criteria), has the specified field value (for the row), and has an upgrade amendment in the date range. In this case, the date criteria is applied to the amendment, not the recurring gift.

**Percent of participation.** The number of constituents with an active recurring gift divided by the number of constituents. The values are displayed as a percent.

**Total amount of missed recurring gift payments.** If a constituent field is selected, this number is determined as follows:

• Number expected in the specified date range for recurring gifts that meet all of the specified gift criteria except the date range criteria (in this case, we are using the date range for the missed payment, not the recurring gift)

AND

• Given by a constituent who meets the specified constituent criteria

AND

**Warning:** If the status of the gift is ‘Complete’, only ‘Skipped’ payments are considered ‘Missed’. For all other recurring gift statuses, either a skipped payment or a payment expected but not paid is included. Also note that this is not the same processing as the ‘Missed Payments Report’ – the missed payments counted here are not the payments missed since the last payment – these are just payments that have been missed at anytime.

• Has the specified field value (for the row) on their constituent record

If a gift field is selected, this number is determined as follows:

• Given by a constituent who meets the specified constituent criteria

AND

• Meets the specified gift criteria (except the date range criteria), has the specified field value (for the row) and, has an amendment in the date range. In this case, the date criteria is applied to the amendment, not the recurring gift.

**Total given for recurring gift payments.** It is important you understand the difference between “Total payments for new recurring gifts” and “Total given for recurring gift payments”. “Total payments for new recurring gifts” is the amount of money generated by a new recurring gift. So for, example, in a breakdown by month, if three new recurring gifts were added in a month, this amount is going to be the total payments applied to those three recurring gifts – regardless of the time frame of the recurring gifts. “Total given for recurring gift payments” will give the total amount of recurring gift payments for the time frame. So with the same example, this amount is the total of the recurring gift pay-cash gifts with a gift date in the month, regardless of when the recurring gift was added.

If a constituent field is selected, this number is determined as follows:

• Meets the specified gift criteria (in this case we are applying all of the criteria to the recurring gift payment, not the recurring gift)

AND

• Given by a constituent who meets the specified constituent criteria

AND

• Has the specified field value (for the row) on their constituent record

If a gift field is selected, this number is determined as follows:
• Meets the specified gift criteria contains the specified field value (for the row)
  AND
• Given by a constituent who meets the specified constituent criteria

**Total no. of amended recurring gifts.** If a constituent field is selected, this number is determined as follows:
• Given by a constituent who meets the specified constituent criteria
  AND
• Has the specified field value (for the row) on their constituent record
  AND
• Meets the specified gift criteria (except the date range criteria) and has an amendment in the date range. In this case, the date criteria is applied to the amendment, not the recurring gift.

If a gift field is selected, this number is determined as follows:
• Given by a constituent who meets the specified constituent criteria
  AND
• Meets the specified gift criteria (except the date range criteria), has the specified field value (for the row), and have an amendment in the date range. In this case, the date criteria is applied to the amendment, not the recurring gift.

**Total no. of new recurring gifts.** If a constituent field is selected, this number is determined as follows:
• Recurring gifts given by constituents who meet the specified constituent criteria
  AND
• Have the specified field value (for the row) on the constituent record
  AND
• Meets the specified gift criteria regardless of the current status of the gift. It just indicates that the gift date of the recurring gift falls into the specified date range.

If a gift field is selected, this number is determined as follows:
• Given by a constituent who meets the specified constituent criteria
  AND
• Meets the specified gift criteria and contains the specified field value (for the row) regardless of the current status of the gift. It just indicates that the gift date of the recurring gift falls into the specified date range.

**Total no. of recurring gifts cancelled/terminated.** If a constituent field is selected, this number is determined as follows:
• Recurring gifts given by constituents who meet the specified constituent criteria
  AND
• Have the specified field value (for the row) on their constituent record
  AND
• Have at least one recurring gift that meets the specified gift criteria except the date range criteria (in this case, we are using the date range for the gift status, not the recurring gift) and has a status of ‘Cancelled’ or ‘Terminated’ and a status date within the date range.

If a gift field is selected, this number is determined as follows:
• Given by a constituent who meets the specified constituent criteria
  AND
• Meets the specified gift criteria except the date range criteria (in this case, we are using the date range for the gift status, not the recurring gift) with a status of ‘Cancelled’ or ‘Terminated’ and a status date that within the date range that contains the specified field value (for the row)
**Total no. of recurring gift payments.** The number of the gifts used when calculating Total Amount of Payments.

**Total payments given for new recurring gifts.** It is important you understand the difference between “Total payments for new recurring gifts” and “Total given for recurring gift payments”. “Total payments for new recurring gifts” is the amount of money generated by a new recurring gift. So for, example, in a breakdown by month, if three new recurring gifts were added in a month, this amount is going to be the total payments applied to those three recurring gifts – regardless of the time frame of the recurring gifts. “Total given for recurring gift payments” will give the total amount of recurring give payments for the time frame. So with the same example, this amount is the total of the recurring gift pay-cash gifts with a gift date in the month, regardless of when the recurring gift was added.

**Note:** The payments counted here can be for any time frame for recurring gifts with a gift date in the specified time frame.

If a constituent field is selected, this number is the total amount of recurring gift payments applied to new recurring gifts (regardless of the time frame of the payment) that satisfy the following criteria:

- Meet the specified gift criteria
  
  AND

- Given by a constituent who meets the specified constituent criteria
  
  AND

- Have the specified field value (for the row) on their constituent record

If a gift field is selected, this number is the total amount of recurring gifts payments applied to new recurring gifts (regardless of the time frame of the payment) that satisfy the following criteria:

- Meet the specified gift criteria contain the specified field value (for the row)
  
  AND

- Given by a constituent who meets the specified constituent criteria

### Statistical Reports

**Statistical Reports** provide you with a breakdown of how many constituents have a specific field value, how many gifts they gave, and how much money they donated. For example, run a **Statistical Report** by state to find out how many constituents live in each state, how many of them made a gift, and the total amount they gave. You can also select the column information to appear on the report. The exact data included depends on your parameter tab settings.

**Note:** This report includes both a Fields tab and Filters tab. The relationship between the tabs is complex if on the Fields tab you select a Field to use that is also listed on the Filters tab. For information about this relationship, see “Statistical Reports” on page 152.

### Statistical Report Columns

**Average Given Per Donor.** This optional column displays the average amount donated by constituents. This is the total amount given divided by the number of donors.

**Average Given Per Gift.** This optional column displays the average amount of gifts donated. This is the total amount given divided by the number of gifts.

**Number of Constituents.** This optional column displays the total number of constituent records satisfying the Field value you select on the Fields tab.

**Number of Donors.** This optional column displays the total number of constituents satisfying the Field value you select on the Fields tab and who also have donated a gift falling within the parameters you selected on the Gift Types tab.
Number of Gifts. This optional column displays the total number of gifts falling within the parameters you selected on the Gift Types tab. These are gifts donated by constituents satisfying the Field value you selected on the Fields tab.

Number of Members, Total Membership Dues, and Total Membership Dues Paid columns print only if you have the optional module Membership Management.

Number of Members. This optional column displays the total number of members satisfying the Field value you select on the Fields tab.

Number of Memberships. This optional column displays the total number of memberships satisfying the Field value you select on the Fields tab.

Percent of Participation. This optional column displays the level of participation as a percentage calculated by dividing the number of donors by the total number of constituents.

Percent of Total Gifts. This optional column displays the ratio of the gift amounts in the corresponding category to the total amount of the gifts donated, displaying the results as a percentage.

Total Given. This optional column displays the total amount of gifts donated. (Comparisons and Summaries, Statistical Reports)

User-defined column. On the Fields tab of the Comparisons and Summaries reports you select the Field you want to use in the summary. For example, if you select “Gender”, Gender appears as a column on the summary report.

Tallies

Tallies count the number of gifts or constituents whose records contain specific field values. Use Tallies to calculate statistics, such as how many constituents with a particular constituent code are in a particular age group. The exact data included depends on your parameter tab settings.

Tallies Columns

Number of Constituents. This optional column displays the total number of constituent records satisfying the Field value you select on the Fields tab.

Number of Members. This column displays the total number of members satisfying the Field value you select on the Fields tab.

Percent of Total Constituents. This column displays the total number of constituents divided by the grand total of constituents and displays as a percentage.

User-defined column. On the Fields tab of the Comparisons and Summaries reports you select the Field you want to use in the summary. For example, if you select “Gender”, Gender appears as a column on the summary report.

Event Management Reports

Note: The Event Management Reports are available only if you have the optional module Event Management.

Event Management, Blackbaud’s event management module, works in conjunction with The Raiser’s Edge 7 to help you manage all aspects of your events. Whether you are organizing a tennis tournament, an awards banquet, a trustee luncheon, a training class for your volunteers, a holiday party, or homecoming activities, the information you need — from prices and expenses, to income generated, to adding participants — is kept in one package.
The optional module *Event Management* is divided into two major parts. The first aspect involves setting up an event record and encompasses the General, Prices, Expenses, Jobs (if you have the optional module *Volunteer Management*), Actions, Attributes, Media, and Notes tabs of the event record. The second part involves adding participants and setting up their participant records on the Participants tab of the same event record.

**Event Management Reports** help you track every aspect of your special events from seating arrangements to dinner preferences, from sporting event rosters to specific lodging information. You can compare event costs to the income generated, track seating and lodging, and determine the performance of your solicitors for a particular event. These reports help you evaluate your event’s success.

### Dinner Preferences

**Note:** A participant is an individual or organization associated with an event. A participant can be a registrant, guest, or sponsor.

The **Dinner Preferences** provide information about participant choices for a selected dinner event. This report includes information for dinner events only. If you select a group of events, none of which is a dinner event, nothing appears on the report. In the report, you can include the dinner name, dinner preferences, constituent name and address information, the total number of requests for each meal preference, the number of dinner preferences requested for each constituent, and any comments. The exact data included depends on your parameter tab settings.

#### Dinner Preferences Columns

- **Comments.** This column displays any comments entered in the Comments field on the More button screen of the participant record.
- **Participant Name.** This column displays the name of the participant associated with the event.
- **Preference.** This column displays entries from the Dinner Preferences field on the More button screen of the participant record.
- **Quantity.**
  
  **Note:** This column displays quantity preferences entered in the Quantity. In reports allowing phone numbers, an indicator (“~”) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

#### Event Expense Report

The **Event Expense Report** analyzes the actual cost involved in organizing an event compared to budgeted amounts. The report can include expenses by expense type, amount paid, date paid, and vendor information. It calculates the total budgeted and total expenses. The report displays the date and description of the expense, budgeted amount, actual amount, comments, total budgeted, and total of expenses for the event. The exact data included depends on your parameter tab settings.

#### Event Expense Report Columns

- **Amount Paid.** This column displays information from the Paid field of the event record. The total amount appears at the bottom of the column.
- **Amount Due.** This column displays the amount paid subtracted from the expense amount. The total amount appears at the bottom of the column.
**Budgeted.** This column displays the amount entered in the Budgeted field on the Expenses tab of the event record.

**Date paid.** This column displays information from the Date field on the Expenses tab of the event record.

**Expense.** This column displays the amount entered in the Expense field on the Expenses tab of the event record.

**Expense Type.** This column displays information from the Event Type field on the Expenses tab of the event record.

**Under (Over) Budget.** This column displays the budgeted amount subtracted from the expense amount.

**Vendor.** This column displays vendor information from the Expenses tab of the event record.

---

**Event Income Report**

The Event Income Report helps you analyze the income generated by an event. The report can include the participant name, date and amount paid, sponsor name, participation type, total paid, and total number of registrants. The report lists registrant names alphabetically or by date paid. You can summarize the report based on participant, solicitor, or sponsor. The exact data included depends on your parameter tab settings.

**Event Income Report Columns**

The Detail report type displays the following columns:

- **Amount Due.** This column displays the amount paid subtracted from the gift amount. The total amount appears at the bottom of the column. The grand total for this column does not include overpayments.

- **Amount Paid.** This column displays information from the Gift Amount field on the Registration Fees tab of the participant record and the Amount field on the Donations tab of the participant record.

- **Date paid.** This column displays information from the Date paid field on the Registration Fees tab of the participant record (this is not the date associated with the gift or donation record).

- **Participant.** This column displays the name of the participant registered for the event.

- **Type.** This column indicates whether the gift was found on the Registration Fees tab or the Donations tab.

You can summarized the report based on participants, solicitors, and/or sponsors. The Summary report type displays the following columns:

- **Participant.** If in the Details category on the Format tab, you selected to summarize your report by participant, this column displays the name of the participant registered for the event.

- **Solicitor.** If in the Details category on the Format tab, you selected to summarize your report by solicitor, this column displays the name of the solicitor registered for the event.

- **Sponsor.** If in the Details category on the Format tab, you selected to summarize your report by sponsor, this column displays the name of the sponsor registered for the event.

- **Type.** This column indicates whether the gift was found on the Registration Fees tab or the Donations tab.

- **Total Amount Due.** This column displays the total of amount each participant/solicitor/sponsor owes.

- **Total Amount Paid.** This column displays the total of amount each participant/solicitor/sponsor has paid.

---

**Event Lists**

The Event Lists Report provides lists of sponsors or registrants for an event. The exact data included depends on your parameter tab settings.
Event Lists Columns

**Attended.** In this column, “Yes” means the Participant has attended checkbox on the General 1 tab of the participant record is marked; “No” means the checkbox is not marked.

**Award.** This column displays information entered from the Awards button on the General 1 tab of the participant record.

**Full Name.** This column displays the full name of all constituents registered for the selected event. Or, if you selected, the column displays sponsor names as well.

**No. Units.** This column displays information from the No. Units column on the Registration Fees tab of the participant record.

**Participation.** This column displays the information recorded in the Participation field on the General 1 tab of the participant record.

**Registration.** This column displays information entered in the Registration field on the General 1 tab of the participant record.

**Sponsor.** This column displays information entered in the Sponsored By field on the General 1 tab of the participant record.

**Status.** This column displays information from the Status field of the General 1 tab of the participant record.

**Unit.** This column displays information from the Unit column on the Registration Fees tab of the participant record.

Event Summary Report

**Note:** In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

The Event Summary Report provides an overview of event finances. You can include key information, such as event ID, registration, attendance, income generated, and expenses incurred to help you determine the success of an event. You can also include information based on event names arranged alphabetically or base on event dates. You can graph the results of this report. The exact data included depends on your parameter tab settings.

Event Summary Report Columns

**Attended.** The information in this column is calculated based on the Participant has attended checkbox on the General 1 tab of the participant record. Only checked boxes are counted.

**Campaign.** This column displays information entered in the Campaign field on the General tab of the event record.

**Capacity.** This column displays information entered in the Capacity field on the General tab of the event record.

**Event.** The Name entered on the General tab of the event record appears in this column.

**Invited.** The information in this column is calculated based on information entered in the Invite? field on the participant record. Only a setting of “Invited” is counted.

**Net.** This tab displays total income minus the total expenses.

**Registered.** The information in this column is calculated based on information entered in the Registration field on a participants record. Only a status of “Registered” is counted.

**Start Date.** This column displays the date entered in the Start date field on the General tab of the event record.
**Total Expenses.** Information included in this column is based on your selections on the Expense Calculation tab of the Event Summary Report.

**Total Income.** The information in this column is based on registration fees, other donations, and sponsoring pledges, or selections you make on the Income Calculation tab of the Event Summary Report.

### Lodging Information

The Lodging Information report provides information about where participants stayed during an event. The report includes the lodging assignment, room number, and sponsor name. This report is particularly useful when organizing seminars, homecoming activities, and trips. It can list registrant names alphabetically or by lodging name and room number. The report can also include participants not yet registered. The exact data included depends on your parameter tab settings.

#### Lodging Information Columns

- **Check in date.** This column displays information from the Check in date field on the General 2 tab of the participant record.
- **Check in time.** This column displays information from the Check in time field on the General 2 tab on the participant record.
- **Check out date.** This column displays information from the Check out date field on the General 2 tab on the participant record.
- **Check out time.** This column displays information from the Check out time field on the General 2 tab on the participant record.
- **Confirmation No.** This column displays information from the Confirmation no. field on the General 2 tab of the participant record.
- **Lodging Name.** This column displays information from the Lodging Name field on the General 2 tab of the participant record.
- **Participant Name.** This column displays the name of the participant.
- **Phone No.** This column displays information from the Phone No. field on the General 2 tab of the participant record.
- **Room No.** This column displays information from the Room No. field on the General 2 tab of the participant record.

### Registration Fees Due Report

The Registration Fees Due Report lists participants who have not paid or have partially paid their fees for an event. You can produce a summary of fees due from event sponsors and select to base the report on either an individual event or a group of related events. If you base the report on a group, you can also print one event per page. The report can include addresses and phone numbers. The exact data included depends on your parameter tab settings.

#### Registration Fees Due Columns

The Detail report type displays the following columns:

- **Amount Due.** This amount is calculated by subtracting the amount paid from gift amount.
- **Amount Paid.** Information in this column is based on the Amount paid field on Registration Fees tab of the participant record.
Att. This column is based on the Participant has attend checkbox on the General 1 tab of the participant record. “Yes” means the box has been checked.

Gift Amount. Information in this column is based on the Gift amount column on Registration Fees tab of the participant record.

Participant. The name of the participant associated with the event.

Participation. Information in this column is based on the Participation field on the General 1 tab of the participant record

Receipt Amount. Information in this column is based on the Receipt Amount column on Registration Fees tab of the participant record.

Registration. Information in this column is based on the Registration field on the General 1 tab of the participant record.

Sponsor/Guest of. Information in this column is based on the Sponsored By field on the General 1 tab of the registrant record or the Guest of field on the General 1 tab of a guest record.

The Summary by sponsor report type displays the following columns:

Sponsor. This column displays information from the Sponsored by field on the General 1 tab of the participant record. A line labeled “Unknown” summarizes all records without Sponsors

Total Due. This amount is calculated by subtracting the total paid from total gift amount.

Total Gift Amount. Information in this column is based on the Gift amount column on Registration Fees tab of all participant records sponsored by the constituent.

Total Paid. Information in this column is based on the Amount paid field on Registration Fees tab of all participant records sponsored by the constituent.

Total Receipt Amount. Information in this column is based on the Receipt Amount column on Registration Fees tab of all participant records sponsored by the constituent.

Seating Arrangements

Note: For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

The Seating Arrangements report lists participants and sponsors alphabetically or by section table, row, and seat assignment. You can base the report on either an individual event or a group of related events. If you base the report on a group, you can print one event per page. This report can show you participants not yet registered. The exact data included depends on your parameter tab settings.

Seating Arrangements Columns

Guest of. This column displays who the participant is a guest of. This information is based on the Guest of field on the General 1 tab of the participant record.

Participant Name. The name of the participant associated with the event.

Table. This column displays the participant’s assigned table based on the Seating Assignments screen in the event record.

Seat. This column displays the seat assigned to the participant based on the Seating Assignments screen in the event record.

Section. This column displays the participant’s assigned section based information on the Seating Assignments screen in the event record.

Sponsor. This column displays information from the Sponsor field on the General 1 tab of the participant record.
Seating Validation Report

The **Seating Validation Report** warns you about potential seating issues. For example, groups not seated together, guests not seated with registrant host, and sponsored participants not seated together.

The report also includes a layout summary, alerting you to items added or removed since the last time you accessed the Seating Setup wizard; lists all participants who have not yet been seated; and generates a seating summary, displaying total participants in the event, total number of seats needed, number of seats assigned, and number of seats still available.

**Seating Validation Report Columns**

- **Group.** This column displays any groups registered for the event.
- **Host.** This column displays the event host, if one is entered on the event record.
- **Seating Summary.** This column displays the total number of participants registered for the event, number of participants that require seating, number of seats in the venue, number of seats already assigned, the number of open seats, and number of participants still needing a seat.
- **Sponsor.** This column displays any sponsors registered for the event.
- **Unseated Participants.** This column displays any participant registered for the event but not yet assigned a seat.

Sporting Event Roster

The **Sporting Event Roster** provides a detailed list of participants in a sporting event. This report runs only for sporting events. If you select a group of events, none of which is a sporting event, nothing appears on the report. The report can list participants alphabetically or by division. It includes division assignments, team assignments, and sponsor names. This report can include participants not yet registered. The exact data included depends on your parameter tab settings.

**Sporting Event Roster Columns**

- **Ability Rating.** This optional column displays information from the **Ability rating** field on the Sports Information screen. This screen is accessed from the More info button on the General tab of the participant record.
- **Age.** This optional column displays information from the **Age** field on the Sports Information screen. This screen is accessed from the More info button on the General tab of the participant record.
- **Assigned No.** This optional column displays information from the **Assigned No.** field on the Sports Information screen. This screen is accessed from the More info button on the General tab of the participant record.
- **Division.** This optional column displays information from the **Division** field on the Sports Information screen. This screen is accessed from the More info button on the General tab of the participant record.
- **Gender.** This optional column displays information from the **Gender** field on the Sports Information screen. This screen is accessed from the More info button on the General tab of the participant record.
- **Ht.** This optional column displays information from the **Height/Weight** field on the Sports Information screen. This screen is accessed from the More info button on the General tab of the participant record.

**Note:** In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

- **Location.** This optional column displays information from the **Location** field on the Sports Information screen. This screen is accessed from the More info button on the General tab of the participant record.
Participant Name. The name of the participant associated with the event.

Position. This optional column displays information from the Position field on the Sports Information screen. This screen is accessed from the More info button on the General tab of the participant record.

Place. This optional column displays information from the Start time/place field on the Sports Information screen. This screen is accessed from the More info button on the General tab of the participant record.

Start Time. This optional column displays information from the Start time/place field on the Sports Information screen. This screen is accessed from the More info button on the General tab of the participant record.

Team. This optional column displays information from the Team field on the Sports Information screen. This screen is accessed from the More info button on the General tab of the participant record.

Wt. This optional column displays information from the Height/Weight field on the Sports Information screen. This screen is accessed from the More info button on the General tab of the participant record.

Financial Reports

Financial Reports help you evaluate the financial position of your organization. The variety of report types included in this category give several ways of viewing financial information. You can view a breakdown of your General Ledger accounts, generate a detailed report focusing on stock and property gifts, list all of your EFT gifts, and much more. Many of the reports also include detail and summary versions, helping you meet every evaluation need.

Note: Report names may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For example, if “Gifts” was changed to “Fees”, the Gift Entry Validation Report reads Fee Entry Validation Report. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

Account Distribution Report

The Account Distribution Report provides a breakdown by General Ledger accounts of gifts donated during a time period you select. The report includes the posting status of gifts and shows debit and credit amounts. The exact data included depends on your parameter tab settings.

Account Distribution Report Columns

Constituent Name. This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

CR Amount. This column displays the credit amount for all gift types.

Date. This column displays the gift date.

DB Amount. This column displays the debit amount for all gift types.

Fund. This column displays the fund ID recorded on the gift record.

Gift Type. This column displays the type of gift created.

GL Account. This column displays General Ledger account numbers for each transaction. If the gift is not posted, the General Ledger account number recorded for the fund is used. If the gift is posted, the selected account number is used if it is different from the fund’s General Ledger number.
Adjusted Gift Report

Note: An adjusted gift is a gift you modified after posting it to your general ledger. An adjustment is recorded in the gift record.

The Adjusted Gift Report provides a list of donations changed through the adjustment process. The report can include General Ledger accounts information and the reason for the adjustment. The exact data included depends on your parameter tab settings.

Adjusted Gift Report Columns

Adjusted Amount. This column displays the amount of the adjustment recorded in the adjustment record.

Adjusted Funds. This column displays the fund ID for the fund(s) reflected in the adjustment record.

Note: Report names may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For example, if “Gifts” was changed to “Fees”, the Gift Entry Validation Report reads Fee Entry Validation Report. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

Adjustment Date. This column displays the date the adjustment was made on the gift as recorded in the adjustment record.

Adjusted Post Date. This column displays the post date of the adjustment, not of the original gift.

Amount. This column displays the original amount on the gift record, regardless of prior adjustments to the gift.

Constituent Name. This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

Date. This column displays the original gift date, regardless of prior adjustments to the gift.

Fund. This column displays the fund(s) on the original gift record, regardless of prior adjustments to the gift.

Post Status. This column displays the posting status of the adjustment, not of the original gift.

Annual Statement Report

The Annual Statement Report provides constituent giving histories for a time period you select. It can include receipt information, including receipts with no receipt amount. This report is useful to send to constituents as an end-of-the-year report so they can review their donations for tax purposes. Each constituent’s information appears on a separate page. The exact data included depends on your parameter tab settings.

Annual Statement Report Columns

Amount. This column displays the amount of the gift; in the UK this takes into account the net or gross option set in User Options.

Constituent Name. This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

Note: In reports allowing phone numbers, an indicator (“~”) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.
Date. This column displays the gift date.
Fund. This optional column displays the fund(s) on the original gift record.
Gift Type. This column displays the type of gift created.
Receipt Amount. This column displays the tax-deductible amount recorded in the Receipt amt field in the gift record.
Receipt Number. This column displays the receipt number or the information entered in the Receipt amt/no field on the Gift tab of the gift record.

Cash Receipts Journal

The Cash Receipts Journal displays cash and stock/property gifts received during a time period you select. The detail version of the report displays each donation with the constituent name. The summary version of the report displays the total amount of gifts received for each campaign, fund, appeal, or constituent code. The exact data included depends on your parameter tab settings.

Cash Receipts Journal Columns

The Detail report type displays the following columns:

- **Acknowledge.** This optional column indicates if an acknowledgment letter has been sent for the gift.
- **Acknowledge Date.** This optional column displays the date the gift was acknowledged.
- **Amount.** This column displays the original amount on the gift record, regardless of prior adjustments to the gift.
- **Appeal.** This optional column displays the solicitation that generated the gift, as recorded in the gift record.
- **Campaign.** This optional column displays the campaign recorded in the gift record.
- **Check Date.** This column displays the check date recorded in the payment details in the gift record.
- **Check Number.** This column displays the check number recorded in the payment details in the gift record.
- **Constituent Name.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.
- **Date.** This column displays the original gift date, regardless of prior adjustments to the gift.
- **Date 1st Pay.** This optional column displays the due date of the first installment payment.
- **Fund.** This column displays the fund recorded on the gift record.
- **Fund ID.** This column displays the fund ID recorded on the gift record.
- **Gift Code.** This optional column displays the gift code recorded on the Miscellaneous tab in the gift record.
- **Gift Constituent Code.** This optional column displays the constituent code recorded in the gift record (the Constituency field on the Miscellaneous tab of the gift record).
- **Gift ID.** This optional column displays the ID assigned to the gift in the Gift ID field on the Miscellaneous tab of the gift record.
- **Gift Status.** This optional column displays weather the gift is active or not.
- **Gift Subtype.** This column displays the information recorded in the Gift subtype field in the gift record.
- **GL Post Date.** This optional column displays the date the gift is posted to General Ledger.
- **GL Post Status.** This optional column displays the posting status of the gift.
- **Issuer.** This optional column displays the name of the company which issued a stock gift. This is recorded in the Issuer field on the Gift tab of the gift record.
Issuer median price. This optional column displays the Median price per unit entered for a stock gift. This is recorded on the Stock Details screen accessed from the Details button on the Gift tab of the gift record.

Issuer number of units. This optional column displays the Number of units entered for a stock gift. This is recorded on the Stock Details screen accessed from the Details button on the Gift tab of the gift record.

Issuer symbol. This optional column displays the stock Symbol entered for a stock gift. This is recorded on the Stock Details screen accessed from the Details button on the Gift tab of the gift record.

Letter code. This optional column displays the code representing the type of letter recorded in the gift record.

Number of Installments. This optional column displays the number of payments due on the installment schedule for master pledges.

Package. This optional column displays any Package information entered on the gift record.

Payment Type. This column displays the type of payment used for the gift (check, credit card, etc.).

Receipt. This optional column indicates if a receipt has been printed for the gift.

Receipt Amount. This optional column displays the tax-deductible amount recorded in the Receipt amt field in the gift record.

Receipt Date. This optional column displays the receipt date used on the receipt printed for the gift.

Receipt Number. This optional column displays the number generated during receipt processing.

Reference. This optional column displays the information recorded in the Reference field on the Gift tab of the gift record.

Send Reminders. This optional column displays “Yes” if the Send reminders checkbox is marked on the Gift tab of the constituent record. The column displays “No” if the Send reminders checkbox is not marked on the Gift tab of the constituent record.

Solicitor name. This optional column displays the name of the solicitor associated with the gift (the name entered in the Solicitor(s) field on the Gift tab of the gift record.

Tribute Name. This column displays the names of constituents with tributes recorded.

The Summary report type displays the following columns:

Amount. This column displays the original amount on the gift record, regardless of prior adjustments to the gift.

Appeal. This optional column displays the solicitation that generated the gift, as recorded in the gift record.

Campaign. This optional column displays the campaign recorded in the gift record.

Constituent Code. This column displays the constituent code recorded in the gift record.

Credit Acct. The General Ledger account credit for the gift amount.

Debit Acct. The General Ledger account debited for the gift amount.

Description. This column displays the fund description recorded on the gift record.

Fund. This column displays the fund recorded on the gift record.

Gift Type. This column displays the type of gift created.
**No. Gifts.** This column displays the number of gifts given to the fund. Gifts counted are based on your selected report parameters.

**Constituent Giving History**

**Note:** For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

The Constituent Giving History lists all constituents who gave gifts during the time period you define. The report is a chronology of constituent gifts and can include related fund information and pledge balances due. The exact data included depends on your parameter tab settings.

**Note:** EFT stands for Electronic Funds Transfer and is a general banking system practice by which transactions, such as deposits or bill payments, are made electronically from The Raiser's Edge to the bank. The EFT Participation Report is available only if you have the optional module Electronic Funds Transfer.

**Constituent Giving History Columns**

- **Acknowledge.** This optional column indicates if an acknowledgment letter has been sent for the gift.
- **Acknowledge Date.** This optional column displays the date the gift was acknowledged.
- **Amount.** This column displays the original amount on the gift record, regardless of prior adjustments to the gift.
- **Appeal.** This optional column displays the solicitation that generated the gift, as recorded in the gift record.
- **Balance.** This column displays the balance of pledges and matching gift pledges.
- **Campaign.** This optional column displays the campaign recorded in the gift record.
- **Constituent Name.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.
- **Date.** This column displays the original gift date, regardless of prior adjustments to the gift.
- **Date 1st Pay.** This optional column displays the due date of the first installment payment.
- **Fund.** This column displays the fund ID recorded on the gift record.
- **Gift.** This column displays the type of gift.
- **Gift Code.** This optional column displays the gift code recorded in the gift record.
- **Gift Constituent Code.** This optional column displays the constituent code recorded in the gift record (the Constituency field on the Miscellaneous tab of the gift record).
- **Gift ID.** This optional column displays the ID assigned to the gift in the Gift ID field on the Miscellaneous tab of the gift record.
- **Gift Status.** This optional column displays weather the gift is active or not.
- **Gift Subtype.** This column displays the information recorded in the Gift subtype field in the gift record.
- **GL Post Date.** This optional column displays the date the gift is posted to General Ledger.
- **GL Post Status.** This optional column displays the posting status of the gift.
- **Honor/Memorial Name.** This column displays the names of constituents with tributes recorded.
- **Issuer.** This optional column displays the name of the company which issued a stock gift. This is recorded in the Issuer field on the Gift tab of the gift record.
**Issuer median price.** This optional column displays the **Median price per unit** entered for a stock gift. This is recorded on the Stock Details screen accessed from the **Details** button on the Gift tab of the gift record.

**Note:** In reports allowing phone numbers, an indicator (‘*’) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

**Issuer number of units.** This optional column displays the **Number of units** entered for a stock gift. This is recorded on the Stock Details screen accessed from the **Details** button on the Gift tab of the gift record.

**Issuer symbol.** This optional column displays the stock **Symbol** entered for a stock gift. This is recorded on the Stock Details screen accessed from the **Details** button on the Gift tab of the gift record.

**Letter code.** This optional column displays the code representing the type of letter recorded in the gift record.

**Number of Installments.** This optional column displays the number of payments due on the installment schedule for master pledges.

**Package.** This optional column displays any **Package** information entered on the gift record.

**Receipt.** This optional column indicates if a receipt has been printed for the gift.

**Receipt Amount.** This optional column displays the tax-deductible amount recorded in the **Receipt amt** field in the gift record.

**Receipt Date.** This optional column displays the receipt date used on the receipt printed for the gift.

**Receipt Number.** This optional column displays the number generated during receipt processing.

**Reference.** This optional column displays the information recorded in the **Reference** field on the Gift tab of the gift record.

**Send Reminders.** This optional column displays “Yes” if the **Send reminders** checkbox is marked on the Gift tab of the constituent record. The column displays “No” if the **Send reminders** checkbox is not marked on the Gift tab of the constituent record.

**Solicitor name.** This optional column displays the name of the solicitor associated with the gift (the name entered in the **Solicitor(s)** field on the Gift tab of the gift record.

### EFT Participation Report

The **EFT Participation Report** provides a list of constituents whose gifts are being paid via the electronic transfer of funds. The exact data included depends on your parameter tab settings.

### EFT Participation Report Columns

**Amount.** This column displays the amount of the gift.

**Constituent.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

**Created On.** This column displays the date the EFT record was created.

**Frequency.** This column displays the frequency of payments recorded in the EFT record.

**Fund.** This column displays the fund description recorded on the gift record.

**Gift Type.** This column displays the type of gift created.

**Next Transaction.** This column displays the date of the next scheduled EFT payment.

**Payment Type.** This column displays the type of payment used for the gift (check, credit card, etc.).
Status. This column lets you know if the EFT participation is currently active.

Total to date. This column shows you the total amount donated to date through the EFT account.

Expected Maturity Year Report

The Expected Maturity Year Report shows you gifts expected to mature within selected report periods. The columns display information for each year range you select. You can use this report to estimate anticipated cash flow from planned gifts as they reach maturity. Based on the Expected Maturity Year entered for each planned gift, the Remainder Value of each applicable gift displays in the column for the report period including the selected year.

The Summary view of the report breaks the gifts down by Fund, displaying the anticipated amounts expected to mature, in total, for each fund, spread out over the user-defined report periods.

Expected Maturity Year Report Columns

The Detail report type displays the following columns:

Amount. This column displays the amount of the gift.

Constituent Name. This column displays constituent names based on your selection in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

Date. This column displays the gift date recorded in the gift record.

Expected Maturity Year. This column displays the year the planned gift is expected to mature.

Fund. This column displays the description of any fund associated with the gift.

Gift Vehicle. This column displays how the gift was given. For example, if the gift is a bequest, “Bequest” appears in this column.

Report Periods columns. User-defined columns from the Report Periods tab. You can include up to 12 report periods and enter column heading information.

Solicitor. This column displays the name of the solicitor associated with the planned gift. If more than one solicitor received credit for a gift, each solicitor’s name is listed.

The Summary report type displays the following columns:

Note: In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

Fund. This column displays the description of any fund associated with the gift.

Gift Amount. This column displays the total amount of the gifts given to the associated fund.

Gift Count. This column displays the number of gifts given to the associated fund.

Report Periods columns. User-defined columns from the Report Periods tab. You can include up to 12 report periods and enter column heading information.
General Ledger Audit Report

The General Ledger Audit Report provides a list of gifts posted to General Ledger then deleted. The report includes the name of the constituent, gift type, gift date, and fund name. Audit information also includes current and future pledge amounts and stock gains or losses. The exact data included depends on your parameter tab settings.

General Ledger Audit Report Columns

Amount. This column displays the amount of the gift.

Broker Fee. This column displays the amount the broker charged for the transaction. This fee is recorded in the sale of stock gift transaction.

Constituent. This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

Current. This column displays the gift amount of the current pledge. If the post date falls on or before the fiscal year ends, then installments due on or before this date are current. All others are posted in the future account. If the post date falls after the fiscal year ends, then installments due on or before next year’s fiscal year ends are posted as current. All others are posted into the future account.

Fund. This column displays the fund ID recorded on the gift record.

Future. This column displays the gift amount of the future pledge.

Gift Date. This column displays the gift date recorded in the gift record.

Gift Type. This column displays the type of gift created.

Post Date. This column displays the date the gift was posted to General Ledger.

Stock Gain (Loss). This column displays the difference between the stock’s original amount and the sold amount, minus the broker fee.

Gift Detail and Summary Report

The Gift Detail and Summary Report provides details about constituent giving during a time period you define. The summary report includes totals of gifts received within the date range for each campaign, fund, appeal, or constituent code. The detail version of the report adds constituent name and address information. You can graph the results of the summary report. The exact data included depends on your parameter tab settings.

Gift Detail and Summary Report Columns

The Detail report type displays the following columns:

Acknowledge. This optional column indicates if an acknowledgment letter has been sent for the gift.

Acknowledge Date. This optional column displays the date the gift was acknowledged.

Appeal. This optional column displays the solicitation that generated the gift, as recorded in the gift record.

Batch Number. This optional column displays the identifying number of the batch file used to commit the gifts to your database.

Note: Report names may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For example, if “Gifts” was changed to “Fees”, the Gift Entry Validation Report reads Fee Entry Validation Report. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

The Gift Detail and Summary Report provides details about constituent giving during a time period you define. The summary report includes totals of gifts received within the date range for each campaign, fund, appeal, or constituent code. The detail version of the report adds constituent name and address information. You can graph the results of the summary report. The exact data included depends on your parameter tab settings.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Campaign</strong></td>
<td>This optional column displays the campaign recorded in the gift record.</td>
</tr>
<tr>
<td><strong>Cash</strong></td>
<td>This column displays the total amount of all cash gifts if you specified this gift type on the Gift Types tab.</td>
</tr>
<tr>
<td><strong>Note:</strong></td>
<td>In reports allowing phone numbers, an indicator (“~”) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.</td>
</tr>
<tr>
<td><strong>Constituent Name</strong></td>
<td>This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.</td>
</tr>
<tr>
<td><strong>Date</strong></td>
<td>This column displays the gift date.</td>
</tr>
<tr>
<td><strong>Date 1st Pay</strong></td>
<td>This optional column displays the due date of the first installment payment.</td>
</tr>
<tr>
<td><strong>Fund</strong></td>
<td>This column displays the fund ID recorded on the gift record.</td>
</tr>
<tr>
<td><strong>Gift Code</strong></td>
<td>This optional column displays the gift code recorded in the gift record.</td>
</tr>
<tr>
<td><strong>Gift Constituent Code</strong></td>
<td>This optional column displays the constituent code recorded in the gift record (the Constituency field on the Miscellaneous tab of the gift record).</td>
</tr>
<tr>
<td><strong>Gift ID</strong></td>
<td>This optional column displays the ID assigned to the gift in the Gift ID field on the Miscellaneous tab of the gift record.</td>
</tr>
<tr>
<td><strong>Gift Status</strong></td>
<td>This optional column displays whether the gift is active or not.</td>
</tr>
<tr>
<td><strong>Gift Subtype</strong></td>
<td>This column displays the information recorded in the Gift subtype field in the gift record.</td>
</tr>
<tr>
<td><strong>GL Post Date</strong></td>
<td>This optional column displays the date the gift is posted to General Ledger.</td>
</tr>
<tr>
<td><strong>GL Post Status</strong></td>
<td>This optional column displays the posting status of the gift.</td>
</tr>
<tr>
<td><strong>Honor/Memorial Name</strong></td>
<td>This column displays the names of constituents with tributes recorded.</td>
</tr>
<tr>
<td><strong>Issuer</strong></td>
<td>This optional column displays the name of the company which issued a stock gift. This is recorded in the Issuer field on the Gift tab of the gift record.</td>
</tr>
<tr>
<td><strong>Issuer median price</strong></td>
<td>This optional column displays the Median price per unit entered for a stock gift. This is recorded on the Stock Details screen accessed from the Details button on the Gift tab of the gift record.</td>
</tr>
<tr>
<td><strong>Issuer number of units</strong></td>
<td>This optional column displays the Number of units entered for a stock gift. This is recorded on the Stock Details screen accessed from the Details button on the Gift tab of the gift record.</td>
</tr>
<tr>
<td><strong>Issuer symbol</strong></td>
<td>This optional column displays the stock Symbol entered for a stock gift. This is recorded on the Stock Details screen accessed from the Details button on the Gift tab of the gift record.</td>
</tr>
<tr>
<td><strong>Letter code</strong></td>
<td>This optional column displays the code representing the type of letter recorded in the gift record.</td>
</tr>
<tr>
<td><strong>Matching Gift Company</strong></td>
<td>you can include in the report display the name of the company who contributed a matching gift if on the General tab you selected to Credit matching gifts to either Donor or Both.</td>
</tr>
<tr>
<td><strong>MG Plg Bal</strong></td>
<td>This column displays matching gift pledge balances. It appears if you specified this gift type on the Gift Types tab.</td>
</tr>
<tr>
<td><strong>Number of Installments</strong></td>
<td>This optional column displays the number of payments due on the installment schedule for master pledges.</td>
</tr>
<tr>
<td><strong>Package</strong></td>
<td>This optional column displays any Package information entered on the gift record.</td>
</tr>
<tr>
<td><strong>Payment Type</strong></td>
<td>This column displays the type of payment used for the gift (check, credit card, etc.).</td>
</tr>
<tr>
<td><strong>Pledge Bal</strong></td>
<td>This column displays pledge balances. It appears if you specified this gift type on the Gift Types tab.</td>
</tr>
<tr>
<td><strong>Receipt</strong></td>
<td>This optional column indicates if a receipt has been printed for the gift.</td>
</tr>
<tr>
<td><strong>Receipt Amount</strong></td>
<td>This optional column displays the tax-deductible amount recorded in the Receipt amt field in the gift record.</td>
</tr>
</tbody>
</table>
Receipt Date. This optional column displays the receipt date used on the receipt printed for the gift.

Receipt Number. This optional column displays the number generated during receipt processing.

Reference. This optional column displays the information recorded in the Reference field on the Gift tab of the gift record.

Send Reminders. This optional column displays “Yes” if the Send reminders checkbox is marked on the Gift tab of the constituent record. The column displays “No” if the Send reminders checkbox is not marked on the Gift tab of the constituent record.

Solicitor name. This optional column displays the name of the solicitor associated with the gift (the name entered in the Solicitor(s) field on the Gift tab of the gift record.

Stock. This column displays stock gift balances. It appears if you specified this gift type on the Gift Types tab.

The Summary report type displays the following columns:

- **Cash.** This column displays the total amount of all cash gifts if you specified this gift type on the Gift Types tab.
- **Description.** This column displays the fund description recorded on the gift record.
- **Fund ID.** This column displays the fund ID recorded on the gift record.
- **MG Plg Bal.** This column displays the total amount of all matching gift pledges. The column appears if you specified this gift type on the Gift Types tab.
- **No. Gifts.** This column displays the number of gifts given to the fund. Gifts counted are based on your selected report parameters.
- **Pledge Bal.** This column displays the total amount of all pledged gifts. This column appears if you specified this gift type on the Gift Types tab.
- **Stock.** This column displays the total value of all stock gifts. It appears if you specified this gift type on the Gift Types tab.

**Gift Entry Validation**

The Gift Entry Validation provides a detailed list of all gifts entered during a time period you define. This report is a useful daily report. Because it provides all information related to each individual gift, it can help you balance accounts at the end of the day. You can also use it to double-check the accuracy of your data entry. The exact data included depends on your parameter tab settings.

**Note:** In reports allowing phone numbers, an indicator (“~”) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

- **Cash.** This column displays the total amount of all cash gifts if you specified this gift type on the Gift Types tab.
- **Description.** This column displays the fund description recorded on the gift record.
- **Fund ID.** This column displays the fund ID recorded on the gift record.
- **MG Plg Bal.** This column displays the total amount of all matching gift pledges. The column appears if you specified this gift type on the Gift Types tab.
- **No. Gifts.** This column displays the number of gifts given to the fund. Gifts counted are based on your selected report parameters.
- **Pledge Bal.** This column displays the total amount of all pledged gifts. This column appears if you specified this gift type on the Gift Types tab.
- **Stock.** This column displays the total value of all stock gifts. It appears if you specified this gift type on the Gift Types tab.

**Gift Entry Validation Columns**

- **Acknowledge.** This column indicates if an acknowledgment letter has been sent for the gift.
- **Acknowledge Date.** This column displays the date the gift was acknowledged.
- **Added By.** This column displays the name of the Raiser’s Edge user who entered the gift into the database.
- **Amount.** This column displays the amount of the gift.

**Note:** Report names may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For example, if “Gifts” was changed to “Fees”, the Gift Entry Validation Report reads Fee Entry Validation Report. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.
### COLUMN DESCRIPTIONS

- **Amt Bills/Coin.** This column displays the amount received as a cash gift.
- **Anonymous.** This column indicates whether the gift was given anonymously.
- **Appeal.** This column displays the appeal that generated the gift, as recorded in the gift record.
- **Bank.** For EFTs, this column displays the paying bank for the gift.
- **Campaign.** This column displays the campaign recorded in the gift record.
- **Card Number.** This column displays the credit card number if you selected credit card for the payment type.
- **Constituent Code.** This column displays the constituent code recorded in the gift record.
- **Constituent.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.
- **Credit Card.** This column displays the type of credit card used (for example, Visa, Master Card).
- **Date.** This column displays the gift date.
- **Date Added.** This column displays the date the gift was added to the database, not the date of the gift.
- **Date 1st Pay.** This column displays the due date of the first installment payment.
- **Distribution.** This shows the campaigns, funds, and appeals used in the split gift.
- **Fund.** This column displays the fund ID recorded in the gift record.
- **Gift Code.** This column displays the gift code recorded in the gift record.
- **Gift Date.** This column displays the gift date recorded in the gift record.
- **Gift ID.** This column displays the gift ID assigned to the gift.
- **Gift Subtype.** This column displays the information recorded in the Gift subtype field in the gift record.
- **Gift Type.** This column displays the type of gift created.
- **GL Post Date.** This column displays the date the gift is posted to General Ledger.
- **GL Post Status.** This column displays the posting status of the gift (for example, Posted, Not Posted, or Do Not Post).
- **Letter.** This column displays the letter recorded in the gift record.
- **Number of Pays.** This column displays the number of payments due on the installment schedule for master pledges.
- **Package.** This column displays Package information entered on the gift record.
- **Pay Method.** This column displays the type of payment used to make the gift (for example, check or credit card).
- **Post.** This column displays the posting status of the gift (“Posted”, “Not Posted”, “Do Not Post”).

### NOTE

In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

- **Post Date.** This column displays the date the gift was posted to General Ledger.
- **Pymt Type.** This column displays the type of payment used for the gift (check, credit card, etc.).
- **Receipt.** This column indicates if a receipt has been printed for the gift.
- **Receipt Amount.** This column displays the tax-deductible amount recorded in the Receipt amt field in the gift record.
Receipt Date. This column displays the receipt date used on the receipt printed for the gift.

Receipt Number. This column displays the number generated during receipt processing.

Reference. This column displays the information recorded in the Reference field on the Gift tab of the gift record.

Ref Date/Chk/Exp On. This column displays the reference date for cash payments. This column displays the check date for check payments and the expiration date of the credit card for credit card payments.

Ref/Chk/Card No. This column displays the “Expires on” date for credit card payments and the check number for check payments.

**Gifts-in-Kind Report**

**Note:** You can use a value of zero if a gift-in-kind has no monetary value.

The Gifts-in-Kind Report provides information specific to gift-in-kind donations. A gift-in-kind donation is a gift of goods or services, such as computer equipment or tutoring, for which a monetary value can be assigned. The report includes the value of the gift and a description of the gift-in-kind. The exact data included depends on your parameter tab settings.

**Gifts-in-Kind Report Columns**

Constituent. This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

Date. This column displays the gift date.

Fund. This column displays the fund ID recorded on the gift record.

Gift Value. This column displays the value of all gifts-in-kind.

Reference. This column displays the information recorded in the Reference field on the Gift tab of the gift record.

**Matching Gift Report**

**Note:** Report names may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For example, if “Gifts” was changed to “Fees”, the Gift Entry Validation Report reads Fee Entry Validation Report. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

The Matching Gift Report provides detail or summary information about gifts matched by matching gift companies. The detail report lists the matching gift company name with the names of constituents whose gifts were matched. The summary report includes a breakdown of gifts made by matching gift companies without constituent names. The exact data included depends on your parameter tab settings.

**Matching Gift Report Columns**

The Detail report type displays the following columns:

Company Name. This column displays the organization name from the Org 1 tab. The contact name appears in parentheses below the organization name. The contact name appears in the format selected on the Format tab. Address and phone numbers appear based on the Org. Address tab parameters.
**Constituent.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

**MG Cash.** This column displays the matching gift pledge payment - cash.

**MG Plg Bal.** This column displays the matching gift pledge balance. The column appears if you specified this gift type on the Gift Types tab.

**MG Stock.** This column displays the matching gift pledge payment stock and matching gift pledge payment sold stock.

**Total.** This column displays the total of all matching gift types included in the report.

The Summary report type displays the following columns:

**Company Name.** This column displays the organization name from the Org 1 tab. The contact name appears in parentheses below the organization name. The contact name appears in the format selected on the Format tab. Address and phone numbers appear based on the Org. Address tab parameters.

**MG Cash.** This column displays the matching gift pledge payment - cash.

**MG Plg Bal.** This column displays the total amount of all matching gift pledges. The column appears if you specified this gift type on the Gift Types tab.

**MG Stock.** This column displays the matching gift pledge payment stock and matching gift pledge payment sold stock.

**Total.** This column displays the total of all matching gift types included in the report.

**Online Vs. Offline Giving Report**

If you have NetCommunity Integration, the **Online vs. Offline Giving Report** is available. Accessed through Reports on the Raiser’s Edge bar, this financial report enables you to compare gifts received through your Blackbaud NetCommunity Web site with constituent giving through other means during a time period you define. The exact data included depends on your parameter tab settings.

The summary report compares totals of gifts received within the date range for each campaign, fund, appeal, or constituent code. You can graph the results of the summary report. The detail report presents the same information as the summary report and adds constituent information.

**Planned Gifts Report**

The **Planned Gifts Report** provides detailed information about planned gifts made by selected constituents within a selected time period. A summary version of the report also provides planned gift totals based on maturity year, fund, appeal, constituent code, solicitor, or gift vehicle.

**Planned Gifts Report Columns**

The Detail report type displays the following columns:

**Acknowledge.** This column indicates if an acknowledgment letter has been sent for the gift.

**Acknowledge Date.** This column displays the date the gift was acknowledged.

**Amount.** This column displays the total amount of gifts for the selected gift type and fund.

**Appeal Description.** This column displays the appeal associated with the gift. The information is pulled from the **Description** field on the General tab of the appeal record.

**Appeal ID.** This column displays the appeal associated with the gift. The information is pulled from the **Appeal ID** field on the General tab of the appeal record.
<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Campaigns.</strong></td>
<td>This column displays the campaign associated with the gift. The information is pulled from the Description field on the General tab of the campaign record.</td>
</tr>
<tr>
<td><strong>Campaign ID.</strong></td>
<td>This column displays the campaign associated with the gift. The information is pulled from Campaign ID field on the General tab of the campaign record.</td>
</tr>
<tr>
<td><strong>Constituent Code.</strong></td>
<td>If the report is filtered by constituent codes on the Filters tab, then the constituent code is the one that passed the filter. If the report is not filtered by constituent codes (either from the gift record or from the constituent based on the filters), then the constituent code is the primary constituent code for the constituent.</td>
</tr>
<tr>
<td><strong>Constituent name.</strong></td>
<td>The constituent name prints as specified on the Format Tab/Name options. The constituent ID and/or constituent name prints in this column also (on separate rows) if selected in the detail section of the format tab.</td>
</tr>
<tr>
<td><strong>Expected Maturity Year.</strong></td>
<td>This column displays the year the planned gift is expected to mature.</td>
</tr>
<tr>
<td><strong>Fund.</strong></td>
<td>This column displays the fund associated with the gift. The information is pulled from the Fund ID field on the General tab of the fund record.</td>
</tr>
<tr>
<td><strong>Fund Description.</strong></td>
<td>This column displays the fund associated with the gift. The information is pulled from the Description field on the General tab of the fund record.</td>
</tr>
<tr>
<td><strong>Gift Code.</strong></td>
<td>This column displays the gift code recorded in the gift record.</td>
</tr>
<tr>
<td><strong>Gift Date.</strong></td>
<td>The gift date is the original gift date on the planned gift.</td>
</tr>
<tr>
<td><strong>Gift ID.</strong></td>
<td>This column displays the ID assigned to the gift in the Gift ID field on the Miscellaneous tab of the gift record.</td>
</tr>
<tr>
<td><strong>Gift Status.</strong></td>
<td>This column displays weather the gift is active or not.</td>
</tr>
<tr>
<td><strong>Gift Subtype.</strong></td>
<td>This column displays the information recorded in the Gift subtype field in the gift record.</td>
</tr>
<tr>
<td><strong>Gift Vehicle.</strong></td>
<td>This column displays the information recorded in the Vehicle field on the Gift tab of the gift record.</td>
</tr>
<tr>
<td><strong>Insurance Carrier.</strong></td>
<td>The name of the insurance company providing the policy included in the constituent’s planned gift.</td>
</tr>
<tr>
<td><strong>Letter Code.</strong></td>
<td>This column displays the type of letter sent acknowledging the gift.</td>
</tr>
<tr>
<td><strong>Net Present Value.</strong></td>
<td>Displays an estimation of the value of the gift if it were to be totally realized today, rather than after the normally expected term of the gift.</td>
</tr>
<tr>
<td><strong>Next Premium Date.</strong></td>
<td>The due date of the next premium payment on the insurance policy included in the constituent’s planned gift.</td>
</tr>
<tr>
<td><strong>Package.</strong></td>
<td>This column displays any Package information entered on the gift record.</td>
</tr>
<tr>
<td><strong>PIF Name.</strong></td>
<td>This column displays the Pooled Income Funds.</td>
</tr>
<tr>
<td><strong>Policy Face Amount.</strong></td>
<td>The face amount of the insurance policy included in the constituent’s planned gift.</td>
</tr>
<tr>
<td><strong>Policy Number.</strong></td>
<td>The number of the insurance policy included in the constituent’s planned gift.</td>
</tr>
<tr>
<td><strong>Policy Type.</strong></td>
<td>The type of insurance policy included in the constituent’s planned gift.</td>
</tr>
<tr>
<td><strong>Premium Amount.</strong></td>
<td>The amount of the premium of the insurance policy included in the constituent’s planned gift.</td>
</tr>
<tr>
<td><strong>Receipt.</strong></td>
<td>This column indicates if a receipt has been printed for the gift.</td>
</tr>
<tr>
<td><strong>Receipt Date.</strong></td>
<td>This column displays the receipt date used on the receipt printed for the gift.</td>
</tr>
</tbody>
</table>
Receipt Number. This column displays the number of receipts generated during receipt processing.

Reference. This column displays the Reference entered on the Gift tab of the gift record.

Remainder Value. This column displays the remainder value of each applicable gift for the report period.

Solictor Name. This column displays the solicitor on the gift record. If more than one solicitor is associated with the gift, then multiple solicitors print in the same column on separate rows. The format is based on the name format section of the format tab.

Total Realized. This column displays the sum of the revenue amounts received associated with the planned gift.

The Summary report type displays the following columns:

Amount. This column displays the total amount of gifts for the selected gift type and fund.

Appeal Description. This column displays the appeal associated with the gift. The information is pulled from the Description field on the General tab of the appeal record. It appears if you select to Summarize By Appeal on the Format tab.

Appeal ID. This column displays the appeal associated with the gift. The information is pulled from the Appeal ID field on the General tab of the appeal record. It appears if you select to Summarize By Appeal on the Format tab.

Constituent Code. This column displays the primary constituent code for the constituent. It appears if you select to Summarize By Constituent Code on the Format tab.

Expected Maturity Year. This column displays the year the planned gift is expected to mature. It appears if you select to Summarize By Expected Maturity Year on the Format tab.

Fund ID. This column displays the fund associated with the gift. The information is pulled from the Fund ID field on the General tab of the fund record. It appears if you select to Summarize By Fund on the Format tab.

Fund Description. This column displays the fund associated with the gift. The information is pulled from the Description field on the General tab of the fund record. It appears if you select to Summarize By Fund on the Format tab.

Gift Code. This column displays the gift code recorded in the gift record.

Gift Vehicle. This column displays the information recorded in the Vehicle field on the Gift tab of the gift record. It appears if you select to Summarize By Gift Vehicle on the Format tab.

Gift Count. This column displays the number of gifts given to the associated fund.

Insurance Carrier. The name of the insurance company providing the policy included in the constituent’s planned gift.

Next Premium Date. The due date of the next premium payment on the insurance policy included in the constituent’s planned gift.

Policy Face Amount. The face amount of the insurance policy included in the constituent’s planned gift.

Policy Number. The number of the insurance policy included in the constituent’s planned gift.

Policy Type. The type of insurance policy included in the constituent’s planned gift.

Premium Amount. The amount of the premium of the insurance policy included in the constituent’s planned gift.

Remainder Value. This column displays the remainder value of each applicable gift for the report period.

Note: Report names may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For example, if “Gifts” was changed to “Fees”, the Gift Entry Validation Report reads Fee Entry Validation Report. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.
**Solicitor.** The solicitor on the gift. If more than one solicitor is associated with the gift, then multiple solicitors print in the same column on separate rows. The format is based on the name format section of the format tab. It appears if you select to Summarize By Solicitor on the Format tab.

**Total Realized.** This column displays the sum of the revenue amounts received associated with the planned gift.

### Other Gifts Report

| Note: | Other gifts are recorded in the gift record in the Gift type field. |

The **Other Gifts Report** provides information about gifts made in the form of miscellaneous donations, which do not easily fit into any other pre-defined category. For example, planned gifts, annuities, and life insurance policies can be classified as other gifts. This report includes the value of the gift and a column with a description of the other gift. The exact data included depends on your parameter tab settings.

### Other Gifts Report Columns

- **Constituent.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.
- **Fund.** This column displays the fund ID recorded on the gift record.
- **Gift Value.** This column displays the value of all other gifts.
- **Reference.** This column displays the Reference entered on the Gift tab of the gift record.

### Stock Gain/Loss Report

| Note: | Information about the acquisition and sale of stock and any profit or loss at the time of sale is recorded on the Sell Stock/Property screen of the gift record. |

The **Stock Gain/Loss Report** provides information about stock gifts. The report includes details about each stock transaction, including the date the stock was donated, the date of the sale, and the name of the donor. The exact data included depends on your parameter tab settings.

### Stock Gain/Loss Report Columns

- **Broker Fee.** This column displays the amount the broker charged for the transaction. This fee is recorded in the sale of stock gift transaction.
- **Constituent.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.
- **Date.** This column displays the gift date.
- **Date Sold.** This column displays the sale date of the stock gift recorded on the Sell Stock/Property screen.

| Note: | In reports allowing phone numbers, an indicator (‘~’) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear. |

- **Gain (Loss).** This column displays the difference between the stock’s original amount and the sold amount, minus the broker fee.
**Issuer.** This optional column displays the name of the company which issued a stock gift. This is recorded in the **Issuer** field on the Gift tab of the gift record.

**Reference.** This column displays the information recorded in the **Reference** field on the Gift tab of the gift record.

**Sold Amount.** This column displays the sale amount of the stock recorded on the Sell Stock/Property screen.

**Stock Value.** The **Value** entered for the stock on the Gift tab of the gift record.

### Membership Reports

**Note:** For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

The optional module **Membership Management** helps you track memberships for your organization. With **Membership Management**, you can track multiple memberships and programs, print lists and directories of members, link gift records to membership records, and perform specific mailing tasks, such as preparing membership cards and renewal notices. In addition, you can perform membership transactions, including locating lapsed members, dropping members who have not responded to renewal notices, upgrading or downgrading memberships, and renewing memberships for members who want to remain active.

On the membership record, you can store information such as the number of years a member has maintained a membership, how many times the membership has been renewed, and the last renewal date. You can also create membership summaries using membership categories, programs, and subcategories as filters.

**Membership Reports** help you retrieve membership information by tracking memberships, analyzing membership activity, and creating lists and directories of members. In addition, you can locate lapsed members, drop members not responding to renewal notices, and examine trends in memberships.

### Comparative Membership Statistics

**Note:** Membership reports are available only if you have the optional module **Membership Management**.

The **Comparative Membership Statistics Report** compares the performance of membership categories in selected date ranges. This report includes the number of memberships or members for each membership level and the income generated. The exact data included depends on your parameter tab settings.

### Comparative Membership Statistics Columns

**Dues.** This optional column displays the dues amount associated with the membership. This information is pulled from the **Dues** field on the Membership tab of the membership record.

**Note:** In reports allowing phone numbers, an indicator (‘~’) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

**End.** This column displays the final number of members or memberships in a particular program, category, or subcategory. The program arrives at this number by subtracting the total number of memberships with the option of **Renew Upgrade Out**, **Renew Downgrade Out**, **Upgrade During Cycle Out**, **Downgrade During Cycle Out** and dropped from the total number of memberships with an option of **Start**, **New**, **Renew Upgrade In**, **Renew Down In**, **Rejoin Same**, **Rejoin Upgrade In**, **Rejoin Downgrade In**, **Upgrade During Cycle In**, and **Downgrade During Cycle in**.
**Report Periods columns.** User-defined columns from the Report Periods tab. You can include up to seven report periods and enter column heading information.

**Start.** This column displays the number of memberships recorded at the beginning of the selected time period.

**Total Paid.** This optional column displays the total amount of all gifts linked to memberships meeting the parameters specified.

---

## Dropped Member Report

The **Dropped Member Report** provides a list of constituents dropped from active membership during a time period you define. The exact data included depends on your parameter tab settings.

### Dropped Members Report Columns

**Current standing.** This optional column displays the current standing of memberships (Active, Lapsed, or Dropped).

**Date Dropped.** This column displays the date the membership was dropped. This is the date entered in the **Date dropped** field on the Drop Membership screen.

**Member.** This column displays the name of the primary member. You can also include the primary member’s maiden name, address, phone number, and joint member names.

**Note:** In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

**Membership.** This column displays the membership’s program, category, or subcategory. At least one membership type must be selected, in the Format/Detail section.

**Reason.** This optional column displays the reason the membership was dropped. This is the data entered in the **Reason** field on the Drop Membership screen.

**Spouse Name.** This optional column displays the name of the primary member’s spouse in the same format as that of the constituent name. If you do not specify a format, then first and last names appear.

---

## Expired Membership Report

The **Expired Membership Report** provides a list of memberships expiring during a time period you define. The exact data included depends on your parameter tab settings.

### Expired Membership Report Columns

**Current standing.** This optional column displays the current standing of memberships (Active, Lapsed, or Dropped).

**Date Expired.** This column displays the date the membership expires as recorded in the **Expires** field on the Membership tab of the membership record.

**Given by.** This optional column displays the name of the constituent who gave the membership as a gift. This information is pulled from the **Membership gift from** field on the Gift of Membership screen.

**Member.** This column displays the name of the primary member. You can also include the primary member’s maiden name, address, phone number, and joint member names.

**Membership Type.** This column displays the type of membership as recorded on the Membership tab of the membership record.
No. Children. This optional column displays the number of children recorded in the membership record from the Members & Cards button.

No. Members. This optional column displays the number of members on the membership record as defined on the Other Members and Card Information screen.

Spouse Name. This optional column displays the name of the primary member’s spouse in the same format as that of the constituent name. If you do not specify a format, then first and last names appear.

Joint Member/Card List Report

The Joint Member/Card List Report provides lists of joint members and membership card holders. The exact data included depends on your parameter tab settings.

Joint Member/Card List Report Columns

All columns listed below are present in your report only if you choose to Display Information For: Card Recipients or Both on the General Tab of the report parameter screen. If you choose to display information for Joint Members only, the report displays only Membership Information and Relationship columns.

Note: In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

Address to Print. This column indicates the address to print on the card (None, Constituent’s, Primary Member). The address is based on the selection in the Address to print option on the Joint Member or Card Recipient screen.

Card Type. This column indicates what type of card the card recipient should receive (child, corporate, guest). The information is pulled from the Type field on the Joint Member or Card Recipient screen.

Good From. This column indicates the date the card becomes valid. The information is pulled from the Valid from field on the Joint Member or Card Recipient screen.

Good Until. This column indicates the date the card is no longer valid. The information is pulled from the Valid to field on the Joint Member or Card Recipient screen.

Joint Member. This column tells you if an individual listed in the Membership Information column is a joint member or not, based on information entered on the Joint Members or Card Recipient screen.

Membership Information. This column displays the name of the primary member, membership category, joint members, and total of joint members for this membership. You can also include the primary member’s maiden name, address, and phone number.

No. to Print. This column indicates the number of cards to print for the recipient. The information is pulled from the Number to print field on the Joint Member or Card Recipient screen.

Relationship. This column displays the joint member’s relationship to the primary member, based on information entered on the member’s constituent record.

Lapsed Member Report

The Lapsed Member Report provides a list of memberships that lapsed or will lapse before the date you specify. This report differs from the Expired Membership Report in that the Lapsed Member Report limits processing to current membership transactions only. That is, this report does not include lapsed memberships renewed on or before the report date. The exact data included depends on your parameter tab settings.
Lapsed Member Report Columns

**Current standing.** This optional column displays the current standing of memberships (Active, Lapsed, or Dropped).

**Date Expired.** This column displays the date the membership expires. This information is pulled from the Expires field on the Membership tab of the membership record.

**Given by.** This optional column displays the name of the constituent who gave the membership as a gift. This information is pulled from the Membership gift from field on the Gift of Membership screen.

**Note:** In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

**Member.** This column displays the name of the primary member. You can also include the primary member’s maiden name, address, phone number, and joint member names.

**Membership.** This column displays the type of membership as recorded on the Membership tab of the membership record.

**No. Children.** This optional column displays the number of children recorded in the membership record from the Members & Cards button.

**No. Members (Previous).** This optional column displays the number of members on the membership record as defined on the Other Members and Card Information screen.

**Spouse Name.** This optional column displays the name of the primary member’s spouse in the same format as that of the constituent name. If you do not specify a format, then first and last names appear.

Membership Dues Report

**Note:** Membership dues are the monetary amount a constituent must pay to join a membership group.

The Membership Dues Report provides information about the income generated from membership dues paid during the time period you define. The exact data included depends on your parameter tab settings.

Membership Dues Report Columns

The Detail report type displays the following columns:

**Amount Paid.** This optional column displays the amount(s) from gifts that are linked to the membership. This amount is pulled form the Amount field on the Gift tab of the gift record linked to the Membership.

**Current standing.** This optional column displays the current standing of memberships (Active, Lapsed, or Dropped).

**Date Paid.** This optional column displays the date the membership was paid. This amount is pulled from the Gift date field on the Gift tab of the gift record associated with the membership.

**Given by.** This optional column displays the name of the constituent who gave the membership as a gift. This information is pulled from the Membership gift from field on the Gift of Membership screen.

**Member.** This column displays the name of the primary member. You can also include the primary member’s maiden name, address, phone number, and joint member names.

**Membership Program/Category/Subcategory.** This column displays the membership’s program, category, or subcategory. At least one membership type must be selected in the Format/Detail section.

**Next Renewal.** This column displays the next renewal date for the membership, as recorded in the Expires field on the Membership tab of the membership record.
No. Children. This optional column displays the number of children recorded in the membership record from the Members & Cards button.

No. Members. This optional column displays the number of members on the membership record as defined on the Other Members and Card Information screen.

Payers. This optional column displays the name of the person paying for the membership.

**Note:** In reports allowing phone numbers, an indicator (\~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

Spouse Name. This optional column displays the name of the primary member’s spouse in the same format as that of the constituent name. If you do not specify a format, then first and last names appear.

Unpaid Dues. This optional column displays the amount of dues that are unpaid.

The Summary report type displays the following columns:

**Amount Paid.** This optional column displays the amount paid for the membership. This amount is pulled from the Amount field on the Gift tab of the gift record associated with the membership.

**Members.** This column displays the number of members associated with the corresponding program/category/subcategory.

**Membership Dues.** This column displays the dues amount associated with the membership. If you process the report by gift date, then any dues associated with the membership linked to the gift used for processing are included. If a membership transaction has multiple gifts linked to it meeting the gift processing criteria, then the membership transaction is counted only once and the membership dues are included only once in the calculation of this field.

**Memberships.** This column displays the number of memberships associated with the corresponding program/category/subcategory.

**Program/Category/Subcategory.** This column displays the membership’s program, category, or subcategory. At least one membership type must be selected in the Format/Detail section.

Unpaid Dues. This optional column displays the amount of dues that are unpaid.

**Membership Given By Report**

The Membership Given By Report lists constituents who received their memberships as gifts from another constituent. The exact data included depends on your parameter tab settings.

**Membership Given By Report Columns**

**Current standing.** This optional column displays the current standing of memberships (Active, Lapsed, or Dropped).

**Date Given.** This column displays the Joined on, Renewed on, Rejoined on, Downgraded on, or Upgraded on date entered on the Membership tab of the membership record.

**Given by.** This column displays the name of the constituent who gave the membership as a gift. This information is pulled from the Membership gift from field on the Gift of Membership screen.

**Member.** This column displays the name of the primary member. You can also include the primary member’s maiden name, address, phone number, and joint member names.
Membership Program/Category/Subcategory. This column displays the membership's program, category, or subcategory. At least one membership type must be selected in the Format/Detail section.

Next Renewal. This optional column displays the next renewal date for the membership, based on the information entered in the Expires field on the Membership tab of the membership record.

Notice Information. This optional column displays the type of renewal notice to send and the name of the person to receive the notices: the primary member, the donor, or both. This information is pulled from the Send renewal notice to option on the Gift of Membership screen.

Spouse Name. This optional column displays the name of the primary member’s spouse in the same format as that of the constituent name. If you do not specify a format, then first and last names appear.

Membership List/Directory

Note: Current membership is defined as the most recent or last membership transaction on the membership record.

The Membership List/Directory generates a list or directory of members. You can include address and phone information and group the memberships based on membership category or membership type. The report uses current membership information. The exact data included depends on your parameter tab settings.

Membership List/Directory Columns

Current standing. This optional column displays the current standing of memberships (Active, Lapsed, or Dropped).

Expires on. This optional column displays the date the membership expires as recorded in the Expires field on the Membership tab of the membership record.

Given by. This optional column displays the name of the constituent who gave the membership as a gift. This information is pulled from the Membership gift from field on the Gift of Membership screen.

Member. This column displays the name of the primary member. You can also include the primary member’s maiden name, address, phone number, and joint member names.

Member Since. This optional column displays the Joined on date for the membership.

Membership Type. This column displays the type of membership as recorded on the Membership tab of the membership record.

No. Children. This optional column displays the number of children recorded in the membership record from the Members & Cards button.

No. Members. This optional column displays the number of members on the membership record as defined on the Other Members and Card Information screen.

Note: In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

Spouse Name. This optional column displays the name of the primary member’s spouse in the same format as that of the constituent name. If you do not specify a format, then first and last names appear.
Membership Statistics by Category

The Membership Statistics by Category report provides a snapshot of activity within each membership category for a time period you define. The report can include information about upgrades, downgrades, total memberships, and income. You can also generate a graph of the report results. The exact data included depends on your parameter tab settings.

Membership Statistics by Category Columns

**Downgrade During Cycle.** This column displays the number of members or memberships that downgraded during the membership cycle during the time period specified.

**Dropped.** This column displays the number of members or memberships dropped in each program, category, and/or subcategory during the time period specified.

**Dues.** This optional column displays the total dues amount associated with the membership. This information is pulled from the Dues field on the Membership tab of the membership record.

**End Members.** This column displays the final number of members or memberships in a particular program, category, or subcategory. The program arrives at this number by subtracting the total number of memberships with the option of Renew Upgrade Out, Renew Downgrade Out, Upgrade During Cycle Out, Downgrade During Cycle Out and dropped from the total number of memberships with an option of Start, New, Renew Upgrade In, Renew Down In, Rejoin Same, Rejoin Upgrade In, Rejoin Downgrade In, Upgrade During Cycle In, and Downgrade During Cycle in.

**Lapsed memberships.** This optional column shows the number of memberships in a particular program, category, and/or subcategory that lapsed without renewing, rejoining, upgrading, downgrading, or dropping during the time period specified.

**Memberships As Of.** This column shows the number of members or memberships during the time period specified in a particular program, category, and/or subcategory with a standing of Active or Lapsed.

**New.** This column displays the number of new members or memberships in each program, category, and/or subcategory during the time period specified.

**Rejoins.** This column displays the number of members or memberships rejoined in each program, category, and/or subcategory during the time period specified.

**Renewals.** This column displays the number of members or memberships renewed in each program, category, and/or subcategory during the time period specified.

**Starting Memberships.** This optional column displays the number of memberships recorded at the beginning of the time period specified.

**Total Paid.** This optional column calculates the total of all gifts linked to the membership during the time period specified.

**Upgrade During Cycle.** This column displays the number of upgraded members or memberships in the membership cycle during the time period specified.

Month/Year Statistical Analysis

**Note:** In reports allowing phone numbers, an indicator (‘~’) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

**Renewals.** This column displays the number of members or memberships renewed in each program, category, and/or subcategory during the time period specified.

**Starting Memberships.** This optional column displays the number of memberships recorded at the beginning of the time period specified.

**Total Paid.** This optional column calculates the total of all gifts linked to the membership during the time period specified.

**Upgrade During Cycle.** This column displays the number of upgraded members or memberships in the membership cycle during the time period specified.

**Note:** The membership category defines the level of giving required for a constituent to gain membership into one of your membership groups or clubs.
The Month/Year Statistical Analysis provides a monthly or yearly breakdown of membership activity. The report can include a count of new, renewed, rejoined, upgraded, downgraded, and dropped memberships. The exact data included depends on your parameter tab settings.

**Month/Year Statistical Analysis Columns**

**Downgrade During Cycle.** This column displays the number of members or memberships that downgraded during the membership cycle between the first and last days of the month.

**Dues.** This optional column displays the dues amount associated with the membership. This information is pulled from the Dues field on the Membership tab of the membership record.

**End Members.** This column displays the final number of members or memberships in a particular program, category, or subcategory. The program arrives at this number by adding Start, New, Renew Upgrade In, Renew Down In, Rejoin Same, Rejoin Upgrade In, Rejoin Downgrade In, Upgrade During Cycle In, and Downgrade During Cycle In options to arrive at a total. It then adds the Renew Upgrade Out, Renew Downgrade Out, Upgrade During Cycle Out, Downgrade During Cycle Out, and Dropped options to arrive at the second total. Finally, the program subtracts the second total from the first total to arrive at the end amount.

**Lapsed memberships.** This optional column shows the number of memberships in a particular program, category, and/or subcategory that lapsed without renewing, rejoining, upgrading, downgrading, or dropping within the specified date range.

**Month.** This column displays the month for which information is displayed. This column appears if you select “Month” in the Breakdown by field on the General tab of the report parameter screen.

**New.** This column displays the number of new members or memberships in each program, category, and/or subcategory satisfying your selected date range.

**Rejoins.** This column displays the number of members or memberships rejoined in each program, category, and/or subcategory satisfying your selected date range.

**Renewals.** This column displays the number of members or memberships renewed in each program, category, and/or subcategory satisfying your selected date range.

**Start Memberships.** This optional column displays the number of memberships you had at the beginning of the month or year.

**Total Paid.** This column calculates the total of all gifts linked to the membership satisfying the parameters you selected.

**Upgrade During Cycle.** This column displays the number of upgraded members or memberships in the membership cycle between the first and last days of the month.

**Year.** This column displays the year for which information is displayed. This column appears if you select “Year” in the Breakdown by field on the General tab of the report parameter screen.

**New Member Report**

The New Member Report provides a list of constituents with new memberships, starting during a time period you define. You can include constituent names, join and renewal dates, and totals. The exact data included depends on your parameter tab settings.

**New Member Report Columns**

**Current standing.** This optional column displays the current standing of memberships (Active, Lapsed, or Dropped).
Expires on. This optional column displays the date the membership expires as recorded in the Expires field on the Membership tab of the membership record.

Given by. This optional column displays the name of the constituent who gave the membership as a gift. This information is pulled from the Membership gift from field on the Gift of Membership screen.

Joined On. This column displays the date the new member joined. This information is pulled from the Date joined field on the New Membership screen.

Membership. This column displays the membership’s program, category, or subcategory. At least one membership type must be selected in the Format/Detail section.

New Member. This column displays the name of the primary new member on the report. You can also include the primary member’s maiden name, address, phone number, and joint member names.

No. Children. This optional column displays the number of children recorded in the membership record from the Members & Cards button.

No. Members. This optional column displays the number of members on the membership record as defined on the Other Members and Card Information screen.

Spouse Name. This optional column displays the name of the primary member’s spouse in the same format as that of the constituent name. If you do not specify a format, then first and last names appear.

Rejoin Report

The Rejoin Report provides a list of constituents dropped from active membership, but who rejoined during a time period you define. You can include constituent names, rejoined or renewal dates, and totals. The exact data included depends on your parameter tab settings.

Rejoin Report Columns

Current standing. This optional column displays the current standing of memberships (Active, Lapsed, or Dropped).

Date Rejoined: This column displays the date entered in the Rejoined on field on the Membership tab of the membership record.

Expires on. This optional column displays the date the membership expires as recorded in the Expires field on the Membership tab of the membership record.

Given by. This optional column displays the name of the constituent who gave the membership as a gift. This information is pulled from the Membership gift from field on the Gift of Membership screen.

Member. This column displays the name of the primary member. You can also include the primary member’s maiden name, address, phone number, and joint member names.

Membership. This optional column displays the membership’s program, category, or subcategory. At least one membership type must be selected in the Format/Detail section.

No. Children. This optional column displays the number of children recorded in the membership record from the Members & Cards button.

No. Members. This optional column displays the number of members on the membership record as defined on the Other Members and Card Information screen.

Rejoin Type. This optional column shows the type of rejoin: Upgrade, Downgrade, or Same.
Spouse Name. This optional column displays the name of the primary member’s spouse in the same format as that of the constituent name. If you do not specify a format, then first and last names appear.

Renewal Projection Report

The Renewal Projection Report projects the amount of income expected from various categories of membership renewals for a time period you define. The exact data included depends on your parameter tab settings.

Renewal Projection Report Columns

Membership (Members) to Renew. This column displays the number of members or memberships (depending on your selection on the General tab) up for renewal within the specified time period.

% Renewed. These three columns display the high, medium, and low level thresholds you defined. The numbers that appear in these columns for the income are affected by the following:

- If you choose to use whole numbers only for the renewable memberships. For example if there are seven users up for renewal and the high threshold is at 75%, the system is expecting 5.25 memberships to be renewed. If you select to use only whole numbers, the number to use is five when it comes to calculating the income.

Period. This column lists the month and year represented by the period.

Program/Category/Subcategory. This column displays the membership’s program, category, or subcategory. At least one membership type must be selected in the Format/Detail section.

Renewal Report

The Renewal Report lists constituents who renewed their memberships during a time period you defined. You can include the member names and addresses, program categories and subcategories, and whether the membership is a gift. The exact data included depends on your parameter tab settings.

Renewal Report Columns

Current standing. This optional column displays the current standing of memberships (Active, Lapsed, or Dropped).

Date Renewed: This column displays the date entered in the Rejoined on field on the Membership tab of the membership record.

Expires on. This optional column displays the date the membership expires as recorded in the Expires field on the Membership tab of the membership record.

Given by. This optional column displays the name of the constituent who gave the membership as a gift. This information is pulled from the Membership gift from field on the Gift of Membership screen.
**Member.** This column displays the name of the primary member. You can also include the primary member’s maiden name, address, phone number, and joint member names.

**Membership.** This optional column displays the membership’s program, category, or subcategory. At least one membership type must be selected in the Format/Detail section.

**Note:** In reports allowing phone numbers, an indicator (‘~’) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

**No. Children.** This optional column displays the number of children recorded in the membership record from the Members & Cards button.

**No. Members.** This optional column displays the number of members on the membership record as defined on the Other Members and Card Information screen.

**Number Times Renewed.** This optional column displays the number of times the membership has been renewed.

**Renewal type.** This optional column displays the type of membership renewal: Upgrade, Downgrade, or Same.

**Spouse Name.** This optional column displays the name of the primary member’s spouse in the same format as that of the constituent name. If you do not specify a format, then first and last names appear.

**Pivot Reports**

**Note:** For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

You can use **Pivot Reports** unique tools to create custom views of your data by dragging and dropping information previously gathered using a query. With these interactive reports, you can analyze database information and create summaries and reports. For more information about **Pivot Reports**, see the Pivot Reports chapter in *The Raiser’s Edge & Microsoft Office Integration Guide*.

**Pledge And Recurring Gift Reports**

A pledge is a promise to make a gift in the future. When you receive a pledge, you need to add the pledge to your **Raiser’s Edge** database by creating a pledge gift record. Pledge gift records, like all gift records, contain essential information about the gift — the gift amount; the campaign, fund, appeal, and package to which the gift should be attributed; the payment type; attributes; soft credits; the installment schedule; and the remaining balance due for the pledge.

Recurring gifts are similar to pledges paid in installments because a constituent agrees to donate a specific amount to your organization over time.

**Pledge and Recurring Gift Reports** help you track all aspects of pledges and recurring gifts made to your organization, including payments, write-offs, and cash flow. You can track pledge and recurring gift activity, anticipate cash flow, view a list of past due pledges, and much more.
Activity Report

Note: A pledge is a promise to make a gift in the future. A master pledge has scheduled installments. Each installment is paid individually over a period of time. An installment is a scheduled payment that reduces the balance of the master pledge.

The Activity Report provides a detailed account of all pledge and recurring gift activity, including payments, installments, and balances due, during the time period you define. You can limit the report to specific pledges, such as outstanding pledges and recurring gifts. This report shows only activity that occurs during the selected time period; it does not list pledges with no activity in the time period. The exact data included depends on your parameter tab settings.

Activity Report Columns

Activity/Amount. Includes the following information:
- Amounts without parentheses are the installment payments due. This is pulled from the Installments/Payments tab on the gift record for all gifts except recurring gifts.
- Amounts with parentheses are the installment payments made by the Donor.
- The balance is installments due minus payments, unless the option to base balance on selected criteria is selected.
- In the UK, the balance is calculated using either the net or the gross amount as defined by the user in User Options.

Activity/Date. This is the date of the activity that corresponds to the adjacent Type. It is either the due date or pay date.

Activity/Type. Not a calculated column; it includes the following information:
- INS = Installment Due (Pledges, even for those without a specified due date)
- PAY = Payments to pledges and recurring gifts
- Write-off = Pledge write-offs.
- MG INS = Matching Gift installments (even for those without a specified due date)
- TRN = Recurring gift transactions

Constituent Name. This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

Date. The date of the original pledge.

Gift Amount. This is the original gift amount; in the UK this is the true pledge amount. This is not based on the User Option of net or gross.

Note: The Activity Report includes linked columns, which are listed on the Columns tab as a single unit in the Available Columns list and Selected Columns grid. For more information, see “Columns Tab” on page 144.

Fund. This column displays the fund description of the fund associated with the pledge. This information is entered in the Description field on the General tab of the fund record.

Type. Numeric values may change based on installment schedule. The following are examples.
- PL = Master Pledge
- PL A2 = Pledge 2 Annual Installments
- PL A3 = Pledge 3 Annual Installments
- PL SA3 = Pledge 3 Semi-Annual Installments
• PL Q4 = Pledge 4 Quarterly Installments
• PL BM5 = Pledge 5 Bimonthly Installments
• PL M6 = Pledge 6 Monthly Installments
• PL SM7 = Pledge 7 Semi-Monthly Installments
• PL S1 = Single installment pledge
• PL BW8 = Pledge 8 Biweekly Installments
• PL W9 = Pledge 9 Weekly Installments
• PL I10 = Pledge 10 Irregular Installments
• REC = Recurring Gift, format follows above; PL is replaced with REC
• Matching Gift Pledge appears as above with an MG before the pledge type. EX: MG PL

Campaign Report

The Campaign Report provides a list of gifts donated to campaigns after a specific date. The report includes the date of final payment (whether future or past), payments made to date, and amounts written off. The detail version of the report includes constituent names and address information. The summary version of this report provides totals of pledges by fund but without constituent names or addresses. This is a good report for listing campaign pledges with outstanding balances. This report is useful if you want to close a campaign but verify the status of all pledges made to the campaign first. The exact data included depends on your parameter tab settings.

Campaign Report Columns

The Detail report type displays the following columns:

Amount. Amount of the original gift. In the UK the net amount of the pledge.
Balance. Amount not paid as of the day the report was run. [Gifts minus payments (including tax claim amount when applicable – based on User Options setting) and skipped].
Campaign. The campaign associated with the gift.
Constituent Name. This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.
Date. Date of the gift
Date Final. Date the final payment is due. May be the word “Open” for open ended recurring gifts.
Payments. Payments made on gifts within a specified date range; in the UK this takes into account the net or gross option set in User Options.
Skipped/Written Off. Any amount written off or skipped.
Type. Type of gift made:
• PL = Master Pledge
• PL A2 = Pledge 2 Annual Installments
• PL A3 = Pledge 3 Annual Installments
• PL SA3 = Pledge 3 Semi-Annual Installments
• PL Q4 = Pledge 4 Quarterly Installments
• PL BM5 = Pledge 5 Bimonthly Installments
• PL M6 = Pledge 6 Monthly Installments
• PL SM7 = Pledge 7 Semi-Monthly Installments
- PL BW8 = Pledge 8 Biweekly Installments
- PL W9 = Pledge 9 Weekly Installments
- PL 110 = Pledge 10 Irregular Installments
- REC = Recurring Gift, format follows above; PL is replaced with REC
- Matching Gift Pledge appears as above with an MG before the pledge type. EX: MG PL

The Summary report type displays the following columns:

**Balance.** Amount not paid as of the day the report was run. [Gifts minus payments (including tax claim amount when applicable – based on User Options setting) and skipped].

**Description.** This column displays the fund description of the fund associated with the gift. This information is entered in the Description field on the General tab of the fund record.

**Fund ID.** This column displays the fund ID of the fund associated with the gift. This information is entered in the Fund ID field on the General tab of the fund record.

**Gift Amount.** Amount of the original gift. In the UK the net amount of the pledge.

**Payments.** Payments made on gifts within a specified date range; in the UK this takes into account the net or gross option set in User Options.

**Skipped/Written Off.** Any amount written off or skipped.

### Cash Flow Report

**Note:** The Cash Flow Report is a forward-looking report; therefore, you would not use dates from the past.

The Cash Flow Report displays anticipated cash flow. The report reviews pledges due within the date range you define and calculates the projected cash flow over one or several periods. The detail version of the report includes constituent names and addresses along with pledge balances. The summary version of the report includes totals due in each date range but does not list constituent names or addresses. The exact data included depends on your parameter tab settings.

### Cash Flow Report Columns

The Detail report type displays the following columns:

- **Constituent Name.** This column displays the constituent's name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

- **Date.** Date the gift was made.

- **Fund ID or Description.** The Fund ID or Description prints if in Configuration you selected to see and use the ID or Description for campaigns, funds, and appeals.

- **Gift Amount.** Full amount of the original gift.

- **Past Due.** Installments, regular pledge or recurring gift amounts not paid prior to first report period.

- **Total.** Total of all report periods.

- **Type.** Type of gift made:
  - PL = Master Pledge
  - PL A2 = Pledge 2 Annual Installments
  - PL A3 = Pledge 3 Annual Installments
  - PL SA3 = Pledge 3 Semi-Annual Installments
• PL Q4 = Pledge 4 Quarterly Installments
• PL BM5 = Pledge 5 Bimonthly Installments
• PL M6 = Pledge 6 Monthly Installments
• PL SM7 = Pledge 7 Semi-Monthly Installments
• PL BW8 = Pledge 8 Biweekly Installments
• PL W9 = Pledge 9 Weekly Installments
• PL I10 = Pledge 10 Irregular Installments
• REC = Recurring Gift, format follows above; PL is replaced with REC
• Matching Gift Pledge appears as above with an MG before the pledge type. EX: MG PL

**User defined Report Periods.** Amount of gifts expected to be paid during specified report periods. For regular pledges the amount due is recorded in the time period the pledge was made. Recurring gifts are considered when the transactions are due.

The Summary report type displays the following columns:

**Fund.** The Fund ID or Description prints if in *Configuration* you selected to see and use the ID or Description for campaigns, funds, and appeals.

**Past Due.** Installments, regular pledge or recurring gift amounts not paid prior to first report period.

**Total.** Total past due of all report periods.

**User defined Report Periods.** Amount of gifts expected to be paid during specified report periods. For regular pledges the amount due is recorded in the time period the pledge was made. Recurring gifts are considered when the transactions are due.

### Journal

The **Journal** provides information about pledge and recurring gift activity. It can include payments made and payments still outstanding. The detail version of the report displays constituent name and address information and pledged amounts. The summary version of the report can include totals of paid and unpaid pledges by fund. The **Journal** is similar to the **Activity Report**, but the **Journal** arranges columns by gift type. The exact data included depends on your parameter tab settings.

### Journal Columns

The **Detail** report type displays the following columns:

**Constituent Name.** This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

**Date.** The date of the activity (either the pledge date, payment date, write-off date, or skip date).

**Fund.** The Fund ID or Description prints if in *Configuration* you selected to see and use the ID or Description for campaigns, funds, and appeals.

**Gift Amount.** The amount of the original pledge or recurring gift.

**Payments.** The amount of the pledge payment or recurring gift payment. (In the UK, the net or gross amount is shown based on User Options).

---

**Note:** In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.
**Pledge/Amount.** For pledges, the original amount of the pledge. For payments, the amount of the pledge installment due or recurring gift transaction due.

**Pledge/Date.** For pledges, the date of the original pledge. For payments, the date the pledge installment is due or the recurring gift transaction was due.

**Skipped/Written Off.** For pledges, this is the write-off amount. For recurring gifts, this is the skipped amount.

**Type.** Type of gift made
- PL = Master Pledge
- PL A2 = Pledge 2 Annual Installments
- PL A3 = Pledge 3 Annual Installments
- PL SA3 = Pledge 3 Semi-Annual Installments
- PL Q4 = Pledge 4 Quarterly Installments
- PL BM5 = Pledge 5 Bimonthly Installments
- PL M6 = Pledge 6 Monthly Installments
- PL SM7 = Pledge 7 Semi-Monthly Installments
- PL BW8 = Pledge 8 Biweekly Installments
- PL W9 = Pledge 9 Weekly Installments
- PL I10 = Pledge 10 Irregular Installments
- REC = Recurring Gift, format follows above; PL is replaced with REC
- Matching Gift Pledge appears as above with an MG before the pledge type. EX: MG PL

The Summary report type displays the following columns:

**Amount.** The total amount of gifts for the selected gift type and fund.

**Description.** This column displays the fund description of the fund associated with the gift. This information is entered in the **Description** field on the General tab of the fund record.

**Fund ID.** This column displays the fund ID of the fund associated with the gift. This information is entered in the **Fund ID** field on the General tab of the fund record.

The **Pledge Status Reports** includes linked columns, which are listed on the Columns tab as a single unit in the **Available Columns** list and **Selected Columns** grid. For more information, see “Columns Tab” on page 144.

**Count.** The total number of gifts for the gift type and fund.

**Credit Account.** The credit account number based on the gift type and fund.

**Debit Account.** The debit account number based on the gift type and fund.

**Fund ID.** This column displays the fund ID of the fund associated with the pledge. This information is entered in the **Fund ID** field on the General tab of the fund record.

**Gift Type.** This column displays the type of gift created (cash, property, planned gift, etc.).

**Not Paid Report**

The **Not Paid Report** lists constituents who made a pledge but have not made any payments toward the pledge. You can run this report to include unpaid installments only or pledges with a balance. The exact data included depends on your parameter tab settings.
Not Paid Report Columns

For the master pledge, the following columns are available:

**Amount.** Amount of original gift. In the UK, this does not take into account the net or gross option in User Options.

**Constituent Name.** This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

**First Pay Due.** Date of the first installment payment due on the Installments/Payments tab of the gift record.

**Fund.** The Fund ID or Description prints if in Configuration you selected to see and use the ID or Description for campaigns, funds, and appeals.

**Gift Date.** Date of original gift.

**Reference.** Pulls from the Reference field on the gift record.

**Type.** Type of gift made

- PL = Master Pledge
- PL A2 = Pledge 2 Annual Installments
- PL A3 = Pledge 3 Annual Installments
- PL SA3 = Pledge 3 Semi-Annual Installments
- PL Q4 = Pledge 4 Quarterly Installments
- PL BM5 = Pledge 5 Bimonthly Installments
- PL M6 = Pledge 6 Monthly Installments
- PL SM7 = Pledge 7 Semi-Monthly Installments
- PL BW8 = Pledge 8 Biweekly Installments
- PL W9 = Pledge 9 Weekly Installments
- PL I10 = Pledge 10 Irregular Installments
- REC = Recurring Gift, format follows above; PL is replaced with REC
- Matching Gift Pledge appears as above with an MG before the pledge type. EX: MG PL

Past Due Report

**Note:** If a pledge or installment payment is partially paid, the Past Due Report still shows the balance as past due if all other parameters are met. If a pledge or an installment payment has been written off, it does not appear on the Past Due Report.

The Past Due Report lists pledge payments past due as of a selected date. Pledges are categorized by the number of days past due. The detail version of the report lists the constituent name and address with the amount past due. The summary version of the report can include a total of the past due amount for each fund. The exact data included depends on your parameter tab settings.
Past Due Report Columns

The Detail report type displays the following columns:

**Constituent Name.** This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

**Date.** The date of the original pledge.

**Days Past Due.** Amount not paid “X” number of days after due date or pledge date in the case of a regular pledge. (In the UK, this column does not take into account the net or gross option set in User Options.) This is calculated based on past due installments so if there is nothing paid, then the net balance is used on each installment.

**Fund.** This column displays the fund associated with the past due gift.

**Gift Amo.** Amount of original gift; In the UK, this is the true amount of the pledge regardless of what the user has selected for the net or gross amount processing in User Options.

**Total.** Totals for report periods.

**Type.** Type of gift made
- PL = Master Pledge
- PL A2 = Pledge 2 Annual Installments
- PL A3 = Pledge 3 Annual Installments
- PL SA3 = Pledge 3 Semi-Annual Installments
- PL Q4 = Pledge 4 Quarterly Installments
- PL BM5 = Pledge 5 Bimonthly Installments
- PL M6 = Pledge 6 Monthly Installments
- PL SM7 = Pledge 7 Semi-Monthly Installments
- PL BW8 = Pledge 8 Biweekly Installments
- PL W9 = Pledge 9 Weekly Installments
- PL I10 = Pledge 10 Irregular Installments
- REC = Recurring Gift, format follows above; PL is replaced with REC
- Matching Gift Pledge appears as above with an MG before the pledge type. EX: MG PL

The Summary report type displays the following columns:

**Days Past Due.** Amount not paid “X” number of days after due date or pledge date in the case of a regular pledge. (In the UK, this column does not take into account the net or gross option set in User Options.) This is calculated based on past due installments so if there is nothing paid, then the net balance is used on each installment.

**Fund Description.** This column displays the fund description of the fund associated with the gift. This information is entered in the Description field on the General tab of the fund record.

**Fund ID.** This column displays the fund ID of the fund associated with the gift. This information is entered in the Fund ID field on the General tab of the fund record.

**Total.** Totals for report periods.

**Note:** In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.
Pledge Status Report

The Pledge Status Report includes pledge activity falling within the report’s date range for pledges made after a date you specify. It comes in two formats (Format 1 and Format 2) and two types (Detail and Summary).

You select the format option from the Detail category on the Format tab.

Format 1 includes the following information:

• Date: Date of original pledge
• Master Pledge: Amount of the original pledge, Regular or Master
• Prior to Payments: Pledge payments made prior to the report start date
• Prior to Written Off: Write-offs made prior to the report start date
• Payments: Payments made within the report's date range
• Written Off: Write-offs made within the report's date range
• Pledge Balance: Master Pledge Amount minus any payments (taking into account the net or gross options in User Options) and write-offs

Note: In reports allowing phone numbers, an indicator (*) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

• Prior to Written Off: Write-offs made prior to the report start date
• Payments: Payments made within the report's date range
• Written Off: Write-offs made within the report's date range

Format 2 includes the following information:

• Date: Date pledge was made
• Amount Pledged: Amount of original pledge, regular or master, made after the General tab’s Include pledges made after date
• Previous Balance: Balance outstanding the day before the report’s start date
• Pledged: Amount of original pledge, regular or master, made within the report date range. If no pledges fall within the report date range, the amount is $0.
• Payments: Payments made toward the pledge within the report's date range
• Written Off: Amounts written off during the report date range
• Pledge Balance: Previous balance plus amount pledged minus payments and write-offs

You select to run the Detail or Summary version of the report from the General tab. The detail version includes constituent name and address information along with the pledge information. The summary version totals pledge information for each fund but cannot include constituent name and address information. Pledges appear on this report based on the date the pledge was made and not the dates of pledge activity. For example, you can use this report to list the payments made during October 2004 to pledges made after January 1, 2004. The exact data included depends on your parameter tab settings.

Pledge Status Report Columns

If in the Detail category on the Format tab, you select Format 1, the following columns are available.

Note: The Pledge Status Reports includes linked columns, which are listed on the Columns tab as a single unit in the Available Columns list and Selected Columns grid. For more information, see “Columns Tab” on page 144.

The Detail report type displays the following columns:
All Dates/Payments. Pledge payments made during all dates. In the UK, this does take into account the net or gross option established in User Options.

All Dates/ Written Off. Any write offs made during all dates.

Constituent Name. This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

Date. Date of original pledge

Fund. This column displays the fund ID of the fund associated with the pledge. This information is entered in the Fund ID field on the General tab of the fund record.

Payments. Payments made within the specified date range. In the UK, this does take into account the net or gross option established in User Options.

Pledge. Amount of the original pledge, regular or master.

Pledge Balance. Master Pledge Amount minus any payments (taking into account the net or gross options in User Options) and write offs.

Prior Amounts/Payments. Pledge payments made prior to the specified date. In the UK, this does take into account the net or gross option established in User Options.

Prior Amounts/ Written Off. Any write offs made prior to the specified date.

Type. Type of gift made

• PL = Master Pledge
• PL A2 = Pledge 2 Annual Installments
• PL A3 = Pledge 3 Annual Installments
• PL SA3 = Pledge 3 Semi-Annual Installments
• PL Q4 = Pledge 4 Quarterly Installments
• PL BM5 = Pledge 5 Bimonthly Installments
• PL M6 = Pledge 6 Monthly Installments
• PL SM7 = Pledge 7 Semi-Monthly Installments
• PL BW8 = Pledge 8 Biweekly Installments
• PL W9 = Pledge 9 Weekly Installments
• PL I10 = Pledge 10 Irregular Installments
• Matching Gift Pledge appears as above with an MG before the pledge type. EX: MG PL

Written Off. Write offs made within the specified date range.

The Summary report type displays the following columns:

All Dates/Payments. Pledge payments made during all dates. In the UK, this does take into account the net or gross option established in User Options.

All Dates/ Written Off. Any write offs made during all dates.

Description. This column displays the fund description of the fund associated with the pledge. This information is entered in the Description field on the General tab of the fund record.

Note: The Pledge Status Reports includes linked columns, which are listed on the Columns tab as a single unit in the Available Columns list and Selected Columns grid. For more information, see “Columns Tab” on page 144.

Fund ID. This column displays the fund ID of the fund associated with the pledge. This information is entered in the Fund ID field on the General tab of the fund record.
Pledge. Amount of the original pledge, regular or master.

Pledge Balance. Master Pledge Amount minus any payments (taking into account the net or gross options in User Options) and write offs.

Prior Amounts/Payments. Pledge payments made prior to the specified date. In the UK, this does take into account the net or gross option established in User Options.

Prior Amounts/ Written Off. Any write offs made prior to the specified date.

If in the Detail category on the Format tab, you select Format 2, the following columns are available.

The Detail report type displays the following columns:

All Dates/Payments. Pledge payments made during all dates. In the UK, this does take into account the net or gross option established in User Options.

All Dates/ Pledged. The Amount of the original pledge, regular or master, made during all dates. If there are no pledges within the date range the amount is $0. In the UK, this is the true amount of the pledge installments within the date range. This does not consider the net or gross User Option.

All Dates/ Written Off. Any write offs made during all dates.

Amount Pledged. Amount of original pledge, regular or master, made after the Pledges Made After date. In the UK, this is the net/true amount of the pledge only.

Note: In reports allowing phone numbers, an indicator (\^) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

Constituent Name. This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

Date. Date of original pledge

Fund. This column displays the fund ID of the fund associated with the pledge. This information is entered in the Fund ID field on the General tab of the fund record.

Pledge Balance. The previous balance plus pledged amount minus payments and write offs.

Previous Balance. The balance outstanding the day BEFORE the start of specified date range.

Type. Type of gift made
  • PL = Master Pledge
  • PL A2 = Pledge 2 Annual Installments
  • PL A3 = Pledge 3 Annual Installments
  • PL SA3 = Pledge 3 Semi-Annual Installments
  • PL Q4 = Pledge 4 Quarterly Installments
  • PL BM5 = Pledge 5 Bimonthly Installments
  • PL M6 = Pledge 6 Monthly Installments
  • PL SM7 = Pledge 7 Semi-Monthly Installments
  • PL BW8 = Pledge 8 Biweekly Installments
  • PL W9 = Pledge 9 Weekly Installments
  • PL I10 = Pledge 10 Irregular Installments
  • Matching Gift Pledge appears as above with an MG before the pledge type. EX: MG PL

The Summary report type displays the following columns:
All Dates/Payments. Pledge payments made during all dates. In the UK, this does take into account the net or gross option established in User Options.

All Dates/ Pledged. The Amount of the original pledge, regular or master, made during all dates. If there are no pledges within the date range the amount is $0. In the UK, this is the true amount of the pledge installments within the date range. This does not consider the net or gross User Option.

All Dates/ Written Off. Any write offs made during all dates.

Description. This column displays the fund description of the fund associated with the pledge. This information is entered in the Description field on the General tab of the fund record.

Note: The Pledge Status Reports includes linked columns, which are listed on the Columns tab as a single unit in the Available Columns list and Selected Columns grid. For more information, see “Columns Tab” on page 144.

Fund ID. This column displays the fund ID of the fund associated with the pledge. This information is entered in the Fund ID field on the General tab of the fund record.

Pledge Balance. The previous balance plus pledged amount minus payments and write offs.

Previous Balance. The balance outstanding the day BEFORE the start of specified date range.

Recurring Gift Amendment Report

The Recurring Gift Amendment Report helps you determine the success rate of your upgrade appeals or campaigns. It can show you who has upgraded or downgraded, when, and how much your donors were previously giving and how much they are giving now. It processes information for amended recurring gifts on a specific date or during a specified date range. You can select to include recurring gifts with amounts that have been upgraded, downgraded, or remained the same; and you can select to process this report as a summary report, detail report, or both. You can filter by constituent code(s), appeal(s), campaign(s), fund(s), and payment type(s). You can summarize the report by campaign, fund, appeal, package, constituent code, solicitor, and pay method. You can break it down by constituent name, amendment month and year, campaign, fund, appeal, solicitor, and frequency. Along with the constituent name, you can include the constituent ID and a maiden name. From this report, you can also create a constituent or gift output query.

Recurring Gift Amendment Report Columns

Amendment Amount. This column displays the amount of the amended recurring gift. This field is not optional. It is always present.

Amendment Date. The date of the amendment. This field is not optional. It is always present.

Appeal. The appeal on the amendment.

Campaign. The campaign on the amendment gift. If the campaign is split, then multiple campaigns prints separated by a semicolon and the column wraps.

Note: In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

Constituent address. The constituent address if selected on the individual and organization address tabs. Multiple phone numbers may print based on the selected phone types on the individual and organization address tabs.
Constituent Code. If the report is filtered by constituent codes on the Filters tab, then the constituent code is the one that passed the filter. If the report is not filtered by constituent codes (either from the gift record or from the constituent based on the filters), then the constituent code is the primary constituent code for the constituent.

Constituent name. The constituent name prints as specified on the Format Tab/Name options. The constituent ID and/or constituent name prints in this column also (on separate rows) if selected in the detail section of the format tab.

Frequency. The frequency of the amendment. Note that if an amendment has been added to the recurring gift, the frequency is based on the last amendment added. The possible frequencies are Annually, Semi-annually, Quarterly, Bimonthly, Monthly (this is used if every x months = 1), Monthly every x months, Semi-monthly, Biweekly, Weekly (this is used if x weeks = 1), Weekly every x weeks.

Fund. The fund on the amendment. If the fund is split, then multiple funds print separated by a semicolon and the column wraps.

Gift Attribute. If a gift attribute is selected, then the name of the gift attribute is used as the heading for the column. The description of the gift attribute.

Package. The package on the amendment. If the package is split, then multiple packages print separated by a semicolon and the column wraps.

Pay method. The pay method from the recurring gift.

Previous Amount. The amount the recurring gift was amended from. If the frequency of the amendment is different from the ‘previous frequency’, then this amount is printed based on the frequency of the amendment.

Previous Appeal. The appeal the recurring gift was amended from. If the appeal is split, then multiple appeals print separated by a semicolon and the column wraps.

Previous Campaign. The campaign from which the recurring gift was amended. If the campaign is split, then multiple campaigns print separated by a semicolon and the column wraps.

Previous Fund. The fund from which the recurring gift was amended. If the fund is split, then multiple funds print separated by a semicolon and the column wraps.

Previous Package. The package the recurring gift was amended from. If the package is split, then multiple packages print separated by a semicolon and the column wraps.

Note: It is possible for a recurring gift to have multiple amendments. The amendment used for this report is based on the date on the general tab. The ‘previous amount’ is not necessarily the original gift amount; the ‘previous amount’ is the amount of the previous amendment if there is one.

Solicitor. The solicitor on the amendment. If more than one solicitor is associated with the gift, then multiple solicitors print in the same column on separate rows. The format is based on the name format section of the format tab.

Variance Amount. The new Amount minus the previous Amount.

Variance Percentage. New Amount minus Previous Amount/(Previous Amount) * 100).

Recurring Gift Missed Payment Report

The Recurring Gift Missed Payment Report processes information for recurring gifts with consecutive missed payments - the number of payments skipped or missed since the last payment made. For example, you may want to see all donors who missed their last three payments. You can then use the information to contact them about resuming their donations.

The report processes information based on the number of payments skipped or missed since the Last payment made. For example, consider the following two donors:
John Doe made a recurring gift of $10 on January 1st, 2003 with a transaction due on the first of each month. Since then, John has made the following payments:
01/01/03 $10 payment received
02/01/03 $10 payment received
03/01/03 $10 payment received
04/01/03 $10 payment received
05/01/03 no payment received
06/01/03 no payment received
07/01/03 no payment received

If you run the Recurring Gift Missed Payment Report on July 15, 2003 with the consecutive missed payments of “3”, John Doe is included in the report because he missed his last three payments.

However, Judy Green made a recurring gift of $10 on January 1st, 2003 with a transaction due on the first of each month. Since then, Judy has made the following payments:
01/01/03 $10 payment received
02/01/03 $10 payment received
03/01/03 $10 payment received
04/01/03 no payment received
05/01/03 no payment received
06/01/03 no payment received
07/01/03 $10 payment received

If you run Recurring Gift Missed Payment Report on July 15, 2003 with the consecutive missed payments of “3”, Judy Green is not included in the report because she made a payment on 07/01/03.

**Note:** To remove regular supporters who have missed payments consecutively from future mailings, transaction files, etc., you can run the Recurring Gift Missed Payment Report and select to create an output query. Then you can use this query to globally change the appropriate recurring gift records’ status to Terminated. For information about **Global Change**, see the **Global Add, Delete, & Change Guide**.

You can process this report as a summary report, detail report, or both. You can filter by campaign(s), fund(s), appeal(s), constituent code(s), gift status (all except Completed), pay method, and frequency. You can report on recurring gifts with no payments, recurring gifts with at least one payment, or all recurring gifts, regardless of the number of payments. You can summarize the report by campaign, fund, appeal, package, constituent code, solicitor, and pay method. You can break it down by frequency, campaign, fund, appeal, package, solicitor, and pay method. Along with the constituent name, you can include the constituent ID and a maiden name. From this report, you can also create a constituent or gift output query.

**Recurring Gifts Missed Payment Report Columns**

1st Payment Date/Amount. The date and the amount of the first payment made for that recurring gift. If no payments have been made for the recurring gift, these fields are blank.

**Appeal.** The report includes the recurring gift appeal. If the appeal is split, then multiple appeals print in the same column on separate rows. Note that if an amendment has been added to the recurring gift, the appeal is based on the last amendment added.

**Campaign.** The report includes the recurring gift campaign. If the campaign is split, then multiple campaigns print in the same column on separate rows. Note that if an amendment has been added to the recurring gift, the campaign is based on the last amendment added.
Cancel/Terminate Date (UK Only). If the status of the recurring gift is ‘Cancelled’ or ‘Terminated’, then the status date prints here. For any other status, this field is blank.

Constituent address. The constituent address prints if selected on the Individual and Organization address tabs. Multiple phone numbers may print based on the selected phone types on the individual and organization address tabs.

Constituent Code. If the report is filtered by constituency on the filters tab, then the constituent code is the one that passed the filter. If the report is not filtered by constituency (either from the gift record or from the constituent based on the filters), then the constituent code is the primary constituency for the constituent.

Constituent name. The constituent name prints as specified on the Format Tab/Name options. The Constituent ID and/or Constituent name prints in this column also (on separate rows) if selected in the detail section of the format tab.

Frequency. The frequency of the recurring gift schedule. Note that if an amendment has been added to the recurring gift, the frequency is based on the last amendment added. The possible frequencies are Annually, Semi-annually, Quarterly, Bimonthly, Monthly (this is used if every x months = 1), Monthly every x months, Semi-monthly, Biweekly, Weekly (this is used if x weeks = 1), Weekly every x weeks.

Fund. The report includes the recurring gift fund. If the fund is split, then multiple funds print in the same column on separate rows. Note that if an amendment has been added to the recurring gift, the fund is based on the last amendment added.

Gift Attribute. If a gift attribute is selected, then the name of the gift attribute is used as the heading for the column. The description of the gift attribute.

Gift Date. The gift date is the original gift date on the recurring gift.

Last Amendment Date/Amount. The date and the amount for the last amendment added. If no amendments have been added for this recurring gift, then these fields are blank.

Last Payment Date/Amount. The date and the amount of the last payment that was made for that recurring gift. If no payments have been made for the recurring gift, these fields are blank. If only one payment was made, then this information is the same as the 1st Payment Date/Amount columns. Even if the last payment is made to a campaign, fund or appeal that is outside the campaign, fund and appeal filters, the actual first payment is included in these columns (not the first payment to the selected campaign, fund and appeals).

Next Transaction Date. The ‘next transaction date’ from the recurring gift.

Package. The package from the recurring gift. If the package is split, then multiple packages print in the same column on separate rows. Note that if an amendment has been added to the recurring gift, the package is based on the last amendment added.

Pay method. The pay method from the recurring gift.

Reference number. The reference number associated with the direct debit/standing order information.

Note: The Recurring Gifts Missed Payment Report includes linked columns, which are listed on the Columns tab as a single unit in the Available Columns list and Selected Columns grid. For more information, see “Columns Tab” on page 144.
Solicitor. The solicitor on the recurring gift. If more than one solicitor is associated with the gift, then multiple solicitors prints in the same column on separate rows. Note that if an amendment has been added to the recurring gift, the solicitor is based on the last amendment added. The name prints in the format selected in the name format section of the format tab.

Terminate Date (US, CAN, AU, NZ only). If the status of the recurring gift is ‘Terminated’, then the status date prints here. For any other status, this field is blank.

Total Amount Given. The total amount of the payments made for the recurring gift (includes matching gift processing).

Total Amount Missed. The total amount of the missed payments. This includes skipped payments.

Total Payments Given. The total number of payments made on the recurring gift (includes matching gift processing). Skipped payments are not included in this count.

Total Payments Missed. The total number of consecutive payments missed since the last payment. This includes skipped payments.

Written-Off Report

Note: In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

The Written-Off Report lists of all pledges written off during a time period you select. Writing off a pledge indicates you do not expect the balance of the pledge to be paid. The detail version of the report can include the constituent name and address information along with the pledge write-off. The summary version of the report includes the total amount written off for each fund but cannot include name and address information. The exact data included depends on your parameter tab settings.

Write-Off Report Columns

The Detail report type displays the following columns:

Constituent Name. This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

Date. The date of the write off on the gift record.

Pledge/Amount. Amount of the original pledge. In the UK, this is the net amount\true amount of the pledge – it is not affected by the net or gross option defined in User Options.

Pledge/Date. The date of the original pledges.

Pledge/Type. Type of gift made
  • PL = Master Pledge
  • PL A2 = Pledge 2 Annual Installments
  • PL A3 = Pledge 3 Annual Installments
  • PL SA3 = Pledge 3 Semi-Annual Installments
  • PL Q4 = Pledge 4 Quarterly Installments
  • PL BM5 = Pledge 5 Bimonthly Installments
  • PL M6 = Pledge 6 Monthly Installments
  • PL SM7 = Pledge 7 Semi-Monthly Installments
• PL BW8 = Pledge 8 Biweekly Installments
• PL W9 = Pledge 9 Weekly Installments
• PL I10 = Pledge 10 Irregular Installments
• Matching Gift Pledge appears as above with an MG before the pledge type. EX: MG PL

Written Off. Amount written off on the gift record.

The Summary report type displays the following column:

Description. This column displays the fund description of the fund associated with the gift. This information is entered in the Description field on the General tab of the fund record.

Fund ID. This column displays the fund ID of the fund associated with the gift. This information is entered in the Fund ID field on the General tab of the fund record.

Count. The number of write-offs.

Written Off. Amount written off on the gift record.

Profiles, Lists, and Directories

Profiles, Lists, and Directories are exactly that — summaries profiling information in a specific area of your database, lists of selected information, and directories of selected constituents. The various reports are generated using selected information from the records in your database. These reports are helpful in presenting information about your constituents to your board members or solicitors and generating telephone and address directories.

Profiles, Lists, and Directories are not arranged around columns. These reports generate alphabetized list of constituents and constituent information you select to include.

Alumni Class List

Note: In profiles, lists, and directories that include phone numbers, “Do not contact” appears at the end of the number, designating “Do not contact” numbers.

Profiles, Lists, and Directories are exactly that — summaries profiling information in a specific area of your database, lists of selected information, and directories of selected constituents. The various reports are generated using selected information from the records in your database. These reports are helpful in presenting information about your constituents to your board members or solicitors and generating telephone and address directories.

Alumni Class List is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.

Appeal Profile

Note: For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

The Alumni Class List provides a list of alumni with their class years. This report can help you plan class reunions or design appeals directed toward alumni. The exact data included depends on your parameter tab settings.

Alumni Class List is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.

Appeal Profile

The Appeal Profile provides a summary of appeal information. You can include associated campaigns and funds, appeal packages, attributes, benefits, expenses related to the appeal, and gifts donated during the appeal. The exact data included depends on your parameter tab settings.

Appeal Profile is not arranged around columns. The profile generates alphabetized list of constituents and constituent information you select to include.
Target Analytics Scores List

The Target Analytics Scores List generates a list of constituents and their Target Analytics ratings. If you have Prospect Research Management, the scores available for use in the list are the score categories you imported into the program from Target Analytics Services. These scores are stored in the Category field of the ratings records. Rating records are accessed from the Ratings category on the Prospect tab. If you do not have Prospect Research Management, all Blackbaud Analytic scores are stored on the Attributes tab of the constituent record. The following scores are available: Annual Gift Likelihood, Major Gift Likelihood, Bequest Likelihood, CRT Likelihood, and BBA Estimated Income.

One the Scores tab, you can select the Target Analytics scores you want to include in the list. You can also filter scores included based on ranges.

Target Analytics Scores List is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.

Constituent Directory

The Constituent Directory generates a list of address and telephone information for constituent records in your database. The exact data included depends on your parameter tab settings. Constituent Directory is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.

Constituent Profile

Note: In profiles, lists, and directories that include phone numbers, “Do not contact” appears at the end of the number, designating “Do not contact” numbers.

The Constituent Profile summarizes information contained in your constituent records. You can run a constituent profile for a constituent, an individual, or an organization. The exact data included depends on your parameter tab settings. Constituent Profile is not arranged around columns. The profile generates alphabetized list of constituents and constituent information you select to include.

Campaign Profile

The Campaign Profile summarizes campaign information contained in your campaign records. You can include campaign solicitors, associated funds and appeals, campaign attributes, and gifts donated to the campaign. The exact data included depends on your parameter tab settings. Campaign Profile is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.

Event Profile

The Event Profile summarizes event information contained in your event records. You can include event details, a financial summary, and participants. The exact data included depends on your parameter tab settings. Event Profile is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.
Fund Profile

The Fund Profile summarizes fund information contained in your fund records. You can include descriptions of the fund, information about the fund solicitors, associated campaigns and appeals, fund attributes, General Ledger distribution, and gifts donated to the fund. The exact data included depends on your parameter tab settings.

**Note:** In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

**Fund Profile** is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.

Grandparent Directory

The Grandparent Directory lists the grandparents of alumni, including their addresses and telephone numbers. The exact data included depends on your parameter tab settings.

**Grandparent Directory** is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.

Honor/Memorial Profile

**Note:** The Honor/Memorial Profile is available only if you have the optional module Honor/Memorial Tracking.

The Honor/Memorial Profile summarizes tribute information contained in your tribute records. You can include constituent names, addresses, and biographical information; solicit codes; credit card information; constituent codes; and spouse, business, education, relationship, and bank information. The exact data included depends on your parameter tab settings.

**Honor/Memorial Profile** is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.

Individual Profile

The Individual Profile summarizes information contained on your individual constituent records. You can include individual constituent name, address, spouse, education, business, and biographical information. The exact data included depends on your parameter tab settings.

**Individual Profile** is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.

MatchFinder Organization Summary

**Note:** The MatchFinder Organization Summary is available only if you have the optional module MatchFinder.
When you use the optional module MatchFinder, the MatchFinder Organization Summary report is available. Accessed through Reports on the Raiser’s Edge bar, this profile report displays the matching gift factor and limits of companies in the MatchFinder database. The exact data included depends on your parameter tab settings. For example, you can select to view information about matching gift companies in a specified location. You can also select to view only companies of a selected industry, educational institution, or other type of nonprofit organization.

Membership Category Profile

**Note:** The Membership Category Profile is available only if you have the optional module Membership Management.

The Membership Category Profile summarizes information about your membership categories and programs. You can include current membership statistics and renewal history. The exact data included depends on your parameter tab settings. Membership Category Profile is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.

Organization Profile

**Note:** For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

The Organization Profile summarizes information contained on your organization constituent records. You can include the organization name, address, and biographical information; constituent codes; individual relationships; contacts; employees; a giving history; actions; and attributes. The exact data included depends on your parameter tab settings. Organization Profile is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.

Parent Directory

**Note:** In profiles, lists, and directories that include phone numbers, “Do not contact” appears at the end of the number, designating “Do not contact” numbers.

The Parent Directory lists parents of alumni. You can include their addresses and telephone numbers. The exact data included depends on your parameter tab settings. Parent Directory is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.

Professional Directory

**Note:** To appear in the Professional Directory, professions or businesses must be recorded in the individual constituent record. This information is taken from the screen accessed from the Business button on the Bio 1 tab or the Relationships tab. For more information about organization relationships, see the Constituent Data Entry Guide.

The Professional Directory lists alumni professions and businesses. You can include their addresses and telephone numbers. The exact data included depends on your parameter tab settings.
Professional Directory is not arranged around columns. The report generates alphabetized list of constituents and constituent information you select to include.

Prospect Research Reports

The Prospect tab in the constituent record helps you track data on prospective and major donors. In The Raiser’s Edge 7, the Prospect tab helps you manage all types of prospect information. You can track gifts made by prospective donors to other organizations and record financial information, such as sources of wealth, annual income, and real estate holdings. You can also track your organization’s proposals, including amounts solicited, amounts funded, ratings data, and even enter extensive notes. Also, if you subscribe to Target Analytics services, scoring information is downloaded into the Ratings category on the Prospect tab.

Note: Prospect Research Reports are available only if you have the optional module Prospect Research Management.

Prospect Research Reports use the information entered from the Prospect tab and helps you analyze the giving potential of donors. These reports track proposals and actions designed to win a donation from a potential donor; calculate the total worth of a prospect; and summarize information about a proposal, including when you expect an answer and the amount you anticipate to receive from the prospect. These reports are especially helpful for donations with special requirements that must be met before the donor gives to your organization. For example, a donor may require scholarship applicants be interviewed, write an essay, or attend a seminar before awarding the scholarship.

Outstanding Proposal Report

The Outstanding Proposal Report lists proposals presented to potential donors. You can include a summary of the proposal, including the amount requested and the amount expected. The exact data included depends on your parameter tab settings.

Outstanding Proposal Report Columns

Amount Asked. This column displays the monetary amount recorded in the Amount asked field on the General tab of the proposal record.

Amount Expected. This column displays the monetary amount recorded in the Amount expected field on the General tab of the proposal record.

Campaign. This optional column displays the campaign entered in the Campaign field on the General tab of the proposal record.

Constituent. This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

Date Asked. This column displays the date recorded in the Date asked field on the General tab of the proposal record.

Date Expected. This column displays the date recorded in the Date expected field on the General tab of the proposal record.

Fund. This optional column displays the fund entered in the Fund field on the General tab of the proposal record.

Gift Type. This column displays the type of gift created (cash, property, planned gift, etc.).

Proposal. This optional column displays the proposal name entered in the Name field on the General tab of the proposal record.

Purpose. This optional column displays the information entered in the Purpose field on the General tab of the proposal record.
Rating. This column displays the most recent rating in the Rating field on the General tab of the proposal record.

Solicitor. This optional column displays the name recorded in the Solicitor(s) field on the General tab of the proposal record.

Proposal Analysis Report

The Proposal Analysis Report compares proposal results with the expected outcome. You can also track the number of days the proposal has been open. The exact data included depends on your parameter tab settings.

Proposal Analysis Report Columns

Amount Asked. This column displays the monetary amount recorded in the Amount asked field on the General tab of the proposal record.

Amount Funded. This column displays the monetary amount recorded in the Amount funded field on the General tab of the proposal record.

Campaign. This optional column displays the campaign entered in the Campaign field on the General tab of the proposal record.

Constituent. This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

Date Asked. This column displays the date recorded in the Date asked field on the General tab of the proposal record.

Date Expected. This column displays the date recorded in the Date expected field on the General tab of the proposal record.

Date Funded. This column displays the date recorded in the Date funded field on the General tab of the proposal record.

Days Open. The number of days the proposal has been active.

Difference. The difference between the Amount Asked and the Amount Funded columns.

Fund. This optional column displays the fund entered in the Fund field on the General tab of the proposal record.

Proposal. This column displays the proposal name entered in the Name field on the General tab of the proposal record.

Purpose. This optional column displays the information entered in the Purpose field on the General tab of the proposal record.

Solicitor. This optional column displays the name recorded in the Solicitor(s) field on the General tab of the proposal record.

Proposal Follow-Up Report

The Proposal Follow-Up Report tracks actions taken after you present a proposal. The report can include the status and priority of the proposal. The exact data included depends on your parameter tab settings.

“Proposal Follow-Up Report Columns” on page 95
Proposal Follow-Up Report Columns

**Action Date.** This column displays the date entered in the **Action date** field on the General tab of the action record associated with the proposal.

**Constituent.** This column displays names in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.

**Note:** In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

**Proposal.** This column displays the proposal name entered in the **Name** field on the General tab of the proposal record.

**Solicitor.** This column displays the name recorded in the **Solicitor(s)** button on the General tab of the action record associated with the proposal record.

**Status.** This column displays the status of the action. This information is pulled from the **Status** field on the General tab of the action record associated with the proposal.

**Type.** This column displays the type of action (phone call, meeting) entered in the **Action type** field on the General tab of the action record associated with the proposal.

### Proposal Pipeline Summary

The **Proposal Pipeline Summary** provides information about solicitors associated with proposals and proposal statuses. This is a cross-tab report with the solicitors listed vertically and the corresponding proposal status horizontally. Each column corresponds to one proposal status and each row to one solicitor. The only data included on the report, beyond solicitor names and proposal statuses is the number of proposals for each status and each solicitor. A **Total** column appears, displaying totals for each row, and a **Total** row appears at the end of the report, displaying totals for each column. The exact data included depends on your parameter tab settings.

### Proposal Pipeline Summary Columns

**Proposal Status Columns.** A column displays for each proposal status you have defined in your system. The number appearing in each column shows you the how many proposal statuses are associated with each solicitor. For example, if “Closed” is a status, the **Closed** column displays the number of closed proposals associated with the corresponding solicitor.

**Solicitor.** This optional column displays the name recorded in the **Solicitor(s)** field on the General tab of the proposal record.

**Total.** This column displays the total number of proposals associated with each solicitor.

### Tribute Reports

**Note:** For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.
The optional module *Honor/Memorial Tracking* helps you effectively manage your honor/memorial records in *The Raiser's Edge 7*. You can track detailed information about donations given in honor, celebration, or memory of an individual or organization. You can add a tribute, edit tributes, view gifts given to a tribute, and enter multiple acknowledgees and tribute types.

**Note:** Tribute Reports are available only if you have the optional module *Honor/Memorial Tracking*.

Tribute Reports helps you retrieve honor/memorial information from your database. You can track donations made in honor, memory, or celebration of a constituent, print lists of contributors, produce a directory of honor/memorials, provide a gift report detailing all donations made toward a tribute, or summarize the overall picture of your tributes.

### Honor/Memorial Contributors List

**Note:** In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

The *Honor/Memorial Contributors List* lists constituents who donated in honor or memory of another constituent. This report lists each contributor and address. You can include telephone numbers and acknowledgement information. This list is a good source for newsletter articles about donors and honor/memorial donations. Because the *Honor/Memorial Contributors List* provides only contributor information, it does not list gift amounts. The *Honor/Memorial Gift Report* provides gift amounts. The exact data included depends on your parameter tab settings.

### Honor/Memorial Contributors List Columns

- **Constituent.** This column displays the name of donating constituents. Names are formatted based on the format selected on the report’s Format tab.

- **Tribute(s) For.** This column displays the honor/memorial name formatted based on your selection for Name Formats on the report’s Format Tab. On the report, the name appears immediately after “for”.

- **Tribute Type.** This column displays information entered in the Tribute Type field on the Tribute Gift screen. This screen is accessed from the Tribute tab of the gift record.

### Honor/Memorial Directory

The *Honor/Memorial Directory* lists each tribute record with the name of the person being honored, memorialized, or celebrated and the names of the acknowledgees to be notified when a donation is made in tribute of someone. The exact data included depends on your parameter tab settings.

### Honor/Memorial Directory Columns

- **End Date.** This column displays the date entered in the Date to field on the Tribute for screen. This screen is accessed from the Honor/Memorial tab of the constituent record.

- **Start Date.** This column displays the date entered in the Date from field on the Tribute for screen. This screen is accessed from the Honor/Memorial tab of the constituent record.

- **Tribute(s) For.** This column displays the honor/memorial name formatted based on your selection for Name Formats on the report’s Format Tab. On the report, the name appears immediately after “for”.

- **Tribute Type.** This column displays information entered in the Tribute Type field on the Tribute Gift screen. This screen is accessed from the Tribute tab in the gift record.
Honor/Memorial Gift Report

**Note:** In reports allowing phone numbers, an indicator (‘~’) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

The **Honor/Memorial Gift Report** provides details about honor/memorial gifts. This report can include each gift with the gift type, amount, fund description, and totals by gift type. The exact data included depends on your parameter tab settings.

### Honor/Memorial Gift Report Columns

- **Amount.** This column displays the monetary amount entered in the Amount field on the Gift tab of the gift record associated with the honor/memorial.
- **Constituent.** This column displays the name of donating constituent. Names are formatted based on the format selected on the Format tab. Address and phone numbers print based on the Ind. Address tab and Org. Address tab parameters.
- **Date.** This column displays date entered in the Gift date field on the Gift tab of the gift record associated with the honor/memorial.
- **Fund Description.** This column displays the fund entered in the Fund field on the Gift tab of the gift record associated with the honor/memorial.
- **Gift Type.** This column displays the information entered in the Gift type field on the Gift tab of the gift record associated with the honor/memorial.
- **Reference.** This column displays the information entered in the Reference field on the Gift tab of the gift record associated with the honor/memorial.
- **Tribute(s) For.** This column displays the honor/memorial name formatted based on your selection for Name Formats on the report’s Format Tab. On the report, the name appears immediately after “for”.
- **Tribute Type.** This column displays information entered in the Tribute Type field on the Tribute Gift screen. This screen is accessed from the Tribute tab in the gift record.

### Honor/Memorial Summary List

The **Honor/Memorial Summary List** provides an overview of the honor/memorial records. The report can include the name of the person being honored, memorialized, or celebrated; the honor/memorial type; the date the tribute was established; whether the tribute is active; and the tribute code. The exact data included depends on your parameter tab settings.

### Honor/Memorial Summary List Columns

- **Accepts Gifts.** This column displays “Yes” if the Gifts may be given to this tribute checkbox is marked; the column displays “No” if the checkbox is not marked. The checkbox is located on the Tribute for screen, accessed from the Honor/Memorial tab of the constituent record.

**Note:** In reports allowing phone numbers, an indicator (‘~’) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

- **Constituent ID.** This column displays the constituent ID entered in the ID field on the Bio 1 tab of the honor/memorial’s constituent record.
**Default Fund.** This optional column displays the fund appearing in the **Default Fund** field on the Tribute for screen. This screen is accessed from the Honor/Memorial tab of the constituent record.

**End Date.** This column displays the date entered in the **Date to** field on the Tribute for screen. This screen is accessed from the Honor/Memorial tab of the constituent record.

**Honor/Memorial Name.** This column displays the name of the honor/memorial constituent formatted based on your selection for Name Formats on the report’s Format Tab.

**Tribute Type.** This column displays information entered in the **Tribute Type** field on the Tribute Gift screen. This screen is accessed from the Tribute tab in the gift record.

**Start Date.** This column displays the date entered in the **Date from** field on the Tribute for screen. This screen is accessed from the Honor/Memorial tab of the constituent record.

### Volunteer Reports

**Note:** **Volunteer Reports** are available only if you have the optional module *Volunteer Management*.

The optional module *Volunteer Management* helps you track all aspects of your volunteers. When you add a constituent to your database who is a volunteer, you can track their volunteer information on the Volunteer tab of the constituent record. When you enter information on the Volunteer tab, the constituent becomes active in *The Raiser’s Edge* as a volunteer for your organization.

From the Volunteer tab, you can assign volunteer types and statuses, enter an emergency contact, and track vehicle information for the volunteer. You define qualifications the volunteer must have for certain jobs, track your volunteer’s medical information and special needs, and determine when the volunteer can work. You can also match a volunteer’s particular interests with enjoyable jobs and create checklists of tasks the volunteer must complete before starting these jobs. You can then track awards given to the volunteer, the amount of service needed to obtain these awards, and the next award the volunteer should receive if he completes the required amount of service.

**Volunteer Reports** help you track information entered on the Volunteer tab. You can track all aspects of your volunteer program. These reports can help you maximize the efficiency of your program by matching assignment needs with volunteers who have the right skills, availability, and experience. In addition, you can track past and current volunteer hours and set award levels.

### Courses and Training Report

The **Courses and Training Report** lists volunteers with the dates they enrolled in courses, the instructor for the course, and information about volunteer certification. The exact data included depends on your parameter tab settings.

### Courses and Training Report Columns

**Certification.** This column displays the information recorded in the **Certification** column in the **Courses and Training** grid. The grid is accessed by clicking **Qualifications** on the Volunteer tab of the constituent record.

**Constituent Name.** This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

**Course.** This column displays the courses recorded in the **Course Name** column in the **Courses and Training** grid. The grid is accessed by clicking **Qualifications** on the Volunteer tab of the constituent record.

**End Date.** This column displays the date recorded in the **End Date** column in the **Courses and Training** grid. The grid is accessed by clicking **Qualifications** on the Volunteer tab of the constituent record.
Expires. This column displays the date recorded in the Expires column in the Courses and Training grid. The grid is accessed by clicking Qualifications on the Volunteer tab of the constituent record.

Instructor. This column displays the name recorded in the Instructor column in the Courses and Training grid. The grid is accessed by clicking Qualifications on the Volunteer tab of the constituent record.

Start Date. This column displays the date recorded in the Start Date column in the Courses and Training grid. The grid is accessed by clicking Qualifications on the Volunteer tab of the constituent record.

Future Awards Report

The Future Awards Report lists volunteers with the award they are due, the number of hours and the last date they worked, and the cumulative number of hours worked for your organization. The award calculation is based on the next award date recorded on the Volunteer tab of the constituent record. The exact data included depends on your parameter tab settings.

Future Awards Columns

Amount Worked. This column displays the hours worked as recorded in the Time Sheets category on the Volunteer tab of the constituent record.

Comments. This column displays the comments recorded in the Comments field of the Future Award frame. The frame is accessed by clicking Award on the Volunteer tab of the constituent record.

Note: In reports allowing phone numbers, an indicator (~) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

Constituent Name. This column displays the constituent's name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

Future Award. This column displays the award information recorded in the Award field of the Future Award frame. The frame is accessed by clicking Award on the Volunteer tab of the constituent record.

Min. Amount of Service. This column displays the minimum amount of service required to earn the award recorded in the Award field of the Future Award frame. You assign the minimum service requirements when you create the award table in Configuration.

Job Assignment Summary

Note: For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

The Job Assignment Summary provides a summary of the hours worked by your volunteers. This report lists the information by assignment, not name, for as many as 12 date ranges. Names and addresses do not appear on this report. You can produce a graph of the report results. The exact data included depends on your parameter tab settings.

Job Assignment Summary Columns

Job Assignment. This column displays the information recorded in the Job field of the Job Assignment screen. This screen is accessed from the Job Assignments category on the Volunteer tab of the constituent record.

Report Periods columns. User-defined columns from the Report Periods tab. You can include up to 12 report periods and enter column heading information.
Time Sheet Report

The Time Sheet Report lists your volunteers and their assignments. You can include the number of hours worked at each assignment, the monetary value of their time, the number of hours worked during the period you select for each volunteer, and the year-to-date and cumulative totals. The exact data included depends on your parameter tab settings.

Time Sheet Report Columns

Constituent Name. This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

Date. This column displays the date entered in the Date field of the Time Sheet screen. This screen is accessed from the Time Sheet category on the Volunteer tab of the constituent record.

Department. This column displays the information entered in the Department field of the Time Sheet screen. This screen is accessed from the Time Sheet category on the Volunteer tab of the constituent record.

Hourly Wage. This column displays the per-hour amount assigned this job assignment in the Hourly wage field of the Time Sheet screen. This screen is accessed from the Time Sheet category on the Volunteer tab of the constituent record.

Hours. This column displays the number of hours entered in the Hours field of the Time Sheet screen. This screen is accessed from the Time Sheet category on the Volunteer tab of the constituent record.

Job Assignment. This column displays the information recorded in the Job field of the Time Sheet screen. This screen is accessed from the Time Sheet category on the Volunteer tab of the constituent record.

Location. This column displays the information entered in the Location field of the Time Sheet screen. This screen is accessed from the Time Sheet category on the Volunteer tab of the constituent record.

Position. This column displays the information entered in the Position field of the Time Sheet screen. This screen is accessed from the Time Sheet category on the Volunteer tab of the constituent record.

Value. This column displays the monetary value calculated using the Hours and Hourly wage data.

Volunteer Awards Report

The Volunteer Awards Report provides a list of volunteers with the award level each has reached. You can also include the minimum amount of service required for the award, the award presented to the volunteer, and the name of the award presenter. This report is useful as a source of newsletter information or press releases so you can publicly recognize your volunteers’ service. The exact data included depends on your parameter tab settings.

Volunteer Awards Columns

Amount Worked. This column displays the number of hours worked as recorded in the Time Sheets category on the Volunteer tab of the constituent record.

Award. This column displays the award entered in the Award column of the grid accessed by clicking the Awards category on the Volunteer tab of the constituent record.

Award Date. This column displays the date entered in the Date column of the grid accessed by clicking the Awards category on the Volunteer tab of the constituent record.
Constituent Name. This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

Min. Amount of Service. This column displays the minimum amount of service required to earn the award. You assign the minimum service requirements when you create the award table in Configuration.

Position. This column displays the information entered in the Position field of the Job Assignment screen. This screen is accessed from the Job Assignments category on the Volunteer tab of the constituent record.

Presented By. This column displays the information entered in the Presented By column of the grid accessed by clicking the Awards category on the Volunteer tab of the constituent record.

Presented With. This column displays the information entered in the Presented With column of the grid accessed by clicking the Awards category on the Volunteer tab of the constituent record.

Volunteer Job Assignment Schedule

Note: In reports allowing phone numbers, an indicator (‘~’) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.

The Volunteer Job Assignment Schedule lists volunteers and their telephone numbers with their job assignments and the days and times of the assignments. You can include the department, location, and position of the assignments to help you with your scheduling. The exact data included depends on your parameter tab settings.

Volunteer Job Assignments Columns

Constituent Name. This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

Date. This column displays the date of the corresponding job assignment. This information is pulled from the Date field of the Time Sheet screen. This screen is accessed from the Time Sheet category on the Volunteer tab of the constituent record.

Day. This column displays the day of the week of the corresponding job assignment.

Department. This column displays the information entered in the Department field of the Job Assignment screen. This screen is accessed from the Job Assignment category on the Volunteer tab of the constituent record.

End Time. This column displays the end time of the corresponding job assignment. This information is pulled from the End time field of the Job Assignment screen. This screen is accessed from the Job Assignments category on the Volunteer tab of the constituent record.

Job Assignment. This column displays all jobs to which the corresponding volunteer is assigned.

Letter Sent. This column displays “Yes” if the Letter sent on checkbox on the Job Assignment screen is marked; it displays “No” if the checkbox is not marked. The Job Assignment screen is accessed from the Job Assignments category on the Volunteer tab of the constituent record.

Letter Sent On. This column displays the dated entered in the Letter sent on field on the Job Assignment screen. The Job Assignment screen is accessed from the Job Assignments category on the Volunteer tab of the constituent record.

Location. This column displays the information entered in the Location field of the Job Assignment screen. This screen is accessed from the Job Assignments category on the Volunteer tab of the constituent record.

Organization/Event. This column displays the information recorded on the General tab of a job record. If no organization or event is selected, this column is blank.
**Requested On.** This column displays the date entered in the **Requested on** field on the Job Assignment screen. The Job Assignment screen is accessed from the **Job Assignments** category on the Volunteer tab of the constituent record.

**Start Time.** This column displays the start time of the corresponding job assignment. This information is pulled from the **Start time** field of the Job Assignment screen. This screen is accessed from the **Job Assignments** category on the Volunteer tab of the constituent record.

**Status.** This column displays the status selected in the **Status** option on the Job Assignment screen. The Job Assignment screen is accessed from the **Job Assignments** category on the Volunteer tab of the constituent record.

---

**Volunteer Match List**

**Note:** The Volunteer Match List does not consider expiration dates on qualifications.

The Volunteer Match List report helps you match your volunteers and your jobs. This report uses the qualifications of your volunteers and their availability, as recorded in the volunteer record, to guide you in making your selections for volunteers for specific jobs. The exact data included depends on your parameter tab settings.

**Volunteer Match List Columns**

**Constituent Name.** This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

---

**Volunteer Skills and Experience**

The Volunteer Skills and Experience report lists your volunteers with a description of their skills and experience, their skill level, and information about the licenses they hold. Use this report to match volunteers with the needs of your project. The exact data included depends on your parameter tab settings.

**Volunteer Skills and Experience Columns**

**Constituent Name.** This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

**Description.** This column displays information about the volunteer entered in the **Description** column of the Skills and Experience grid. This grid is accessed by clicking **Qualifications** on the Volunteer tab of the constituent record.

**Expires.** This column displays the date the volunteer’s license expires. The information is pulled from the **Expires** column of the Skills and Experience grid. This grid is accessed by clicking **Qualifications** on the Volunteer tab of the constituent record.

**License.** This column displays information about the volunteer entered in the **License Type** column of the Skills and Experience grid. This grid is accessed by clicking **Qualifications** on the Volunteer tab of the constituent record.

---

**Note:** In reports allowing phone numbers, an indicator (‘~’) appears at the end of the number, designating “Do not contact” numbers. Also, if the report includes “Do not contact” phone numbers, a footer explains the indicator to all report users. The report footer prints only if the indicator appears in the report. If no “Do not contact” phone numbers are included, the footer does not appear.
License Number. This column displays information about the volunteer entered in the License No. column of the Skills and Experience grid. This grid is accessed by clicking Qualifications on the Volunteer tab of the constituent record.

Skill Level. This column displays information about the volunteer entered in the Skill Level column of the Skills and Experience grid. This grid is accessed by clicking Qualifications on the Volunteer tab of the constituent record.

Volunteer Summary

The Volunteer Summary report lists your volunteers with the dates they began their service and information about their most recent assignments. You can include the number of hours each worked in previous years and in the current year with a cumulative total. The exact data included depends on your parameter tab settings.

Note: For information about the parameter tabs and the settings available, see “Parameter Tabs” on page 135.

Volunteer Summary Columns

Begin Date. This column displays the date the volunteer began working for your organization. This date pulls from the earliest Start date entered in the General category on the Volunteer tab of the constituent record.

Constituent Name. This column displays the constituent’s name in the format selected on the Format tab. The maiden name appears in parentheses below the name. Address and phone numbers appear based on the Ind. Address tab and Org. Address tab parameters.

Date. This column displays the start date of the volunteer’s most recent job assignment. This information is pulled from the Start date field of the Job Assignment screen. You access the Job Assignment screen by clicking Job Assignments on the Volunteer tab of the constituent record.

Hours. This column displays the number of hours worked during the volunteer’s most recent job assignment. This information is pulled from the Hours field of the Time Sheet screen. You access the Time Sheet screen by clicking Time Sheet on the Volunteer tab of the constituent record.

Job Assignment. This column displays the volunteer’s most recent job assignment. This information is pulled from the Job field of the Job Assignment screen. You access the Job Assignment screen by clicking Job Assignments on the Volunteer tab of the constituent record.

Prior Year. This column displays the total number of hours the volunteer worked during years prior to their most recent job assignment. This information is generated by adding all amounts entered in the Hours field of the Time Sheet screen of all job assignments the previous years. You access the Time Sheet screen by clicking Time Sheet on the Volunteer tab of the constituent record.

This Year. This column displays the total number of hours the volunteer worked during the current year. This information is generated by adding all amounts entered in the Hours field of the Time Sheet screen of all job assignments in the current year. You access the Time Sheet screen by clicking Time Sheet on the Volunteer tab of the constituent record.

Total. This column displays the number of hours the volunteer worked during the prior year and this year added together.
Report Basics

Navigating in Reports ................................................................. 107
Buttons ................................................................. 108
  Report Category Screen Buttons ......................................... 108
  Report Parameter File Screen Buttons .................................. 109
Toolbar ................................................................. 109
Favorites ................................................................. 110
User Options for Reports .......................................................... 115
Business Rules for Reports .......................................................... 116
Creating and Running Reports ...................................................... 116
Editing a Report ............................................................. 119
Previewing a Report .......................................................... 122
Printing a Report ............................................................. 125
Exporting a Report .......................................................... 127
Sending a Report using E-Mail ..................................................... 130
Deleting a Report Parameter File ................................................. 133

Procedures

Adding a report to the list of favorites ........................................... 110
Organizing your list of favorites ..................................................... 112
Creating and running a new report .............................................. 116
Editing a report ............................................................. 120
Previewing a report .......................................................... 123
Printing a report ............................................................. 125
Exporting a report .......................................................... 128
Sending a report as e-mail ..................................................... 131
Deleting a report parameter file ................................................. 133
The Raiser's Edge 7 includes many standard reports to help you produce and view information you need quickly and easily. These reports give you information to help you stay up-to-date with every aspect of your organization. You can analyze the giving trends of your constituents, evaluate the financial position of your organization, track information about pledges, and generate demographic profiles.

In The Raiser's Edge, reports are divided into the following categories.

- Action Reports
- Analytical Reports
- Campaigns, Funds, and Appeals Reports
- Custom Reports
- Demographic and Statistical Reports
- Event Management Reports
- Financial Reports
- Membership Reports
- Pivot Reports
- Pledge and Recurring Gifts Reports
- Profiles, Lists, and Directories
- Prospect Research Reports
- Tribute Reports
- Volunteer Reports

**Note:** For more information about accessing an action report, see “Navigating in Reports” on page 107 of this guide.

For a detailed description of each report category, see “Report Descriptions” on page 1.

Parameter tabs are what distinguish the reports from each other. For example, the Appeal Comparison Summary report — under the Campaigns, Funds, and Appeals category — includes a Gift Types tab. This tab requires you to select the gift types you want to include in your summary report. The Constituent Directory report — under the Profiles, Lists, and Directories category — does not include a Gift Types tab, because gift type information is not included in directories.

This chapter — Report Basics — includes detailed instructions about the basic reporting functions: opening, creating, editing, deleting, and printing reports. Unlike the parameter tabs, these functions are essentially the same, regardless of the report type. This chapter also includes explanations about buttons and the toolbar, and working with favorites. If you need help completing any of the tabs, see “Parameter Tabs” on page 135. All the tabs are arranged alphabetically, with each field, button, option, and checkbox explained in detail.
Navigating in Reports

The Reports page is the central location for reporting in *The Raiser’s Edge*. To access this page, select *Reports* from the Raiser’s Edge bar. The Reports page appears, displaying links to all report categories.

![Report Category Links](image)

**Note:** If you want to see only the reports you saved, mark the *Only show my reports* checkbox at the bottom of the page. If you leave the checkbox unmarked, all saved reports appear.

At the bottom of the Reports page, in the *Commonly Used Reports* frame, links to samples of the most popular *Raiser’s Edge* reports appear. Click the link to open the sample report.
To open a report category and view all reports available in that category, click the category link. The report category page appears. For example, if you select Profiles, Lists, and Directories, the Profiles, Lists, and Directories screen appears.

All available report types appear in a list on the left side of the screen. When you select a report type, any report parameter files created and saved in that report type appear in the grid on the right side of the screen. To easily toggle between report categories, a list of the Reports categories appears to the far left of the screen, next to the Raiser’s Edge bar. To move to a different report category, click the category button. For example, to move from the Profiles, Lists, and Directories screen to the Action Reports category, click the Action Reports button.

**Buttons**

Buttons appear throughout The Raiser’s Edge, helping you to better navigate through the program. This section addresses all buttons associated with Reports.

**Report Category Screen Buttons**

Three buttons appear near the top of all report category pages.

- **New**
  
  The New button opens a new report parameter file. For example, if you want to create a new action report, from the Action Reports screen, select the report type and click New.

- **Open**
  
  The Open button opens an existing report parameter file. For example, if you want to open a saved Dinner Preferences report, highlight the report parameter file, and click Open.
The **Delete** button deletes an existing report parameter file. For example, if you want to remove a saved **Dinner Preferences** report from your database, highlight the report parameter file, and click **Delete**.

**Report Parameter File Screen Buttons**

At the bottom of every report parameter file, a number of buttons appear, helping you navigate through the parameter tabs and print the report.

- **Back** button moves you to the previous tab.
- **Next** button moves you to the next tab.
- **Cancel** button stops a processing report.
- **Print** button generates and prints the report.
- **Preview** button generates the report and displays it on screen.
- **Layout** button displays the report layout using a sample report. Unlike **Preview**, **Layout** does not generate your report.

**Toolbar**

The toolbar in **Reports** contains buttons for the most common commands used when running a report. For example, you can print or save a report by clicking one button, instead of accessing these commands from the **File** menu. This section displays the buttons that appear in **Reports** and explains what each one does.

- **Save the report**
- **Preview the report**
- **Print the report**
- **Export the report**
In *The Raiser’s Edge*, the **Favorites** menu offers a number of time-saving options. For example, you can quickly create, find, or open, specific report types, or you can create shortcuts to the reports you use most often. This section shows you how to add a report to your list of favorites and organize and view your list of favorites.

**Note:** For more information about working with favorites, see the *Program Basics Guide*.

- **Adding a report to the list of favorites**
  
  If you have a report parameter file that you use often, you can add it to your list of favorites and easily access it anytime. This is especially helpful if the list of saved report parameter files displayed on the report type screen is extensive. You no longer have to scroll down the long list to find your parameter file. You can instead, run the report from the Home page.

  1. Locate the report parameter file you want to add to your favorites list. For instance, in the following example, on the Action Reports page, we highlighted the “Action Summary for Supervisor” report.
2. From the menu bar select **Favorites, Add Page to Favorites**. The New Favorite screen appears.

![New Favorite Screen](image)

3. In the **Name** field, you can accept the default name or enter a new **Name** for the favorite. This **Name** appears in the **Favorites** list on your Home page.

4. In the **Description** field, you can accept the default description information or enter your own details about this favorite. This information appears when you hover your cursor over the favorite **Name** on the Home page.

5. In the **Default Action** field, you can select the action you want performed when you click on this report link on the Home page. For example, if you select Preview, a preview of the report appears when you click this link on the Home page.

6. In the **Create in** field, you can accept the default Favorite Menu folder or select a different folder in which to store the favorite report. If you select the default Favorites Menu folder, the favorite **Name** appears in the **Favorites** list on your Home page. If you select a different folder, for example “Procedures”, the favorite **Name** appears in the Procedures folder in the **Favorites** list on your Home page.

To create a new folder in which to store your favorite, click **New folder**. The New Folder screen appears.

![New Folder Screen](image)

In the **Name** field, enter a name for your new folder.

In the **Description** field, enter a description to help you identify the information contained in this folder.

In the **Create in** field, select the folder in which you want the new folder stored. To include this folder in the **Favorites** list on your Home page, select the “Favorites Menu”.

**Note:** For more information about working on the Home page, see the **Program Basics Guide**.

In the **Default Action** field, you can select the action you want performed when you click on this folder on the Home page.

To return to the New Favorite screen, click **OK**.
7. After you complete the New Favorite screen, click **OK**.

8. To view your new favorite, click **Home** on the Raiser's Edge bar. The Home page appears, displaying all your **Favorites**.

- Organizing your list of favorites
  1. From **The Raiser's Edge** menu bar, select **Favorites**, **Organize Favorites**. The Organize Favorites screen appears.

2. To arrange items in folders, you can select the item with your cursor and drag and drop it to the new location in the list.

3. To create a new folder, click **New Folder**. The New Folder screen appears.

   ![New Folder Screen](image)

   In the **Name** field, enter a name for your new folder.

   **Note**: For more information about working on the Home page, see the **Program Basics Guide**.

   In the **Description** field, enter a description to help you identify the information contained in this folder.
In the Default Action field, you can select the action you want performed when you click on this folder on the Home page.

In the Create in field, select the folder in which you want the new folder stored. To include this folder in the Favorites list on your Home page, select the “Favorites Menu”.

**Note:** When you complete a procedure on the Organize Favorites screen, click OK to save the changes and exit Organize Favorites. If you do not want to save any changes you made to the list of favorites, click Cancel.

To return to the Organize Favorite screen, click OK.

![Organize Favorites](image-url)

Your new folder appears at the end of the favorites lists.

4. To copy information in the favorites list, click Copy. For example, if you want the same favorites file in two or more folders, select the favorites file and click Copy. The Edit Folder screen appears.

![Edit Folder](image-url)

In the Name field, enter a name for the copied favorites file. You can keep the original name or create a new name.

In the Description field, enter a description to help you identify the information contained in this copy, or the reason for the copy.
In the Default Action field, you can select the action you want performed when you click on this folder on the Home page.

In the Move to field, select the folder in which you want the copied favorites file stored.

**Note:** When you complete a procedure on the Organize Favorites screen, click OK to save the changes and exit Organize Favorites. If you do not want to save any changes you made to the list of favorites, click Cancel.

To return to the Organize Favorite screen, click OK.

Your copied favorites file appears at the bottom of your favorites list.

5. To edit information in a favorites file, click Edit. For example, if you want to change the name of a favorites file, select the file and click Edit. The Edit Folder screen appears.

   ![Edit Folder Screen](image)

   Change the Name or any other information contained on the screen, and click OK. You return to the Organize Favorites screen.

6. To delete information in the favorites list, highlight the information and click Delete. For example, if you copied a file and want to remove the original from the favorites list, select the favorites file you want to delete, and click Delete. The file is permanently removed from your database.
7. To return the favorites list to only the defaults included with the program click Reset. This deletes all user-defined favorites and folders. A warning message appears.

![The Raiser's Edge]

Resetting the favorite folder structure will delete all user defined folders and favorites.

Do you want to reset the folder structure?

Yes  No

**Warning:** You cannot Cancel a reset. Once you click the Reset button, and click Yes on the confirmation screen, the program resets favorites to the program defaults. This cannot be undone.

To remove the information, click Yes. You return to the Organize Favorites screen.

Only the defaults included with the program remain.

8. To close the Organize Favorites screen, click OK.

**User Options for Reports**

User options are preferences you set that affect how *The Raiser's Edge* looks and runs on the workstation you are using. User options are login-specific, which means that if you log into any workstation using your password, your preferences are active on that workstation. When you log off that workstation, your preferences are not active for any other user.

You can establish certain user options for all reports. For example, you can decide to automatically save report parameters when you close a report and choose your font preferences for reports. You can also choose whether your selections on the report Format tab or in File, Print Setup determine print orientation and set user options for gifts in reports.
For information about setting user options, see the User Options chapter of the *Program Basics Guide*.

**Business Rules for Reports**

**Warning:** The **Business Rules** link on the Configuration page is visible only to users who have Supervisor rights assigned in **Security**.

Unlike user options, business rules affect all workstations using *The Raiser's Edge*. You can set business rules from the **Security** link of **Administration**. Business rules can make a big difference in how you use *The Raiser’s Edge* and **Reports**. For example, you can select to **Exclude deceased individuals from** reports.

For more information about setting business rules, see the Configuration chapter of the *Configuration & Security Guide*.

**Creating and Running Reports**

Creating reports in *The Raiser’s Edge* is a relatively simple procedure. You complete a series of tabs and click a button or select a menu option to generate the report. However, determining what goes into each report, how it should look, and what to keep out, may prove a bit more difficult.

This section takes you step-by-step through the basic steps of creating a report. The procedure applies to all reports in the program. If you need help completing any of the tabs, see “Parameter Tabs” on page 135. All the tabs are arranged alphabetically, with each field, button, option, and checkbox explained in detail.

- **Creating and running a new report**

  Although this procedure focuses on creating an Action Detail report, it applies to all reports in *The Raiser’s Edge*. If you need help completing any of the tabs, see “Parameter Tabs” on page 135. All the tabs are arranged alphabetically, with each field, button, option, and checkbox explained in detail.

  1. On the Raiser’s Edge bar, click **Reports**. The Reports page appears.
2. Click the report category link you want to work in. For example, to generate an Action Detail report, click the Action Reports link. The Action Reports page appears.


3. Select the report type in which you want to work. For example, select Action Detail Report.


5. Complete all parameter tabs. For detailed explanations about all the tabs and the fields, buttons, checkboxes, and options included on each tab, see “Report Descriptions” on page 1.
6. To view the report on screen before printing it, click **Preview**. The program generates the report based on your parameter tab selections, and the report appears.

You can print the report from the preview screen by clicking **Print**. To close the report and return to the report parameter tabs, click the red “X” in the upper left corner.

7. If on the General tab, you marked **Create <record type> output query**, the Save Static Query screen appears.

![Save Static Query](image)

8. In the **Query name** field, enter a name for the query. For example, if you are running an Action Detail Report, you may name your query “Actions Records Query”. You can open this query in **Query**.

9. In the **Description** field, enter a detailed description of the information contained in this query. For example, you may enter date information, so you know the age of the query.

10. You can also allow others to use and/or modify this file by marking the **Other users may execute this query** and **Other users may modify this query** checkboxes.
11. Click **Save**. The printing process begins. The program generates and prints out a hard copy of your report based on your parameter tab selections. A screen appears, tracking the printing process.

![Printing Records](image)

12. To save the report parameter file, from *The Raiser’s Edge* menu bar, select **File, Save**. The Save Report As screen appears.

![Save Report As](image)

13. In the **Report name** field, enter a name for the new report parameter file. For example, if you run an **Action Detail Report** to view information about the history of your major projects, you may name your report “Major Projects - Action History”. This name appears on the right side of the report types screen.

14. In the **Description** field, enter a detailed description of the information contained in this parameter file. For example, you may want to enter a description of the information included in the report.

15. You can also allow others to use and/or modify this parameter file by marking the **Other users may run this Report** and **Other users may modify this Report** checkboxes.

16. To save the new report, click **Save**. You return to the report parameter file.

17. To close the parameter file, from the menu bar, select **File, Close**. You return to the report types page.

### Editing a Report

You can open and change any report parameter file you created and saved. Although this procedure focuses on editing an **Action Detail** report, it applies to all reports in *The Raiser’s Edge*. If you need help completing any of the tabs, see “Parameter Tabs” on page 135. All the tabs are arranged alphabetically, with each field, button, option, and checkbox explained in detail.
Editing a report

1. On the Raiser's Edge bar, click Reports. The Reports page appears.

2. Click the report category link in which you want to work. For example, to edit an Action Detail report, click Action Reports. The Action Reports page appears.

3. From the list on the left, select the report type you want to open. For instance, in the previous example, we selected Action Detail Report.

A list of all saved report parameter files appears on the right. For instance, in the previous example, we selected the “Not Completed Actions With High Priority” report parameter file.
4. Once you locate and select the report parameter file you want to change, click **Open**. The report parameter file appears, displaying the General tab.

5. Make any necessary changes. If you need help completing any of the tabs, see “Parameter Tabs” on page 135. All the tabs are arranged alphabetically, with each field, button, option, and checkbox explained in detail.

6. To view the report on screen before printing it, click **Preview**. The program generates the report, based on your parameter tab selections, and the report appears.

You can print the report from the preview screen by clicking **Print**. To close the report and return to the report parameter tabs, click the red “X” in the upper left corner.
7. If you do not want to preview the report, you can click Print. The program generates and prints out a hard copy of your report, based on your parameter tab selections. A screen appears, tracking the printing process.

![Printing Records](image)

8. To save the report parameter file, from the menu bar, select File, Save. The Save Report As screen appears.

![Save Report As](image)

9. In the Report name field, enter a name for the new report parameter file. If you want to replace the parameter file you edited, you do not have to enter a different name. If you want to save the parameter file you opened and edited, you must enter a new name. This name appears on the right side of the report types screen.

10. In the Description field, enter a detailed description of the information contained in this parameter file. For example, you may want to include date information.

11. You can also allow others to use and/or modify this parameter file by marking the Other users may run this Report and Other users may modify this Report checkboxes.

12. To save the new report, click Save. You return to the parameter file.

13. To close the parameter file, from the menu bar, select File, Close. You return to the report types page.

**Previewing a Report**

*Note:* Click the binoculars at the top of the preview screen to search for specific information in the report preview. Make sure you are on the first page of the preview if you want to search all pages. The search looks only on the page you are viewing and pages after. For example, if you are on page three of the preview and click search, it will not find the information you are searching for on pages one and two.

Previewing a report gives you a chance to review the report’s information and format before you print out a hard copy. This is particularly helpful for long reports that may take some time to print and require a lot of paper. Using the Preview button on the report parameter file, you can preview the report from the opened parameter file. Or, if you want to preview a saved report, you can select the report title on the report types screen and, without opening the report, select File, Preview from The Raiser’s Edge menu bar. Both procedures are explained in this section.

How your report looks depends on your selections on the Format tab of the report parameter file. For a detailed explanation of all formatting options, see “Parameter Tabs” on page 135.
Although this procedure takes you step-by-step through the process of previewing an Action Detail report, it applies to all reports in *The Raiser's Edge*.

- **Previewing a report**
  1. On the Raiser’s Edge bar, click **Reports**. The Reports page appears.

![Report Category Links](image)

**Note:** Before printing, you also must confirm the print settings in *The Raiser’s Edge* are correct. The Print Set Up screen — accessed by selecting **File, Print Setup** from *The Raiser’s Edge* menu bar — displays information about your printers, paper size and orientation, and much more. For more information about establishing print settings, see the *Program Basics Guide*.

2. Click the report category link containing the report you want to preview. For example, to print an Action Detail report, click **Action Reports**. The Action Reports page appears.

![Action Reports](image)
3. From the list on the left, select the report type under which the parameter file you want to preview is saved. For instance, in the previous example, we selected **Action Detail Report**. A list of saved action detail report parameter files appears on the right.

4. From the list of saved report parameter files, select the file you want to preview.

5. To preview the report without opening the report parameter file, from *The Raiser’s Edge* menu bar, select **File, Preview**. The program generates the report and displays it on your screen.

Or

If you want to view the report from the report parameter file, click **Open**. The report parameter file appears, displaying the General tab.

![Image of Not Completed Actions With High Priority dialog box](image)

**Note:** Click the binoculars at the top of the preview screen to search for specific information in the report preview. Make sure you are on the first page of the preview if you want to search all pages. The search looks only on the page you are viewing and pages after. For example, if you are on page three of the preview and click search, it will not find the information you are searching for on pages one and two.
6. Click **Preview**. The program generates the report and displays it on your screen.

Tip: To print the report from the preview, click **Print** on the toolbar.

7. To close the report, click the red “X” in the top left corner of the screen. You return to the report parameter file.

### Printing a Report

**Note:** We recommend previewing the report before printing. This allows you time to proof the information and confirm the format.

You can print a hard copy of any report created in *The Raiser’s Edge*. Using the **Print** button on the report parameter file, you can print the report from the opened parameter file. Or, if you want to print a saved report, you can select the report title on the report types screen and, without opening the report, select **File**, **Print** from *The Raiser’s Edge* menu bar. Both procedures are explained in this section.

How your report looks depends on your selections on the Format tab of the report parameter file. For a detailed explanation of all formatting options, see “Parameter Tabs” on page 135.

Although this procedure takes you step-by-step through the process of printing an Action Detail report, it applies to all reports in *The Raiser’s Edge*.

- **Printing a report**

**Note:** You must confirm the print settings in *The Raiser’s Edge* are correct before you run a print job. The Print Set Up screen — accessed by selecting **File**, **Print Setup** on the menu bar — displays information about your printers, paper size and orientation, and much more. For a detailed explanation of establishing print settings, see the **Program Basics Guide**.
1. On the Raiser’s Edge bar, click **Reports**. The Reports page appears.

2. Click the report category link containing the report you want to print. For example, to print an Action Detail report, click **Action Reports**. The Action Reports page appears.

3. From the list on the left, select the report type under which the parameter file you want to print is saved. For instance, in the previous example, we selected **Action Detail Report**. A list of saved action detail report parameter files appears on the right.

4. From the grid of saved report parameter files on the right, select the parameter file you want to print. For instance, in the previous example, in the right pane, we selected “Not Completed Actions With High Priority”.

5. To print the report without opening the report parameter file, from **The Raiser’s Edge** menu bar, select File, Print. The printing process begins.

Or
If you want to view the report parameter file before printing, select **Open**. The report parameter file appears, displaying the General tab.

6. On the action bar, click **Print**. The printing process begins. A screen appears, tracking the progress.

![Printing Records](image)

To cancel the print job, click **Cancel Printing**.

7. After the report prints, you return to the report parameter screen.

8. To close the report parameter screen, select **File, Close** from **The Raiser’s Edge** menu bar.

---

**Exporting a Report**

If you need to use report information in another software application, you can export the report parameter file. For example, you may want to share your report information with someone who does not have **The Raiser’s Edge**. Using the export option available in **Report**, you can export your report data into a shared application, such as Microsoft Excel. When you export a report, you send report information to the database of another software application using a data file. You can export a report from the opened report parameter file. Or, if you want to export a saved report, you can select the report title on the report types screen and, without opening the report, select **File, Export** from the menu bar. Both procedures are explained in this section.

Although this procedure takes you step-by-step through the process of exporting an Action Detail report, it applies to all reports in **The Raiser’s Edge**.
Exporting a report

1. On the Raiser’s Edge bar, click Reports. The Reports page appears.

2. Click the report category link containing the report you want to export. For example, to export an Action Detail report, click Action Reports. The Action Reports page appears.

3. From the list on the left, select the report type under which the parameter file you want to export is saved. For instance, in the previous example, we selected Action Detail Report. A list of saved action detail report parameter files appears on the right.

4. From the grid of saved report parameter files on the right, select the file you want to export. For instance, in the previous example, in the right pane, we selected “Not Completed Actions With High Priority”.

5. To export the report without opening the report parameter file, from the menu bar, select File, Export. The Export screen appears (skip to step 7).

Or
If you want to export from report parameter file, click **Open**. The report parameter file appears, displaying the General tab.

6. Select **File, Export** from the menu bar on the report parameter screen. The Export screen appears.

7. In the **Format** field, select an export format. This determines the way the data exported from your database appears in the data file and with which application it is used. There are several export formats that work with **The Raiser’s Edge**: Blackbaud Report Writer, Microsoft Access, Character Separated Value, Comma Separated Value. For a complete list and description of the formats, see the Export Formats section of the Export chapter in the **Query & Export Guide**.

8. In the **Destination** field, select where you want the exported information to go (the other software application). For example, if you want to export the parameter file to a disk, select “Disk file”. When you click **OK**, the Choose Export File screen appears, and you can map to your disk file and save the exported information. You can then take the disk file and open it in another application.

9. Click **OK**. Depending on the **Format** and **Destination** information you enter, you may receive a couple more screens, asking for additional information. For example, if you select “Character Separated Value” as your **Format**, the Character-Separated Values screen appears, asking you to select a character you want to use as a separator. Or, if you select a version of Microsoft Excel in the **Format** field and you select “Application” in the **Destination** field (sending the export information directly to the Excel application), the Format Options screen appears, asking you to select formatting options available in Excel.
10. After you complete all the screens, the export process begins. The Exporting Records screen appears, tracking the progress.

![Exporting Records Screen]

To cancel the process, click **Cancel Exporting** at any time.

11. When the export is complete, you return to the report category page or the report parameter file screen, depending on where you were when you ran the export.

12. If you are on the report parameter file screen and you want to close it, select **File, Close** from the menu bar. You return to the report category page.

13. From the report category page, you can select another function in *The Raiser's Edge* or select **File, Exit** to close the program.

### Sending a Report using E-Mail

In *The Raiser's Edge* you can share report information with other users through electronic mail. You can send the results of a report to another user for further analysis or to use in other applications. When you use e-mail to send report information, you perform two functions: you change the format of the information to a data file, and you send this data file to another individual.

You can send a report from the opened report parameter file. Or, if you want to send a saved report, you can select the report title on the report types screen and, without opening the report, select **File, Send as mail** from *The Raiser's Edge* menu bar. Both procedures are explained in this section.

Although this procedure takes you step-by-step through the process of sending an **Action Detail Report** through e-mail, it applies to all reports in *The Raiser's Edge*. 
Sending a report as e-mail

1. On the Raiser’s Edge bar, click Reports. The Reports page appears.

2. Click the report category link containing the report you want to send. For example, to send an Action Detail report using e-mail, click Action Reports. The Action Reports page appears.

3. From the list on the left, select the report type under which the parameter file you want to send is saved. For instance, in the previous example, we selected Action Detail Report. A list of saved action detail report parameter files appears on the right.

4. From the grid of saved report parameter files on the right, select the file you want to export. For instance, in the previous example, in the right pane, we selected “Not Completed Actions With High Priority”.

5. To send the report without opening the report parameter file, from The Raiser’s Edge menu bar, select File, Send as Mail, and the Export screen appears (skip to step 7).

Or
If you want to send the e-mail from the report parameter file, click **Open**. The report parameter file appears, displaying the General tab.

6. Select **File, Send as Mail** from the parameter file menu bar. The Export screen appears.

7. Because you must change the format of the information to a data file before you can send it in an e-mail message, you must export the information into the data file.

   In the **Format** field, select an export format. This determines the way the data exported from your database appears in the data file and with which application it is used. There are several export formats that work with *The Raiser’s Edge*: Blackbaud Report Writer, Microsoft *Access*, Character Separated Value, Comma Separated Value. For a complete list and description of the formats, see the Export Formats section of the Export chapter in the *Query & Export Guide*.

8. In the **Destination** field, select where you want the exported information to go. For example, you can export the parameter file to another application and then send the file from that application. Or, select “Microsoft Mail (MAPI)” to include the data as an attachment in an e-mail message from *The Raiser’s Edge*.

9. Your next step depends on the **Format** and **Destination** information you enter. You may receive a couple more screens, asking for additional information. For example, if you select “Character Separated Value” in the **Format** field, the Character-Separated Values screen appears, asking you to select a character you want to use as a separator. Or, if you select “Microsoft Mail (MAPI)” in the **Destination** field, the Send Mail screen appears and you can enter an e-mail address and message to include with the report information.
10. After you complete all of the screen prompts, the export process begins. The Exporting Records screen appears, tracking the progress.

To cancel the process, click **Cancel Exporting** at any time.

11. When the export is complete, the message is sent, and you return to the report category screen or the report parameter file screen, depending on where you were when you sent the e-mail message.

12. If you are on the report parameter file screen and you want to close it, select **File, Close** from the menu bar. You return to the report category page.

13. From the report category page, you can select another function in *The Raiser’s Edge* or select **File, Exit** to close the program.

### Deleting a Report Parameter File

Deleting a report parameter file permanently removes the file from your database. Once you decide a file is no longer needed, removing it is a simple process.

Although this procedure takes you step-by-step through the process of deleting an Action Detail report, it applies to all reports in *The Raiser’s Edge*.

- **Deleting a report parameter file**

  **Warning:** We strongly recommend you make a backup copy of the database before deleting any information from *The Raiser’s Edge.*
1. On the Raiser’s Edge bar, click **Reports**. The Reports page appears.

2. Click the report category link containing the report you want to delete. For example, to delete an Action Detail report, click **Action Reports**. The Action Reports page appears.

3. From the list on the left, select the report type under which the parameter file you want to delete is saved. For instance, in the previous example, we selected **Action Summary Report**. A list of saved action summary report parameter files appears on the right.

4. From the grid of saved report parameter files on the right, select the file you want to delete.

5. To delete the report parameter file, click **Delete**. The report is permanently removed from the list and your database.
# Parameter Tabs

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes Tab</td>
<td>141</td>
</tr>
<tr>
<td>Availability Tab</td>
<td>143</td>
</tr>
<tr>
<td>Columns Tab</td>
<td>144</td>
</tr>
<tr>
<td>Expense Calculation</td>
<td>146</td>
</tr>
<tr>
<td>Include Expenses with these Dates</td>
<td>147</td>
</tr>
<tr>
<td>For Expense Calculation, Include these Vendors Only</td>
<td>147</td>
</tr>
<tr>
<td>Expense Types/Include these Expense Types</td>
<td>148</td>
</tr>
<tr>
<td>Fields Tab</td>
<td>149</td>
</tr>
<tr>
<td>Statistical Reports</td>
<td>152</td>
</tr>
<tr>
<td>Filters Tab</td>
<td>153</td>
</tr>
<tr>
<td>Format Tab</td>
<td>156</td>
</tr>
<tr>
<td>Headings</td>
<td>157</td>
</tr>
<tr>
<td>Heading Format</td>
<td>157</td>
</tr>
<tr>
<td>Print Page Number in Heading</td>
<td>157</td>
</tr>
<tr>
<td>Print Report Date in Heading</td>
<td>158</td>
</tr>
<tr>
<td>Print Report Heading on Each Page</td>
<td>158</td>
</tr>
<tr>
<td>Criteria</td>
<td>158</td>
</tr>
<tr>
<td>Detail</td>
<td>159</td>
</tr>
<tr>
<td>Fonts</td>
<td>176</td>
</tr>
<tr>
<td>Sort/Break</td>
<td>177</td>
</tr>
<tr>
<td>Sort by query order</td>
<td>177</td>
</tr>
<tr>
<td>Available Fields/Sort Fields</td>
<td>177</td>
</tr>
<tr>
<td>Break Report by &lt;Sort Field 1&gt;</td>
<td>178</td>
</tr>
<tr>
<td>Page Footer</td>
<td>180</td>
</tr>
<tr>
<td>Page Footer Text</td>
<td>180</td>
</tr>
<tr>
<td>Print Page Number in Footer</td>
<td>180</td>
</tr>
<tr>
<td>Print Report Date in Footer</td>
<td>181</td>
</tr>
<tr>
<td>Report Footer</td>
<td>181</td>
</tr>
<tr>
<td>Report Footer Text</td>
<td>181</td>
</tr>
<tr>
<td>Miscellaneous</td>
<td>182</td>
</tr>
<tr>
<td>Amount Display Options</td>
<td>182</td>
</tr>
<tr>
<td>Report Orientation</td>
<td>182</td>
</tr>
<tr>
<td>Double space report</td>
<td>183</td>
</tr>
<tr>
<td>Name Formats</td>
<td>183</td>
</tr>
<tr>
<td>Color Scheme</td>
<td>188</td>
</tr>
<tr>
<td>Apply a Color Scheme</td>
<td>188</td>
</tr>
<tr>
<td>General Tab</td>
<td>188</td>
</tr>
<tr>
<td>Action Priorities</td>
<td>189</td>
</tr>
<tr>
<td>Action Progress</td>
<td>189</td>
</tr>
<tr>
<td>Alumni Information to Use</td>
<td>189</td>
</tr>
<tr>
<td>As of Date</td>
<td>190</td>
</tr>
<tr>
<td>Available Sections</td>
<td>190</td>
</tr>
<tr>
<td>Base Analysis On</td>
<td>190</td>
</tr>
</tbody>
</table>

*Note: The page numbers are indicated for each section.*
Base Funding On ................................................................. 190
Base Report On ................................................................. 191
Base Report Processing On .................................................... 191
Consecutive Payments Missed as of ........................................ 192
Count Consecutive Years to this Period .................................. 192
Counts to Include ............................................................... 192
Create Output Query .......................................................... 192
Credit Gifts of Membership To ............................................... 193
Credit Matching Gifts To ...................................................... 193
Display Information For ....................................................... 193
Event Categories to Include .................................................. 194
For Calculating Income ......................................................... 194
Group by ........................................................................... 194
Include ............................................................................ 195
Include Actions From .......................................................... 195
Include Actions with these Dates .......................................... 196
Include Advocacy Actions with these Dates ............................... 196
Include <Appeals, Campaigns, Funds> with Date Range Containing ........................................................................ 196
Include Awards with these Dates ............................................ 196
Include Contributors with these Gift Dates ............................... 197
Include Courses and Training with these Expiration Dates ............ 197
Include EFTs with these Dates ............................................... 197
Include Expenses with these Dates ......................................... 198
Include Events Starting within these Dates ............................... 198
Include Gifts Made After ....................................................... 198
Include Gifts with these Adjustment Dates ............................... 198
Include Gifts with these Dates ............................................... 199
Include Inactive Appeals ....................................................... 199
Include Inactive Campaigns ................................................... 199
Include Inactive Events ......................................................... 199
Include Inactive Funds ........................................................ 200
Include Inactive Proposals ..................................................... 200
Include Job Assignments with a Status of ............................... 200
Include Job Assignments with these Dates ............................... 200
Include Jobs with these Start Dates ....................................... 200
Include Memberships as of .................................................... 201
Include Memberships Dropped within these Dates ..................... 201
Include Memberships that are Within these Dates ...................... 201
Include Memberships that Expire within these Dates .................. 202
Include Memberships with these Dates ................................... 202
Include Only Active Memberships in ‘Memberships as of’ Count ................................................................. 203
Include Pledges Made After ................................................... 203
Include Proposals with No Date Asked .................................... 203
Include Records with these Dates .......................................... 203
Include Recurring Gifts with these Amendment Dates ............... 203
Include Scores with these Dates ............................................ 204
Include Skills and Experience with Expiration Dates On or Before ........................................................................ 204
Include these amendments ................................................... 204
Include these Constituents ....................................................... 205
Include these Memberships ................................................... 205
Include these Participants Only ............................................... 205
Include these Tributes .......................................................... 206
Include Tributes with no Gift Activity ..................................... 206
Include Volunteers with these Dates ....................................... 206
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Volunteers with these Start Dates</td>
<td>206</td>
</tr>
<tr>
<td>Include Volunteers with these Total Hours</td>
<td>207</td>
</tr>
<tr>
<td>Include Write-Offs Within These Dates</td>
<td>207</td>
</tr>
<tr>
<td>Lapsed on or Before</td>
<td>207</td>
</tr>
<tr>
<td>Location Filter(s)</td>
<td>207</td>
</tr>
<tr>
<td>Membership Categories/Include these Membership Categories</td>
<td>209</td>
</tr>
<tr>
<td>Pledge Type</td>
<td>209</td>
</tr>
<tr>
<td>Print Each Section on a Separate Page</td>
<td>209</td>
</tr>
<tr>
<td>Projected Renewal Targets</td>
<td>209</td>
</tr>
<tr>
<td>Process the Report Using the Rules For</td>
<td>210</td>
</tr>
<tr>
<td>Report Types</td>
<td>210</td>
</tr>
<tr>
<td>Report On</td>
<td>210</td>
</tr>
<tr>
<td>Report On Event</td>
<td>211</td>
</tr>
<tr>
<td>Report Only on Group</td>
<td>211</td>
</tr>
<tr>
<td>Selected Sections</td>
<td>211</td>
</tr>
<tr>
<td>Soft Credit Gifts To</td>
<td>212</td>
</tr>
<tr>
<td>Sort order</td>
<td>212</td>
</tr>
<tr>
<td>Sort report by</td>
<td>212</td>
</tr>
<tr>
<td><strong>Gift Types Tab</strong></td>
<td>213</td>
</tr>
<tr>
<td>Gift Types</td>
<td>214</td>
</tr>
<tr>
<td>Available Gift Types</td>
<td>215</td>
</tr>
<tr>
<td>All Cash</td>
<td>215</td>
</tr>
<tr>
<td>All Gifts-In_Kind</td>
<td>215</td>
</tr>
<tr>
<td>All Other</td>
<td>215</td>
</tr>
<tr>
<td>All Planned Gifts</td>
<td>215</td>
</tr>
<tr>
<td>All Pledges</td>
<td>215</td>
</tr>
<tr>
<td>All Stocks</td>
<td>216</td>
</tr>
<tr>
<td>All Write Offs</td>
<td>216</td>
</tr>
<tr>
<td>Options on the Gift Types Tab</td>
<td>216</td>
</tr>
<tr>
<td><strong>Graph Tab</strong></td>
<td>217</td>
</tr>
<tr>
<td>Graph Type</td>
<td>218</td>
</tr>
<tr>
<td>Data Source</td>
<td>219</td>
</tr>
<tr>
<td>Detail</td>
<td>220</td>
</tr>
<tr>
<td>Location</td>
<td>221</td>
</tr>
<tr>
<td><strong>Income Calculation</strong></td>
<td>222</td>
</tr>
<tr>
<td>For Calculating Income, Include these Participants Only</td>
<td>222</td>
</tr>
<tr>
<td>Include these Constituents</td>
<td>223</td>
</tr>
<tr>
<td>For Calculating Income</td>
<td>223</td>
</tr>
<tr>
<td><strong>Ind. Address Tab</strong></td>
<td>223</td>
</tr>
<tr>
<td>Step 1</td>
<td>225</td>
</tr>
<tr>
<td>Step 2</td>
<td>225</td>
</tr>
<tr>
<td>Step 3</td>
<td>225</td>
</tr>
<tr>
<td>Step 4</td>
<td>226</td>
</tr>
<tr>
<td><strong>Org. Address Tab</strong></td>
<td>226</td>
</tr>
<tr>
<td>Printing Contacts in Your Report</td>
<td>227</td>
</tr>
<tr>
<td>Step 1</td>
<td>228</td>
</tr>
<tr>
<td>Step 2</td>
<td>228</td>
</tr>
<tr>
<td>Step 3</td>
<td>230</td>
</tr>
<tr>
<td>Printing only the organization</td>
<td>230</td>
</tr>
<tr>
<td>Step 1</td>
<td>230</td>
</tr>
<tr>
<td>Step 2</td>
<td>230</td>
</tr>
<tr>
<td>Step 3</td>
<td>230</td>
</tr>
<tr>
<td>Step 4</td>
<td>231</td>
</tr>
<tr>
<td><strong>Profile Contents Tab</strong></td>
<td>232</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Participants</td>
<td>251</td>
</tr>
<tr>
<td>Prices</td>
<td>252</td>
</tr>
<tr>
<td>Proposal Attributes</td>
<td>252</td>
</tr>
<tr>
<td>Proposal Media</td>
<td>253</td>
</tr>
<tr>
<td>Proposals</td>
<td>253</td>
</tr>
<tr>
<td>Prospect Information</td>
<td>253</td>
</tr>
<tr>
<td>Prospect Ratings</td>
<td>254</td>
</tr>
<tr>
<td>Prospect Chronology</td>
<td>254</td>
</tr>
<tr>
<td>Renewal History</td>
<td>254</td>
</tr>
<tr>
<td>Renewal Information</td>
<td>255</td>
</tr>
<tr>
<td>Seating</td>
<td>255</td>
</tr>
<tr>
<td>Solicit Codes</td>
<td>255</td>
</tr>
<tr>
<td>Solicitor Assignments</td>
<td>255</td>
</tr>
<tr>
<td>Solicitor Goals</td>
<td>256</td>
</tr>
<tr>
<td>Solicitors</td>
<td>256</td>
</tr>
<tr>
<td>Spouse Information</td>
<td>256</td>
</tr>
<tr>
<td>Volunteer Assignments</td>
<td>257</td>
</tr>
<tr>
<td>Volunteer Availability</td>
<td>257</td>
</tr>
<tr>
<td>Volunteer Awards</td>
<td>258</td>
</tr>
<tr>
<td>Volunteer Checklist</td>
<td>258</td>
</tr>
<tr>
<td>Volunteer Courses</td>
<td>258</td>
</tr>
<tr>
<td>Volunteer Information</td>
<td>259</td>
</tr>
<tr>
<td>Volunteer Mandate Information</td>
<td>259</td>
</tr>
<tr>
<td>Volunteer Medical Information</td>
<td>259</td>
</tr>
<tr>
<td>Volunteer Special Needs</td>
<td>260</td>
</tr>
<tr>
<td>Volunteer Skills</td>
<td>260</td>
</tr>
<tr>
<td>Volunteer Summary</td>
<td>260</td>
</tr>
<tr>
<td>Volunteer Time Sheets</td>
<td>261</td>
</tr>
<tr>
<td>Report Periods Tab</td>
<td>261</td>
</tr>
<tr>
<td>Scores Tab</td>
<td>263</td>
</tr>
<tr>
<td>Section IA Tab</td>
<td>265</td>
</tr>
<tr>
<td>Calculate Outstanding Pledges</td>
<td>266</td>
</tr>
<tr>
<td>Pledges for Current Operations/Capital Purposes</td>
<td>266</td>
</tr>
<tr>
<td>Section III Tab</td>
<td>266</td>
</tr>
<tr>
<td>Section IIIA Tab</td>
<td>268</td>
</tr>
<tr>
<td>Section IIIB Tab</td>
<td>269</td>
</tr>
<tr>
<td>Section IV Tab</td>
<td>270</td>
</tr>
<tr>
<td>Section IV Part 1 Tab</td>
<td>272</td>
</tr>
<tr>
<td>Section IV Part 2 Tab</td>
<td>273</td>
</tr>
<tr>
<td>Section IV Part 3 Tab</td>
<td>274</td>
</tr>
<tr>
<td>Solicitors Tab</td>
<td>275</td>
</tr>
</tbody>
</table>
Report parameter tabs define your report. These tabs help you systematically determine what to include and exclude when creating your report. The tabs also help you determine a format for your output. For example, do you want all records in your database in the report? Do you want to include deceased constituents in your report? Do you want page footers in your report? You answer these questions and many more on the report parameter tabs.

Many of the reports include common parameter tabs with similar fields, buttons, checkboxes, and options. For example, all reports have a General tab, and most General tabs have the Include button. On the other hand, very few reports include the Report Periods tab. The tabs, fields, buttons, options, and checkboxes available depend on the report type and its specific purpose. For example, all Action Reports include an Actions Priority frame, asking you which priorities from the action records you want to see in your report. None of the Membership Reports include this frame, because action priorities are not part of the membership record in The Raiser's Edge.

While completing the parameter tabs, you must remember that before a record is included in your report, it must satisfy all parameter settings you select. For example, if on the General tab of the Campaign Goal Summary, you select to include all records, but on the Filters tab, you narrow the Constituent Codes to Employee, only constituent records with Employee entered in the Constituent Codes grid of the Bio 2 tab of the constituent record are included in the report. Or, if you include deceased constituents in your report by marking the Deceased constituents checkbox on the General tab, this does not mean all deceased constituents in the database appear on the report. A selected date range or an attribute you exclude can eliminate some deceased constituents. Also, report results are limited by the data entered in your Raiser's Edge database. For example, if most of your Raiser's Edge records include incomplete or no address information, including address information in your reports will be difficult.

Note: For information about creating, printing, previewing, exporting, and sending a report by e-mail, see “Report Basics” on page 105.

This section offers detailed descriptions of every tab found in all the Raiser’s Edge Reports. It also includes explanations for all fields, buttons, checkboxes, and options offered on each tab. The tabs — and the fields, buttons, checkboxes, and options included on each tab — are arranged alphabetically.
Attributes Tab

The Attributes tab helps you refine your report criteria, using attribute information included on the record type for which you are running the report. You can choose to include or exclude information based on attributes.

Warning: It is easy to confuse attributes with constituent codes. To learn more about constituent codes and attributes in general, see the Constituent Records chapter in the Constituent Data Entry Guide.

In The Raiser’s Edge, attributes add flexibility to your record keeping by giving you the ability to define and store special information about a wide variety of record types, for which there is no specific field. You can identify a category for the attribute and then store an entry specific to that category. For example, attributes may include activities in action records, anniversaries and interests in constituent records, alumni sponsors in education records, or a deposit gift transaction date in gift records. These are just a few examples of what you can do with attributes in The Raiser’s Edge.

You create attribute table entries for any type of information your organization wants to track, in Configuration. Each attribute is assigned a Description. For example, you can assign a Description of “Committees” to your constituent records. You can also add comments to the attribute such as “Constituent is a lifetime member of the Planning Committee.” You can then use this information in many areas of The Raiser’s Edge program.

Note: For more information about setting up attributes, see the Configuration chapter in the Configuration & Security Guide.

In Reports, the Attributes tab filters records you want to include in or exclude from your report. For example, in many reports you can filter information based on attributes listed on the Attributes tab of constituent or gift records. In some reports, you can filter criteria included in your report based on attributes listed on the Attributes/Notes tab of education records or attributes listed on the Attributes/Expenses tab of appeal records. The options vary between report types.

To use the tab to locate records you want to include in your report, mark the Include Records with these Attributes checkbox. The frame is activated, and you can select the attributes you want to use to locate acceptable records. For example, you can filter the report to include constituent records with an attribute Category of Mailing and a Description of Yes on the Attributes tab of the constituent record.
You can similarly exclude constituent records from your report by marking **Exclude Records with these Attributes**. When you mark this checkbox, the frame is activated, and you can select the attributes you want to use to prevent certain records from being included in your report.

The following two procedures, show you how to include records using attributes and how to exclude records using attributes. Although the procedures are based on a specific report type, they apply to all Attributes tabs in *Reports*. The only difference is the available record types vary based on the report type you run.

- **Including records with specific attributes**

  This procedure shows you how to include records based on attribute information contained on the Attributes tab of the constituent record. For example, you want to generate a **New Donor Report** and include only new constituents who have an interest in walking, based on information entered on the attributes tab of their constituent records.

  1. From the New Donor Report screen, select the Attributes tab.
  2. Mark the **Include Records with these Attributes** checkbox.
  3. In the first row of the **Record Type** column, select “Constituent”. This tells the program you want information from the Attributes tab of the constituent record.
  4. In the **Category** column, select “Interests”.
  5. In the **Description** column, select “Walking”.

  6. Select another tab or generate your report. Constituent records listing this attribute information on the Attributes tab are included in your report.

- **Excluding records with specific attributes**

  This procedure shows you how to exclude records based on attribute information contained on the Attributes tab of the constituent record. For example, you are considering a mail appeal for new donors. Before you commit to the mailing, you want to get to know your new donors and decide to generate a **New Donor Report**. However, you want all new donors who do not want to be solicited excluded from the report.

  1. From the **New Donors Report**, select the Attributes tab.
  2. Above the second grid, mark the **Exclude Records with these Attributes** checkbox.
  3. In the **Record Type** column, select “Constituent”. This tells the program you want information from the Attributes tab of the constituent record.
  4. In the **Category** column, select “Special Mailing Types”.

  **Note**: For information about generating a report, see “Report Basics” on page 105.

  **Warning**: If you include and exclude the same attribute, a message appears when you attempt to print, preview, export, or e-mail the report, telling you no records meet the specified criteria.
5. In the **Description** column, select “Do Not Solicit”.

6. Select another tab or generate your report. All constituents with Do Not Solicit entered as a Special Mailing Type on the Attributes tab of their constituent record, are excluded from your report.

### Availability Tab

Only the Volunteer Match List Report uses the Availability tab. Use this tab to limit the volunteers included in your report based on when they are available.

For example, you need a volunteer to man the front desk from 12 p.m. to 5 p.m. on Sundays for the first six months of the year. To view only volunteers matching this criteria, mark the **Use selected months only** checkbox. The frame activates, and you can select the months in which you need volunteers. Use the arrow buttons to move your selections from the **Months** box into the **Selected Months** box. Only constituent records with matching information entered in the **From Date** and **To Date** columns in the **Availability/Interests** category on their Volunteer tab are included in the report.

To view only volunteers matching day of the week criteria, mark the **Use selected days only** checkbox. The frame activates, and you can select the days on which you need volunteers. Use the arrow buttons to move your selections from the **Days** box into the **Selected Days** box. Only constituent records with matching information entered in the **Day** column in the **Availability/Interests** category on their Volunteer tab are included in the report.
To view only volunteers matching the time criteria, mark the **Use specific time only** checkbox. The frame activates, and you can enter the hours during which you need volunteers in the **Available between** fields. Only constituent records with matching information entered in the **Start time** and **End time** columns in the **Availability/Interests** category on their Volunteer tab are included in the report.

If you do not want to include volunteers satisfying a portion of the availability requirements, mark the **Only include volunteers available for the entire time specified** checkbox.

## Columns Tab

Using the Columns Tab available in some reports, you can select the data columns you want to appear on your report.

On this tab, you choose options regarding columns to be included in the report. All columns included on the Columns tab are optional report columns.

Some column options are linked columns, which are listed on the Columns tab as a single unit in the **Available Columns** list and **Selected Columns** grid.
For example, in the Activity Report, accessed through Pledge and Recurring Gift Reports, three columns - Type, Date, and Amount - are linked under the group heading of Activity.

If you change the text, using the Custom Heading column in the Selected Columns grid, to read Activities, Type, Dt., and Amt. respectively, the final report displays a group heading of “Activities” in the bar that groups all three fields, and the individual column headings display “Type,” “Dt.” and “Amt.” respectively.

The column width for any set of linked columns is a single width for the entire set. The individual columns within that set are defined as a specific — and fixed — percentage of that overall width for the set. Then, if you change the overall width for a linked set of columns, each of the individual columns within that set retains the same proportional width, relative to the overall width of the set. The displayed width of an individual column will not be less than 0.25in. (0.63 cm). If you reduce the column width for a set of linked columns to a setting which makes a single column in that set fall below the minimum width, that individual column remains at the minimum width while the other column(s) in the set are resized proportionally.

Also, you cannot add, delete, or change the order of individual columns in a linked set. If you move the linked set to a different position in the report, the linked columns comprising that set will retain their original order relative to each other. If you add or delete the linked set to/from the Selected Columns grid, the entire set of linked columns are added or deleted accordingly.

Available Fields. The Available Fields box lists all column information you can include in your report. Use the arrow button to add columns to the Selected Columns grid.

Custom Column Heading. This column allows you to change the column heading text for any selected column.

Min. Width (cm). A single column width is assigned the entire set of linked columns. The individual columns within the set are defined as a specific - and fixed - percentage of the overall width for the set. If, using the Min. Width (cm) column in the Selected Columns grid, you change the overall width for a linked column, each of the individual columns within that set retain the same proportional width, relative to the overall width of the set. The displayed width of an individual column cannot be less than 0.25in. or 0.63 cm. If you reduce the column width for a set of linked columns to a setting below the minimum width, the individual column remains at the minimum width, while the other column(s) in the set are resized proportionally.

When the report width exceeds the available page space, the displayed total report width changes automatically to a red font. This alerts you that the report exceeds the printable paper size.
Regardless of the displayed total report width, when the report is generated, the data expands horizontally to fill the page or reduces in total width to fit onto the page. The entered column widths in the grid on the Columns tab set the minimum width at which those columns display, assuming that the total report width does not exceed the available space. If the report must be reduced in width, each column is reduced proportionally.

**Selected Columns.** The Selected Columns grid displays all column information you selected to include in your report. The Default Column Name column displays the program-name for the column. In the Custom Column Heading column, you can change the program-name used in your report. In the Width (in) column, you can set the column width you want used in your report.

**Note:** Column names with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

A number of reports display data in multiple “levels” or lines of data for each record included in the report. For example, the detail version of the Cash Flow Report shows the Constituent Name on the first line of each record, the Gift Type, Gift Date, and Fund on the second line, and the Gift Amounts for several different report periods on the third line. This display pattern repeats for each record in the report.

In addition, the Selected Columns grid includes the following features for multi-level reports:
- A “level number” is pre-assigned to each available field for the report. Fields displayed in the top row of each data set are Level 1 fields; those displayed in the second row are Level 2, etc. These assigned levels are unique for each multi-level report.
- When an available field is displayed in the Selected Columns grid, the applicable level number displays in the column. You cannot change the level number assigned to any field in a report.
- When changing the position of a column in the report by moving that column’s information up or down in the grid, the row of data in the grid may only be moved within the listing of columns with the same level number. A Level 3 column may not be moved up to the Level 2 columns in the grid.

**Report Orientation.** Select the page orientation — Portrait or Landscape — you want to use for the report.

**Report View.** In the Report View field, available in some reports, you choose a detailed or summarized view. The summarized view includes several options on which to base the summary. When you select a view, the Available Fields list and the Selected Columns default information changes based on your selection.

**Restore Defaults.** Click the Restore Defaults button to restore the default columns and column names.

**Total Report Width.** This field displays a running total of the column widths as listed in the Selected Columns grid for all columns, with the total width vertically aligned with the column widths in the grid. This number refreshes each time a column is added to or deleted from the grid. When you change the width of a column in the grid.

If the report width exceeds the available page space as determined by the paper size, report orientation, and print margins, the displayed number change automatically to a red font. This alerts you that the report, as defined, exceeds the printable paper size.

For multi-level reports, widths for the selected columns in each level are added together to determine the overall report width for each level. The formula used for calculating the Total Report Width compares the overall designated widths for each level and uses the widest level width as the Total Report Width for that report.

**Expense Calculation Tab**

**Note:** For information about event records, see the Event Management Data Entry Guide.
Only the **Event Summary Report** uses the Expense Calculation tab. Use this tab to calculate expenses from an event to include on your report. You can select the vendors and types of expenses from an event to include in the report.

In the **Include Expenses with these Dates** frame you can specify a date or date range to identify the records to include in the report. In the **Date to use** field, you can select from several date options (all dates, a specific date range, a specific day). If you select <Specific range>, additional fields appear, and you can enter a start and end date.

In the **For Expense Calculation, Include these Vendors Only** frame, you can select the vendors for which you want to include or exclude expenses. This information is based on the event record. In *The Raiser’s Edge*, vendors are individuals or organizations providing a service or product for an event. For example, a vendor can be the catering service you hire when you host a dinner event. You must enter each event vendor as a participant (registrant, guest, or sponsor) of the event and designate them as a vendor on the Participation tab of their participant record. Expense information used in the report comes from the Expenses tab of the event record.

**Note:** For information about participant records, see the *Event Management Data Entry Guide*. 
Invited vendors as of. If you want to include vendor expense information for vendors who have been invited as of a certain date, mark the Invited vendors as of checkbox. The date field is activated, and you must select the date. You can include all dates or a specific date. If you select <Specific date>, a Date field appears, and you can enter a specific date. You can also select other dates, such as Yesterday or Tomorrow.

This information is based on the Invited? field on the General tab of the vendor’s participant record.

Note: To use selected records, you must first have a query of records. For information about creating and saving a query, see the Query & Export Guide.

Registered vendors as of. If you want to include vendor expense information for vendors who have registered as of a certain date, mark the Registered vendors as of checkbox. The date field is activated, and you must select the date. You can include all dates or a specific date. If you select <Specific date>, a Date field appears, and you can enter a specific date. You can also select other dates, such as Yesterday or Tomorrow.

This information is based on the Registration field on the General tab of the participant record.

Vendors who have attended. If you want to include vendor expense information for vendors who have attended the event, mark the Vendors who have attended checkbox. Your report then includes income from vendors with the Participant has attended checkbox marked on the bottom of the participant record.

Expense Types/Include these Expense Types

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

You can further refine the expense information included in your Event Summary Report based on expense types. This information is taken from the Expense Type column of the Expenses tab on the event record. To select expense types to include in your report, in the Expense Types box, highlight an expense type, and click the single right arrow to move the expense type into the Include these Expense Types box.
Fields Tab

All Demographic and Statistical Reports include the Fields tab. On this tab, you select the Raiser’s Edge field on which you want to base your report. You also select the columns to include. The report information is then arranged based on the fields you select, displaying information relative to the columns you select.

From the list on the left of the screen, you select Field or Columns, telling the program which option you want to define. The right side of the screen changes, based on your selection. You can then select the field or column information you want to include in your report.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.
For example, if you want to run the **Comparisons and Summaries** report, you may want to compare total gifts based on professions. First, on the left side of the screen, select **Field**. On the right side of the screen, in the **Field to use** field, select Profession. The tab changes, adding a checkbox and two boxes.

If you do not want a comparison using all professions in your **Raiser’s Edge** database, on the bottom half of the screen, you can mark **Use Selected Field Values Only**. In the **Field Values** box, select the professions you want to use in your comparison and, using the right arrow key, move your selection into the **Include These Field Values** box.

Next, on the left side of the screen, select **Columns**. A grid appears on the right side of the screen. In the **Information** column, select Total given. When you generate your report, all the professions you selected appear in the **Profession** column on the far left side of your report with the **Total given** for each displayed to the right.

Although the procedure included in this section shows you how to select field and column information in the **Comparisons and Summaries** report, this procedure applies to all the Fields tab in all **Demographic and Statistical Reports**.

For information about how this tab works specifically in the **Statistical Reports**, see “Statistical Reports” on page 152.

- **Selecting a field to use**

  **Note:** For more information about the Attributes tab and constituent records, see the Constituent Record chapter in the **Constituent Data Entry Guide**.

  In this procedure, we run a **Comparisons and Summaries** report based on constituents who have interests in contemporary art, photography, and volunteering. We want to view these constituents with the number of donors, total given, and average given per donor. You enter constituent interest information on the Attributes tab of the constituent record.

  1. From the **Comparisons and Summaries** report, select the Fields tab.
  2. From the list on the left, select **Field**.
  3. In the **Field to use** field, select Constituent attributes.
  4. In the **Category** field, select Interests.
5. Mark the **Use Selected Field Values Only** checkbox to activate the **Field Values** and **Include These Field Values** boxes.

**Note:** On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

6. In the **Field Values** box, select “Contemporary Art” and, using the single right arrow, move it into the **Include These Field Values** box.

7. Repeat step 6 and move “Photography” and “Volunteering” from the **Field Value** box into the **Include These Field Values** box.

**Note:** A statistical report with one to five columns prints in portrait orientation. With six or seven columns, the report prints in landscape.
8. From the list on the left, select **Columns**. A grid appears on the right side of the screen.

![Image of the grid with columns](image)

9. In the first row of the **Information** column, select “Number of donors”. In the **Heading 1** and **Heading 2** columns, enter the headings you want to appear with this information on your report. **Heading 1** information appears on top of **Heading 2** information in your report. You can also accept the default heading information — Number of = **Heading 1** and Donors = **Heading 2**.

10. Repeat step 9 and add “Total given”, and “Average given per donor” in the next two rows.

11. If for any reason you want to remove a column from the grid, highlight the entire row, and press **DELETE** on your keyboard.

12. If you want to revert back to the default columns, click **Load All Defaults**.

**Note:** For detailed instruction about running a report, see “Report Basics” on page 105.

13. After completing the tab, select another tab or run your report.

**Statistical Reports**

In **Statistical Reports**, the **Fields** tab and the **Filters** tab work in conjunction with one another when filtering information available on both tabs. For example, both tabs offer Constituent Codes as a filtering option.

- **Fields tab:**
  If you select Constituency code in the **Field of use** field, the **Use Selected Field Values Only** checkbox appears at the bottom of the tab. Mark this checkbox and select the constituency codes you want to include on the report (all codes included in the **Include These Field Values** box).

- **Filters tab:**
  Constituent Codes also appear on the Filters tab. This filter is available on the report regardless of the field selected in the **Fields to Use** field on the Fields tab. The report determines which constituents are included based on the primary constituency code. The Filters tab determines what the report sees as the primary constituent code for each constituent. It also determines under which constituency code the constituent prints.
In order to be included in the report, a constituent’s primary constituency code must be included on the Fields tab. Normally we think of the primary constituency code as the first valid constituency code on the constituent’s record. However, if “Include Selected” is chosen for the Constituent Codes row on the Filters tab, only the selected constituency codes are considered on the constituent’s record.

For example, a constituent has three constituency codes listed on the Bio2 tab of his constituent record in the following order: Trustee, Alumni, and Parent.

Based on his constituent record, Trustee is his primary constituent code. However, if on the Filters tab, you select “Parent”, The Raiser’s Edge considers Parent the primary constituent code for this report.

The order of importance is also based on the Filters tab. You can select to base the hierarchy on either of the following:

- Constituent – This looks at the order of the codes on the constituent’s record to determine which constituency code is considered primary and under which constituent code it appears on the report.
- Table – This looks at the order of the codes under Configuration, Tables, Constituent Codes to determine which constituency code is considered primary and under which constituent code it appears on the report.

**Filters Tab**

**Note:** Filters are criteria that records must meet to be included in a report.

The Filters tab helps you further refine your report criteria based on fields, buttons, checkboxes, and options available on records in The Raiser’s Edge. For example, on the Filters tab of the New Donors Report, you can restrict the new donors included in your report to only those with a constituent code of Volunteer entered on the Bio 2 tab of their constituent records.

You can also choose not to filter reports based on criteria available on this tab by accepting the Include All defaults and selecting another tab.

The following explanations of each Filters tab column apply to all report types in The Raiser’s Edge. The only difference is the available Filters vary based on the type of report you run.
Filters. The Filters column lists all filters available to refine your report criteria. The list of Filters options changes slightly, based on the report type you run. For example, if you are running an Appeals Analysis, you can filter constituent records based on Constituent Codes, Funds, Appeals, and Campaigns. If you are running a SYBUNT Report, you can additionally filter constituent records based on Constituent Solicitor and Gift Solicitors. This column is for viewing purposes only. You cannot change what appears in this column.

Filter Option. In the Filter Option column, you can choose to Include All records with the corresponding Filters options or Include Selected Filters options. For example, if you want to include only records associated with your Annual Campaign, in the Filter Option column next to Campaigns, select Include Selected. You can then select Annual Campaign in the Selected Filters column.

Note: If you mark the Show inactive entries checkbox on the Selected screen, all active and inactive campaigns display in the box. If you leave the Show inactive entries checkbox unmarked, the program lists only active campaigns.

Selected Filters. The Selected Filters column displays the criteria selected for a particular filter. For example, if you want to include only records associated with your Annual Campaign and in the Include column next to Campaigns you selected Include Selected, in the Selected Filters column, click the binoculars. The Selected screen appears.

Note: When you select to filter on Campaigns, Funds, or Appeals, you can choose to apply Campaign, Fund, and Appeal queries by clicking Query at the top of the Selected screen. Another screen then appears, allowing you to select the query you want to use to filter information included in the report. For more information about working in Query, see the Query and Export Guide.

In the box on the left, select Annual and click the single right arrow. Annual appears in the Include these Campaigns box.
To return to the Filters tab, click OK.

Annual Campaign now appears in the **Selected Filters** column.
Format Tab

Your settings on the Format tab determine the appearance of your report. Depending on the report type you select, you can add headings, page footers, and report footers; choose to print the criteria used to create the report; format individual and organization names; select how you want monetary amounts displayed; double space your report; choose a print orientation; and include colors.

The tree view on the left of the screen lists all formatting options available for the report type: Headings, Criteria, Detail, Sort/Break, Miscellaneous, Page Footer, Report Footer, Name formats, and Color scheme. Not all report types include every tree view option.

When you select a tree view category, the right side of the screen changes, displaying all the fields, checkboxes, and options available for that category. The following sections include alphabetized lists of all the Format tab tree view categories available in Reports, including all the fields, checkboxes, and options associated with the category.
Headings

Available in all reports, you can use the **Headings** category to create report titles and subtitles, include your organization name on the report, and add page numbers and dates.

**Heading Format**

**Title.** To create a title for the report, in the **Title** field, enter up to a 50-character title. The title appears at the top of your report.

**Subtitle.** To better explain the information included in the report, you can also enter up to a 50-character **Subtitle**. For example, if you generate a report to see how many constituents responded to actions in 2003, you can enter “Responded in 2003” in the **Subtitle** field. The subtitle appears under your title.

**Align.** If you enter title information, specify the alignment in the **Align** field. Choose Left, Center, or Right alignment.

**Print Organization name in header.** To include your organization’s name on the first line in the heading, mark the **Print Organization name in header** checkbox. This can be helpful if your report is going to be presented with other reports from a number of different organizations.

**Note:** If you do not enter a title for the report, the program defaults to the Blackbaud title, (Action Detail Report, Action Summary Report).

**Subtitle.** To better explain the information included in the report, you can also enter up to a 50-character **Subtitle**. For example, if you generate a report to see how many constituents responded to actions in 2003, you can enter “Responded in 2003” in the **Subtitle** field. The subtitle appears under your title.

**Align.** If you enter title information, specify the alignment in the **Align** field. Choose Left, Center, or Right alignment.

**Print Organization name in header.** To include your organization’s name on the first line in the heading, mark the **Print Organization name in header** checkbox. This can be helpful if your report is going to be presented with other reports from a number of different organizations.

**Print Page Number in Heading**

To display page numbers at the top of the report pages, mark **Print Page Number in Heading**. The fields available in the frame are enabled.
**Warning:** If in the **Page Footer** category on the Format tab, you select to include page numbers and dates with your footers, you may not want to repeat this information in your heading. If you do, the information appears in both places on your report.

**Format.** Select a format for your page number. For example, you can select Page 1, p1, 1.

**Align.** Select how you want your page numbers aligned. You can choose Left, Center, or Right.

Back to “Headings” on page 157

**Print Report Date in Heading**

To display the date of the report at the top of the report page, mark **Print Report Date in Heading**. The fields available in the frame are enabled.

**Format.** Select a format for your date information. For example, you can select a Short Date (03/03/2003) or a Long Date (Wednesday, May 1, 2003).

**Align.** Select how you want your date information aligned. You can choose Left, Center, or Right.

Back to “Headings” on page 157

**Print Report Heading on Each Page**

To display the heading information, including the date, at the top of every page in the report, mark **Print report heading on each page**. If you leave the checkbox unmarked, the heading information prints on only the first page.

Back to “Headings” on page 157

**Criteria**

Available in all reports, use **Criteria** if you want to print your report parameter settings with the report. This helps you remember the data you used to create the report.
To enable the frame, mark the **Print Report Criteria** checkbox. In the **Criteria to print** box, mark all the criteria you want to print with your report. Unmark any information you do not want to print with your report.

Specify where the program should print this information in the **Include on** field at the bottom of the screen. You can choose to print the criteria on a separate page or the first page of the report. If you select a separate page, the criteria prints at the end of your report.

### Detail

The **Detail** category includes just that, details about the information you want to print with your report. For example, if you run an **Actual vs. Target Report**, you can select to include **maiden name** and **include non-givers**.

The fields, checkboxes, and options available with **Detail** vary, based on the report type you select. This section includes an alphabetized list, explaining all fields, checkboxes, and options available the **Detail** category of all reports in *The Raiser’s Edge*.

**Additional Information to Display on Report frame.** In this frame, you can select to include additional information in your report. The options available in this frame vary based on the report type you select.

If you select **maiden name**, the report includes any information entered in the **Maiden name** field on the Bio 1 tab of the constituent record. If you select **Joint member names**, the report includes any information entered in the **Joint Member** section of the Joint Member or Card Recipient screen of the membership record. If you select **Comments**, the report includes any information entered in the **Comments** field of the Membership tab on the membership record.

**Appeals to Include frame.** When running a Campaign Detail Report or a Fund Detail Report you can choose the appeal information you want to include. You can select to include All appeals in your database or the **Default appeal only**. If you select the **Default appeal only**, only the fund with the Default ? column marked on the Appeals tab of the campaign or fund record (depending on the report type you are running) is included in the report.

**Base Report On frame.** In the **Tickler Report**, you can base your report on **Notified user** or **Solicitor**.

If you select **Notified user**, the data in your report is arranged based on who was notified about this action. You establish who you want to notify on the General tab of the action record.
If you select Solicitor, the data in your report is arranged based on the solicitor assignments the action.

**Base report on maiden name.** When creating an Alumni Class List, you may want to base the report on the student’s maiden name. Mark this checkbox, and if a constituent has a Maiden name entered on the Bio 1 tab of their constituent record, the maiden name appears first on the list. The constituent’s Last name and First name from the Bio 1 tab, appear beneath the maiden name. If a constituent does not have a maiden name entered, then Last name and First name appear.

**Breakdown by packages.** In some reports, you can include information entered on the Package tab of the appeal record. A package gives you the ability to track and analyze the profitability of different solicitations within a single appeal. If in your report, you choose to Include package information, you can also break your report down based on this package information.
**Break report by.** In this field, select how you want to divide information in your report. For example, if you select Fiscal Year, data in your report is divided based on your fiscal years; if you select Month, data in your report is divided based each month. **Break Report By** categories appear as columns at the top of your report. What you can choose to **Break Report By** varies, based on the report type you run.

---

**Note:** For more information about appeal records, see the Appeals section in the *Campaigns, Funds, & Appeals Data Entry Guide*.

**Campaigns to Include frame.** When running an **Appeal Detail Report** or a **Fund Detail Report**, you can choose the campaign information you want to include. You can select to include **All campaigns** in your database or the **Default campaign only**. If you select the **Default campaign only**, only the campaign with the **Default?** column marked on the Campaigns tab of the appeal or fund record (depending on the report type you are running) is included in the report.

**Children Meeting Criteria frame.** In your **Parent Class Analysis**, you can select which child’s class, if there is more than one, gets credit for the gifts. In the **Children Meeting Criteria** frame, select **Attribute to child graduating first**, if you want the first child’s class credited for the gift. Select **Attribute to child graduating last** if you want the latest child’s class credited for the gift. Or select **Split evenly** if you want the gift split between the two classes.

**Condensed format.** In the **Gift Entry Validation Report**, you can generate the report in a condensed format. If you want gifts printed in a column format with three to four stacked rows of gift information per column, as pictured below, mark this checkbox.

---

<table>
<thead>
<tr>
<th>Const\ R#</th>
<th>Gift Type</th>
<th>Amount</th>
<th>Fund</th>
<th>Campaign</th>
<th>Package</th>
<th>Recei pt</th>
<th>Pay Method</th>
<th>Acknow Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>JPD\ 1</td>
<td>Cash</td>
<td>$ 30.00</td>
<td>1999 Annual Fund</td>
<td>Annual Campaign</td>
<td>Annual Giving Thank You</td>
<td>Received</td>
<td>$ 30.00</td>
<td>Personal Check</td>
</tr>
<tr>
<td>JPD\ 2</td>
<td>Cash</td>
<td>$ 100.00</td>
<td>1999 Annual Fund</td>
<td>Annual Campaign</td>
<td>Annual Giving Thank You</td>
<td>Not Received</td>
<td>$ 100.00</td>
<td>Personal Check</td>
</tr>
<tr>
<td>JPD\ 3</td>
<td>Cash</td>
<td>$ 500.00</td>
<td>1999 Annual Fund</td>
<td>Annual Campaign</td>
<td>Annual Giving Thank You</td>
<td>Not Received</td>
<td>$ 500.00</td>
<td>Personal Check</td>
</tr>
</tbody>
</table>

---
If you want each gift grouped with all related information separately, as pictured below, do not mark this checkbox.

**Gift:**
- **Gift Date:** 08/05/1999
- **Contributor:** Joseph B. Davis
- **Fund:** 1999 Annual Fund
- **Campaign:** Annual Campaign
- **Amount:** $30.00
- **Reference:** Annual String Thank You
- **Acknowledged:** Acknowledged
- **Pay Method:** Personal Check

**Gift:**
- **Gift Type:** Cool
- **Gift Subtype:** Annual
- **Package:** 1999 Annual Mailer
- **Receipt Number:** 118
- **Receipt Date:**

**Detail Order frame.** If in your report, you want records arranged based on gift amounts, from the highest to the lowest, select **Amount Given**. If you want the records arranged in alphabetical order based on the constituent last name, select **Constituent last name**.

In the **General Ledger Audit Report**, instead of **Amount given**, you can arrange records based on the date they were posted to the **Nominal Ledger** by selecting **Post date**.

**Display Options for Membership Types frame.** In this frame, select how you want to view membership information. You must mark at least one checkboxes. If you mark all three, each selection prints information on a separate page in your report.

If you want to see how many memberships you have in each membership program, mark **Programs**. A membership program is the overall umbrella description for a group of membership categories. For example, a museum may have an Arts Program with membership categories of Individual, Student, Family, Sustainer, and Patron.

If you want to see how many memberships you have in each category, mark **Categories**. Membership category defines the level of giving required for a constituent to gain membership into one of your membership groups or clubs. Membership categories can be linked to a specific membership program. For example, a zoo may have the categories of Junior Curator and Young Explorer under the Kid’s Club membership program.

If you want to see how many memberships you have in each subcategory, mark **Subcategories**. A membership subcategory defines, more specifically, the member’s area of interest. For example, a zoo with a Junior Curator category in the Kid’s Club program may also have the subcategories of Lion, Panda, Koala, Polar Bear, and Sea Turtle, to which each member who is most interested in that animal belongs.

**Display Variance As frame.** In the **Comparative Report**, you can view the difference or variation between the gifts included in your report. In the **Detail** category, you can select how you want variance information displayed. To view the currency variance as a dollar amount, select **Currency** in the **Display Variance As** frame. To view the currency variance as a percentage, select **Percentage** in the **Display Variance As** frame. You can also select to display **Both**, the dollar amount and the percentage.

If you select **Percentage**, the **Report percentage changes of at least** field is enabled, and you can restrict the percentage increase or decrease criteria. For example, if you want to view only records with a 10% increase between periods, enter “10” in this field.
If you select Currency, the Report currency changes of at least field is enabled, and you can restrict the dollar increase or decrease criteria. For example, if you want to view only records with a $100 increase between periods, enter “100” in this field.

**Note:** On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

**Fields/Fields to Include boxes.** The Fields box displays all the additional information you can include in your report. To include the information, select the option in the Fields box and, and using the single right arrow, move your selection into the Fields to Include box. For example, if you want to see gift payment details in your report, such as the payment method, select Payment Details in the Fields box. Click the single right arrow to move it into the Fields to Include box.

**For Constituents with Multiple Field Values frame.** You can decide how to handle constituents who have more than one of the field values you selected on the Fields tab. If you want the constituent counted on the report only one time based on the primary, or first, field value met select **Include constituent for the primary field value**. If you want the constituent counted on the report for all matching field values, mark **Include constituent for all field values**. This frame activates only if you enter field information on the Fields tab.

**Note:** For more information about appeal records, see the Appeals section in the Campaigns, Funds, & Appeals Data Entry Guide.

**Funds to Include frame.** When running an Appeal Detail Report or a Campaign Detail Report, you can choose the fund information you want to include. You can select to include All funds in your database or the Default fund only. If you select the Default fund only, the fund with the Default ? column marked on the Funds tab of the appeal or campaign record (depending on the report type you are running) is included in the report.

**Gift Distribution frame.** Using the Gift Distribution frame in the Gift Fund Analysis report, you can determine how gifts are distributed through a Campaign Giving Hierarchy. This frame appears only if you are reporting on a campaign (selected “Campaign” in the Report On field on the General tab).

**Note:** Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

The distribution options help you understand exactly what the numbers on your report mean. When viewed in the hierarchy itself, gift totals roll up to the parent; however, a straightforward rollup may not provide all the information you need in a report.

For example, you have the following simple hierarchy.

**Buildings**
- Athletic Buildings
  - Basketball Arena
  - Football Stadium
- Library
In the early stages of the campaign, you receive the following gifts.

Buildings $1,000.00
Athletics Buildings $500.00
Basketball Arena $200.00
Football Stadium $200.00
Library $400.00

“Buildings” includes the total of gifts directed toward Buildings, as well as the total of gifts directed to all its child funds (likewise for “Athletics Buildings”). Displaying these gift totals in a hierarchical layout would show the following.

Buildings $2,300.00
  • Athletic Buildings $900.00
    Basketball Arena $200.00
    Football Stadium $200.00
  • Library $400.00

While these totals are accurate, they may be difficult to interpret. To help with this, three Gift Distribution options are available on the Format tab of a Campaign Fund Analysis Report.

The Show (unspecified) option makes the totality of gift data easier to understand by providing (unspecified) child levels for displaying gifts directed at a parent fund. Continuing with the previous example, consider the following:

Buildings $1,000.00
Athletics Buildings $500.00
Basketball Arena $200.00
Football Stadium $200.00
Library $400.00

Selecting Show (unspecified) results in the following.

Buildings $2,300.00
  • Buildings (unspecified) $1,000.00
    Athletic Buildings (unspecified) $500.00
    Basketball Arena $200.00
    Football Stadium $200.00
  • Library $400.00

Although these numbers are now easier to interpret, they can still be a little misleading in comparison against fund goals when trying to get a sense of progress towards those goals. In measuring the total for “Basketball Arena” against its goal, the $500.00 in gifts directed to “Athletics Buildings” is not counted when that money could be split between “Basketball Arena” and “Football Stadium.” To solve this viewing dilemma, you can select the Distribute Evenly option.

Distribute Evenly allows you to divide the gift totals specifically directed at a parent fund evenly among the children of that parent. If a fund is both a child and a parent, it receives an appropriate value distributed down from its parent, and that value is in turn included in the amount distributed to its children. Once again, continuing with the previous examples, consider the following:
Buildings $1,000.00  
Athletics Buildings $500.00  
Basketball Arena $200.00  
Football Stadium $200.00  
Library $400.00

The Distribute Evenly option displays the gifts as follows.

Buildings $2,300.00
- Athletic Buildings $1,400.00
  - Basketball Arena $700.00
  - Football Stadium $700.00
- Library $900.00

In this example, the $1000.00 directed to “Buildings” is distributed evenly among “Athletics Buildings” and “Library” and then the $500.00 directed to “Athletics Buildings” PLUS the $500.00 distributed from “Buildings” is split evenly between “Basketball Arena” and “Football Stadium.”

This provides a more reasonable view of the gift totals as compared to the goals, but it does not take into account how far each fund is from its goal. The third option, Balance Against Goals, accommodates this view.

Balance Against Goals allows you to divide the gift totals and accounts for how far each fund is from its goal. Instead of distributing the money evenly among the child funds, it distributes amounts proportional to the variance of each fund from its goal. Once again, continuing with the previous examples, consider the following:

Buildings $1,000.00
Athletics Buildings $500.00
Basketball Arena $200.00
Football Stadium $200.00
Library $400.00

If the goals for each fund are as follows — Buildings=$5,000.00, Athletics Buildings=$3,000.00, Library=$2,000.00, Basketball Arena=$1,500.00, Football Stadium=$1,500.00 — then selecting Balance Against Goals gives you following break down on your report:

Buildings $2,300.00
- Athletic Buildings $1,366.67
  - Basketball Arena $683.33
  - Football Stadium $683.34
- Library $933.33

Because “Athletics Buildings” totals (directed at “Athletics Buildings” and its child funds) $900 against a goal of $3,000.00 and “Library” totals $400 against a goal of $2,000.00, “Athletics Buildings” receives 7/15 of the money distributed from “Buildings”, while “Library” receives 8/15 of the money distributed from “Buildings.”

If any child of a given parent fund does not have a goal, distributions for ALL child funds of that parent are calculated in inverse proportion to the gift totals for each child.

For example, the same gifts displayed in a hierarchy with the Balance Against Goals option selected but no goals defined, generates the following results:

Buildings $2,300.00
- Athletic Buildings $1,344.44
  - Basketball Arena $672.22
  - Football Stadium $672.22
• Library $955.56


**Note:** Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in *The Raiser’s Edge* Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the *Configuration & Security Guide*.

**Gift Reporting frame.** If in your report you want only the gift totals for each individual, select **Totals Only**. The constituents’ names appear with their total gift information for the time period selected. If you want each individual gift included in your report along with the gift date, select **Individual**. Each gift and gift date appear next to the constituents’ names.

**Group by first initial of last name/org name.** Mark this checkbox if you want to group constituent’s included in your report based on Last name if the constituent is an individual or Org name if the constituent is an organization. The report inserts letter dividers for each group. For example, all last names and organization names beginning with “A” are alphabetized and listed under “A” in your report. If you want each alphabetical group to have its own page, mark the **Start each group on a new page** checkbox.

**Include Acknowledgee information.** You can include acknowledgee information entered in the Acknowledgees grid of the tribute record if you mark this checkbox. The acknowledgee name and address appears under the Acknowledge heading in your report. An acknowledgee is a family member, friend, associate, or honoree that should be notified or thanked when a gift is donated to honor, memorialize, or celebrate an honor/memorial constituent.

**Note:** For information about accessing and working in an action record, see the Actions chapter in the *Constituent Data Entry Guide*.

**Include action attributes.** Mark this checkbox if you want to include attribute information entered on the Attributes/Notes tab of the action record. If you do not want action attributes in your report, leave this checkbox unmarked.

**Include action information for associated events and appeals.** In the Campaign Detail Report, you can include information about actions entered on any event record or appeal record linked to the campaign. If you do not want this information included, leave this checkbox unmarked.

**Include action notes.** Mark this checkbox if you want to include note information entered on the Attributes/Notes tab of each action record. If you do not want action notes in your report, leave this checkbox unmarked.

**Include appeal attributes.** Mark this checkbox if you want to include attribute information entered on the Attributes/Expenses tab of the appeal record. If you do not want appeal attributes in your report, leave this checkbox unmarked.

**Include appeal notes.** Mark this checkbox if you want to include note information entered in the Notes box of each appeal record included in your report. If you do not want appeal notes in your report, leave this checkbox unmarked.

**Include appeals with no activity.** In the Appeals Analysis, you can include an appeal record that has the Appeal is inactive marked on the General tab and no associated gift activity if you mark the **Include appeals with no activity** checkbox. However, if the appeal record has Appeal is inactive marked on the General tab but has associated gift activity that satisfies your report criteria, the appeal and the gift activity appear on your report, even if you unmark the **Include appeals with no activity** checkbox.
### Include appeals with zero amounts.
In some appeal reports, you can include appeal records to which no gifts are associated. The appeal name appears in the report with zeros entered in all the amount columns.

### Include breakdown by income type.
In some Event Reports, if you want to include a Type column on your report, telling you the type of event income each participant, solicitor, or sponsor gave, mark this checkbox. In event records, income can be in the form of registration fees or donations.

### Include brought forward total from.
You can include a total given prior to the Date to Use you entered on the General tab if you mark this checkbox. For example, if on the General tab you entered the report start date as of 06/01/2000, but you want to calculate the amount received from January to June, enter 01/01/2000 in the Date field that activates when you mark this checkbox. The brought forward amount is calculated using the start date minus one as the end date.

### Include budget amounts.
You can include expense information for packages you choose to include in your report. To include amounts entered in the Budgeted column of the Attributes/Expenses tab of the appeal record, mark the Include budget amounts checkbox. In the report, the expense budgeted amount appears under the total expense amount. Under the budgeted amount, the report includes the difference.

### Include campaign attributes.
Mark this checkbox if you want to include attribute information entered on the Attributes tab of the campaign record. If you do not want campaign attributes in your report, leave this checkbox unmarked.

### Include campaign notes.
Mark this checkbox if you want to include note information entered in the Notes box of each campaign record included in your report. If you do not want campaign notes in your report, leave this checkbox unmarked.

### Include campaigns with zero amounts.
In some campaign reports, you can include campaign records to which no gifts are associated. The campaign name appears in the report with zeros entered in all the amount columns.

### Include column totals.
You can include gift totals for each constituent in your report. If you mark this checkbox, the program totals each gift column (Amount, Pledge, Pledge Balance) for each constituent appearing in your report.

### Include expense information.
You can include total expense information for each appeal included in your report by marking this checkbox. This information is taken from the Attributes/Expenses tab of the appeal record.

### Include First Gift.
On the First/Greatest/Latest Gift Report, you must mark this checkbox if you want to include information about constituents’ first gift.

### Include fund attributes.
Mark this checkbox if you want to include attribute information entered on the Attributes tab of the fund record. If you do not want fund attributes in your report, leave this checkbox unmarked.

### Include fund description.
You can include the description of any funds associated with the gift records included in your report by marking this checkbox. Fund description usually contain the full name of the fund. This information is taken from the Description field on the General tab of the fund record.

**Note:** For more information about appeal records, see the Campaigns, Funds, & Appeals Guide.

**Note:** For more information about campaign records, see the Campaigns, Funds, & Appeals Guide.

**Note:** For more information about gift records, see the Gift Records Guide.

**Note:** For more information about appeal records, see the Appeals chapter in the Campaigns, Funds, & Appeals Guide.

**Note:** Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.
Include fund ID. You can include the fund ID in your report by marking this checkbox. The ID information appears under the fund description on your report. The ID can include letters and numbers, and the description should contain the full name of the fund. This information is taken from the Fund ID field of the General tab on the fund record.

Note: For more information about fund records, see the Campaigns, Funds, & Appeals Guide.

Include fund notes. Mark this checkbox if you want to include note information entered in the Notes box of each fund record included in your report. If you do not want fund notes in your report, leave this checkbox unmarked.

Include funds with zero amounts. In some fund reports, you can include fund records to which no gifts are associated. The fund name appears in the report with zeros entered in all the amount columns.

Include general ledger account numbers. You can choose to include in your report debit and credit account numbers for gifts posted in your general ledger by marking this checkbox.

Note: Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser's Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

Include Gifts. You can choose to include in your report gifts marked as “Posted” to the general ledger, “Not posted” to the general ledger, or both. This information is taken from the GL post status field on the Miscellaneous tab of the gift record.

Include GL account numbers on summaries. When running the Summary version of the Cash Receipt Journal, you can choose to include in your report general ledger account numbers. Including these numbers does substantially slow down your processing time.

Include Greatest Gift. On the First/Greatest/Latest Gift Report, you must mark this checkbox if you want to include information about constituents’ greatest gift.

Note: Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser's Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

Include Inactive packages. In some reports you can include a package that has Package is inactive marked on the General tab of the Package screen but has no associated gift activity. However, if the package has Package is inactive marked on the General tab but has associated gift activity satisfying your report criteria, the package and the gift activity appear on your report, even if you unmark the Include Inactive packages checkbox. You access the Package screen from the Package tab of the appeal record.

Include Latest Gift. On the First/Greatest/Latest Gift Report, you must mark this checkbox if you want to include information about constituents’ latest gift.

Include maiden name. You can include your constituents’ maiden names in your report. If you mark this checkbox, the maiden name appears between parenthesis under the constituent’s name.

Note: For more information about education records, see the Managing Relationships section of the Constituent Records chapter in the Constituent Data Entry Guide.

Include major information. You can include information about a student’s major(s) on the report by marking this checkbox. This information is taken from the Major grid on the School tab of the education record. You access the education record by clicking the Education button on the Bio 1 tab of the constituent record or by opening the education record from the Relationships tab.

Note: For more information about education records, see the Managing Relationships section of the Constituent Records chapter in the Constituent Data Entry Guide.
Include minor information. You can include information about a student’s minor(s) on the report by marking this checkbox. This information is taken from the Minor grid on the School tab of the education record. You access the education record by clicking the Education button on the Bio 1 tab of the constituent record or by opening the education record from the Relationships tab.

Note: For more information about events, see the Event Management Data Entry Guide.

Include name to print from seating arrangements grid. If you want name information entered in the Name to Print column of the Seating Assignments screen of the event records included in your Seating Arrangements report, mark this checkbox. Any Name to Print information entered for the table, row, or seat appears on your report.

Include non-givers. You can include in your report constituents who have not given a gift in the report period you select. If you mark this checkbox, the constituent name appears but gift information is blank.

Note: For more information about appeal records, see the Appeals section in the Campaigns, Funds, & Appeals Data Entry Guide.

Include package information. In some reports you can include information entered on the Package tab of the appeal record by marking this checkbox. Packages give you the ability to track historic and statistical information for different facets of a single appeal. For example, your Year End Appeal may consist of several different mailings. One may feature a simple appeal letter, while the other may feature the letter, plus a color brochure. By making each mailing a separate package, you can analyze the effectiveness of each individually rather than as a single mailing to determine if the color brochure is worth the additional expense. Packages let you precisely analyze the effectiveness of your appeals. To include appeal package information in your report, mark the Include package information checkbox.

If you mark this checkbox, the Include Inactive packages checkbox is activated.

Note: For more information about gift records, see the Basis Gift Records Guide.

Include receipt amount. You can include the receipt amount of a gift in your report. The receipt amount is the monetary amount you print on the receipt. We recommend you enter the tax-deductible portion of the gift. This information is taken from the Receipt amt field of the Gift tab in a gift record.

Include report period totals. In the Job Assignment Summary, if you want the total number of hours for each period you defined on the Report Periods tab, mark this checkbox. For information about the Report Periods tab, see “Report Periods Tab” on page 261.

Note: For more information about solicitors, see the Solicitors chapter in the Constituent Data Entry Guide.

Include solicitors with no activity. In the Solicitor Comparison Report, Solicitor Goal Summary, and Solicitor Performance Report, you can include a solicitor who has This solicitor is inactive marked on the Solicitor Information screen (accessed from the Details button of their constituent record) and who has no associated gift activity. However, if the solicitor has This solicitor is inactive marked on their record but has associated gift activity satisfying your report criteria, the solicitor and the gift activity appear on your report, even if you unmark the Include solicitors with no activity checkbox.

Note: For more information about spouse information, see the Constituent Record chapter in the Constituent Data Entry Guide.

Include spouse. You can include spouse information entered from the Spouse button on the Bio 1 tab of the constituent record if you mark this checkbox. The spouse name appears under the constituent name on the report.
Include spouse employment information. If you choose to Include spouse in your report, you can also include spouse employment information entered from the Spouse button on the Bio 1 tab of the constituent record if you mark this checkbox. The spouse name and employment information appear under the constituent name and employment information on the report.

**Note:** For more information about education records, see the Managing Relationships section of the Constituent Records chapter in the Constituent Data Entry Guide.

Include students who left. In the Alumni Class Analysis and Parent Class Analysis, you can include students who left school without graduating by marking this checkbox. This information is based on the Status and Date left fields of the education record.

**Note:** Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

Include these recurring gifts. In the Recurring Gift Missed Payment Report, you can restrict the recurring gifts included in the report based on the number of payments made: Recurring gifts with no payments; Recurring gifts with at least one payment; or All recurring gifts, regardless of the number of payments. This information is entered on the Transactions tab of the gift record.

Include tributes. If you have the optional module Honor/Memorial Tracking, you can include in your report honor/memorial names associated with gifts.

**Note:** For more information about tributes, see the Tribute Data Entry Guide.

An honor/memorial is a constituent who is being honored, memorialized, or celebrated by gifts donated to your organization.

**Note:** For more information about seating assignments, see the Event Management Data Entry Guide.

Include unassigned seats. If you want to keep track of event seats not yet assigned in the event record, you can include this information in your report by marking the Include unassigned seats checkbox. Seating assignments are entered on the Seating Assignments screen accessed by clicking the Seating button on the General tab of the event record.

Include zero activity funds. In the Cash Receipts Journal, if you select Funds in the Summarize By frame, you can also choose to include fund records associated with no gifts. Mark Include zero activity funds and the fund name appears in the report with zeros entered in all the amount columns. You associate a fund with a gift in the Fund field on the General tab of the gift record.

Limit Report Results. Using this frame, when running Advocacy Tallies, Statistical Reports, or Tallies, you can set report limits based on a number of factors. For example, if on the Fields tab, you selected a number of constituent professions on which you want your report based, in this frame you can then limit the professions included based on the amount of each gift. To activate the frame, mark Limit Report Results. In the Limit the Results to field, you can select Number of constituents, Number of gifts, Number of donors, Total given,
Average given per donor, Average given per gift, Percent of participation, Percent of total gifts, or Number of members. The two parameter fields at the bottom of the frame change based on your Limit the results to selection. For example, if you select Average given per gift in the Limit the results to field, the Start amount (value) and End amount (value) fields appear. If you want gifts averaging between $50 and $1000 included in your report, enter “50” as your Start amount and “1000” as your End amount.

Linked gifts. In the Planned Gifts Report, mark this checkbox and the Detail view of the report includes information about gifts linked to the planned gifts included on the report.

Minimum number of consecutive years. In the Consecutive Years Report, enter the minimum number of consecutive years a constituent must have given in order to appear on the report.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

Phone Types/Include these Phone Types. If you want to include the phone numbers of your constituents in your report, you can tell the program which phone types are acceptable and list them in order of preference, using the Phone Types box. To select your first phone type choice, select the phone type and click the single right arrow. Your selection moves into the Include these Phone Types box. In the Include these Phone Types box, make sure you order the phone types from top to bottom, based on your preferences. When you generate the report, the program searches for the first phone type in the Include these Phone Types box. If it does not find your first choice, it searches for your second choice. If it finds none of the phone types included in the Include these Phone Types box, no phone information appears for the constituent in your report. This information comes from the Phones/E-mail/Links grid on the Bio 1 tab of the constituent record.

Primary summary for report/Secondary summary for report. In these fields, select how you want information in your Action Summary Report summarized. For example, if you select Action Category, data in your report is summarized based on action categories such as Phone Call, Meeting, Mailing, Task/Other, or E-mail; if you select Solicitor, data in your report is summarized based on your solicitors’ names. This information makes up the rows appearing on the left side of your report. Because you can run two summaries, in the Primary summary for report field, enter the information you want summarized first in your report. Enter the information you want summarized second in the Secondary summary for report field. If you want only one summary, select <none> in the Secondary summary for report field.

Note: For more information about volunteer records, see the Volunteers & Jobs Data Entry Guide.

Print availability. When running a Volunteer Match List, you can include the volunteers’ availability in your report by marking this checkbox. This information is taken from the Volunteer Availability grid in the Availability/Interests category on the volunteer record.

Print bank information. If you want to include bank information related to constituents included in your report, mark the Print bank information checkbox. This information is taken from the Bank/Financial Institution screen accessed by clicking the Bank button on the constituent record or the Bank/Financial Institution category on the Relationship tab of the constituent record.

Note: Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.
Print blank line after each participant. When running some Event Reports, you can make the report easier to read by printing blank lines between participants listed on the report. To include the blank lines, mark this checkbox.

Print each category, gift on a separate page. Mark this checkbox and each donor category or gift record (depending on the report type you are running) appears on its own page in your report.

Print each class on a new page. In the Alumni Class Analysis, mark this checkbox and each graduating class prints on its own page. You enter class information in the Class of field on the education record.

**Note:** For more information about honor/memorial records, see the Tribute Data Entry Guide.

Print one event per page. When running an event report, if you want each event included to have its own page in the report, mark this checkbox.

Print one honor/memorial per page. When running a tribute report, if you want each honor/memorial included to have their own page in the report, mark this checkbox. An honor/memorial is a constituent who is being honored, memorialized, or celebrated by gifts donated to your organization.

Print one solicitor/notified user per page. The title of this checkbox changes, depending on the option you select in the Base Report On frame — Solicitor or Notified User. If you want each solicitor or notified user to have their own page in the report, mark this checkbox.

Print one tribute per page. When running a tribute report, if you want each tribute included to have its own page in the report, mark this checkbox. A tribute explains the reason why you are honoring, memorializing, or celebrating a constituent.

Print Options. When running a Cash Flow Report, you can select what exactly you want to print on the report. You can select to include Payment, Tax, Both payment and tax, or the Sum of payment and tax.

Report Format frame. In this frame, you can choose one of two different formats for your Pledge Status Report. If you select Format 1: Prior year payments, current year payments and write-off history for a selected time period, the report includes a Prior Amounts section, displaying Pledge, Payments, and Written Off columns. It also includes an All Dates section, displaying Payments, Written Off, and Pledge Balance columns. If you select Format 2: Pledges, payments and write-offs for a selected time period, the report includes a Previous Balance column. It also includes an All Dates section, displaying Pledged, Payments, Written Off, and Pledge Balance columns.

**Note:** For more information about event records, see the Event Management Data Entry Guide.
Report order frame. Select how you want your event report arranged. If you select Alphabetically by participants, all participants associated with the event are listed in alphabetical order in the Participants column. Section, table, and seat information appear in each participant’s row. If you select Section/Table/Seat sequence, the report is arranged based on the section number, table number, and seat number. The participant name appears next to the seat number.

You enter event seating information from the Seating Assignments screen accessed from the Seating button on the General tab of the event record.

Secondary summary for report. When running an Action Summary Report, you summarize information based on two action functions. In the Secondary summary for report field, you select the second function by which you want the report summarized: Action Category, Action Type, Action Status, etc. For example, if you select Action Type in the Primary summary for report field and Action Status in the Secondary summary for report field, the report lists all action types included in your database along with the total number of actions associated with each one. Along with each action type, a secondary entry appears, displaying the status of each action type.

Show adjustment history. After entering a gift record in The Raiser’s Edge, you can use the Adjust option in the gift record to make and track any changes to the gift amount or funds to which the gift is designated. If you want to display this adjustment information on your report, mark the Show adjustment history checkbox.

Note: For more information about membership records, see the Membership Data Entry Guide.

Show upgrade, downgrade, and same breakdown for rejoins. If you want to view a breakdown for membership rejoin based on the number of upgrades, downgrades, or those that stayed the same, mark this checkbox. A rejoin is a membership that fails to renew before being dropped. You cannot renew a membership that has been dropped. Once a membership is dropped, the member must rejoin. You enter upgrade, downgrade, and same information from the Membership tab of the membership record.

Show upgrade, downgrade, and same breakdown for renewals. If you want to view a breakdown for membership renewals based on the number of upgrades, downgrades, or those that stayed the same, mark this checkbox. You enter upgrade, downgrade, and same information from the Membership tab of the membership record.
Sponsors frame. In some event reports, you can select the sponsor information you want to include on your report. A sponsor is an individual or organization sponsoring or representing, a registrant. Sponsor information is entered from the Sponsor category available on the Participants tab of the event record. To include all sponsors associated with an event, select All sponsors. If you want to include a specific sponsor associated with an event, select One sponsor. In the field next to the options, select the sponsor you want to include.

Summarize by frame. The options available in this frame vary based on the report category. If you are working in Event Management Reports, in this frame you select how you want information in your event report summarized: based on Participant, Solicitor, Sponsor, or you can mark all three. For example, if you mark Participant, information on your report is arranged around a Participant column, which lists name and address information for participants of this event. This information comes from the Participants tab of the event record. If you mark more than one option, a separate report prints for each Summarize by option you select.

If you are working in Financial Reports, this frame is activated only if you select Summary or Both in the Report Type frame on the General tab. In this frame, you must tell the program how you want information summarized. You can select to summarize gift information based on Campaign, Fund, Appeal, Constituent Code, or all four. For example, if you mark Campaign, gift information on your report is arranged around a Campaign ID column, showing you the number of gifts and amounts of gifts for your various campaigns. If you mark more than one checkbox in this frame, a separate report prints for each Summarize by option you select.

Top Donor Criteria frame. You can select how many records you want displayed when choosing top donors to include in your Top Donor Report. For example, if you want the top 10 donors, enter “10” and select “Count” in the Top field. If you want the top 10% of your donors, enter “10” and select “Count” in the Top field.
Use donor category table. In the Donor Category Report, you can base you report on donor category tables you establish in Configuration. These tables reflect different cumulative giving award categories for your donors and specify a minimum amount a donor must give to become a member of this category. For example, you can create a donor category called Major Donors and for that table, you can create entries for VIP with a minimum cumulative giving amount of $10,000, Benefactor with a minimum amount of $5,000, and Friend with a minimum amount of $1,000. To base your report on a donor category table, select the table number in the Use donor category table field.

After you select a donor category table, the Available Categories box displays the values for that table. To include only select categories in the report, mark Use Selected Categories Only and move the categories you want to include from the Available Categories box into the Include these categories box.

Variance to Include frame. In your Comparative Report, you can select the currency difference or variance on which you want your report based. For example, you are comparing constituent total giving between the years 01/01/2001-12/31/2001 and 01/01/2002-12/31/2003, and you want to see only constituent’s whose giving increased and by how much. In the Variance to Include frame, select Increase. If you want to see only constituent’s whose giving decreased in this time period and by how much, select Decrease in the Variance to Include frame. You can also select Both to include constituent’s whose giving decreased or increased and by how much in the time period.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

What would you like to print. In the What would you like to print field, select one of the following: Address, Phone, Address & phone, or None. If you include phone numbers, select a phone type, such as Home, E-mail, or Cellular Phone in the Phone Type box and, using the single right arrow, move it into the Include these Phone Types box. The program then prints any matching phone types found on the constituent record in your report.
Fonts

In Profiles, Lists, and Directories, if you run a profile, you can select the fonts you want to use.

To set the font you want to use in your heading, click the Profile Heading button. The Font screen appears, allowing you to set the heading font.

Click OK to return to the Format tab. You can also set fonts for Category Heading, Category Subheading, and Profile Body.
Sort/Break

**Warning:** When running Action Reports, the same action may be counted twice, depending on the break you select. For example, if you break on solicitor and two solicitors are associated with the action, the action appears twice (once for each solicitor). In this case the report counts the action only once in the grand total at the bottom of the report.

Use Sort/Break to select the order in which records appear on the report. For example, if you choose Selected Records on the General tab, you can sort the report based on the order of the query, or you can manually select the fields you want used to sort the report contents.

**Sort by query order**

If on the General tab you choose Selected Records from the Include button and you want your report sorted based on the order of the query you selected, mark **Sort by query order**. The remainder of the screen is then disabled.

**Available Fields/Sort Fields**

If on the General tab you choose All Records from the Include button or you want to change the record order of a query you selected in the Include button, you must manually select a sort order using the fields in the Available Fields box. To manually sort records, select the field in the Available Fields box on which you want to base the sort order of your report. Use the right arrow to move the field from the Available Fields box to the Sort Fields box.

**Note:** On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.
For example, to sort the report alphabetically by action categories, select Action Category in the Available Fields box and click the right arrow to move Action Category into the Sort Fields box. Then click the Desc button on the bottom right of the Sort Fields box. The report is then arranged based on the alphabetical order of the action category (for example, E-mail actions appear first, followed by any Mailing actions, followed by any Meetings).

You can also sort using more than one field. For example, move Action Category and Constituent to the Sort Fields box. Action Category lists first, so records on the report sort first by action category, then by constituent names within each category.

**Settings for Break 1/Settings for Break 2**

In some reports, you can select break options for two sort fields. The report then summarizes data contained in each break field. For example, in the Outstanding Proposal Report, if you move Campaign and Fund into the Sort Fields box, you can define break options for each. The report then includes summary data for each sort field (Campaign and Fund) along with grand totals.

The Settings for Break 1 and Settings for Break 2 options are activated if you move more than one sort field into the Sort Fields box, and you mark the Break Report by <Sort Field> checkbox.

To define breaks for the first sort field, select the sort field in the Sort Fields box, and select the Settings for Break 1 option. Complete the Break Reports by <Sort Field> frame. To define breaks for the second sort field, select the sort field in the Sort Fields box, and select the Settings for Break 2 option. Complete the Break Reports by <Sort Field> frame.

**Break Report by <Sort Field 1>**

*Warning:* If you do not mark the Break Report by checkbox, the frame is disabled and there is no break in the report.

To break the report at the sort field that appears first in the Sort fields box, mark the Break Report by <Sort Field 1> checkbox. The first field automatically appears as the header at each break on the report. In the Text before value and Text after value fields, enter the text to appear before or after each break. The sample display below the fields show you how the break header will look on the report. For example, if you move Constituent into the Sort fields box, you can choose to break the report up by each constituent.

In the Break Footer frame, you can choose to print “totals” in your report and to include data from only one Sort Field on each page.

**Print count of records.** Mark Print count of records to include a count of records included with each sort field. For instance, in the Sort/Break Sample Report picture, we sorted our report based on Constituent, and for the first constituent (or sort field) there are three action records.

**Print count as% of total.** Mark Print count as% of total to include data showing you what percent of the total records included in your report this sort field makes up. For instance, in the following example, AAA Concrete (the Constituent Sort Field) and its three action records account for 27% of the total number of actions in this report.
Page break on each new <Sort Field 1>. To insert a page break with each sort field, mark **Page break on each new <Sort Field 1>**. For instance, in the previous picture, if we had not marked **Page break on each new <Sort Field 1>**, the next sort field would appear on the same page as AAA Concrete, below the **Break Footer** information.
Page Footer

Use Page Footer to create a footer to appear at the bottom of every page in the report. You can also select to print the page number or the date in the footer of each page, instead of in the heading. The Page Footer category is the same in all reports.

Page Footer Text

Text. Enter the text (up to 80 characters) you want to appear in your page footer. This text prints at the bottom of every page of the report. For example, you may want to include a short description of the type of records included in the report.

Align. If you enter any information in the Text box, you must specify the alignment in the Align field. Choose Left, Center, or Right.

Print Page Number in Footer

To display a page number at the bottom of every page, mark the Print Page Number in Footer checkbox. The rest of the frame is enabled.

Warning: If in the Heading category on the Format tab, you select to include page numbers and dates with your heading, you may not want to repeat this information in your footers. The information would then appear in both places.

Format. Select a format for your page number. For example, you can select Page 1, p1, 1.

Align. Select how you want your page numbers aligned. You can choose Left, Center, or Right.
Print Report Date in Footer

To display the date of the report at the bottom of every page, mark the **Print Report Date in Footer** checkbox. The rest of the frame is enabled.

**Format.** Select a format for your date information. For example, you can select a Short Date (09/15/2003) or a Long Date (Thursday, September 15, 2003).

**Align.** Select how you want your information aligned. You can choose Left, Center, or Right.

Report Footer

Use **Report Footer** to include a footer that appears only on the last page of the report. For example, if you choose to print the report criteria on a separate page with your report, you may want to mark where the report data ends. Readers then know the information contained in the last page(s) is not part of the official report. The **Report Footer** category is the same in all reports.

![Report Footer Text](image)

**Report Footer Text**

**Text.** Enter the text (up to 150 characters) you want to appear in your report footer. This text appears at the end of the report.

**Align.** If you enter any information in the **Text** box, you must specify the alignment in the **Align** field. Choose Left, Center, or Right.
Miscellaneous

Use **Miscellaneous** to specify how to display numerical amounts, select page orientations, and select line spacing. The fields, checkboxes, and options available in the **Miscellaneous** category vary based on the report type.

### Amount Display Options

Select how you want monetary amounts displayed in your report. The fields and checkboxes available in this frame vary based on the report type.

**Show currency character.** To see the dollar sign ($) in front of monetary values, mark the **Show currency character** checkbox.

**Show 1000’s separator.** To include commas in numeric values (1,000), mark the **Show 1000’s separator** checkbox.

**Show decimals.** To display monetary values with two decimal places ($12.03), mark the **Show decimals** checkbox. If you unmark this checkbox, amounts and numbers are rounded to the nearest dollar ($12).

**Show percent.** To display the percent symbol (%) with numbers that are percentages, mark the **Show percent** checkbox.

**Show blanks instead of zero amounts.** To leave a blank in place of amount fields that are zero, mark **Show blanks instead of zero amounts**.

**Negative amount format.** To change how negative amounts print in your report, click the drop-down arrow in this field. The program defaults to parentheses (20). You can change it to a minus sign (-20).

**Sample Display.** As you make selections in the **Amount Display Options** frame, you can view how the selections affect what prints in your report in the **Sample Display** frame.

### Report Orientation

Select the page orientation — **Portrait** or **Landscape** — you want to use for the report.
Double-space report

To double-space your report, mark the **Double-space report** checkbox. If left unmarked, the report prints single-spaced.

Optional Columns

**Note:** Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in *The Raiser’s Edge* Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the *Configuration & Security Guide*.

In some reports, you can include an optional column, containing additional information relevant to your report. For example, in the *Gift Detail and Summary* report, you can include a Gift ID column or Hon/Mem (Honor/Memorial) name column for tribute gifts.

All optional columns available for a report appear in the **Optional Columns** box. The frame title tells you how many optional columns you can select. For example, in the *Gift Detail and Summary* report, you can **Select up to 1 Optional Column**. To include an optional column in your report, select it in the **Optional Columns** box and, using the single right arrow, move the column into the **Include these Optional Columns** box.

Name Formats

Use **Name formats** to select addressee and salutation formats for you report. Because addressee/salutation formats for individuals differ from those for organizations, **Name formats** is divided into two selections — **Individual** and **Organization**. Also, if you have solicitor information in your report, you may want to use a different addressee/salutation from that you select for your individual constituents. Therefore, on some reports a **Solicitor** folder with **Individual** and **Organization** options is also included in the **Name formats** category. The same is true for honor/memorials and acknowledgees. In some **Tribute Reports**, **Honor/Memorial** and **Acknowledgee** folders appear so you can select addressee/salutation information specific to honor/memorials and acknowledgees.
Defining individual name formats

The Individual option in the Name formats category is the same for Constituent, Solicitor, Honor/Memorial, and Acknowledge. Although the following procedure shows you how to select an addressee/salutation format for an individual constituent, you can apply the same procedure when selecting any individual addressee/salutation format.

1. From the report parameter screen, select the Format tab.

Note: For information about selecting addressees and salutations for your constituents, see the Constituent Records chapter in the Constituent Data Entry Guide.

2. From the tree view on the left in the Name formats folder, select Individual. Addressee/Salutation options appear on the right.

Note: For information about setting up addressees and salutations for your constituents, see the Configuration chapter in the Configuration & Security Guide.
3. To print one of the name formats listed on the Addressees/Salutations tab of a constituent record, select the **From individual** option.

4. Select an addressee/salutation to use for individuals in your report, in the **Use this addressee/salutation if present on the Individual** field.

5. Select an alternative addressee/salutation in the **Otherwise use** field. If your first choice is not present on the constituent record, this option is used.

**Note:** For information about selecting addressees and salutations for your constituents, see the Managing Mailing Information section of the Constituent Records chapter in the *Constituent Data Entry Guide*. 
6. To print one of the name formats listed from the *Addressee/Salutations* link of *Configuration*, select *From Configuration*.

![New Action Summary Report](image)

7. Select an addressee/salutation to use for individuals in your report in the **Use this addressee/salutation from Configuration** field. If the addressee/salutation is not present on a constituent record, the program uses the key name, which is first name, middle initial, and last name.

**Note:** If you select an embedded addressee/salutation in the **Use this addressee from Configuration** field, two additional fields appear so you can select the format for the embedded formation. For more information about embedded addressee/salutations, see the *Configuration & Security Guide*.

8. To format each constituent’s name as first name, middle initial, last name, select **Use individual name**.

![New Action Summary Report](image)
Defining organization name formats

The Organization option in the Name formats category is the same for Constituent, Solicitor, Honor/Memorial, and Acknowledgee. Although the following procedure shows you how to select an addressee/salutation format for an organization constituent, you can apply the same procedure when selecting an addressee/salutation format for an organization solicitor, honor/memorial, or acknowledgee.

1. From the report parameter screen, select the Format tab.
2. From the tree view on the left in the Name formats folder, select Organization. Addressee/Salutation options appear on the right.
3. To include the constituent ID in the organization’s addressee/salutation, mark the Include Constituent ID checkbox.
4. Sample displays how your selection will look in the report.

Note: For information about generating a report, see “Report Basics” on page 105.

5. Select another formatting option or generate your report.
Color Scheme

Use Color Scheme to select colors for report headings. If you leave the Apply a Color Scheme checkbox unmarked, the report prints in black and white.

Apply a Color Scheme

To select colors for a report, mark the Apply a Color Scheme checkbox. All checkboxes in the frame are enabled. Click the colored box that corresponds to the area to change. For example, to print the heading background a shade of blue, click the box next to Column heading back color, and the Color screen appears with a palette so you can make your selection.

Select the shade of blue you want and click OK. You return to the Format tab, and the color is applied to your heading information. Make selections for other parts of the report by clicking the box for Column heading fore color, Group heading back color, and Group heading fore color.

If, after changing the color scheme of the report, you want to return to the original program default settings, click the Reset to System Defaults button and the report prints in the original color scheme.

General Tab

Note: As you select different colors, the sample display box shows you how the selections change the appearance of the report.

Note: The program warns you if you try to print, preview, or save the report without completing a required field.
On the General tab, you decide the general criteria you want to govern what is included in your report. For example, you can tell the program to include all records satisfying your specific criteria, selected records you saved in a query file, or one record. The General tab appears on all reports; however, the fields, buttons, checkboxes, and options change slightly, depending on the report type you select.

This section includes an alphabetized list of all fields, buttons, options, and checkboxes found on the various Raiser’s Edge reports. However, not all fields, buttons, options, and checkboxes are found on every report.

Action Priorities

**Note:** For more information about action records, see the Actions chapter in the Constituent Data Entry Guide.

In this frame, you can select the action priorities you want to include in your report: High priority, Normal priority, or Low priority. Action priorities are established in the Priority field on the General tab of the action record.

Action Progress

**Note:** For more information about action records, see the Actions chapter in the Constituent Data Entry Guide.

In this frame, you can select the action progress you want to include in your report: Completed or Not Completed. Action progress information is entered in the Action completed on field/checkbox on the General tab of the action record.

Alumni Information to Use

Available in several Profiles, Lists, and Directories, in this field, you can select to use either primary alumni information or information from another school when including alumni information in a report. Primary alumni information is recorded from the Education button on the Bio 1 tab of an individual constituent record.
As of Date

This field is available in the Membership Category Profile. The date you enter in the As of Date field determines the cut off point for the program to determine activity for the membership categories. For example, if you enter 04/04/2003, the program considers all activity for membership categories satisfying your report criteria from 04/04/2003 and before.

Available Sections

The Available Sections box appears in the Seating Validation Report. In this box, all potential seating validations this report can search for display.

- Groups not seated together: Select this option if you want to see every member of a group not seated at the same higher level item (table/row, unless other is selected in which case a section).
- Guests not seated with registrant host: Select this options if you want to see guests not seated at the same higher level item (table/row, unless other is selected in which case a section) as their registrant host.
- Sponsored participants not seated together: Select this option if you want to see two registrants within a sponsorship list for the same sponsor not seated at the same higher level item (table/row, unless other is selected in which case a section).
- Layout summary: Select this option if you want to see a summary of the layout, with a list of Sections, the Tables/Rows in each Section, and the Number of Seats, Number Assigned, and Number Open for each Table/Row.
- Unseated participants: Select this option if you want a list of all participants who have not yet been seated.
- Seating summary: Select this option to see total participants in an event, total number of seats needed, and the number of seats still available.

Base Analysis On

The Base Analysis On frame is available in some Prospect Research Reports. In this frame, select the dates you want to use to filter information included in your report.

**Note:** For information about proposal records, the Prospect Data Entry Guide.

**Date to use.** Depending on the report type you select, you can select to use the Date asked, Date expected, Date funded. This information is based on the Date asked, Date expected, and Date funded fields on the General tab of the proposal record.

**Date.** In the Date field, you define acceptable date parameters. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the Date asked, Date expected, and Date funded to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all proposal records satisfying your report criteria with the Date asked, Date expected, and Date funded falling between the date range you enter. You can also select <Include all dates>, and the program includes all proposal records satisfying your report criteria, regardless of the Date asked, Date expected, and Date funded.

Base Funding On

**Note:** Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser's Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.
The **Base Funding On** frame is available in some **Prospect Research Reports**. In this frame, you can select to base funding information on the **Proposal** or **Gift summary**.

**Proposal.** If you select **Proposal**, gift amounts are pulled from the Amount funded field on the Proposal record. If you select this option, the Gift Types Tab disappears.

**Gift summary.** If you select **Gift summary**, gift amounts are pulled from the gift Amount field of the gift record linked to the proposal. If you select this option, the Gift Types tab appears. For information about the Gift Types tab, see “Gift Types Tab” on page 213.

**Date funded.** When you select **Gift summary**, the Date funded field is activated. You must select to use the First gift date (the date of the first gift linked to the proposal is reported on) or the Last gift date (the date of the last gift linked to the proposal is reported on).

### Base Report On

**Warning:** If **Campaign** or **Campaign category** is selected in the **Base Report On** frame, gifts without an associated campaign are not included on the report.

Available only in the **VSE Survey Report**, your selection in this frame impacts what you see on some of the other report tabs. Select **Funds**, **Fund categories**, **Campaigns**, or **Campaign categories**. If you select **Funds**, the gifts included are based on the Fund field on the gift record. If you select **Fund categories**, the gifts included are based on the funds from the gift record that fall into a specified fund category. These categories are defined on the original fund record. If you select **Campaigns**, the gifts included are based on the Campaign field on the gift record. If you select **Campaign categories**, the gifts included are based on the campaigns from the gift record that fall into a specified campaign category. These categories are defined on the original campaign record.

### Base Report Processing On

The options in this frame vary, depending on the report you run.

In the **Membership Given By Report**, select who to credit for gifts of membership in your report: the member or the donor. A gift of membership describes a situation in which a constituent is the primary beneficiary of membership benefits, but is not responsible for the membership dues.

**Member.** Select this option if you want the recipient of the membership gift to receive credit for the gift of membership in your report.

**Donor.** Select this option if you want the constituent who gave the membership gift to receive credit for the gift of membership in your report.

In the **Renewal Projection Report**, you can select to include the number of memberships or the number of members in your report. For example, David Murphy renews his Family membership during the membership drive and adds his wife as a Joint Member. You record this information on his membership record. His membership counts only one time if you mark **No. of memberships**, but if you select **No. of members**, two members are counted for this membership record — David and his wife.

**Warning:** The number of members will most likely not be the same as the number of memberships. Remember, one membership can have several members.

**No. of memberships.** Select this option if you want to base your projection on the number of memberships in your database. If you select this option, the program uses the number of actual memberships in your database for a given membership level.

**No. of members.** Select this option if you want to base your projection on the number of members in your database. The program uses the Total number of members on this membership field on the Other Members and Card Information screen of the membership record to calculate the total number of members for a given membership level.
Consecutive Payments Missed as Of

**Note:** Report names, fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in *The Raiser’s Edge* Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the *Configuration & Security Guide*.

In the **Recurring Gift Missed Payment Report**, you can select the number of payments the donor must have missed and as of what date, to filter information included in your report. In the **Date** field, enter the date as of when you want the number of missed payments counted. In the **Minimum number of consecutive payments missed** field, enter the minimum number of recurring gift payments that must be missed before the donor’s information is included in the report.

For example, if you want to see all recurring gifts with at least six missed payments as of today’s date, select Today in the **Date** field and enter 6 in the **Minimum number of consecutive payments missed** field.

**Count Consecutive Years up to this Period**

In this frame, you can specify date to use to filter records included in your report.

**Date to use.** In the **Date to use** field, you can select the Gift date or the GL post date (the date the gift was posted to Blackbaud’s *General Ledger* software). Selecting the Gift date gives you all gifts with dates satisfying the parameters in the **Date** field. Selecting the GL post date gives you all gifts with a general ledger posting date satisfying the parameters in the **Date** field.

**Date.** In the **Date** field, you define acceptable date parameters. For example, if in the **Date to use** field, you select the Gift date, in the **Date** field select the date or date range in which you want the Gift date to fall. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all records satisfying your report criteria with gift dates falling between the date range you enter. There are a number of additional options available in this field: This calendar yr, Last calendar yr, This fiscal yr, Last fiscal yr, etc.

**Counts to Include**

In this frame, you can select how the program counts memberships. This is based on membership record activity at the start of the date range you enter on the Report Periods tab or at the end of the date range you enter on the Reports Periods tab. For example, if the first date range on the Report Periods tab is 08-01-2002 to 08-31-2002 and a member joined in 07-15-2002 and the membership expires 07-15-2003, the start members and end members for the date range on the top of the report are one, but the detail section of the report does not count that membership at all because the activity did not occur within the selected time frame.

**Start memberships.** Select this option to include a **Start** column on your report, showing the number of members or memberships in a particular Program/Category/Subcategory for the start of each specified date range.

**End memberships.** Select this option to include an **End** column on your report, showing the number of members or memberships in a particular Program/Category/Subcategory for the end of each specified date range.

**Both.** Select this option to include a **Start** and **End** column on your report.

**Create Output Query**

**Note:** For more information about saving an output query, see the “Report Basics” on page 105.
In almost all reports, you can choose to create an output query of all records included in the report. An output query saves these records in a query file, and you can use the file in other Raiser’s Edge applications. For example, you are running an Appeal Detail Report. Create an output query containing these names, and later, you can use this query to print mailing labels to send information specific to the constituents included in this report.

**Note:** For more information about queries, see the Query & Export Guide.

To create an output query, mark the Create output query checkbox. In some reports, you must also select a query type (Action, Appeal, Gift, Constituent). Selecting a specific query type instructs the program to use that particular record type in the query. Query types also determine the field categories available to include in a query.

When you select to Print, Preview, or Export the report, the Save Static Query screen appears, asking you to name and describe the output query. It is important you remember the name of your query so you can access it later in Query or other Raiser’s Edge applications.

**Credit Gifts of Membership To**

In this frame, you can select who is credited for gifts of membership in your report. A gift of membership describes a situation in which a constituent is the primary beneficiary of membership benefits, but is not responsible for the membership dues.

**Note:** For more information about gifts of membership, see the Membership Data Entry Guide.

**Member.** Select this option if you want the recipient of the membership gift credited for gifts of membership in your report.

**Donor.** Select this option if you want the constituent who gave the membership gift credited for gifts of membership in your report.

**Credit Matching Gifts To**

**Warning:** If you select Both in the Credit Matching Gifts To frame, the gift appears twice on the report and total gift amounts may not be accurate.

In many reports, you can refine your report criteria using the Credit Matching Gifts To frame. Matching gifts are gifts donated by a business, matching a constituent’s (usually an employee of the business) donation. When you run reports containing gifts, you need to specify how the program should report this information. You can credit the Donor, MG Company, or Both.

**Note:** For more information about matching gifts, see the Matching Gifts chapter in the Gift Records Guide.

**Donor.** When you select Donor, the donor receives credit for the matching gift.

**MG Company.** If you select MG Company, the matching gift company receives credit for the matching gift.

**Both.** When you select Both, both the donor and the matching gift company receive full credit for the matching gift.

**Display Information For**

Available in the Joint Member/Card List Report, in this frame you tell the program what information you want displayed in your report: Joint members, Card recipients, or Both.
Joint member. A joint member is a member in your database covered under a primary membership. You enter joint member information on the Joint Member or Card Recipient screen, accessed from the Members & Cards button on the membership record.

In the Joint Member/Card List Report, if you select this option, the report displays a Membership Information column, displaying information about the primary membership, and a Relationship column, displaying joint membership information associated with the primary membership.

Card recipients. Card recipients are not necessarily constituents in your database. For example, a primary member of a museum may request a card for his baby-sitter, even though she is not a constituent. This way, she can take his children to the museum. You enter card recipient information on the Joint Member or Card Recipient screen, accessed from the Members & Cards button on the Membership record.

Note: For more information about joint members and card recipients, see the Membership Data Entry Guide.

If you select the Joint Member/Card List Report option, the report displays a Membership Information column, displaying information about the primary membership, and a Card Type column listing information about any additional card recipients. It also displays the number of cards to print, how long the card is good, and address information.

Both. If you select this option, both joint member and card recipient information displays in your report.

Event Categories to Include

Note: For more information about event records, see the Event Management chapter in the Event Management Guide.

Available in the Event Profile, in this frame you can select the event categories you want to include in your report: Sporting event, Dinner event, Class, or Other. This information is based on the Category field on the General tab of the event record.

For Calculating Income

Available in some Event Management Reports, you can select how you want income calculated on your report.

Note: For more information about participant records, see the Event Management chapter in the Event Management Guide.

Include registration fees. Mark this checkbox if you want registration fees included in the income calculation. A registration fee is the amount of money your organization charges for a level (or unit) of participation in an event. You enter this information on the Registration Fees tab of participant records.

Include other donations. Mark this checkbox if you want to include in your report donations entered on the Donations tab of the participant record.

Include sponsoring pledges. Mark this checkbox if you want sponsoring pledges included in the income calculation. A sponsoring pledge is a donation made on behalf of a registrant, guest, or sponsor participating in a sporting event. You enter this information on the Sponsoring Pledge tab of participant records.

Group by

In the Group by field, you can select to group information included in your report based on the event “Group” or the “Campaign”. For example, if you select “Group”, expense information is arranged based on each event included in the report. If you select “Campaign”, expense information is arranged based on each campaign associated with the events included in the report.
Include

The **Include** button is available in most reports. From this button, you determine what records you want to include in your report: **All Records** in your database, **Selected Records** you saved in a query file, or **One Record**.

**Note:** To use **Selected Records**, you must have a query of records to include. For information about creating and saving a query, see the Query chapter in the *Query & Export Guide*.

If you choose **Selected Records** or **One Record**, the Open screen appears, and you can locate and select the query file or specific record you want to include.

From this screen you can select, edit, or add a query to use in your reports.

Selecting records using the **Include** button does not necessarily mean all these records are included in your report. These records must satisfy all criteria you select while completing the parameter tabs.

For example, if you select to include **All Records**, but you also choose to not include **Deceased constituents**, all constituent records with the **Deceased?** checkbox marked on the Bio 1 tab are excluded. Or, if on the Filters tab, you choose to include only records linked to the 2003 Annual Fund, any record in your database not connected to this fund is excluded.

Include Actions From

Available in all **Action Reports**, use the **Include Actions from** frame to tell the program which actions you want to include in your report. You can include actions from **Constituents**, **Appeals**, and/or **Events** records. This information is based on the Actions tab included on all three record types.
Include Actions with these Dates

In this frame, you can specify an action date to use to filter records included in your report.

**Note:** For more information about action records, see the Actions chapter in the *Constituent Data Entry Guide*.

**Action Date/Date.** In the *Include Actions with these Dates* frame, in the *Action Date/Date* field, you select the action date on which you want your report based. You can select a date range in which you want the action date to fall. If you select *<Specific range>*, additional fields appear in the frame, allowing you to enter Start and End date information. Then the program includes all action records satisfying your report criteria with action dates falling between the date range you enter. You can also select *<Include all dates>*, and the program includes all action records satisfying your report criteria, regardless of the action date. This is based on the date entered in the *Action date* field on the General tab of the action record.

Include Advocacy Actions with these Dates

In this frame, you can specify a date to use to filter records included in your report.

**Date.** In the *Date* field, you define acceptable date parameters. If you select *<Specific range>*, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all records satisfying your report criteria with the advocacy action date falling between the date range you enter. You can also select *<Include all dates>*, and the program includes all records satisfying your report criteria, regardless of the advocacy action date.

Include *<Appeals, Campaigns, Funds>* with Date Range Containing

**Note:** For more information about the appeals, campaigns, and funds, see the *Campaigns, Funds, & Appeals Data Entry Guide*.

This frame appears in a number of *Analytical Reports*. In the *Date* field, you define acceptable date parameters. You can select the specific date (Today, Yesterday, Tomorrow) or date range in which you want the appeal, campaign, or fund dates to fall to qualify for your report. You can also select *<Include all dates>*, and the program includes all records satisfying your report criteria, regardless of the appeal, campaign, or fund date. Or, you can select a *<Specific date>* and an additional field appears in the frame, allowing you to enter specific date information. Then the program includes all records satisfying your report criteria with an appeal, campaign, or fund date matching the date you enter.

Include Awards with these Dates

In the *Volunteer Awards Report*, you can refine your report criteria by specifying the award date(s) you want the program to consider when generating your report. This information is taken from the *Date* column in the *Awards* category on the Volunteer tab of the constituent record.

On the volunteer report, in the *Volunteer date as of* field, you define the acceptable date parameters. For example, if you select *<Specific range>* , additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all volunteers satisfying your report criteria with an award date falling in the date range you entered. You can also select *<Include all dates>*, and the program includes all volunteers satisfying your report criteria, regardless of the award date.
Include Contributors with these Gift Dates

In this frame, you can specify a gift date to use to filter records included in your report.

**Date to use.** In the Include Contributors with these Gift Dates frame, in the Date to use field, you can select the Gift date or the GL post date (the date the gift was posted to Blackbaud’s General Ledger software). Selecting the Gift date gives you all gifts with dates satisfying the parameters in the Date field. Selecting the GL post date gives you all gifts with a general ledger posting date satisfying the parameters in the Date field.

**Date.** In the Date field, you define acceptable date parameters. For example, if in the Date to use field, you select the Gift date, in the Date field select the date or date range in which you want the Gift date to fall. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all records satisfying your report criteria with gift dates falling between the date range you enter. You can also select <Include all dates>, and the program includes all records satisfying your report criteria, regardless of the gift date.

Include Courses and Training with these Expiration Dates

**Note:** For more information about the Volunteer tab and courses and training information, see the Volunteers & Jobs Data Entry Guide.

In some volunteer reports, you can filter records included in your report based on the expiration dates entered for your volunteer courses and training. This information is entered in the Qualifications category on the Volunteer tab of the constituent record. In your volunteer reports, in the Expiration date to use field, you can select an expiration date. If you select <Specific date>, an additional field appears in the frame, allowing you to enter the date you want used. Then the program includes all volunteers satisfying your report criteria with the specified expiration date in the Courses and Training grid in the Qualifications category on the Volunteer tab of their constituent record. You can also select <Include all dates>, and the program includes all volunteers satisfying your report criteria, regardless of the expiration date.

Include EFTs with these Dates

This frame appears in the EFT Participation Report in Financial Reports. EFT stands for Electronic Funds Transfer and is a general banking system by which transactions, such as deposits or bill payments, are made electronically from a donor’s bank account or credit card to your bank account.

**Note:** For more information about EFTs, see the Electronic Gifts (EFT) Guide.

In the Date field, you define acceptable EFT date parameters. This information is based on the Transaction due on or before field on the Automatically Generate Transactions/Payment screen in the optional module Electronic Funds Transfer. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the EFT date to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all records satisfying your report criteria with EFT dates falling between the date range you enter. You can also select <Include all dates>, and the program includes all records satisfying your report criteria, regardless of the EFT date.
Include Expenses with these Dates

This frame appears in some Analytical Reports. In the Date field, you define acceptable date parameters. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the expense dates to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all records satisfying your report criteria with expense dates falling between the date range you enter. You can also select <Include all dates>, and the program includes all records satisfying your report criteria, regardless of the expense date.

Include Events Starting within these Dates

Note: For more information about the event record, see the Event Management Data Entry Guide.

In this frame, you can specify event date(s) to use to filter records included in your report. In the Include Events Starting within these Dates frame, in the Date to use field, you can define acceptable date parameters. For example, if you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all event records satisfying your report criteria with starting dates falling between the date range you enter. You can also select <Include all dates>, and the program includes all records satisfying your report criteria, regardless of the event starting date. You enter the event start date in the Start date field on the General tab of the event record.

Include Gifts Made After

Note: Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

This frame is available in the Campaign Report and the Cash Flow Report. These reports include gifts made after a certain date. In this frame, in the Date field, you enter the gift date after which you want the report to include gift information. For example, you can select Yesterday, and all gifts with a gift date later than yesterday appear in your report. If you select <Specific date>, an additional field appears in the frame, allowing you to enter a specific Date after which you want gift information. Then the program includes all gifts satisfying your report criteria, with a gift date after the date you enter. You can also select <Include all dates>, and the program includes all gifts satisfying your report criteria, regardless of the gift date. You enter the gift date in the Gift date field on the Gift tab of the gift record.

Include Gifts with these Adjustment Dates

Available in the Adjusted Gift Report, in this frame, you can specify a gift adjustment date to use to filter records included in your report. In the Include Gifts with these Adjustment Dates frame, in the Date field, you define acceptable adjustment date parameters. For example, if in the Date field you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all gift records satisfying your report criteria with adjusted gift dates falling between the date range you enter. You can also select <Include all dates>, and the program includes all records satisfying your report criteria, regardless of the adjusted gift date.

Note: For more information about adjustment dates, see the Adjusting a Gift section of the Gift Records Guide.

Gift adjustment dates are taken from the Adjustment date field of the Adjustment screen. This screen is accessed from the Gift menu in the Gift record.
Include Gifts with these Dates

Note: In Include Gifts with these Dates, leave the Start field blank to indicate all records with dates up to and including the report End date. Leave the End field blank to indicate all records with dates on or after the report Start date.

In this frame, you can specify a gift date to use to filter records included in your report. The fields available in this frame change slightly based on the report you select to run.

Date to use. In the Date to use field, you can select the Gift date or the GL post date (the date the gift was posted to Blackbaud’s General Ledger software). Selecting the Gift date gives you all gifts with dates satisfying the parameters in the Date field. Selecting the GL post date gives you all gifts with a General Ledger posting date satisfying the parameters in the Date field.

Date. In the Date field, you define acceptable date parameters. For example, if in the Date to use field you select the Gift date, in the Date field select the date range in which you want the Gift date to fall. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all records satisfying your report criteria with gift dates falling between the date range you enter. You can also select <Include all dates>, and the program includes all records satisfying your report criteria, regardless of the gift date.

Gifts made after. In the Past Due Report, you can view past due gifts. In the Gifts made after field, enter the gift date after which you are interested in gifts. For example, you can select Last day of this week, and all gifts made after the last day of this week that satisfy the other report criteria you select are included in your report. If you select <Specific date>, an additional field appear in the frame, allowing you to enter a specific Date. Then the program considers all records satisfying your report criteria with gift dates after the date you enter.

Note: For more information about pledge installments, see the Pledges chapter in the Gift Records Guide.

Past due as of. In the Past Due Report, you can view past due gifts. In the Past due as of field, enter the date as of you want all past due gifts. For example, if you want to see all gifts past due as of today, select Today in this field. If you select <Specific date>, an additional field appears in the frame, allowing you to enter a specific Date. Then the program includes all gifts satisfying your report criteria and are past due as of the date you enter. This date information is taken from the Pledge Installment Schedule established on the Installment Payments tab of the gift record.

Include Inactive Appeals

Mark this checkbox to include inactive appeal records. These are appeal records with the Appeal is inactive checkbox marked on the General tab.

Include Inactive Campaigns

Mark this checkbox to include inactive campaign records. These are campaign records with the Campaign is inactive checkbox marked on the General tab.

Include Inactive Events

Mark this checkbox to include inactive event records. These are event records with the Event is inactive checkbox marked on the General tab.
Include Inactive Funds

Mark this checkbox to include inactive fund records. These are fund records with the Fund is inactive checkbox marked on the General tab.

Include Inactive Proposals

Mark this checkbox to include inactive proposal records. These are proposal records with the Proposal is inactive checkbox marked on the General tab.

Include Job Assignments with a Status of

In some volunteer reports, you can refine your report criteria based on the status of the job assignments. Status information is entered in the Status field on the Job Assignment screen.

- **Assigned.** If in your report you want only job assignments with the status of Assigned on the Job Assignment screen, select Assigned.

- **Requested.** If in your report you want only job assignments with the status of Requested on the Job Assignment screen, select Requested. The Requested on field is activated.

- **Requested on.** If you select Requested, enter the Requested on date you want to include in your report. This date must match the date entered in the Requested on field on the Job Assignment screen in order for the job assignment to be included in your report.

Include Job Assignments with these Dates

In the Volunteer Job Assignments Report, you can refine your report criteria by specifying the job assignment date(s) you want the program to consider when generating your report. This information is based on Start date and End date fields on the Job Assignment screen. You access this screen by selecting the Job Assignments category on the Volunteer tab of the constituent record or by selecting the Volunteers tab of the job record.

On the volunteer report, in the Assignment date to use field, you define the acceptable date parameters. For example, if you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all volunteers satisfying your report criteria with job assignment dates falling in the date range you entered. You can also select <Include all dates>, and the program includes all volunteers satisfying your report criteria, regardless of the job assignment date.

Include Jobs with these Start Dates

**Note:** For more information about job records, see the Volunteers & Jobs Data Entry Guide.

In some volunteer reports, you can refine your report criteria by specifying a start date for your jobs. This information is taken from the Start date field on the job record. In the volunteer report, you define acceptable start date parameters in the Date field. For example, if in the Date field you select <Specific range>, additional fields appear in the frame, allowing you to enter the start and end date information. Then the program includes all jobs satisfying your report criteria with the start date following within the date range you entered. You can also select <Include all dates>, and the program includes all jobs satisfying your report criteria, regardless of the start date.
Include Memberships as of

Available in some Membership Reports, in this frame you can choose to include memberships with transactions as of a certain date when filtering records to include in your report. A membership transaction is used to describe the membership activities comprising a membership record. The activities can include adding, renewing, rejoining, upgrading, downgrading, and dropping a membership.

In the Include Memberships as of frame, in the **Date** field, you define acceptable date parameters. For example, if in the **Date** field you select <Specific range>, an additional field appears in the frame, allowing you to enter the date. Then the program includes all membership records satisfying your report criteria with an activity satisfying the selected date. You can also select <Include all dates>, and the program includes all membership records satisfying your report criteria, regardless of activity dates.

Include Memberships Dropped within these Dates

Available in some Membership Reports, in this frame you can choose to filter records included in your report based on the date the membership was dropped. In the Include Memberships Dropped within these Dates frame, in the **Date** field, you define acceptable drop date parameters. For example, if in the **Date** field you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all membership records satisfying your report criteria with drop dates falling between the date range you enter. You can also select <Include all dates>, and the program includes all membership records satisfying your report criteria, regardless of the drop date.

**Note:** For more information about dropped memberships and dates, see the Gift Records Guide.

Drop date information is taken from the **Date dropped** field of the Drop membership screen. This screen is accessed by selecting Membership, Drop from the menu bar of the membership record or by clicking the Drop button on the toolbar.

Include Memberships that are Within these Dates

**Note:** In Include Gifts with these Dates, leave the Start field blank to indicate all records with dates up to and including the report End date. Leave the End field blank to indicate all records with dates on or after the report Start date.

Available in some membership reports, in this frame you can choose to filter records included in your report based on Membership dates or Gift dates. The fields available in this frame vary slightly based on the report type you select.

Date to use. In the **Date to use** field, select Membership dates and the program filters records based on the last transaction date in the membership record. A membership transaction is used to describe the membership activities comprising a membership record. The activities can include adding, renewing, rejoining, upgrading, downgrading, and dropping a membership.

If you select Gift dates, the program filters records based on the **Gift date** of the gift record. Only gifts that meet the specified report criteria are used. This also means that only memberships linked to the associated gifts display in the report.

**Date.** In the **Date** field, you define acceptable transaction date parameters. For example, if in the **Date** field you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all membership records satisfying your report criteria with transaction dates falling between the date range you enter. You can also select <Include all dates>, and the program includes all membership records satisfying your report criteria, regardless of the transaction date. All membership records with any transactions recorded within your date parameters, is included in the report. A membership transaction is used to describe the membership activities comprising a membership record. The activities can include adding, renewing, rejoining, upgrading, downgrading, and dropping a membership.
Include only memberships that are linked to gifts. If you choose to process the report based on membership dates, the Include only memberships that are linked to gifts checkbox appears. Mark this checkbox if you want to process the report for only memberships linked to gifts, even though the processing date you selected is based on the membership dates.

Breakdown by. In the Month/Year Statistical Analysis, use the Breakdown by field to determine how you want information in your report broken down, by Month or Year. In the start and end fields that appear, you must enter a start month and end month if you select Month in the Breakdown by field. You must enter a start year and end year if you select Year in the Breakdown by field.

Start month/year. Enter the month and year from which you want the report to start considering membership records to include in your report. The program considers only membership dates.

End month/year. Enter the month and year from which you want the report to stop considering membership records to include in your report. The program considers only membership dates.

Include Memberships that Expire within these Dates

Available in some Membership Reports, in this frame you can choose to filter records included in your report based date the membership expires. In the Include Memberships that Expire within these Dates frame, in the Date field, you define acceptable expiration date parameters. For example, if in the Date field you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all membership records satisfying your report criteria with expiration dates falling between the date range you enter. You can also select <Include all dates>, and the program includes all membership records satisfying your report criteria, regardless of the expiration date.

Expiration date information is taken from the Expires field on the Membership tab of the membership record.

Include Memberships with these Dates

Available in some Membership Reports, in this frame you can choose to filter records included in your report based on Membership dates or Gift dates. In the Date to use field, select Membership dates and the program filters records based on the last transaction in the membership record. A membership transaction is used to describe the membership activities comprising a membership record. The activities can include adding, renewing, rejoining, upgrading, downgrading, and dropping a membership.

If you select Gift dates, the program filters records based on the Gift date of the gift record. Only gifts that meet the specified report criteria are used. This also means that only memberships linked to the associated gifts display in the report.

If you choose to process the report based on membership dates, the Include only memberships that are linked to gifts checkbox appears. Mark this checkbox if you want to process the report for only memberships linked to gifts, even though the processing date you selected is based on the Membership dates.

After you select a Date to use, select the Report Periods tab and define specific date ranges you want the program to use when filtering membership records to include in the report.
Include Only Active Memberships in ‘Memberships as of’ Count

**Note:** Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in *The Raiser’s Edge* Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the *Configuration & Security Guide*.

When you run a *Membership Statistics by Category* report, you can select to include only active membership records in your count. If you mark this checkbox, the **Memberships prior to** and **Memberships as of** columns count only memberships with a current standing as of the day the report is run.

Include Pledges Made After

In the *Pledge Status Report*, you can view status information about pledges made after a certain date. In the **Include pledges made after** field, enter the specific date after which you want to include pledge information in your report. The program then includes pledge gifts satisfying your report criteria that were made after the date you enter in this field. This is based on the **Pledged on** date entered on the Gift tab of the gift record.

Include Proposals with No Date Asked

**Note:** For more information about the proposal record, see the *Prospect Data Entry Guide*.

In some *Prospect Research Reports*, if you mark the **Include Proposals with no date asked**, your report includes proposals even if the **Date asked** field on the proposal record is blank.

Include Records with these Dates

In this frame, you can choose to filter records included in your report based on dates. Where in *The Raiser’s Edge* this information is based depends on the report you are running. For example, if you are running an *Appeal Profile*, the date information is based on **Start date** and **End date** entered on the General tab of the appeal record.

**Date.** In the **Date** field, you define acceptable date parameters. For example, if in the **Date** field you select **<Specific range>**, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all records satisfying your report criteria with dates falling between the date range you enter. You can also select **<Include all dates>**, and the program includes all records satisfying your report criteria, regardless of the date.

Include Recurring Gifts with these Amendment Dates

**Note:** Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in *The Raiser’s Edge* Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the *Configuration & Security Guide*.

In this frame, you can choose to filter records included in your report based on dates recurring gifts were amended. This information is based on the **Amendment date** entered on the Amendment tab of the Amendment screen. The Amendment screen is accessed from the Amendment tab on the gift record.

**Date to use.** In the **Date to use** field, you can choose to base the report on the Gift date or GL post date. If you select Gift dates, the program uses the gift date of the amended gift record. If you select GL post date, the program uses the date the amendment was posted to your general ledger.
**Date.** In the Date field, you define acceptable amendment date parameters. For example, if in the Date field you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all amendments satisfying your report criteria with amendment dates falling between the date range you enter. You can also select <Include all dates>, and the program includes all amendments satisfying your report criteria, regardless of the amendment date.

Include Scores with these Dates

This frame appears in the Target Analytics Scores List. Target Analytics is a service that uses your Raiser’s Edge data to identify your best charitable giving prospects. The service analyzes historical and current data, as well as behavioral trends. You learn which individuals are your best annual, major, and planned giving prospects now and in the future.

**Note:** For more information about Target Analytics, see the Target Analytics chapter in the Data Enrichment Services Guide.

In the Date field, you define acceptable score date parameters. This information is based on the Date field of the rating records. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the score date to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all records satisfying your report criteria with score dates falling between the date range you enter. You can also select <Include all dates>, and the program includes all records satisfying your report criteria, regardless of the score date.

Include Skills and Experience with Expiration Dates On or Before

**Note:** For more information about the Volunteers tab and skills and experience information, see the Volunteers & Jobs Data Entry Guide.

In some Volunteer Reports, you can filter records included in your report based on the expiration dates entered for your volunteer skills and experience. This information is entered in the Skills and Experience grid of the Qualifications category on the Volunteer tab of the constituent record. In your volunteer reports, in the Expiration date to use field, you can select an expiration date. If you select <Specific date>, an additional field appears in the frame, allowing you to enter the date you want to use. Then the program includes all volunteers satisfying your report criteria with the specified skills and experience expiration date information included in the Skills and Experience grid in the Qualifications category on the Volunteer tab of their constituent record. You can also select <Include all dates>, and the program includes all volunteers satisfying your report criteria, regardless of the Skills and Experience expiration date.

Include these Amendments

You can refine your report criteria using the Include these Amendments frame. In this frame, you can select the type amendment to include or exclude in your report. For an amendment to be included in the report, it must satisfy all selected criteria.

**Note:** If in the Include button, you selected to include One Record in your report, all checkboxes in the Include these Constituents frame are disabled.

**Upgrade.** To include amendments that increased the original recurring gift amount.

**Downgrade.** To include amendments that decreased the original recurring gift amount.

**Same.** To include amendments that did not change the original recurring gift amount.
Include these Constituents

You can refine your report criteria using the **Include these Constituents** frame. In this frame, you can select the constituent records to include or exclude in your report. For a constituent to be included in the report, he must satisfy all selected criteria.

**Note:** If in the Include button, you selected to include One Record in your report, all checkboxes in the **Include these Constituents** frame are disabled.

**Inactive constituents.** To include constituents with the Is inactive checkbox marked on the Bio 1 tab of their constituent record, mark *inactive constituents.*

**Deceased constituents.** To include constituents with the Deceased? checkbox marked on the Bio 1 tab of their constituent record, mark the *Deceased constituents* checkbox. You may want to include deceased constituents in the report if the constituent’s spouse is still interested in your organization but does not have a constituent record.

**Constituents with no valid address.** To include constituents with the Has no valid addresses checkbox marked on the Bio 1 tab of their constituent record, mark the *Constituents with no valid addresses* checkbox.

Include these Memberships

In some reports, you can refine your report criteria using the **Include these Memberships** frame. In this frame, you can select the membership records to include or exclude in your report.

**Note:** For more information about membership records, see the *Membership Data Entry Guide*.

**Lapsed memberships.** To include membership records that lapsed, mark this checkbox. A lapsed membership standing means the constituent failed to renew a membership before the Expires on date in the membership record. The membership remains lapsed until you upgrade, downgrade, renew, or drop it.

**Dropped memberships.** To include dropped membership records, mark this checkbox. When a member informs you she no longer wants to be a member of your organization, you can change the membership standing to Dropped. Dropping a membership allows you to keep a record of her past membership activity but not longer includes her as an active member. You cannot renew a dropped member. You must rejoin dropped members.

Include these Participants Only

Available in some **Event Reports**, you can select the event participants you want to include in your report, using this frame. A participant can be a registrant, guest, or sponsor. All your volunteers, vendors, speakers, coordinators, and instructors are also considered participants.

**Note:** For more information about participant records, see Adding Participants section of the *Event Management Data Entry Guide*.

**Invited Participant as of.** If you mark this checkbox, you want to include only participants with Invited selected in the Invited? field on the General tab of the participant record. You can further refine your report criteria by entering date information in the field next to the Invited Participant as of checkbox. If you do not want to restrict records based on the date, select Include all dates. If you select <Specific date> the Date field appears. Enter the specific date you want to use.
Registered Participants as of. If you mark this checkbox, you want to include only participants with Registered selected in the Registration field on the General tab of the participant record. You can further refine your report criteria by entering date information in the field next to the Registered Participants as of checkbox. If you do not want to restrict records based on the date, select Include all dates. If you select <Specific date> the Date field appears. Enter the specific date you want to use.

Participants who have attended. If you mark this checkbox, you want to include only participants with the Participant has attended checkbox marked on the bottom of the participant record.

Include these Tributes

Available in some Tribute Reports, you can select the tributes you want to include in your report, using this frame. You enter tribute information on the Honor/Memorial tab of a constituent record.

Note: For more information about tributes, see the Tribute Data Entry Guide.

Gifts may be given to this tribute. Mark this checkbox if you want to include tribute records to which gifts are being accepted. The Gifts may be given to this tribute checkbox must be marked on the tribute record.

Gifts may not be given to this tribute. Mark this checkbox if you want to include tribute records to which gifts are not being accepted. The Gifts may be given to this tribute checkbox must be unmarked on the tribute record.

Include Tributes with no Gift Activity

Note: Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

In some tribute reports, you can include tributes that have received no gifts, by marking the Include tributes with no gift activity checkbox.

Include Volunteers with these Dates

In the Time Sheet Report, you can refine your report criteria by specifying the date(s) you want the program to consider when generating your report. This information is taken from the Date field of the Time Sheet screen. This screen is accessed by selecting the Time Sheets category on the Volunteer tab of the constituent record.

On the volunteer report, in the Volunteer date as of field, you define the acceptable date parameters. For example, if you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all volunteers satisfying your report criteria with a time sheet date falling in the date range you entered. You can also select <Include all dates>, and the program includes all volunteers satisfying your report criteria, regardless of the date on their time sheet.

Include Volunteers with These Start Dates

In some volunteer reports, you can refine your report criteria by specifying a start date for your volunteers. This information is taken from the Start Date column in the General category on the Volunteer tab of the constituent record. In the volunteer report, you define acceptable start date parameters in the Date field. For example, if in the Date field you select <Specific date>, an additional field appears in the frame, allowing you to enter the specific date. Then the program includes all volunteers satisfying your report criteria with the start date you entered. You can also select <Include all dates>, and the program includes all volunteers satisfying your report criteria, regardless of their start date.
Include Volunteers with these Total Hours

In the Volunteer Summary, you can refine your report criteria by specifying the total number of hours a volunteer must work. This information is taken from the Summary category on the Volunteer tab of the constituent record.

In the Total hours between fields enter the range of hours you want to include in your report. Volunteers are included on the report if their total hours fall within the selected range. If you leave the Total hours between fields blank, volunteers with at least one value recorded on any of the fields on the Summary category of the Volunteer tab are included.

Include Write-Offs Within These Dates

In the Written-Off Report, you can view all pledge gifts written off within a given time period. In this frame, you establish that time period.

Date to use. In the Date to use field, you can choose to base the report on the Gift date or GL post date. If you select Gift dates, the program uses the gift date of the write-off from the gift record. If you select GL post date, the program uses the date the write-off was posted to your general ledger.

Note: For more information about write-offs, see Pledges chapter of the Gift Records Guide.

Date. In the Date field, you define acceptable write-off date parameters. For example, if in the Date field you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Then the program includes all write-offs satisfying your report criteria with write-off dates falling between the date range you enter. You can also select <Include all dates>, and the program includes all write-offs satisfying your report criteria, regardless of the write-off date. The write-off date is based on the Date field on the Write Off screen.

Lapsed on or Before

Available in some Membership Reports, in this frame you can choose to filter records included in your report based on date the membership lapses. In the Lapsed on or before frame, in the Date field, you define acceptable lapse date parameters. For example, if in the Date field you select <Specific range>, an additional Date field appears in the frame, allowing you to enter the date. Then the program includes all membership records satisfying your report criteria that lapsed on or before this date. You can also select <Include all dates>, and the program includes all membership records satisfying your report criteria, regardless of when they lapsed.

Note: For more information about lapsed dates, see the Gift Records Guide.

Lapsed date information is taken from the Expires field on the Membership tab of the membership record.

Location Filter(s) Frame

Available in the MatchFinder Organization Summary, in this frame you can choose to filter MatchFinder records based on City, State, and Zip Code.

When selecting filtering information, you establish a set of conditions each record must meet before the record is included in your report. You establish these requirements using the criteria operators included in the drop-down menu accessed in each field.
You can use criteria operators to filter for specific records. For example, if you want to include all MatchFinder constituents located in Cleveland, OH, you can use the “equals” criteria operator in the City and State fields. After you select an operator, additional fields appear, allowing you to enter the specific City and State information.

The following criteria operators are available:

**Equals.** When you choose this operator, the records selected in your report must have the exact entry you define.

**Does Not Equal.** When you choose “does not equal” as your operator, the records selected for your report must not match the entry you define.

**Greater Than.** If you select “greater than” as your operator, the records selected must have a value greater than the one you define.

**Greater Than or Equal To.** Selecting “greater than or equal to” as your operator limits the records selected to those with a value greater than or equal to the one you define.

**Less Than.** When you select “less than” as your operator, you limit the records selected to those with an entry less than the value you define.

**Less Than or Equal To.** When “less than or equal to” is selected as an operator, the records selected must have an entry less than or equal to the value you define.

**One Of.** Choosing “one of” as the operator means that records selected must have at least one of the entries you define. The “one of” operator acts as an “or” between the entries you select.

**Not One Of.** Choosing “not one of” as the operator means that records selected must not contain any of the entries you define.

**Between.** When you choose “between” as the operator, the records selected must fall within the range you define. This criteria operator is inclusive.

**Not Between.** If this operator is selected, the records included in your report must not fall within the range you specify. This operator is exclusive.

*Note:* The “blank” operator is helpful if you want to see which records have empty fields.

**Blank.** If you select “blank” as the operator, the records selected for your query must have a blank in the field you specify. For example, if you choose Constituent ID is “blank”, the program selects records with an empty Constituent ID field.

**Is Not Blank.** When “is not blank” is selected as the operator, the selected records must have an entry in the field you specify.

**Contains.** Choosing “contains” as the operator selects records containing the defined value anywhere in the field.

**Does Not Contain.** Choosing “does not contain” as the operator selects records that do not have the defined entry anywhere in the field you specify.

**Begins With.** Selecting “begins with” as the operator means that records selected must have an entry beginning with the value you define.

**Does Not Begin With.** When you choose “does not begin with” as the operator, the records selected must not have an entry beginning with the value you define.
**Like.** The “like” operator allows you to use wildcard characters to replace a character or a set of characters in a field. This operator and the wildcard characters are particularly useful when you are not sure of the spelling or if you suspect something might be misspelled.

**Not Like.** The “not like” operator selects the records that are not spelled like the entry you define. You can use wildcard characters with this operator.

**Note:** The “sounds like” operator is available only for text fields.

**Sounds Like.** The “sounds like” operator can be used when you want to select records based on a field for which you do not have the exact spelling. You can also use wildcard characters with this operator.

**Membership Categories/Include these Membership Categories**

**Note:** On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

In the **Membership Category Profile**, you can view detailed information about membership categories in your database. Membership category defines the level of giving required for a constituent to gain membership into one of your membership groups or clubs. Membership categories can be linked to a specific membership program.

In the **Membership Categories** box of the **Membership Category Profile**, you must select the categories you want to include in your report. To include a category, select it and click the single right arrow to move it into the **Include these Membership Categories** box.

**Pledge Type**

Available in some reports, in this field select the pledge type you want included in your report: Master or Installment.

**Note:** For more information about pledges, see the Pledges chapter in the *Gift Records Guide*.

A master pledge is a gift record containing the gift amount a constituent agrees to donate and the installment schedule for the pledge payments. An installment is a scheduled payment that reduces the balance of a master pledge. This information is based on the Pledge Installment Schedule screen. You access this screen from the **Schedule** button of a gift record. The **Schedule** button appears if you are creating a Pledge **Gift type**.

**Print Each Section on a Separate Page**

The **Print each section on a separate page** checkbox appears in the **Seating Validation Report**. Mark this checkbox if you want information from each section you included in the **Selected Section** box to appear on a separate page in your report. For example, if you selected to include Groups not seated together and Sponsored participants not seated together, the Groups not seated together seating issues print on one page of the report and the Sponsored participants not seated together issues print on another page, even if there is enough room on one page for all issues.

**Projected Renewal Targets**

In this frame enter what you predict your member and membership renewal rate will be in the various giving levels: **High**, **Medium**, and **Low**.
Process the Report Using the Rules For

Available only in the VSE Survey Report, you select the survey rules you want used for this report in the Process the Report Using the Rules For frame. The rules differ depending on whether you run it for an elementary or secondary school, or for a college. Select either Private Elementary and Secondary School or College. Options on other sections of the report vary based on your selection. For example, there is a different list of VSE Sources, and Funds for Current Operations. Also, you see only the Section IV Part 3 tab if you select College.

Report Types

The options available in this frame vary, based on the report type you run.

Comparison. In the Comparisons and Summaries Report, if you select Comparison, the program generates summaries for two or more report periods and also shows the variance of difference between the periods as a percentage or a dollar amount.

Both. The function of the Both option varies based on report type.

- In most reports, if you select Both, the program generates two reports. One with name and address information and the other without name and address information.
- In the Registration Fees Due Report, if you select Both, you get a copy of both the detail report based on participant registration fees due and the summary report based sponsor total gift and receipt amounts.

Detail. The function of the Detail option varies between reports.

- In many reports, if you select Detail (default), the Ind. Address and/or Org. Address tabs appear, as does the Name formats category on the Format tab. You can then include addressee/salutation and address information on the report. On the address tabs, you can choose to include address, phone, address and phone, or no address or phone information. For a detailed explanation of the tabs, see “Ind. Address Tab” on page 223 or “Org. Address Tab” on page 226. In the Name formats category on the Format tab, you can choose the addressees and salutations you want used with constituent names in your report. For a detailed explanation of this category, see “Name Formats” on page 183.
- In the Registration Fees Due Report, if you select Detail, the report is based on participant registration fees due. It displays Sponsor Guest of, Participation, Registration, Gift Amount, Receipt Amount, Amount Paid, and Amount Due information. It also tells you if the registrant attended the event.

Summary. The function of the Summary option varies between reports.

- In most reports, if you select Summary, the Ind. Address and Org. Address tabs, and the Name Formats category on the Format tab are not available. Address information and the constituent names are not included in the report.
- In the Comparisons and Summaries, if you select Summary, the program generates summaries for up to five report periods. Constituent names do not appear on these reports.
- In the Registration Fees Due Report, if you select Summary by sponsor, the program generates total gift and receipt amounts for sponsors of the event. It also displays the total amount paid and the total amount due for each sponsor.

Report On

Available on some Event Reports, in the Report on field select what you want to report on, Events, Campaigns, Reporting Hierarchy, or Groups. If you select Events, Reporting Hierarchy, or Campaigns, in the next field, you must enter the event, report hierarchy, or campaign you want the report based on. You can click the binoculars to access the Open screen and search for an event or campaign in your database.
You can also base the report on a group. You establish groups on the General tab of the event record. A group specifies a series of related events. For example, your organization holds three training classes for new volunteers during the summer. Although each training class has a unique name, you group the three classes together with the common name, “Summer Volunteer Training.” If you want to base your report on this group, select Group in the Report on field and in the next field, select Summer Volunteer Training.

Report On Event

Available on some Event Management Reports, in the Report on Event field select which event you want to report on. You can click the binoculars to access the Open screen and search for an event in your database.

Report Only on Group

Note: For more information about the event records, see the Event Management Data Entry Guide.

Available on some Event Management Reports, mark the Report Only on Group checkbox to base your report on a group. You establish groups on the General tab of the event record. A group specifies a series of related events. For example, your organization holds three training classes for new volunteers during the summer. Although each training class has a unique name, you group the three classes together with the common name, “Summer Volunteer Training.” If you want to base your report on this group, select Summer Volunteer Training in the field next to the Report Only on Group checkbox. You must mark the checkbox to activate the field.

Selected Sections

The Selected Sections box appears in the Seating Validation Report. In this box, move, using the arrow buttons, all seating validations you want to include in your report. All available validations are listed in the Available Sections box.

• Groups not seated together: Select this option if you want to see every member of a group not seated at the same higher level item (table/row, unless other is selected in which case a section).

Note: Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

• Guests not seated with registrant host: Select this options if you want to see guests not seated at the same higher level item (table/row, unless other is selected in which case a section) as their registrant host.

• Sponsored participants not seated together: Select this option if you want to see two registrants within a sponsorship list for the same sponsor not seated at the same higher level item (table/row, unless other is selected in which case a section).

• Layout summary: Select this option if you want to see a summary of the layout, with a list of Sections, the Tables/Rows in each Section, and the Number of Seats, Number Assigned, and Number Open for each Table/Row.

• Unseated participants: Select this option if you want a list of all participants who have not yet been seated.

• Seating summary: Select this option to see total participants in an event, total number of seats needed, and the number of seats still available.
Soft Credit Gifts To

**Note:** For more information about soft crediting gifts, see the Gift Records Guide.

In almost all reports, you can refine your report criteria using the **Soft Credit Gifts To** frame. When you add a new gift, you use soft credits to credit multiple constituents for the same gift without duplicating the gift in your database. When you run a report containing gifts, you need to specify how the program should report this information. You can credit the **Donor**, **Soft credit recipients**, or **Both**.

**Donor.** If you select **Donor**, the donor receives full credit for the gift, and the soft credit recipients receive no credit for the gift. When you select this option, soft credit recipients entered on the Soft Credit tab of the gift record do not receive credit for the gift in the report.

**Soft credit recipients.** If you want to select how gift amounts are divided between soft credit recipients, mark **Soft credit recipients**. You can then select **Use distribution on gift**, **Full amount to all**, or **Split evenly**.

- If you select **Use distribution on gift**, soft credit recipients are credited with the amount specified on the Soft Credit tab of the gift record.
- If you select **Full amount to all**, each soft credit recipient receives credit for the full amount of the gift.
- If you select **Split evenly**, the full amount of the gift is divided evenly between the soft credit recipients. When you select the **Soft credit recipients** option, the donor does not receive credit for the gifts unless he is also a soft credit recipient.

**Warning:** If you select **Both** in the **Soft Credit Gifts to** frame, the gift appears twice on the report and total gift amounts may not be accurate.

**Both.** When you select **Both**, you can determine how the gift amount is divided between the donor and the soft credit recipients in your report. You can select **Use distribution on gift**, **Full amount to all**, or **Split evenly**.

- If you select **Use distribution on gift**, the donor receives full credit for the gift and the soft credit recipients are credited with the amount specified on the Soft Credit tab of the gift record.
- If you select **Full amount to all**, the donor and each soft credit recipient receive full credit for the gift.
- If you select **Split evenly**, the amount of the gift is divided evenly between the donor and the soft credit recipients. If the donor is also a soft credit recipient, the donor is credited for the gift only once.

**Sort Order**

In the **MatchFinder Organization Summary** you can select how you want information included in the report sorted: ascending alphabetical order or descending alphabetical order. For example, if in the **Sort Report by** field, you select “Company name” and in the **Sort order** field you select “Ascending” the report displays matching gift company information in ascending alphabetical order based on the matching gift companies name.

**Sort Report by**

In the **MatchFinder Organization Summary** you can select how you want information included in the report sorted. For example, you can sort information based on the company name or the industry associated with the matching gift company.
Gift Types Tab

**Note:** The Gift Types tab name may vary if your organization changed the word “Gift” in *The Raiser's Edge* Business Rules. For example, if “Gifts” was changed to “Fees”, the tab reads “Fee Types”. For more information about changing the default word “Gift”, see the Configuration chapter in the *Configuration & Security Guide*.

In several report parameter files, on the Gift Types tab, you must select the gift types you want to include in your report. In *The Raiser's Edge*, gifts can be classified as Cash, Pledge, Gift-in-Kind, Stock/Property, Other, and Recurring Gift. The gift types, checkboxes, and fields available on this tab vary, based on the report type you run.

To choose the gift types to include in the report, highlight a gift type in the Gift Types box and click the right arrow to move it to the Include these Gift Types box. By default, the program automatically includes the most common gift types in the Include these Gift Types box. Using the single and double arrows, you can move gift types in and out of Include these Gift Types box. If you want to return to the program defaults, click the Load All Defaults button. The gift types available vary, depending on the report you are running.

Some report types include the Report column field on the Gift Types tab. Use this field to select the gifts to print in each column of the report. For example, you want to include pledge information in your Alumni Class Analysis. In the Report column, select the column in which you want this information to appear in (Column 2). In the Column name field, enter “Pledge” (or whatever you want to title this column). Then, using the Gift Types and Include these Gift Types boxes, select the gift information you want to appear in this column (Pledge, MG Pledge). When you run your report, your second column reads Pledge and includes pledge and matching gift pledge information included on the Gifts tab of the constituent record.

The Other Gifts Report in Financial Reports includes the Column name field at the top of the Gift Types tab. Use this field to enter the column name you want to appear on your report for your gifts. The program defaults to “Gift Value”. This column displays the dollar value of the gifts included in the report.

**Note:** For more information about gift types, see the Understanding Gift Types section of the *Gift Records Guide*.

To choose the gift types to include in the report, highlight a gift type in the Gift Types box and click the right arrow to move it to the Include these Gift Types box. By default, the program automatically includes the most common gift types in the Include these Gift Types box. Using the single and double arrows, you can move gift types in and out of Include these Gift Types box. If you want to return to the program defaults, click the Load All Defaults button. The gift types available vary, depending on the report you are running.

Some report types include the Report column field on the Gift Types tab. Use this field to select the gifts to print in each column of the report. For example, you want to include pledge information in your Alumni Class Analysis. In the Report column, select the column in which you want this information to appear in (Column 2). In the Column name field, enter “Pledge” (or whatever you want to title this column). Then, using the Gift Types and Include these Gift Types boxes, select the gift information you want to appear in this column (Pledge, MG Pledge). When you run your report, your second column reads Pledge and includes pledge and matching gift pledge information included on the Gifts tab of the constituent record.

The Other Gifts Report in Financial Reports includes the Column name field at the top of the Gift Types tab. Use this field to enter the column name you want to appear on your report for your gifts. The program defaults to “Gift Value”. This column displays the dollar value of the gifts included in the report.

**Note:** Any gift type listed with the word “Pay” in front, has been applied to pledges.
The **Comparison and Summaries Report** in **Demographic and Statistical Reports** includes the **Report period** field at the top of the Gift Types tab. Use this field to identify the report period for which you are selecting gift information. This report can compare and summarize two or more periods. The **Report period** you select corresponds to the report period defined on the Report Periods tab. For example, on the Gift Types tab, you select Period 1 in the **Report period** field, and on the Report Period tab, the first period defined is 01/01/2003 to 12/31/2003 and the **Heading 1** title is First Fiscal Year. The gift types you select on the Gift Types tab will be for the first report period defined on the Report Period tab, and the **Heading 1** title from the Report Periods tab, appears in the **Period Name** field at the top of the Gift Types tab.

The Gift Types tab also includes the following checkboxes. Not all of the checkboxes listed below appear on all Gift Types tabs. They vary based on the report type you run.

### Gift Types

**Cash.** A Cash gift is a gift paid by any form of cash including currency, personal or business check, credit card, and direct debit. For example, if a constituent donates $50 using her credit card, classify this gift as Cash. You can record the type of cash received in the **Pay method** field on the Gift tab of a gift record.

**Note:** A pledge gift record is sometimes called a master pledge.

**Pledge.** A Pledge is a promise to make a future donation and can be paid in single or multiple payments, called installments. For example, a constituent may pledge to give your organization $100. Later in the month, the constituent sends a check for $100 to pay the pledge. This pledge was paid in one payment, or installment.

**Note:** When you select Pledge in the **Gift Type** field on a gift record, the Installments/Payments tab appears on the gift record.

When you create a gift record for a pledge, you should define a payment schedule on the Installments/Payments tab of the gift record. When you receive a pledge payment from the constituent, you must create a separate gift record for the pledge payment and apply the payment toward the pledge to reduce the balance. Gift records of all gift types, except pledge, can be applied toward a pledge to reduce the balance. For example, a constituent may pay $100 pledge with a Gift-in-Kind of a computer printer valued at $100.

**Stock/Property.** When a constituent donates stock or property, such as land, estate, or stock certificates, you can classify the gift as Stock/Property. When you receive a stock/property gift, your organization may choose to keep the gift or sell the stock/property to benefit the goals of your organization. When recording the value of a stock/property gift, you should enter the gift’s value as of the date it is transferred to your organization. If you decide to sell the stock/property gift, you can use the **Sell Stock/Property** option to record the sale amount.

**Gift-in-Kind.** A Gift-in-Kind is a donation of goods or services for which you can easily assign a monetary value. Some examples of Gifts-in-Kind include furniture, computer equipment, and time donated by an accountant. When you add a gift record for a Gift-in-Kind, you can record an estimate of the value of the gift.

**Other.** Other gifts are miscellaneous donations that do not fall under one of the previous gift types. You may want to classify legacy or insurance gifts as Other gifts.

**Recurring Gift.** A Recurring Gift is a template used to create cash gift records at regular intervals. For example, a constituent may agree to donate $20 to your organization from his paycheck until he retires. Recurring gifts can occur for a specified or unspecified length of time. When scheduling a recurring gift, you do not need to specify the date the constituent plans to end the gift. After the constituent retires and stops sending gifts, you can edit the gift record and enter the end date for the recurring gift.
Available Gift Types

**Note:** Remember, for a gift to be included in the report, the date on the gift record must also fall within the date range you define on the General tab of the report parameter.

The following list explains the gift types processed based on the gift type selected in the Include these Gift Types box. The gift types available vary based on the report you run. For example, the All Write Offs gift types are not an option in the Annual Statement Report; however, the gift types are available in the Account Distribution Report.

### All Cash
- **Cash:** Any gift entered with a gift type of “cash” not applied to a pledge or recurring gift.
- **Pay-Cash:** Any cash gift applied to a gift with a gift type of “pledge”.
- **MG Pay-Cash:** Any cash gift applied to a gift with a gift type of “matching gift pledge”.

**Note:** Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

- **Recurring Gift Pay-Cash:** Any cash gift applied to a gift with a gift type of “recurring gift”.

### All Gifts-In-Kind
- **Gift-In-Kind:** Any gift entered with a gift type of “Gift-in-Kind” not applied to a pledge.
- **Pay-Gift-In-Kind:** Any gift-in-kind applied to a gift with a gift type of “pledge”.
- **MG Pay-Gift-In-Kind:** Any gift-in-kind applied to a gift with a gift type of “matching gift pledge”.

### All Others
- **Other:** Any gift entered with a gift type of “Other” not applied to a pledge.
- **Pay-Other:** Any other gift applied to a gift with a gift type of “pledge”.
- **MG Pay-Other:** Any other gift applied to a gift with a gift type of “matching gift pledge”.

### All Planned Gifts
- **Planned Gift:** Any gift entered with a gift type of “Planned Gift”.

### All Pledges
- **Pledge:** Any gift entered with a gift type of “Pledge”.
- **MG Pledge:** Any gift entered with a gift type of “matching gift pledge”.

**Note:** Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.
All Stocks

- **Stock/Property**: Any gift entered with a gift type of “Stock/Property”, and there is no sale information entered related to the stock/property.

- **Stock/Property Sold**: Any gift entered with the original gift type of “Stock/Property”, and there is sale information entered related to the stock/property. Also, if you want the report to use the date the stock was sold as the gift date, mark the **Use sale date for sold stock/property** checkbox at the bottom of the screen. If the sale date does not fall within the date range you entered on the General tab, the gift is not included in your report. If you want stock and property gifts reported based on the worth of the stock and property at the time of the sale instead of at the time your organization acquired the gifts, mark the **Use sale amount for sold stock/property** checkbox. Also, marking this checkbox enables the **Subtract broker fee from sold stock/property** checkbox.

- **Pay-Stock/Property**: Any stock or property gift not sold and applied to a gift with a gift type of “Pledge”.

- **MG Pay-Stock/Property**: An stork or property gift not sold and applied to a gift with a gift type of “Matching Gift Pledge”.

- **Pay-Stock/Property (Sold)**: Any stock or property gift sold and applied to a gift with a gift type of “Pledge”. Also, if you want the report to use the date the stock/property was sold as the gift date, mark the **Use sale date for sold stock/property** checkbox at the bottom of the screen. If the sale date does not fall within the date range you entered on the General tab, the gift is not included in your report. If you want stock and property gifts reported based on the worth of the stock and property at the time of the sale instead of at the time your organization acquired the gifts, mark the **Use sale amount for sold stock/property** checkbox. Also, marking this checkbox enables the **Subtract broker fee from sold stock/property** checkbox.

- **MG Pay-Stock/Property (Sold)**: Any stock or property gift sold and applied to a gift with a gift type of “Matching Gift Pledge”. Also, if you want the report to use the date the stock/property was sold as the gift date, mark the **Use sale date for sold stock/property** checkbox at the bottom of the screen. If the sale date does not fall within the date range you entered on the General tab, the gift is not included in your report. If you want stock and property gifts reported based on the worth of the stock and property at the time of the sale instead of at the time your organization acquired the gifts, mark the **Use sale amount for sold stock/property** checkbox. Also, marking this checkbox enables the **Subtract broker fee from sold stock/property** checkbox.

All Write Offs

- **Write Off**: Any write off applied to a gift with a gift type of “Pledge”.

- **MG Write Off**: Any write off applied to a gift with a gift type of “matching gift pledge”.

Options on the Gift Types Tab

**Recurring Gift**: A Recurring Gift is a template used to create cash gift records at regular intervals. For example, a constituent may agree to donate $20 to your organization from his paycheck until he retires. Recurring gifts can occur for a specified or unspecified length of time. When scheduling a recurring gift, you do not need to specify the date the constituent plans to end the gift. After the constituent retires and stops sending gifts, you can edit the gift record and enter the end date for the recurring gift.

**Exclude zero amount gifts**: If you do not want the report to include gifts entered or adjusted to zero, mark the **Exclude zero amount gifts** checkbox.

**Use sale date for sold stock/property**: If you want the report to use the date the stock was sold as the gift date, mark the **Use sale date for sold stock/property** checkbox. If the sale date does not fall within the date range you entered on the General tab, the gift is not included in your report.

**Use sale amount for sold stock/property**: If you want stock and property gifts reported based on the worth of the stock and property at the time of the sale instead of at the time your organization acquired the gifts, mark the **Use sale amount for sold stock/property** checkbox. Also, marking this checkbox enables the **Subtract broker fee from sold stock/property** checkbox.
**Subtract broker fee from sold stock/property.** If you want the report to calculate the gift amount of sold stock and property gifts minus broker fees, mark the *Subtract broker fee from sold stock/property* checkbox. The checkbox is enabled only when the *Use sale amount for sold stock/property* checkbox (above) is marked.

**Use gift balance instead of gift amount.** If on your report, you want to see the balance remaining for gifts, make sure *Recurring Gift* is in the *Include these Gift Types* box and mark *Use gift balance instead of gift amount*.

**Calculate gift balance based on selected date range, campaign, fund and appeal.** If you want the report to base the balance of a pledge on the date criteria selected on the General tab and criteria selected on the Filters tab, mark the *Calculate gift balance based on selected date range, campaign, fund and appeal* checkbox.

For example, Erin Kelly pledges $100 to the Annual Campaign. When she makes the payment, she decides she now wants to give to the Campaign for Excellence. She makes her $100 payment to the Campaign for Excellence, bringing her actual balance down to $0. If you run a report with *Calculate gift balance based on date range, campaign, fund, and appeal* marked and you select the Annual Campaign as the filter, the report shows Erin Kelly with an outstanding balance of $100.

Also, if she paid her $100 to the Annual Campaign as planned but her payment arrived outside the date range you select for the report, a balance appears on the report.

### Graph Tab

Many reports include a Graph tab. Use the Graph tab to view report results in a bar or pie graph format. A graph may prove more user-friendly, helping volunteers and board members understand complicated data. When printing a report, you can select to print only the report, only the graph, or both the report and the graph.

You create your graph in selections: *Graph type*, *Data source*, *Detail*, and *Location*. All four sections are addressed in detail in this section. Also, while you work on the Graph tab, designing your report graph, a sample graph appears to the right side of the screen. This sample shows you how the graph will look on the report, based on your selections on this tab.
Graph Type

In the Graph type category, you must choose if you want to include a graph with your report. The program defaults to Report only. To activate the graph options in this category and the other category options, you must select either Graph only or Report and graph. You can then select the type of graph you want to include with your report.

- **Report only.** Select this option if you want to print only your report data and no graph. The program defaults to this option.
- **Graph only.** Select this option if you want to print only a graph representing your report data.
- **Report and graph.** Select this option if you want to print both a graph representing your report data and a copy of the report.

**Available graph types.** In this box, you can choose to have your report data presented in a Bar graph format or a Pie graph format.

**Graph type options.** This box displays a sample of your graph, based on your selections so far.
Data Source

In the **Data source** category, you tell the program what data from your report you want included in your graph.

**Columns to Include.** In this box, you must select the columns from your report that you want represented on your graph. The **Columns to Include** box lists all the columns available for the selected report. Unmark the checkbox next to any column you do not want to include in the graph.
In **Detail**, you can enter title information for your graph, name the graph axis, choose to include a legend, and more.

**Chart title.** In this field, enter a title you want to appear at the top of your graph.

**Subtitle.** In this field, enter a subtitle you want to appear under the **Chart title** in your graph.

**X-axis title.** The x-axis of your report is the bottom axis. If you want to title this axis, enter the title in this field.

For example, if appeal information is displayed on the x-axis, you may want to title it “Appeals”, so readers of your graph know what they are looking at.

**Y-axis.** The y-axis of your report is the left side axis. If you want to title this axis, enter the title in this field.

For example, if year information is displayed on the y-axis, you may want to title it “Years”, so readers of your graph know what they are looking at.

**Show legend.** To include a legend in your report, defining what each color represents, mark this checkbox. The legend box appears in the upper right corner of your report.

**Show data values.** To include values, such as dollar amounts, reflecting what each colored section of your graph represents, mark this checkbox. If you do not mark this checkbox, the color-coded graph appears, with no values.

**Show grid lines.** If you want to include network of uniformly spaced horizontal and perpendicular lines in to locate points on the graph, mark this checkbox.
Location

In the **Location** category, if you select to print the report and graph, you can tell the program where in the report you want the graph included.

In the **Location** field, select Bottom and the graph prints at the bottom of the last page of your report, select Top and the graph prints at the top of the first page of your report, or select Separate page and the graph prints on a separate page from your report.
Income Calculation Tab

Only the event report Event Summary Report uses the Income Calculation tab. On this tab you can calculate income from an event to include on your report. You can select the participants and types of income from the event to include.

For Calculating Income, Include these Participants Only

You select to include or exclude participant income based on information in the event record, using the checkboxes available in the For Calculating Income, Include these Participants Only frame.

Note: For more information about participant records, see Adding Participants section of the Event Management Data Entry Guide.

Invited participants as of. To include all invited participants as of a certain date, mark the Invited participants as of checkbox. This information is based on the Invite? and accompanying date fields on the General tab of the participant record. If you mark the Invited participants as of checkbox, the date field is activated and you must enter an “as of” date. You can select to include all dates or a specific date. If you select “<Specific date>”, a Date field appears, so you can enter a specific date. You can also select from a list of dates, such as “Yesterday” or “Last day of”. All date information is based on the date field next the Invite? field on the General tab of the participant record. If this checkbox is not marked, the Invite? field is ignored.

Registered participants as of. To include all registered participants as of a certain date, mark the Registered participants as of checkbox. This information is based on the Registration and accompanying date fields on the General tab of the participant record. If you mark the Registered participants as of checkbox, the date field is activated, and you must enter an “as of” date. You can select to include all dates or a specific date. If you select “<Specific dates>”, a Date field appears so you can enter a specific date. You can also select from a list of dates, such as “Yesterday” or “Last day of”. All date information is based on the date field next the Registration field on the General tab of the participant record. If this checkbox is not marked, the Registration field is ignored.
**Participants who have attended.** To include all participants who have the Participant has attended checkbox marked on the General tab of their participant record, mark the Participants who have attended checkbox. If this checkbox is not marked, the Participants who have attended checkbox is ignored.

### Include these Constituents

You can further refine your event income criteria using the Include these Constituents frame. In this frame, you can select the constituent records to include or exclude when determining event income.

**Note:** For more information about constituent records, see Constituent Record chapter of the Constituent Data Entry Guide.

**Inactive constituents.** To include constituents with the Is inactive checkbox marked on the Bio 1 tab of their constituent record, mark the Inactive constituents checkbox.

**Deceased constituents.** To include constituents with the Deceased? checkbox marked on the Bio 1 tab of their constituent record, mark the Deceased constituents checkbox. You may want to include deceased constituents in the report if the constituent’s spouse is still interested in your organization but does not have a constituent record.

**Constituents with no valid address.** To include constituents with the Has no valid addresses checkbox marked on the Bio 1 tab of their constituent record, mark the Constituents with no valid addresses checkbox.

### For Calculating Income

In this frame, you select the event gifts you want to use when calculating income for an event in your report.

**Include registration fees.** If you want income from registration fees included when the program calculates event income, mark the Include registration fees checkbox. Registration fees are the amounts of money your organization charges for the levels (or units) of participation for an event. This information is based on the Registration Fees tab of the participant record.

**Include other donations.** If you want “other” donations given to your organization associated with an event, mark the Include other donations checkbox. The program then includes gifts enter from the Donations tab of the participant record when generating the income for an event.

**Include sponsoring pledges.** If you want to include sponsoring pledges when the program calculates event income, mark the Include sponsoring pledges checkbox. Sponsoring pledge donations are made on behalf of a participant of a sporting event. No other event type allows for sponsoring pledges. If you mark the Include sponsoring pledges checkbox, the program includes pledges entered on the Sponsoring Pledges tab of a participant record when calculating event income for your report.

### Ind. Address Tab

**Note:** Use the Ind. Address tab only for individuals in the database. To select organization addresses in a report, use the Org. Address tab.
In several reports in *The Raiser's Edge* you can include address information. On these report parameter screens, address tabs (Ind. Address and/or Org. Address) appears, and you can select the address information you want to include. On the Ind. Address tab, you select individual constituent address information.

![Image of address tab in The Raiser's Edge software](image)

**Note:** The program does not omit records from the report based on address information. If the program fails to locate a valid address, the record appears on the report with no address information.

The program selects an address for each individual constituent included in your report, using the four steps detailed on this tab. The program can consider seasonal addresses, address attributes, and specific address types when selecting an address. Using this tab, you can even select an alternate address for the program to use, should it fail to find a valid preferred address for a constituent. To ensure your report includes the address information you want, you must complete the information in all four steps. For example, if you fail to complete Step 4, and the program cannot locate a preferred address for a constituent, no address prints for the constituent, because “Print with no address” is the default in Step 4.

**Print two addresses on report.** On some reports, you can print two addresses. For example, if you want to include two addresses, say home and business, mark this checkbox. The **Setting for first address** and **Setting for second address** options are activated. Select **Setting for first address** and complete Step 1 - Step 3, selecting information you want to include for the first address. Then select **Settings for second address** and complete Step 1 - Step 3, selecting information you want to include for the second address. The program remembers both settings and includes both sets of addresses in your report.

**Note:** If on the Address screen of the constituent record, the **Send mail to this address** checkbox is not marked, even if you choose to include address information on the report, the address does not display.

**What would you like to print.** In the **What would you like to print** field, select one of the following criteria: Address, Phone, Address & phone, or None. If you include phone numbers, select a phone type, such as Home, E-mail, or Cellular Phone in the **Phone type** field.

If you are running the **Constituent Directory** in Profiles, Lists, and Directories, in the **Phone type** field you can select All or Selected phone types. If you select Selected, in the next field, click the binoculars to open the Phone Types screen and select the phone types you want to include in this directory.
Step 1

In Step 1, you can choose to include seasonal addresses in your report. If the program considers seasonal addresses, it selects the first valid seasonal address it finds. If it does not find a valid seasonal address, the program uses your selections in Step 2.

**Consider addresses with seasonal dates as of.** To allow the program to consider seasonal address when generating your report, mark the **Consider addresses with seasonal dates as of** checkbox.

In the corresponding field, select the as of date you are willing to accept seasonal addresses. For example, if you select Today, then all seasonal addresses with valid dates as of today’s date are considered for your report. If you select <Specific date>, the **Date** field appears, and you must enter the date you want to use (12/12/2003). The report uses the date you enter to determine whether the seasonal address is valid.

Step 2

In Step 2, specify the address types to consider if a valid seasonal address is not found in Step 1, or if you did not select to include seasonal addresses in the report.

To select the address types you want the program to look for when generating your report, highlight address type in the **Addresses** box and click the single right arrows to move it to the **Addresses to use** box. If you list multiple address types in the **Addresses to use** box, arrange them in order of preference. To arrange the address types in the **Addresses to use** box, highlight the address type and click the up or down arrow. For example, in the **Addresses to use** box you have Preferred address and Primary business. If a constituent has both addresses on his constituent record, you want the program to use the Primary business address first. Highlight Primary business and click the up arrow to move it to the top of the list. The program defaults to “Preferred address” in the **Addresses to use** box.

Step 3

In Step 3, you can further refine the address information included in your report using attributes. For example, to avoid outdated or incorrect addresses, you can select to include only NCOA (National Change of Address) confirmed addresses.

**Note:** NCOA is an address correction service that works with Blackbaud’s **NCOA On-Demand**. For more information, see the Address Correction Services chapter in the **Data Enrichment Services Guide**.
To select address attributes you want to consider for your report, click the Address Attributes button. The Address Attributes to Consider screen appears.

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
<th>Short Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCOA Confirmed?</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

**Note**: For more information about the Attributes tab on the constituent Address screen, see the Constituent Records chapter in the Constituent Data Entry Guide.

Select an attribute Category (NCOA Confirmed?) and a Description (Yes) you want present in each address. This information is entered on the Attributes tab of the constituent Address screen.

When you finish entering address attributes, click OK. You return to the report parameter screen. “Yes” appears next to the Address Attributes button.

**Note**: Any Description information entered on the Address Attributes to Consider screen appears next to the Address Attributes button.

**Step 4**

In Step 4, select the address type you want the program to use if it cannot find an address type satisfying any of your selections in Steps 1 through 3. You can choose to Print with no address or Print specific address. If you select Print specific address, the Address to print field appears. Select the alternate address you want.

**Org. Address Tab**

**Note**: The program does not omit records from the report based on address information. If the program fails to locate a valid address, the record appears on the report with no address information.
In several reports in *The Raiser’s Edge*, you can include address information. On these report parameter screens, address tabs (Ind. Address and/or Org. Address) appears, and you can select the address information you want to include. On the Org. Address tab, you select organization constituent address information.

On this tab, you can select to print contact address information or only the organization address information. The program selects an address for each organization constituent included in your report, using the four steps detailed on this tab. The program can consider address attributes and specific address types when selecting an address. Using this tab, you can even select an alternate address for the program to use, should it fail to find a valid preferred address for a constituent. To ensure your report includes the address information you want, you must complete the information in all four steps. For example, if you fail to complete Step 4, and the program cannot locate a preferred address for a constituent, no address prints for the constituent, because “Print with no address” is the default in Step 4.

**What would you like to print.** In your report, you can select to print organization constituents with their Address, Phone, Address and Phone, or None. If you select Phone or Address and Phone, the Phone type field is enabled. If you select None, the reminder of the tab is disabled.

**Note:** If on the Address screen of the constituent record, the *Send mail to this address* checkbox is not marked, even if you choose to include address information on the report, the address does not display.

**Phone type.** Select the organization constituent phone type you want to include in your report (Home, Business, Car). This field is enabled if you select Phone or Address and Phone in the *What would you like to print* field. If the program fails to locate the selected phone type on a constituent record, no phone information appears in the report for that constituent.

**Printing the Organization Contact Address in Your Report**

You can choose to print the organization name or contact information in your report. If you select the Print contacts option, the organization name does not appear in your report. Also, the Org. Address tab displays buttons and fields specific to contacts, and you can define the contact information you want to include.
Step 1
In Step 1, select whose address information you want to include in your report: the address of the organization's contact or only the address of the organization. If you select Print contacts, steps 2-3 include buttons and fields in which you can define the contact types you want to include in your report.

Step 2
If in Step 1 you select to Print contacts in your report, the organization contacts and their address information appear in your report. In Step 2 you must identify the contact types to include, using the Contact Information button.

Contact Information. Click this button to specify the contact types to include in your report. The Contacts to Print screen appears.

You can include all contact types or selected contact types. To select specific contact types, mark the Include Selected Contact Types Only checkbox. In the Contact types box, highlight the contact type you want to include and click the single right arrow to move it to the Contact types to include box. For example, if you are running a report about matching gifts an organization has made and need to use their matching gift coordinators, mark the Include Selected Contact Types Only checkbox and select Matching Gift in the Contact types box. Click the right arrow to move Matching Gift to the Contact types to include box. Now the program includes the names of the matching gift coordinators for the organizations.

If you list multiple contact types in the Contact types to include box, make sure you list the contact types in order of your preference. The program begins searching for the first type listed in the Contact types to include box. When it finds the first type listed, it includes that contact type in your report. For example, if you include Primary and Matching Gift contact types in the Contact types to include box, and Primary is first, the program stops searching for contacts as soon as it finds a primary contact on the constituent record. If you prefer the program uses Matching Gift contacts, but Primary contacts are acceptable if a Matching Gift contact does not exist on a constituent record, move Matching Gift to the top of the list. To move a types in the Contact types to include box, highlight the contact type, and click the up or down arrow as necessary.

If you do not mark the Include Selected Contact Types Only checkbox, the program considers all contact types for the report. It selects the first type located on the record to include in your report.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.
After you select all the contact types whose addresses are acceptable for your report, click OK. You return to the Org. Address tab. A display appears to the right of the Contact Types to Include button, listing the contact types you selected. If you have not specified any contact types, the label displays “<All contact types>”.

**Contact Address Attributes.** Also in Step 2, you can further refine the contact address information included in your report using attributes. For example, to avoid outdated or incorrect addresses, you can select to include only NCOA (National Change of Address) confirmed addresses.

**Note:** NCOA is an address correction service that works with Blackbaud’s NCOA On-Demand. For more information, see the Address Correction Services chapter in the Data Enrichment Services Guide.

To select address attributes you want to consider for your report, click the Contact Address Attributes button. The Contact Address Attributes to Consider screen appears.

In the Contact Address Attributes to Consider for this Report frame, select one of the following: Include Contacts with one of these address attributes, no address attributes, or different address attribute categories or Only consider Contacts with one of these address attributes. If you select the second option, you can also mark If an Organization does not have a valid Contact with one of these address attributes, consider Contacts with no address attributes or different address attribute categories. For a detailed explanation of how each option processes addresses, click the Click here for help and examples.

Next, select the address attribute Category and Description on which to base this attribute filter. This information is pulled from the Attributes tab of the constituent Address screen.

When you finish entering address attributes, click OK. You return to the report parameter screen. “Yes” appears next to the Address Attributes button.

**Note:** For more information about the Attributes tab on the constituent Address screen, see the Constituent Records chapter in the Constituent Data Entry Guide.
Step 3

In Step 3, select the address type you want the program to use if it cannot find an address type satisfying any of your selections in Steps 1 or 2. You can choose to Print the organization name with no address or Print the organization name with specific address. If you select to print a specific address, the Address to print field appears. Select the alternate address you want.

Printing only the Organization Address in Your Report

You can choose to print the organization name or contact information in your report. If you select the Print only the organization option, the organization name and address information appear in your report. Also, the Org. Address tab displays boxes, buttons, and fields specific to the organization name and address, so you can define the information you want to include.

Step 1

In Step 1, select whose address information you want to include in your report: the address of the organization’s contact or only the address of the organization. If you select Print only the organization, steps 2-3 include buttons and fields in which you can define the organization address information you want to include in your report.

Step 2

If in Step 1 you select to Print only the organization in your report, the organization and its address information appear in your report. In Step 2 you must identify the address to include.

To select the address types you want the program to look for when generating your report, highlight address type in the Addresses box and click the single right arrow to move it to the Addresses to use box. If you list multiple address types in the Addresses to use box, arrange them in order of preference. To arrange the address types in the Addresses to use box, highlight the address type and click the up or down arrow. For example, in the Addresses to use box you have Preferred address and Business. If an organization has both addresses on its constituent record, you want the program to use the Business address first. Highlight Business and click the up arrow to move it to the top of the list. The program defaults to “Preferred address” in the Addresses to use box.

Step 3

In Step 3, you can further refine the address information included in your report using attributes. For example, to avoid outdated or incorrect addresses, you can select to include only NCOA (National Change of Address) confirmed addresses.

Note: NCOA is an address correction service that works with Blackbaud’s NCOA On-Demand. For more information, see the Address Correction Services chapter in the Data Enrichment Services Guide.
To select address attributes you want to consider for your report, click the **Address Attributes** button. The Address Attributes to Consider screen appears.

### Address Attributes to Consider

Specify the Address Attributes an address should have to be given preference in processing. If no address is found, the process is repeated and addresses with no address attributes or different address attribute categories are considered.

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
<th>Short Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>NCOA Confirmed?</td>
<td>Yes</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** For more information about the Attributes tab on the constituent Address screen, see the Constituent Records chapter in the *Constituent Data Entry Guide*.

Select an attribute **Category** (NCOA Confirmed?) and a **Description** (Yes) you want present in each address. This information is entered on the Attributes tab of the constituent address record.

When you finish entering address attributes, click **OK**. You return to the report parameter screen. “Yes” appears next to the **Address Attributes** button.

**Note:** Any **Description** information entered on the Address Attributes to Consider screen appears next to the **Address Attributes** button.

### Step 4

In Step 4, select the address type you want the program to use if it cannot find an address type satisfying any of your selections in Steps 1 through 3. You can choose to Print with no address or Print specific address. If you select Print specific address, the **Address to print** field appears. Select the alternate address you want.
Profile Contents Tab

When you run a profile, the Profile Contents tab appears. On this tab, you can select groups of information to include in the report. A group includes bits of similar information, usually stored in the same section of *The Raiser’s Edge*. For example, the *Addresses* group adds to your report address information entered on the constituent record. The *Appeal Information* group includes information entered on an appeal record, such as start and end dates, overall goal, and number solicited.

When you select a group, you include all the fields contained in that group. For example, if you mark the *Biographical Information* checkbox, information from the Bio 1 and Bio 2 tabs of the individual constituent record or the Org 1 and Org 2 tabs of the organization constituent record are included in your report, including gender and marital information. The groups available in the *Include these groups* box depend on the profile type you select and the optional modules you own. For a detailed explanation of each group, see “Groups in Reports” on page 233.

Buttons on the Profile Contents Tab

Although the fields, checkboxes, and options available on this tab change, based on your selection in the *Include these groups* box, several buttons are available, regardless of the group you select.

**Duplicate.** With the **Duplicate** button you can duplicate a selected group in the *Include these Groups* box. All defaults from the original group carry over into the new, duplicated group. For example, you want to include addresses in two different formats — a *One-line listing* and a *Detailed Listing*. Select *Addresses* in the *Include these groups* box. In the *Addresses Information Format* frame, select *One-line listing*. Click **Duplicate**. The *Addresses (1)* group is added to the *Include these groups* box. Select *Addresses (1)*. In the *Addresses Information Format* frame, select *Detailed Listing*. Now, as long as you have both categories marked in the *Include these groups* box, both address formats appear in your report.

**Remove.** You can remove a duplicate group from the *Include these groups* box by highlighting the duplicate group and clicking the **Remove** button. You cannot remove an original group.

**Up and Down Arrows.** To move a group up or down in the group list, highlight the group and click the up or down arrows to place the group where you want it.
Groups in Reports

**Warning:** Highlighting a group name does not select it. You must mark the checkbox or double-click the group name to include the group in your report.

The Include these groups box on the left side of the Profile Contents tab displays all groups from which you can choose information to include in your report. A group includes bits of similar information, usually stored in the same section of *The Raiser's Edge*. To select groups to use in the report, mark the checkbox next to each group you want to include. For example, to include the renewal history on a Membership Profile, mark the checkbox next to **Renewal History**. You can include as many groups as you like in a profile.

Information available with each group varies. For example, if you run an **Individual Profile**, you can select the **Biographical Information** group and information from the Bio 1 and Bio 2 tabs of an individual constituent record or the Org 1 and Org 2 tabs of an organization constituent record appears on the report. Or, if you run an **Appeal Profile**, you can select the **Appeal Information** group and information from the appeal record appears on the report.

When you select a group to appear on your report, fields, checkboxes, and options appear on the right side of the tab, allowing you to further refine the information to include. For example, in **Constituent Profile**, if you mark **Biographical Information** in the Include these groups box, a **Heading** field appears on the right side of the tab along with two checkboxes: Include record statistics and Include credit card information.
In the **Heading** field, you can enter the heading you want to use in the report to identify the biographical information section. Mark the **Include record statistics** checkbox to include a record statistics section in your report. The report then includes statistical information about your constituents, such as the date added, added by, the date last change, last changed by, and more. To include credit card information entered in the credit card grid of the Bio 2 tab of an individual constituent record or the Org 2 tab of an organization constituent record, mark **Include credit card information**.

**Note:** Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in *The Raiser’s Edge* Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the *Configuration & Security Guide*.

Or, if you run a **New Campaign Profile** and you mark **Gift History** in the **Include these groups** box, a **Soft Credit Gifts to** and a **Credit Matching Gifts to** frame appears. You can then select how you want soft credit and matching gift information handled in your report.

On all Profile Content tabs, you can mark the **Show only selected criteria** checkbox at the bottom left of the tab and only groups with a check mark remain in the **Include these groups** box. This may prove helpful if the group list is long, and you do not want to scroll to view all of the marked groups.

The following alphabetical list of groups explains the groups available in profiles. Because each profile includes only information specific to the profile type you are running, not all groups are available on all profiles. Only the **Heading** field is available for all groups.

**Actions**

If you use the **Actions** group, you can select a format, priority, standing and date you want to use for your report. This information is based on data entered in the action record. If you choose to include actions in your profile, you can enter a **Heading** to use for the action section of the report.

**Note:** For more information about actions, see the Actions chapter in the *Constituent Data Entry Guide*.

**Action information format.** If you select **One-line listing**, the report displays one line of action information.

The line includes action date, action category, action type, solicitor, action status, and if the action is completed. If you select **Detailed listing**, the report also includes action notes, start and end times, and proposal information.
Action Priority. In this frame, you can select the action priorities you want to include in your report: **High priority, Normal priority, or Low priority.** Action priorities are established in the **Priority** field on the General tab of the action record.

Action Progress. In this frame, you can include actions based on their progress: **Completed or Not Completed.** This information is based on the **Action completed on** checkbox/field on the General tab of the action record.

Date. In the **Date** field, you define acceptable action date parameters. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the action date to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. This information is based on **Action date** field on the General tab of the action record.

Customize button. If you click **Customize**, you can filter actions based on action categories, action types, and/or action statuses. For example, if you may want to see only Meeting actions. For detailed instructions on using the filters, see “Filters Tab” on page 153.

Addressees/Salutations

If you use the **Addressees/Salutations** group, you can include any addressee/salutation information entered on the constituent record. The report displays the type of addressee/salutation (for example, Informal Addressee or Informal Salutations), and the constituent’s addressee/salutation for each type (Ben, Mr. Ben Smith). This information is based on data entered on the Addressees/Salutations tab of the constituent record. If you choose to include addressee/salutation information in your profile, you can enter a **Heading** to use for the addressee/salutation section of the report and select the types of addressee/salutations you want to include.

**Note:** On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

Addr/Sal Types/Include these Addr/Sal Types. Use these two boxes to select the addressees/salutations you want to include in your report. All available addressees/salutation types appear in the **Addr/Sal Types** box. To include a type in your report, select it in the **Addr/Sal Types** box and click the single right arrow to move it into the **Include these Addr/Sal Types** box.

Addresses

To include address information in your profile, select the **Addresses** group. The address type and the address display. This information is based on data entered on the Bio 1 tab of the individual constituent records or the Org 1 tab of the organization constituent record. If you choose to include address information in your profile, you can enter a **Heading** to use for the address section of the report, select an address format, and filter addresses based on date information.

**Note:** For more information about addresses, see the Constituent Records chapter in the **Constituent Data Entry Guide**.

Address Information Format. If you select **One-line listing**, the report displays basic address information: address lines, city, state, ZIP. If you select **Detailed listing**, the report also includes date information for the address, if the address is preferred, CART information, and much more. This information is based on the Bio 1 tab of the individual constituent records or the Org 1 tab of the organization constituent record.

Date. In the **Date** field, you define acceptable address date parameters. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the address date to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. This information is based on the **Valid Dates** frame on the Address screen of the constituent record.

**Note:** Filter information selected from the **Customize** button in a group, filters information only for the selected group. It does not prevent a record from being included in the report.
**Customize button.** If you click Customize, you can further filter addresses based on address types. For example, you may want to include only home address information in your report. For detailed instructions on using the filters, see “Filters Tab” on page 153.

**Amendment History**

In the Constituent Profile, Individual Profile, and Organization Profile, you can include an Amendment History. This can be helpful if you want to see the giving trends for a donor or group of donors over a period of time. You may want to see how many times this financial year a particular individual upgraded (or downgraded) her recurring gift..

**Appeal Summary**

In the Appeal Profile, you can select to view information entered on the appeal record. Mark the Appeal Summary group and the report summarizes all areas of the appeal record: packages, goals, pledges, write-offs, and much more. If you choose to include an appeal summary section in your report, you can then enter a Heading to use for the section.

**Appeals**

To include appeal information from the appeal record, including goals and totals given, mark the Appeals group. If you choose to include an appeals section on your report, you can then enter a Heading to use for the section of the report and determine how soft credit gifts and matching gifts are handled.

**Soft Credit Gifts To.** You can refine your report criteria using the Soft Credit Gifts To frame. When you add a new gift, you use soft credits to credit multiple constituents for the same gift without duplicating the gift in your database. When you run a report containing gifts, you need to specify how the program should report this information. You can credit the Donor, Soft credit recipients, or Both. For more information, see “Soft Credit Gifts To” on page 212.

**Warning:** If you select Both in the Credit Matching Gifts To frame, the gift appears twice on the report and total gift amounts may not be accurate.

**Credit Matching Gifts To.** In many reports, you can refine your report criteria using the Credit Matching Gifts To frame. Matching gifts are gifts donated by a business, matching a constituent’s donation. When you run reports containing gifts, you need to specify how the program should report this information. You can credit the Donor, MG Company, or Both. For more information, see “Credit Matching Gifts To” on page 193.

**Note:** For more information about soft crediting gifts, see the Gift Records Guide.

**Assigned Solicitors**

To view a list of all solicitors assigned to a constituent, including the solicitor name, campaign, ask amount, and date information, mark the Assigned Solicitors group. This information is based on Assigned Solicitors category on the Relationships tab of the constituent record. You can then enter a Heading to use for the assigned solicitor information section of the report and select an Assigned Solicitor Format.

**Note:** For more information about assigned solicitors, see the Solicitors chapter in the Constituent Data Entry Guide.

**Assigned Solicitor Format.** If you select One-line listing, the report displays basic information about the solicitor assigned to a constituent: solicitor name, campaign, ask amount, and date information. If you select Detailed listing, the report also includes fund and notes information.
**Note:** Filter information selected from the Customize button in a group, filters information only for the selected group. It does not prevent a record from being included in the report.

**Customize Gift button.** If you click Customize, you can filter solicitors based on specific solicitors. For example, you may want to include only solicitor Allison Andrews. Then any gift record that does not have Allison Andrews as the gift solicitor, does not have an assigned solicitor section in the profile. For detailed instructions on using the filters, see “Filters Tab” on page 153.

**Attributes**

**Note:** On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

To view a list of all attributes on the constituent record, including description and date information, mark the Attributes group. This information is based on the Attributes tab of the constituent record. If you choose to include an attributes section in your profile, you can then enter a Heading to use for this section of the report and select the specific attributes you want to include.

**Attributes/Include these Attributes.** Use these two boxes to select the attributes you want to include in your report. All available attributes appear in the Attributes box. To include an attribute in your report, select it in the Attributes box and click the single right arrow to move it into the Include these Attributes box.

**Banks/Financial Institutions**

**Note:** For more information about the Banks/Financial Institutions screen, see the Constituent Records chapter in the Constituent Data Entry Guide.

To view a list of all bank and financial information entered on the constituent record, including the name of the bank, account information, and if the account is primary, mark the Banks/Financial Institutions group. This information is based on the Bank/Financial Institution screen accessed from the Bank button on the Bio 1 tab of an individual constituent record or the Org 1 tab of the organization constituent record and financial information entered on the Relationship tab. If you include bank information in your report, you can then enter a Heading to use for the bank/financial information section of the report, select a Bank Information Format, and select the type of Bank Information you want to include.

**Bank Information Format.** If you select One-line listing, the report displays basic bank information: name of the bank, account information, and if the account is primary. If you select Detailed listing, the report also includes transit/routing information, notes, if the account is active, and the bank telephone number.

**Bank Information.** If you mark Primary, the report includes information from the Bank/Financial Institution screen only if the Primary bank information checkbox at the bottom of the screen is marked. If you mark Non-primary, the report includes information from the Bank/Financial Institution screen only if the Primary bank information checkbox is not marked. To include all information from the Bank/Financial Institution screen mark both checkboxes.

**Benefits**

**Note:** For more information about appeal benefits, see the Appeals section of the Campaigns, Funds, & Appeals Data Entry Guide.

To include a list of benefits associated with each appeal in your report, including count, unit cost, total value, and if the benefit was sent, mark the Benefits group. This information is based on the Benefits screen, accessed from the Default Benefits button of the appeal record. You can then enter a Heading to use for the benefit information section of the report.
Biographical Information

To include biographical information in your report, mark the Biographical Information group. This information is based on the Bio 1 and Bio 2 tabs of an individual constituent record or the Org 1 and Org 2 tabs of an organization constituent record. If you choose to include a biographical section in your profile, you can then enter a Heading to use for this section of the report and choose to include statistical data and credit card information.

**Note:** For more information about biographical information, see the Constituent Records chapter in the Constituent Data Entry Guide.

**Include record statistics information.** To include a record statistics section in your report, mark this checkbox. The report then includes statistical information about your constituents, such as the date added, added by, the date last change, last changed by, and more.

**Include credit card information.** To include credit card information entered in the credit card grid of the Bio 2 tab of an individual constituent record or the Org 2 tab of an organization constituent record, mark this checkbox. The report then includes the credit card type, account number, and expiration date.

Businesses

**Note:** For more information about the business information on the constituent record, see the Constituent Records chapter in the Constituent Data Entry Guide.

To view information about a constituent’s employer mark the Businesses group. This information is based on the business relationship information entered on the Organization Relationship screen. To be included in the report, the Employee checkbox must be marked on the General tab of the Organization Relationship screen. You access this screen from the Business button on the Bio 1 tab of the constituent record or the Organizations category on the Relationships tab of the constituent record.

This section of the report includes the name of the organization, the position held by the constituent, the relationship, and date information. If you want to include organization relationship information about non-employers in your report, see the “Organization Relationships” on page 250.

If you choose to include a business section in your profile, you can enter a Heading to use for the organization relationship information section of the report, select a Business Information Format, and select the type of Business Information you want to include.

**Business Information Format.** If you select One-line listing, the report displays basic business information: type of industry, position held by constituent, and date information. If you select Detailed listing, the report also includes the business address and ID, any notes, primary and contact information, and more.

**Business Information.** If you mark Primary, the report includes employer information only if the Primary business information checkbox is marked on the Organization Relationship screen. If you mark Non-primary, the report includes information from the Organization Relationship screen only if the Primary business information checkbox is not marked. To include all information mark both checkboxes.

Campaign Information

In the Campaign Profile, select the Campaign Information group to include in your profile information about each campaign available in your database, including the campaign ID, descriptions, overall goal, start and end dates, date added and by whom, date changed and by whom, and much more. You can then enter a Heading to use for the campaign information section of the report.

**Note:** For more information about the campaign record, see the Campaigns section of the Campaigns, Funds, & Appeals Data Entry Guide.
Campaigns

To view a list of all campaign information associated with records included in your report, including the campaign ID, descriptions, overall goal, and dates, mark the Campaigns group. This information is based on data entered in the campaign record. If you choose to include a campaigns section in your profile, you can then enter a Heading to use for the campaign information section of the report, select a Campaign Information Format, and select the type of campaigns you want to include.

Campaign Information Format. If you select One-line listing, the report displays basic campaign information: ID, description, dates, and overall goal. If you select Detailed listing, the report also includes category and note information and if the campaign is active or the default.

Campaigns/Include these Campaigns. Use these two boxes to select the campaigns you want to include in your report. All available campaigns appear in the Campaigns box. To include a campaign in your report, select it in the Campaigns box and click the single right arrow to move it into the Include these Campaigns box.

Campaign Summary

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

In the Campaign Profile, you can select to view campaign summary information. If you use the Campaign Summary group, the report summarizes all areas of the campaign record: packages, goals, pledges, write-offs, and much more. You can then enter a Heading to use for the campaign information section of the report.

Constituent Codes

To include a constituent codes section in your report, displaying all constituent codes associated with each constituent record included in the report, mark the Constituent Codes group. This information is based on data entered in the Constituent Codes grid on the Bio 2 tab of the constituent record. You can then enter a Heading to use for the constituent code information section of the report and select the codes you want to include.

Constituents Codes/Include these Constituent Codes. Use these two boxes to select the constituent codes you want to include in your report. All available constituent codes appear in the Constituent Codes box. To include a constituent code in your report, select it in the Constituent Codes box and click the single right arrow to move it into the Include these Constituent Codes box.

Constituent Name

If you want a constituent name section in your report, displaying name information from the Bio 1 tab of the individual constituent records and the Org 1 tab of organization constituent records, mark the Constituent Name group. You can then enter a Heading to use for the constituent name information section of the report and select to include address and phone information.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

Include on profile. In the Include on profile field, select one of the following: “Preferred Address”, “Phone”, “Preferred Address & phone”, or “None”. If you include phone numbers, select a phone type, such as “Home”, “E-mail”, or “Cellular Phone” in the Phone Type box. Using the single right arrow, move your selection into the Include these Phone Types box. The program then prints on your report any matching phone types found on the constituent record.
Contacts

If you mark the **Contacts** group, you can select include a section listing all contact information associated with organization constituent records included in your report, including name, position, profession, relationship, and contact type information. This information is based on the Organization Relationship screen on the Relationships tab of the constituent record. If you choose to include a contacts section in your profile, you can then enter a **Heading** to use for the contact information section of the report and select a **Contact Format**.

**Contact Format.** If you select **One-line listing**, the report displays basic contact information: name, position, profession, relationship, and contact type. If you select **Detailed listing**, the report also includes the contact’s gender, nickname, birth date, Social Security Number, and much more.

**Note:** Filter information selected from the **Customize** button in a group, filters information only for the selected group. It does not prevent a record from being included in the report.

**Customize button.** If you click **Customize**, you can filter contacts based on specific contact types and/or relationship types. For example, you may want to include only primary contact information in this section of your report. For detailed instructions on how to use the filters, see “Filters Tab” on page 153.

Coordinators

In the **Event Profile**, you can select to view event coordinator information. If you use the **Coordinators** group, the report includes the **Name** of the coordinator and any notes entered in the **Comments** column of the Event Coordinators screen. This information is based on data entered on the Event Coordinators screen, accessed from the **Coordinator** button on the General tab of the event record. You can enter a **Heading** to use for the coordinator section of the report.

Education/Schools

To view information about a constituent’s education record, mark the **Education/Schools** group. This information is based on the education information entered on a constituent record from the **Education** button on the Bio 1 tab and in the **Education/Schools** category on the Relationships tab. This includes the school name, degree, major, graduation date, and if this is the primary education record. You can enter a **Heading** to use for the education/school information section of the report, select an **Education Information Format**, and select the type of **Education Information** you want to include.

**Education Information Format.** If you select **One-line listing**, the report displays basic education information: school name, degree, major, graduation date, and if this is the primary education record. If you select **Detailed listing**, the report also includes minor, GPA, fraternity/sorority information and more.

**Education Information.** If you mark **Primary**, the report includes education information only if the **Primary alumni information** checkbox is marked on the Education/School screen. If you mark **Non-primary**, the report includes information from the Education/School screen only if the **Primary alumni information** checkbox is not marked. To include all information mark both checkboxes.

**Include education attributes.** To include in your report education attribute information entered on the **Attributes/Notes** tab of the Education/School screen, mark the **Include education attributes** checkbox.

**Note:** Filter information selected from the **Customize** button in a group, filters information only for the selected group. It does not prevent a record from being included in the report.
**Customize button.** If you click Customize, you can filter education information included in this section of the report based on specific education types. For example you may want to include only four-year colleges in your report. For detailed instructions on how to use the filters, see “Filters Tab” on page 153.

**Employees**

*Note:* For more information about employees (primary organization records), see the Constituent Records chapter in the *Constituent Data Entry Guide.*

When running a Constituent Profile, you can include an employee section on all organization constituent profiles. Mark the Employees group to view information about a constituent’s employees, including name, position, and profession information. This information is based on individuals added on the Relationships tab of an Organization constituent record and reciprocated on the Individual constituent record and vice versa. You can enter a **Heading** to use for the employees information section of the report and select an **Employee Format**.

**Employee Format.** If you select One-line listing, the report displays basic employee information: including name, position, and profession information. If you select Detailed listing, the report also includes address, ID, gender, birth date, age, and more.

**Customize button.** If you click Customize, you can filter employee information included in this section of the report based on specific relationship types. For example you may want to include only attorneys. For detailed instructions on how to use the filters, see “Filters Tab” on page 153.

**Event Class Schedule**

When running an Event Profile, you can include a class schedule section. Mark the Event Class Schedule group to view class schedule information, including the number of classes and starting and ending times, entered on the Class Schedule screen of the class event record. You access this screen by clicking the Schedule button on the General tab of a class event record.

*Note:* For more information about event records, see the *Event Management Data Entry Guide.*

If you choose to include class schedule information, you can enter a **Heading** to use for this section of the report.

**Include class schedule grid.** Mark this checkbox to include information entered in the grid on the Class Schedule screen of the event record. The grid includes date and time information for the class.

**Event Details**

When running an Event Profile, you can include detailed information from the event record in your profile. Mark the Event Details group to view event name, event ID, category, location, start and end dates, start and end times, groups, goals, capacity, number invited, and much more.

If you choose to include detailed event information, you can enter a **Heading** to use for this section of the report.

**Expenses**

The Expenses group changes, based on the profile type you run.

When running an Event Profile, you can include in your profile expense information from the event record. Mark the Expenses group to view expense type, budgeted amounts, expense amounts, how much was paid and when, vendor information, and any comments. This information comes from the Expenses tab of the event record. If you choose to include expense information, you can enter a **Heading** to use for this section of the report.

When running an Appeal Profile, you can include in your profile appeal expense information included in the appeal record. Mark the Expenses group to view the reason for the expense, any package information associated with the expense, the date, amount, and budgeted amount. This information comes from the Expenses grid on the Attribute/Expenses tab of the appeal record.

---

Note: For more information about employees (primary organization records), see the Constituent Records chapter in the *Constituent Data Entry Guide.*

Note: For more information about event records, see the *Event Management Data Entry Guide.*
If you choose to include appeal expense information, you can enter a **Heading** to use for this section of the report, select a format, and select the expenses you want to include.

**Expense Information Format.** If you select **One-line listing**, the report displays basic appeal expense information: the reason for the expense, any package information associated with the expense, the date, amount, and budgeted amount. If you select **Detailed listing**, the report also includes comments.

**Note:** On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

**Expenses/Include these Expenses.** Use these two boxes to select the expenses you want to include in your report. All available expenses appear in the Expenses box. To include an expense in your report, select it in the Expenses box and click the single right arrow to move it into the Include these Expenses box.

**Financial Data**

**Note:** For more information about prospect records, see the *Prospect Data Entry Guide*.

In some profiles, you can include information from the Financial Information category on the Prospect tab of the constituent record. Mark the Financial Data group to include the reason for the expense, any package information associated with the expense, the date, amount, and budgeted amount. This information is based on data entered from the Financial Information category on the Prospect tab of the constituent record. If you choose to include a financial data section in your profile, you can enter a **Heading** to use for this section of the report and select the data you want to include.

**Financial Data/Include these Financial Data.** Use these two boxes to select the financial information you want to include in your report. All available data appears in the Financial Data box. To include a data item in your report, select it in the Financial Data box and click the single right arrow to move it into the Include these Financial box.

**Financial Summary**

In the **Event Profile**, you can include information from the Event Financial Summary. The Event Financial Summary is generated from the **View** menu on the shell by selecting **Summaries, Event Financial Summary**. If you choose to include this information in your profile, the summary information defined on the Event Management Summary screen of each event record included in your profile appears. You can then enter a **Heading** to use for this section of the report.

**Note:** For more information about financial summaries, see the *Summaries Guide*.

**Include breakdown information.** To include a financial breakdown based on types of income (registration fees, other donations, and sponsoring pledges), mark this checkbox. The profile then displays the total amount in each type along with the amount paid and the balance due.

**Fund Information**

**Note:** For more information about the fund record, see the *Campaigns, Funds, & Appeals Data Entry Guide*. 
In the Fund Profile, select the Fund Information group, and you can view information about each fund available in your database, including the fund ID, descriptions, overall goal, start and end dates, date added and by whom, date changed and by whom, and much more. This information is based on data entered in the fund record. If you choose to include a fund information section in your profile, you can then enter a Heading to use for this section of the report.

Fund Relationship

In the Fund Profile, select the Fund Relationship group, and you can display the fund relationships on a Constituent Profile report for a given constituent. This information is based on data entered in the fund record. If you choose to include a fund relationship section in your profile, you can then enter a Heading to use for this section of the report.

Fund Summary

Note: For more information about summaries, see the Summaries Guide.

In the Fund Profile, you can include information from the Fund Summary. The Fund Summary is generated from the View menu on the shell by selecting Summaries, Fund Summary. If you choose to include this information in your profile, the summary information defined on the Fund Summary screen of each fund record included in your profile appears. You can then enter a Heading to use for this section of the report.

Funds

To view a list of all fund information associated with records included in your report, including the fund ID, descriptions, overall goal, and dates, mark the Funds group. This information is based on the fund record. You can then enter a Heading to use for the funds information section of the report, select a Funds Information Format, and select the type of funds you want to include.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

Fund Information Format. If you select One-line listing, the report displays basic fund information: ID, description, dates, and overall goal. If you select Detailed listing, the report also includes category, note information, if the fund is active, and if the fund is the default fund.

Funds/Include these Funds. Use these two boxes to select the funds you want to include in your report. All available funds appear in the Funds box. To include a fund in your report, select it in the Funds box and click the single right arrow to move it into the Include these Funds box.

Note: Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

Gift History

To include gift history information from campaign, fund, or appeal records (depending on the profile type you run) included in your profile mark the Gift History group. The profile then displays constituent name; gift date; gift type; fund, appeal, or campaign, depending on the profile type you run; amount pledged; and balance due. This information is based on data entered in gift records associated with the fund, appeal, or campaign. If you choose to include a gift history section in your profile, you can then enter a Heading to use for this section and select how you want soft credit gifts and matching gifts handled.
Soft Credit Gifts To. You can refine your report criteria using the Soft Credit Gifts To frame. When you add a new gift, you use soft credits to credit multiple constituents for the same gift without duplicating the gift in your database. When you run a report containing gifts, you need to specify how the program should report this information. You can credit the Donor, Soft credit recipients, or Both. For more information, see “Soft Credit Gifts To” on page 212.

Warning: If you select Both in the Credit Matching Gifts To frame, the gift appears twice on the report and total gift amounts may not be accurate.

Credit Matching Gifts To. In many reports, you can refine your report criteria using the Credit Matching Gifts To frame. Matching gifts are gifts donated by a business, matching a constituent’s donation. When you run reports containing gifts, you need to specify how the program should report this information. You can credit the Donor, MG Company, or Both. For more information, see “Credit Matching Gifts To” on page 193.

Date. In the Date field, you define acceptable date parameters. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the gift or GL posting date to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information.

Note: For more information about soft crediting gifts, see the Gift Records Guide.

Date to use. In this field, tell the program what date information you want used: Gift date or GL post date. The Gift date is based on the date entered in the Gift date field on the Gift tab of the gift record. The GL post date is based on the date entered in the GL post date field on the Miscellaneous tab of the gift record.

Note: Filter information selected from the Customize button in a group, filters information only for the selected group. It does not prevent a record from being included in the report.

Customize button. If you click Customize, you can filter campaign, fund, or appeal information included in this section of the report. For example you may want to include only the 2003 Direct Mail appeal in your report. For detailed instructions on how to use the filters, see “Filters Tab” on page 153.

Gift Summary

Note: For more information about summaries, see the Summaries Guide.

In some profiles, you can include information from the Gift Summary. The Gift Summary is generated from the View menu on the program shell by selecting Summaries, Gift Summary. If you choose to include this information in your profile, the summary information defined on the Gift Summary screen of each gift record included in your profile appears. You can then enter a Heading to use for this section of the report.

Note: Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

Gifts to Other Organizations

In some profiles, you can include information from the Gifts to other Organizations category on the Prospect tab of the constituent record. Mark the Gifts to Other Organizations group to include the organization’s name, the type of organization, amount given, date given, reason for the gift, and any comments entered on the record.

Note: For more information about prospect records, see the Prospect Data Entry Guide.

If you choose to include this information, you can enter a Heading to use for this section of the report.
**Date.** In the **Date** field, you define acceptable date parameters for the gifts to other organizations. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the **Date Given** to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. This information is based on the date entered in the **Date Given** column in the **Gifts to other Organizations** category on the Prospect tab of the constituent record.

**Giving History**

In some profiles, you can include a giving history of the records included in the profile, including gift date, gift type, fund, amount pledged, balance due, and any reference information. To include this information, mark the **Giving History** group. You can then enter a **Heading** to use for the giving history information section of the report and select how you want soft credit gifts and matching gifts handled.

**Note:** For more information about soft crediting gifts, see the **Gift Records Guide**.

**Soft Credit Gifts To.** You can refine your report criteria using the **Soft Credit Gifts To** frame. When you add a new gift, you use soft credits to credit multiple constituents for the same gift without duplicating the gift in your database. When you run a report containing gifts, you need to specify how the program should report this information. You can credit the **Donor**, **Soft credit recipients**, or **Both**. For more information, see “Soft Credit Gifts To” on page 212.

**Warning:** If you select **Both** in the **Credit Matching Gifts To** frame, the gift appears twice on the report and total gift amounts may not be accurate.

**Credit Matching Gifts To.** In many reports, you can refine your report criteria using the **Credit Matching Gifts To** frame. Matching gifts are gifts donated by a business, matching a constituent’s donation. When you run reports containing gifts, you need to specify how the program should report this information. You can credit the **Donor**, **MG Company**, or **Both**. For more information, see “Credit Matching Gifts To” on page 193.

**Note:** For more information about gift records, see the **Gift Records Guide**.

**Date.** In the **Date** field, you define acceptable date parameters. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the gift or GL posting date to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information.

**Date to use.** In this field, tell the program what date information you want used: Gift date or GL post date. The Gift date is based on the date entered in the **Gift date** field on the Gift tab of the gift record. The GL post date is based on the date entered in the **GL post date** field on the Miscellaneous tab of the gift record.

**Note:** For more information about pledges, see the Pledges chapter in the **Gift Records Guide**.

**Pledge type.** In this field select the pledge type you want included in your report: Master or Installment. A master pledge is a gift record containing the gift amount a constituent agrees to donate and the installment schedule for the pledge payments. An installment is a scheduled payment that reduces the balance of a master pledge. This information is based on the Pledge Installment Schedule screen in the gift record.

**GL Distribution**

Mark the **GL Distributions** category available in the **Fund Profile** to include fund distribution information in your report. GL distribution information is based on **Raiser’s Edge** posting made to have Blackbaud’s **General Ledger**. If you have Blackbaud’s **General Ledger**, you can enter credit and debit account information for gift types and subtypes into **The Raiser’s Edge** directly from the **General Ledger** database. This information is entered on the GL Distribution tab in the fund record. When you add a fund to gifts in **The Raiser’s Edge**, the accounts you specified are automatically debited and credited in **General Ledger**. A **General Ledger** account distribution is the accounting practice of spreading (distributing) percentage amounts of gifts to multiple **General Ledger** fund accounts. If you select to include the **GL Distribution** category in your profile, you can enter a **Heading** to use for this section of the report and select a format for the information.
**General Ledger Distribution Format.** If you select **One-line listing**, the report displays basic distribution information: gift type, debit account number, and credit account number. If you select **Detailed listing**, the report also includes date and note information.

**Goal Summary**

*Note:* For more information about summaries, see the *Summaries Guide*.

In the **Event Profile**, you can include information from the Goal Summary. The Goal Summary is generated from the *The Raiser’s Edge* shell by selecting **View, Summaries**, and then selecting **Event Goal Summary**. If you choose to include this information in your profile, the summary information defined on the Goal Summary screen of each event record included in your profile appears. You can then enter a **Heading** to use for this section of the report.

**Hon/Mem Giving History**

In the **Honor/Memorial Profile**, you can include a giving history of the honor/memorial records included in the profile, including constituent, gift date, gift type, fund, amount, and any reference information. To include this information, mark the **Honor/Memorial Giving History** group. You can then enter a **Heading** to use for the giving history information section of the report and select how you want soft credit gifts and matching gifts handled, the date information you want to use, and the pledge type you want to include.

*Note:* For more information about soft crediting gifts, see the *Gift Records Guide*.

**Soft Credit Gifts To.** You can refine your report criteria using the **Soft Credit Gifts To** frame. When you add a new gift, you use soft credits to credit multiple constituents for the same gift without duplicating the gift in your database. When you run a report containing gifts, you need to specify how the program should report this information. You can credit the **Donor**, **Soft credit recipients**, or **Both**. For more information, see “Soft Credit Gifts To” on page 212.

*Warning:* If you select **Both** in the **Credit Matching Gifts To** frame, the gift appears twice on the report and total gift amounts may not be accurate.

**Credit Matching Gifts To.** In many reports, you can refine your report criteria using the **Credit Matching Gifts To** frame. Matching gifts are gifts donated by a business, matching a constituent’s donation. When you run reports containing gifts, you need to specify how the program should report this information. You can credit the **Donor**, **MG Company**, or **Both**. For more information, see “Credit Matching Gifts To” on page 193.

*Note:* For more information about gift records, see the *Gift Records Guide*.

**Date.** In the **Date** field, you define acceptable date parameters. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the gift or GL posting date to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information.

**Date to use.** In this field, tell the program what date information you want used: Gift date or GL post date. The Gift date is based on the date entered in the **Gift date** field on the Gift tab of the gift record. The GL post date is based on the date entered in the **GL post date** field on the Miscellaneous tab of the gift record.

*Note:* For more information about pledges, see the Pledges chapter in the *Gift Records Guide*.

**Pledge type.** In this field select the pledge type you want included in your report: Master or Installment. A master pledge is a gift record containing the gift amount a constituent agrees to donate and the installment schedule for the pledge payments. An installment is a scheduled payment that reduces the balance of a master pledge. This information is based on the Pledge Installment Schedule screen in the gift record.

**Customize button.** If you click **Customize**, and three tabs appear.
On the Filters tab, you can filter information included in your report based on appeals, campaigns, and/or funds. For example, you may include only information from your Annual Campaign. For detailed instructions on how to use the filters, see “Filters Tab” on page 153.

On the Gift Types tab, you define the gift information you want to include in your profile. For example, you may want to include only write-off information in your report. For detailed instructions on how to use this tab, see “Gift Types Tab” on page 213.

On the Format tab, you select how you want to sort your profile. You can select ascending (Asc) or descending (Desc) order based on any of the columns available in the profile: Gift date, Constituent, Gift type, Fund, or Amount. For example, if in the Detail Sort Order frame you select Constituent and Asc, the information in the Honor/Memorial Giving History section of your report is arranged in alphabetical order based on constituents’ first name. If you select Gift date and Asc, the information is arranged from the oldest to the newest gift date.

**Hon/Mem Gift Summary**

*Note:* For more information about honor/memorial gift summaries, see the Constituent Summaries chapter in the *Summaries Guide*.

If you have constituents who are honor/memorials, and you create an Honor/Memorial Gift Summary from their constituent records, you can include this summary information in your Honor/Memorial Profile when you mark the Honor/Memorial Gift Summary group. You can then view gift information for tributes set up for the constituent. This information is based on the Honor/Memorial Gift Summary created from the View menu of an honor/memorial constituent record. If you mark the Honor/Memorial Gift Summary group, in the profile, you can enter a Heading to use for the gift summary information section of the report.

**Hon/Mem Information**

To view general honor/memorial information, including tribute type, date from, a description of the tribute, and its status, mark the Honor/Memorial Information group. This information is based on the constituent tribute records. You can then enter a Heading to use for the honor/memorial information section of the report, select an Honor/Memorial Information Format, and a Date filter.

**Honor/Memorial Information Format.** If you select One-line listing, the report displays basic honor/memorial information: tribute type, date from, a description of the tribute, and its status. If you select Detailed listing, the report also includes the default fund and notes.

**Date.** In the Date field, you define acceptable date parameters. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the honor/memorial to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. This information is based on the Date From field on the Honor/Memorial tab of the constituent record.

*Note:* Filter information selected from the Customize button in a group, filters information only for the selected group. It does not prevent a record from being included in the report.

**Customize button.** If you click Customize, you can filter information included in this section of the report based on tribute types. For example you may want to include only “In memory of” tributes in your report. For detailed instructions on how to use the filters, see “Filters Tab” on page 153.
Individual Relationships

To view a list of individual relationships in the Individual Profile or Fund Profile, including name, relationship, and notes, mark the Individual Relationships group. This information is based on individual relationships entered on the Relationships tab of your constituent records. You can then enter a Heading to use for the relationship information section of the report and select an Individual Relationship Format.

Individual Relationship Format. If you select One-line listing, the report displays basic individual relationship information: name, relationship, and notes. If you select Detailed listing, the report also includes address, ID, gender, age, reciprocal relationships, date information, and much more.

Customize button. If you click Customize, you can filter individual relationship information based on specific relationship types. For example, you may want to include only brothers. For detailed instructions on how to use the filters, see “Filters Tab” on page 153.

Instructors

When running an Event Profile, mark the Instructors group to include instructors entered on the Instructors screen. This screen is accessed from the Instructors button on the General tab of the event record. If you select to include the Instructors group, you can enter a Heading to use for the instructors section of the report.

Location

Note: For more information about event records, see the Event Management Data Entry Guide.

When running an Event Profile, mark the Location group to include the event location entered on the Location Information screen. This screen is accessed from the Location button on the General tab of the event record. If you choose to include the Location group, you can enter a Heading to use for the location section of the report.

Media

When running an Event Profile, you can include the event media information, including media type, description, date, and who entered the media information by marking the Media group. This information is based on the Media tab of the event record. You can enter a Heading to use for the media section of the report and select the type of media information you want to use.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

Media Types/Include these Media Types. Use these two boxes to select the media types you want to include in your report. All available media types appear in the Media Types box. To include a type in your report, select it in the Media Types box and click the single right arrow to move it into the Include these Media Types box.

Membership History

In some profiles, you can include membership history information, including program, category, subcategory, expiration information, and dates by marking the Membership History group. This information is based on the Membership History tab of the membership record. You can enter a Heading to use for the location section of the report.

Membership Information

Note: For more information about membership records, see the Membership Data Entry Guide.
In some profiles, you can include a membership information section in the report. Mark the Membership Information group to view information about the membership type, current standings, program, category, and subcategory. This information is based on the Membership record. You can enter a Heading to use for the membership information section of the report, select a Membership Information Format, and select the type of membership information you want to include.

Membership Information Format. If you select One-line listing, the report displays basic membership information: type, current standings, program, category, and subcategory. If you select Detailed listing, the report also includes date information.

Membership Information. If you mark Member is primary, the report includes information for members entered from the Membership tab of the membership record. If you mark Member is non-primary, the report includes information for only members entered from the Other Members and Cards Information screen on the membership record. This screen is accessed by clicking the Members & Cards button. To include all members information mark both checkboxes.

Note: Filter information selected from the Customize button in a group, filters information only for the selected group. It does not prevent a record from being included in the report.

Customize button. If you click Customize, you can filter members included based on transaction types, programs, and/or categories. For example you may want to include only members with a transaction type of Upgraded. For detailed instructions on how to use the filters, see “Filters Tab” on page 153.

Membership Overview

Note: For more information about membership records, see the Membership Data Entry Guide.

In the Constituent Profile, you can include an overview of constituents’ membership activity. If you mark the Membership Overview group, you can see how many members are included on the constituent’s membership record; how long the constituent has been a member; as well as program, category, and date information. This information is based on the Membership record. You can enter a Heading to use for the membership overview section of the report, select a Membership Overview Format, and select the type of membership information you want to include in the overview.

Membership Overview Format. If you select One-line listing, the report displays basic membership information: how many members are included on the constituent’s membership record; how long the constituent has been a member; and program, category, and date information. If you select Detailed listing, the report also includes drop information, number of children on the membership, last renewed date, and more.

Membership Overview. If you mark Primary, the report includes information for members entered from the Membership tab of the membership record. If you mark Non-primary, the report includes information for only members entered from the Other Members and Cards Information screen on the membership record. This screen is accessed by clicking Members & Cards. To include all members information mark both checkboxes.

Customize button. If you click Customize, you can filter members included based on transaction types, programs, and/or categories. For example you may want to include only members with a transaction type of Upgraded. For detailed instructions on how to use the filters, see “Filters Tab” on page 153.

Membership Statistics

When running a Membership Category Profile, you can include statistics for each membership category, including number of members, number of primary members, total dues, total dues paid, number of males, number of females, average age of the members, and more by marking the Membership Statistics group. This information is based on information entered in the membership record. You can enter a Heading to use for the membership statistics section of the report.
Membership Subcategories

When running a Membership Category Profile, you can include statistics for each membership subcategory, including number of members, number of primary members, total dues, and total dues paid by marking the Membership Subcategories category. This information is based on information entered in the membership record. You can enter a Heading to use for the membership subcategory section of the report.

Membership Summary

When running a Constituent Profile, you can include a summary of all the membership information included on the Membership tab of the constituent’s record. You can include total years a member, the total times renewed, years without a drop, date first joined, date last renewed, and date next renew is due by marking the Membership Summary group. This information is based on information entered on the constituent’s membership records. You can enter a Heading to use for the membership summary section of the report.

Notes

In some profiles, you can select to include note information by marking the Notes group. Where in The Raiser’s Edge this information comes from, depends on the profile type you run. If you run a Constituent Profile, an Organization Profile, an Honor/Memorial Profile, or an Individual Profile, notes come from the Notes tab of the constituent record. If you run an Event Profile, notes come from Notes tab of the event record. In all profiles, you can enter a Heading to use for the notes section of the report, choose to include a subheading and details, and select the notepad types.

Use notepad type for subheading. If you want to use the type information entered in the Type field on the Notepad screen, accessed from the Notes tab, as a subheading in the notes section of your report, mark this checkbox.

Include notepad details. In Individual Profile, Organization Profile, Constituent Profile, and Honor/Memorial Profile, you can include notepad details such as type, date, title, author, and description in your report by marking this checkbox.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

Notepad Types/Include these Notepad Types. Use these two boxes to select the notepad types you want to include in your report. Notepad types are determined in the Type field on the Notepad screen, accessed from the Notes tab. All available types appear in the Notepad Types box. To include a type in your report, select it in the Notepad Types box and click the single right arrow to move it into the Include these Notepad Types box.

Date. In the Date field, you define acceptable date parameters. This information is based on the Date field on the Notepad screen accessed from the Notes tab. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the notepad date to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information.

Organization Relationships

In some profiles, you can include an organization relationships section. If you mark the Organization Relationships group, the report displays the organization name, relationship, position, and date information. This information is based on information entered in the Organization category on the Relationships tab of the constituent record. You can enter a Heading to use for the organization relationship section of the report and select an Organization Relationship Format.

Organization Relationship Format. If you select One-line listing, the report displays basic relationship information: organization name, relationship, position, and date information. If you select Detailed listing, the report also includes address, ID, industry, notes, and more.
Customize button. If you click Customize, you can filter the organization relationships included based on relationship types. For example, you may want to include only board member relationships. For detailed instructions on how to use the filters, see “Filters Tab” on page 153.

Packages

Note: For more information about appeal records, see the Appeals section of the Campaigns, Funds, & Appeals Data Entry Guide.

In the Appeal Profile, you can include a list of packages associated with each appeal. If you mark the Packages group, the report displays package ID, a description, the category, date information, and the overall goal. This information is based on information entered in the Packages tab of the appeal record. You can enter a Heading to use for the packages section of the report and select a Package Information Format.

Package Information Format. If you select One-line listing, the report displays basic package information: package ID, a description, the category, date information, and the overall goal. If you select Detailed listing, the report also includes notes, number solicited, if the package is still active, and the default gift amount.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

Participants

Note: For more information about event records, see the Event Management Data Entry Guide.

In the Event Profile, you can include a list of participants associated with each event included in your report. If you mark the Participants group, the report displays number of registrants, sponsors, and guests; the total number of participants; participant names; categories; sponsorship information; who the participant is a guest of; the invitation date, response date; and if the participant attended. This information is based on information entered on your participant records, accessed from the Participants tab of the event record. You can enter a Heading to use for the participants section of the report and select a Participant Information format.

Participant Information. If you select One-line listing, the report displays basic participant information: number of registrants, sponsors, and guests; the total number of participants; participant names; categories; sponsorship information; who the participant is a guest of; invitation date; response date; and if the participants attended. If you select Detailed listing, the report also includes address, ID, status, and more.

If you select any of the checkboxes listed at the bottom of the screen, this frame is disabled.

Include sport information. For sporting events, you can include a sport information subsection in the participants section of the report by marking this checkbox. The sport information section displays details about the sporting event to which the participant is registered: start time, location, assigned number, gender, age, height, weight, ability rating, and more. This information is based on the data entered from the More Info button on the General 1 tab of the participant records, accessed from the Participants tab of the event record.

Note: A dinner event can be any type of event where you provide a meal. Dinner events are not restricted to “dinner.” You may have luncheons, picnics, and breakfasts at your organization. When you add a “dinner” event record, you must first establish the category of Dinner.
Include dinner preferences information. For dinner events, you can include any dinner preference information. The dinner preference section of the report includes the dinner preference, the quantity, and any comments included on the record. This information is based on the data entered from the More Info button on the General 1 tab of the participant record of a dinner event.

Include awards presented information. You can include any award information associated with the event. The award section of the report includes the award presented, who presented it, and any comments included on the record. This information is based on the data entered from the Award button on the General 1 tab of the participant record of an event.

Include participant guests list. You can include a list of guests associated with a participant of an event. A guest is an individual or organization attending an event as an invitee (guest) of a registrant. Guests are primarily added from the Participants tab of an event record, but guests can also be added from the General 1 tab of a registrant record.

Include participants sponsored list. You can include a list of registrants and their guests associated with a sponsor of an event. A sponsor is an individual or organization sponsoring, or representing, a registrant or a group of registrants. A sponsor may pay all the registration fees and the registrants may participate in the event as a group. You add sponsors, registrants, and guests from the Participants tab of an event record.

Prices

Note: For more information about event records, see the Event Management Data Entry Guide.

In the Event Profile, you can include a list of prices established for registration fees for your events. If you mark the Prices group, the report displays the price unit (for example, individual, couple, group), the gift amount per unit, the receipt amount, and any comments. The units of registration fee prices are established on the Prices tab of the event record. If you select the Prices group, you can enter a Heading to use for the prices section of the report and select a Price Information format.

Price Information. If you select One-line listing, the report displays basic price information: price unit (individual, couple, group), the gift amount per unit, the receipt amount, and any comments. If you select Detailed listing, the report includes the same information, but arranges it in a list view instead of in columns.

Include benefits information. You can include in your report any benefits associated with the various price units by marking this checkbox. The report adds a benefits information sections for each price unit in which benefits are available. The report displays the benefit, how many, cost, comments, notes, and more. You enter benefits information on the Prices tab of the event record.

Proposal Attributes

Note: For more information about proposal records, see the Proposal section of the Prospect Data Entry Guide.

You can include in your report any proposal attributes associated with constituent records. If you mark the Proposal Attributes group, the report displays the attribute category, description, and date. You assign attributes to you constituents from the Attributes/Notes tab of the proposal record. Proposal records are created in the Proposal category on the Prospect tab of the constituent record. If you select to include proposal attributes in your report, you can enter a Heading to use for this section of the report and select the attributes you want to include.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

Attributes/Include these Attributes. Use these two boxes to select the proposal attributes you want to include in your report. All available proposal attributes appear in the Attributes box. To include an attribute in your report, select it in the Attributes box and click the single right arrow to move it into the Include these Attributes box.
Proposal Media

You can include in your report any proposal media items associated with constituent records. If you mark the Proposal Media group, the report displays the name of the proposal, the media type, a description, the date the media item was added to the record, and who added it. You assign proposal media types to your constituent records from the Media tab of the proposal record. Proposal records are created in the Proposal category on the Prospect tab of the constituent record. If you select to include proposal media types in your report, you can enter a Heading to use for this section of the report and select the media types you want to include.

Media Types/Include these Media Types. Use these two boxes to select the proposal media types you want to include in your report. All available proposal media types appear in the Media Types box. To include a media type in your report, select it in the Media Types box and click the single right arrow to move it into the Include these Media Types box.

Proposals

You can include in your report any proposals associated with constituent records. If you mark the Proposals group, the report displays the proposal name, purpose, date, amount asked, status, date funded, and amount funded. You create proposal records in the Proposal category on the Prospect tab of the constituent record. If you select to include proposals in your report, you can enter a Heading to use for this section of the report and select how you want this information formatted.

Proposal Information Format. If you select One-line listing, the report displays basic proposal information: proposal name, purpose, date, amount asked, status, date funded, and amount funded. If you select Detailed listing, the report also includes the campaign and fund information, the solicitor, deadline, rating, and more.

Date. In the Date field, you define acceptable date parameters. This information is based on WHAT???. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the proposal date to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information.

Note: Filter information selected from the Customize button in a group, filters information only for the selected group. It does not prevent a record from being included in the report.

Customize button. If you click Customize, you can filter the proposals included based on purposes, campaigns, funds, or gift solicitors. For example you may want to include only proposals associated with your Annual Campaign. For detailed instructions on how to use the filters, see “Filters Tab” on page 153.

Prospect Information

In some profiles, you can include a prospect information section. Mark the Prospect Information group to view information about the prospect’s classification and status. This information is based on data entered in the General category on the Prospect tab of the constituent record. If you select to include prospect information, you can enter a Heading to use for this section of the report and choose to also include philanthropic interests and “will not give to” information.

Note: For more information about prospects, see the Prospect Data Entry Guide.

Include philanthropic interests. You can include in your report philanthropic interests entered in the General category on the Prospect tab of the constituent record. The philanthropic interest appears, along with any comments entered on the record.

Include will not give to information. You can include in your report information about organizations or causes to which a constituent will not give. You enter this information in the General category on the Prospect tab of the constituent record. In addition to the organization or cause to which the constituent refuses to donate, any comments entered on the record also appear on the report.
Prospect Ratings

In some profiles, you can include a prospect rating information section. Mark the **Prospect Rating** group to view information about the source of the rating, and the rating’s date, category, and description. This information is based on data entered in the **Ratings** category on the Prospect tab of the constituent record. If you select to include prospect rating information, you can enter a **Heading** to use for this section of the report.

Prospect Chronology

In some profiles, you can include a prospect chronology section. Mark the **Prospect Chronology** group to view information about the prospect records in your database. If you select to include prospect chronology information, you can enter a **Heading** to use for this section of the report and choose to include chronology information.

Include

The Include checkboxes are the same as those found on the Chronology category of the prospect record. To not include the checkbox information, unmark the checkbox.

**Actions.** Mark **Actions** if you want a list of all action records entered on the constituent record.

**Events.** Mark **Events** if you want a list of all events to which the constituent is associated.

**Gifts.** Mark **Gifts** if you want a list of all gifts records entered on the constituent record.

**Appeals.** Mark **Appeals** if you want a list of all appeal records to which the constituent is associated through the Appeals tab of the constituent record. You can limit the appeals displayed by selecting Sent Appeals or Unsent Appeals.

**Proposals.** Mark **Proposals** if you want a list of all proposal records entered on the constituent record. You can limit the proposals displayed by selecting Funded Proposals.

Date Information

In the **Date** field, you can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the notepad date to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Date information is not required for proposals and appeals. But, if you filter the chronology information by date and a proposal or appeal does not have a date, the proposal or appeal do not appear in the chronology.

**Note:** Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in *The Raiser’s Edge* Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the *Configuration & Security Guide*.

**Date.** In the **Date** field, you define acceptable date parameters. This information is based on the following fields:

- The **Action date field on the General tab of the action record**
- The **Start date and End date** fields on the General tab of the event record
- The **Gift date field on the Gift tab of the gift record**
- The **Start date and End date** fields on the General tab of the appeal record
- The **Deadline** field on the General tab of the proposal record

. Renewal History

**Note:** For more information about membership records, see the *Membership Data Entry Guide*. 
In some profiles, you can include a renewal history section. Mark the **Renewal History** group to view the date the renewal was sent, the name on the renewal, renewal letter information, and more. This information is based on data entered in Renewal Notice History screen, accessed from *Past Renewal* button on the membership record. If you select to include renewal history information, you can enter a **Heading** to use for this section of the report.

**Renewal Information**

In some profiles, you can include a renewal information section. Mark the **Renewal Information** group to view when you sent the renewal notice, which renewal letter was sent, and who received the renewal letter. Membership renewal notice information is generated when you create custom or standard renewal notices in *Mail* or when you print renewal notice information from a constituent record and the member renews his membership as a result of the notices. If you select to include renewal information, you can enter a **Heading** to use for this section of the report.

**Seating**

When running an *Event Profile*, you can include a seating chart section. Mark the **Seating** group to view seating information, including the total number of seats available for the event, the number of seats assigned, and the number still unassigned. This information is based on the Seating Assignment Chart setup from the *Seating* button on the General tab of the event record.

**Note:** For more information about event records, see the *Event Management Data Entry Guide*.

If you choose to include seating information, you can enter a **Heading** to use for this section of the report.

**Include class seating grid.** Mark this checkbox to include information you entered in the grid on the Seating Assignments screen. This screen is accessed by clicking the *Seating* button on the General tab of the event record. The grid includes section, table, rows, seat, participant, and name to print information.

**Solicit Codes**

In the *Individual Profile*, you can include a list of solicit codes associated with each individual constituent record included in your report. If you mark the **Solicit Code** group, the report displays the solicit code information, such as Do not call. This information is based on information entered in the *Solicit codes* field on the Bio 1 tab of the constituent record. You can enter a **Heading** to use for the solicit codes section of the report and select the specific codes you want to include.

**Note:** For more information about solicit codes, see the Constituent Records chapter of the *Constituent Data Entry Guide*.

**Solicit Codes/Include these Solicit Codes.** Use these two boxes to select the solicit codes you want to include in your report. All available codes appear in the **Solicit Codes** box. To include a code in your report, select it in the **Solicit Codes** box and click the single right arrow to move it into the **Include these Solicit Codes** box.

**Solicitor Assignments**

**Note:** Solicitors are assigned to constituents, campaigns, funds, unspecified goals, and gifts.

In the some profiles, you can include a list of solicitors assigned to each constituent record. If you mark the **Solicitor Assignments** group, the report displays the solicitor name, the type of solicitor, amount assigned the solicitor, and the date range for the assigned solicitation. This information is based on information entered in the *Assigned Solicitor* category on the Relationships tab of the constituent record. If you choose to include solicitor assignments in your report, you can enter a **Heading** to use for this section.
Solicitor Goals

In the some profiles, you can include a list solicitor goals assigned to a solicitor’s constituent record. If you mark the Solicitor Goals group, the report displays the type of goal; amount; campaign, fund, and category information; and to whom the solicitor reports. This information is based on data entered on the Goal screen. This screen is accessed from the Goals tab of the Solicitor Information screen, which is accessed by clicking Details on the Bio 1 tab of the solicitor’s constituent record. If you choose to include solicitor goals in your report, you can enter a Heading to use for this section.

Solicitors

Note: For more information about solicitors the Constituent Records chapter of the Constituent Data Entry Guide.

In the Campaign Profile and Fund Profile, you can include a list solicitors assigned to campaign or fund records (depending on the type of profile you are running). If you mark the Solicitors group, the report displays team information, team goals, solicitor goals, and totals. This information is based on data entered on the Solicitors tab of the campaign or fund records. If you choose to include solicitors in your report, you can enter a Heading to use for this section.

Include solicitor ID. You can include ID information in parentheses next to the solicitor name if you mark this checkbox.

Solicitor Types/Include these Solicitor Types. Use these two boxes to select the solicitors types you want to include in your report. All available types appear in the Solicitor Types box. To include a type in your report, select it in the Solicitor Types box and click the single right arrow to move it into the Include these Solicitor Types box.

Spouse Information

In the some profiles, you can include spouse information from the constituent record. If you mark the Spouse Information group, the report displays spouse name, nickname, maiden name, address, date of birth, age, and deceased information. You enter spouse information from the Spouse button on the Bio 1 tab of the constituent record. If you choose to include spouse information in your report, you can enter a Heading to use for this section, include education information, and business information.

Include Education Information. You can include spouse education information entered on the spouse relationship record. If you mark this checkbox, the frame is activated.

• Format - If you select One-line listing, the report displays basic spouse education information: school name, degree, major, graduation date, and if this is the primary education record. If you select Detailed listing, the report also includes the type of school, minor, GPA, fraternity/sorority information and more.

• Include - If you mark Primary, the report includes education information entered on the spouse relationship record only if the Primary alumni information checkbox is marked on the Education/School screen. If you mark Non-primary, the report includes education information only if the Primary alumni information checkbox is not marked. To include all information mark both checkboxes.

Include Business Information. You can include spouse business information entered on the spouse relationship record. If you mark this checkbox, the frame is activated.

• Format - If you select One-line listing, the report displays basic spouse business information: organization name, industry, position, and the dates employed. If you select Detailed listing, the report also includes address and phone information.
• **Include** - If you mark **Primary**, the report includes business information entered on the spouse relationship record only if the **Primary business information** checkbox is marked on the Organization Relationship screen. If you mark **Non-primary**, the report includes business information only if the **Primary business information** checkbox is not marked. To include all information mark both checkboxes.

**Note:** Filter information selected from the **Customize** button in a group, filters information only for the selected group. It does not prevent a record from being included in the report.

**Customize button.** If you click **Customize**, you can select the addressee/salutation you want to use for the spouse name on the report. For detailed instructions on how to select an addressee/salutation, see “Name Formats” on page 183.

### Volunteer Assignments

In some profiles, if the constituent is a volunteer, you can include a list of volunteer assignments entered on their constituent record. If you mark the **Volunteer Assignments** group, the report displays the assignment, status, position, date range, and department. You enter volunteer job assignments from **Job Assignments** category on the Volunteer tab of the constituent record. If you choose to include volunteer assignments in your report, you can enter a **Heading** to use for this section.

**Note:** On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

**Assignments/Include these Assignments.** Use these two boxes to select the assignments you want to include in your report. All available assignments appear in the **Assignments** box. To include an assignment in your report, select it in the **Assignments** box and click the single right arrow to move it into the **Include these Assignments** box.

**Status.** In this frame, select a status you want to use to filter volunteer job assignments included in your report.

- **Assigned** - Only volunteer job assignments with the **Assigned** option selected in the **Status** field of the Job Assignment screen are included in your report.

**Note:** For more information about volunteers, see the **Volunteers & Jobs Data Entry Guide.**

- **Requested** - Only volunteer job assignments with the **Requested** option selected in the **Status** field of the Job Assignment screen are included in your report.

- **Both** - Volunteer job assignments are included regardless of the **Status** option selected on the Job Assignment screen.

### Volunteer Availability

In some profiles, if the constituent is a volunteer, you can include availability information entered on their constituent record. If you mark the **Volunteer Availability** group, the report displays the dates, days, and times the constituent can work. You enter volunteer availability information from **Availability/Interests** category on the Volunteer tab of the constituent record. If you choose to include volunteer availability information in your report, you can enter a **Heading** to use for this section.

**Date.** In the **Date** field, you define acceptable availability date parameters. This information is based on the **Date to** and **Date from** fields in the **Availability/Interests** category on the Volunteer tab of the constituent record. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the availability date to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information.
Volunteer Awards

In some profiles, if the constituent is a volunteer, you can include awards information entered on their constituent record. If you mark the Volunteer Awards group, the report displays the date, name of the award, what the constituent received, who presented the award, comments, and information about future awards. A future award is the next award a volunteer will potentially receive, if he completes the service requirements for that award. You enter volunteer award information from Awards category on the Volunteer tab of the constituent record. If you choose to include volunteer award information in your report, you can enter a Heading to use for this section.

Volunteer Checklist

Note: For more information about volunteers, see the Volunteers & Jobs Data Entry Guide.

In some profiles, if the constituent is a volunteer, you can include checklist information entered on their constituent record. A checklist is a “to do” list you assign to a volunteer. If you mark the Volunteer Checklist group, the report displays the checklist item, the date the item was requested, the date it was received, and any letter sent as a result of the checklist item. You enter volunteer checklist information from Checklist category on the Volunteer tab of the constituent record. If you choose to include volunteer checklist information in your report, you can enter a Heading to use for this section and select the specific checklist items you want to include.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

Checklist Items/Include these Checklist Items. Use these two boxes to select the checklist items you want to include in your report (Complete Application, Attend Orientation, Health Class). All available items appear in the Checklist Items box. To include an item in your report, select it in the Checklist Items box and click the single right arrow to move it into the Include these Checklists Items box.

Date. In the Date field, you define acceptable date parameters for the checklist items you want to include in your report. This information is based on the Date Requested and Date Completed columns in the Checklists category on the Volunteer tab of the constituent record. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the dates to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information.

Volunteer Courses

Note: For more information about volunteer, see the Volunteers & Jobs Data Entry Guide.

In some profiles, if the constituent is a volunteer, you can include job-related courses and training a volunteer has completed and that are entered on their constituent record. If you mark the Volunteer Courses group, the report displays the course name, start and end date information, any certification received, the certification expiration date, and any comments. You enter volunteer courses information in the Courses and Training grid from the Qualifications category on the Volunteer tab of the constituent record. If you choose to include volunteer courses information in your report, you can enter a Heading to use for this section and select the specific courses you want to include.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

Courses/Include these Courses. Use these two boxes to select the courses you want to include in your report (CPR, Water Safety, First Aid). All available courses appear in the Courses box. To include a course in your report, select it in the Courses box and click the single right arrow to move it into the Include these Courses box.
Volunteer Information

In some profiles, if the constituent is a volunteer, you can include general volunteer information entered on their constituent record. If you mark the Volunteer Information group, the report displays the volunteer type, status, start and end dates, reason finished, vehicle information, contact information, and assignment interests. You enter most volunteer information in the General category on the Volunteer tab of the constituent record. Assignment information is based on the Job Assignments category on the Volunteer tab of the constituent record. If you choose to include general volunteer information in your report, you can enter a Heading to use for this section, choose to include assignments, and select the specific volunteer types you want to include.

Include assignment interests. If you mark Include assignment interests, the report displays the assignment interests. You enter volunteer assignment interests from the Availability/Interests category on the Volunteer tab of the constituent record.

Volunteer Types/Include these Types. Use these two boxes to select the volunteer types (Coordinator, Gift Shop, General) you want to include in your report. All available types appear in the Volunteer Types box. To include a type in your report, select it in the Volunteer Types box and click the single right arrow to move it into the Include these Volunteer Types box.

Date. In the Date field, you define acceptable date parameters for the volunteer information you want to include in your report. This information is based on the Start Date and End Date columns in the General category on the Volunteer tab of the constituent record. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the dates to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information.

Volunteer Mandate Information

Note: For more information about volunteer, see the Volunteers & Jobs Data Entry Guide.

In some profiles, if the constituent is a mandate volunteer, you can include mandate information entered on their constituent record. If you mark the Volunteer Mandate Info group, the report displays start and end date information, the mandated hours, hours served, the agency mandating the hours, contact information, and any comments. A mandate is an official order from a court or public agency requiring that an individual serve some type of volunteer duty. You enter mandate information in the Mandate Info category on the Volunteer tab of the constituent record. If you choose to include mandate information in your report, you can enter a Heading to use for this section.

Volunteer Medical Information

In some profiles, if the constituent is a volunteer, you can include volunteer medical information entered on their constituent record. If you mark the Volunteer Medical Info group, the report displays a description of the medical information, comments, and date information. You enter medical information in the Medical Information grid of the Medical/Special Needs category on the Volunteer tab of the constituent record. If you choose to include medical information in your report, you can enter a Heading to use for this section and select the medical needs you want to include.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

Medical Info/Include these Medical Info. Use these two boxes to select the medical information you want to include in your report (Allergies, TB Test, Heart Condition). All available information appears in the Medical Info box. To include an information item in your report, select it in the Medical Info box and click the single right arrow to move it into the Include these Medical Info box.
Volunteer Special Needs

In some profiles, if the constituent is a volunteer, you can include volunteer special needs entered on their constituent record. If you mark the Volunteer Special Needs group, the report displays a description of the special need and comments. You enter special needs information in the Special Needs grid of the Medical/Special Needs category on the Volunteer tab of the constituent record. If you choose to include special needs in your report, you can enter a Heading to use for this section and select the special needs you want to include.

Special Needs/Include these Special Needs. Use these two boxes to select the special needs you want to include in your report (Wheelchair Access, Baby-sitting, Wheelchair). All available needs appear in the Special Needs box. To include a need in your report, select it in the Special Needs box and click the single right arrow to move it into the Include these Special Needs box.

Volunteer Skills

Note: For more information about volunteer, see the Volunteers & Jobs Data Entry Guide.

In some profiles, if the constituent is a volunteer, you can include volunteer skills entered on their constituent record. If you mark the Volunteer Skills group, the report displays a description of the skill, the skill level, the license type and when it expires, and comments. You enter skills in the Skills and Experience grid of the Qualifications category on the Volunteer tab of the constituent record. If you choose to include skills in your report, you can enter a Heading to use for this section and select the skills you want to include.

Volunteer Skills/Include these Volunteer Skills. Use these two boxes to select the skills you want to include in your report (Typing, Photographer, Carpenter). All available skills appear in the Volunteer Skills box. To include a skill in your report, select it in the Volunteer Skills box and click the single right arrow to move it into the Include these Volunteer Skills box.

Volunteer Summary

In some profiles, if the constituent is a volunteer, you can include a volunteer summary section. Mark the Volunteer Summary group to view information about the volunteer’s start date, awards, total hours, hours for the year, years of service, and a dated breakdown of the hours worked. This information is a summary of key bits of data entered on the Volunteer tab of the constituent record. If you select to include summary information, you can enter a Heading to use for this section of the report and enter date information.

Note: For more information about volunteer summaries, see the Optional Module chapter in the Summaries Guide.

Date. In the Date field, you define acceptable date parameters for the volunteer information you want to include in your report. This information is based on the various date fields on the Volunteer tab of the constituent record. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the dates to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information. Volunteer information included on your report must satisfying these parameters.

Customize button. If you click Customize, you can further filter volunteer information you want to use on the report. For example, you can select to include only special event coordinator information. For detailed instructions on how to select filters, see the “Filters Tab” on page 153.
Volunteer Time Sheets

In some profiles, if the constituent is a volunteer, you can include a volunteer time sheet section. Mark the Volunteer Time Sheet group to view date, assignment, department, hours, wage, position, and location information. This information is based on the data entered on the Time Sheet screens, accessed from the Time Sheets category on the Volunteer tab of the constituent record. If you select to include time sheet information, you can enter a Heading to use for this section of the report and enter date information.

**Date.** In the Date field, you define acceptable date parameters for the volunteer time sheet information you want to include in your report. This information is based on the Date field on the Time Sheet screen accessed from the Time Sheets category on Volunteer tab of the constituent record. You can select the specific date (Today, Yesterday, Tomorrow) or select a date range in which you want the dates to fall to qualify for your report. If you select <Specific range>, additional fields appear in the frame, allowing you to enter start and end date information.

**Note:** Filter information selected from the Customize button in a group, filters information only for the selected group. It does not prevent a record from being included in the report.

**Customize button.** If you click Customize, you can filter volunteer time sheet information included on the report based on assignments. For example, you may want time sheet information for only front desk volunteers. For detailed instructions on how to select filters, see the “Filters Tab” on page 153.

Report Periods Tab

On some reports, you must define the time periods you want included on the report. On most of the Report Periods tabs, you select start and end dates you want to use to define information to include in your report. You also enter report headings for the information you define. With this breakdown of reporting periods, you get a clearer picture of activity during a smaller time frame.
Start Date and End Date. Enter start and end dates for the periods you want to include in the report. One column appears for each pair of start and end dates entered. For example, if you enter “01/01/2002” in the Start Date column and “12/31/2002” in the End Date column, the Information included for these two dates appears in one column on your report.

Note: At least one start date is required in the Start Date column.

Information. On the Solicitor Comparison Report, you can also include any of the following miscellaneous information on the report. The information must satisfy the date requirement you enter in the Start Date and End Date columns to be included in the report.

- Total Gift Amount – The total amount of all gifts given within the date range and as specified on the rest of the report parameters
- Number of Gifts – The total number of all gifts given within the date range and as specified on the rest of the report parameters
- Number of Donors – The total number of constituents who have given gifts within the date range and as specified on the rest of the report parameters

Note: Fields, options, and frames with the word “Gift” may vary if your organization changed the word “Gift” in The Raiser’s Edge Business Rules. For more information about changing the default word “Gift”, see the Configuration chapter in the Configuration & Security Guide.

- Average Gift Amount – The total gift amount divided by the number of gifts given within the date range and as specified on the rest of the report parameters

Heading 1 and Heading 2. Enter a heading title to use on your report to represent the data you selected in the row. For example, if in the Information column you selected Total Gift Amount and in the date columns you specified the year 2002, this information appears in a column on your report. Heading 1 and Heading 2 allow you to enter a title for that column. Heading 1 is the name that appears first in the report. Heading 2 appears under the Heading 1 title.

If you do not want any headings, leave these columns blank and no headings appear. To use default headings, click the Default Heading Values button. The program enters the report period start date in the Heading 1 column and the end date in the Heading 2 column.

Autofill Dates. After you enter a date in the Start Date column, the Autofill Dates button is enabled. Click this button and the program automatically fills in the rest of the report period dates. The Autofill Dates screen appears, and you can determine how the program automatically completes the rest of the date information.

**Tip:** Enter just one start day then use Autofill Dates to fill in the report periods for you.
On the Autofill Dates screen, enter the number of report periods you want to use in the **Enter number of periods** field. In the **Autofill by** field, select the type of period you want the program to fill in for you: **Day**, **Month**, **Quarter** (available if the **Start Date** is the first of a month; otherwise, it is not available), and **Year**. For example, if in the **Start Date** column you enter 01/01/2002 and you want information for all of 2002 and 2003, on the Autofill Dates screen, enter “2” in the **Enter number of periods** field and select **Year** in the **Autofill by** field. This tells the program you want information for two years, starting with the **Start Date**.

To return to the Report Periods tab, click **OK**. Your selections appear in the grid.

If you are running a **Past Due** pledge report, you must enter start and end days for the periods to include on the Report Periods tab.

### Start Days/End Days

Enter day ranges for past due pledges. For example, if in one period you want all pledges between 1-30 days past due, enter “0” in the **Start Days** column and “30” in the **End Days** column.

On your report, one column appears for each start day entered. For example, if you select four day ranges for past due pledges, four columns appear. You can enter day ranges or accept the default days.

### Headings

You can enter a column title for each day range in the **Headings** column. If you do not want any headings, leave this column blank and no heading appears above the day ranges on your report. To use default headings, click the **Default Heading Values** button. The program enters the report period start day, a dash, and the report period end day in the **Heading** column.

### Insert column for No Expected Maturity Years

Available in the Expected Maturity Year Report, marking this checkbox you can easily add a **No Maturity Year** column to your report. This column includes gifts where no maturity year is specified.

**Scores Tab**

**Warning**: The information on this tab is unique to this section. Choices made on this tab do not apply to any other sections of the report.
Only the **Target Analytics Scores List** has the Scores tab. Use this tab to select the columns you want to display on the report, the range of each score you want considered, and the order you want the scores displayed.

**Available Scores/Scores to Include.** If you have *Prospect Research Management*, the **Available Scores** are the score categories you imported into the program from Target Analytics Services. These scores are stored in the **Category** field of the ratings records. Rating records are accessed from the **Ratings** category on the Prospect tab. If you do not have *Prospect Research Management*, the following scores are available: Annual Gift Likelihood, Major Gift Likelihood, Bequest Likelihood, CRT Likelihood, and BBA Estimated Income. Move all scores you want to include into the **Scores to Include** box, using the arrow key.

**Score Options screen/Options.** The Score Options screen appears every time you move an available score into the **Scores to Include** box. It also appears if you highlight a score in the **Scores to Include** box and click the **Options** button.

- **Column heading:** You must enter a column heading to appear on your report for each score you choose to include.
• **Score order**: Select the order in which you want scores to appear on your report: Ascending or Descending.

• **Include Scores in this Range**: You can filter constituents included in your report based on score ranges. If you want to use this filter, enter the smaller of the range numbers in the **Range start** field. Enter the larger score number in the **Range end** field. If you enter a number in the **Range start** field and keep the **Range end** field blank, all scores greater than or equal to the **Range start** are included. If you enter a number in the **Range end** field and leave the **Range start** field blank, all scores less than or equal to the **Range end** field are included.

---

### Section IA Tab

**Warning**: The information on this tab is unique to this section. Choices made on this tab do not apply to any other sections of the report.

Only the **VSE Survey** report has the Section IA tab. Use this tab to report the number and amount of gifts promised, but not received from donors. You can include pledges obtained during the fiscal year but still outstanding at the end of the year regardless of the promised payment date. Gifts in this section should not be counted anywhere else in the survey.

**Warning**: You must make at least one fund selection in the **Pledges for Current Operations** frame, or nothing is calculated for this section and section IV Part 1E of the report. The report displays all zeros.

The tab is the same for elementary schools and secondary schools and colleges.
Calculate Outstanding Pledges

In the Calculate Outstanding Pledges box, select what you want the outstanding pledges count based on: Current Operations or Capital Purposes. When you make a selection, the right side of the screen changes, offering parameter settings specific to current operations or capital purposes.

Current Operations. To include in your report campaigns, campaign categories, funds, and fund categories associated with current operations, select Current Operations.

Capital Purposes. To include in your report campaigns, campaign categories, funds, and fund categories associated with a capital purpose, select Capital Purposes.

Pledges for Current Operations/Capital Purposes

The name of this frame changes, based on your selection in the Calculate Outstanding Pledges box. In this frame, select the records and funds you want to include in your report.

Note: You determine if you want to work with funds, fund categories, campaigns, or campaign categories in the Base Report On frame on the General Tab.

Include. To select the gift records you want to use for your calculations in this section, click Include and choose All Records, Selected Records, or One Record. If you choose Selected Records or One Record, the Open screen appears, and you can locate and select the gift query file or specific gift record you want to include. Only gifts with a Gift Type of Pledge are included in this section. Recurring gifts are not counted.

Find. To help you locate a specific fund, fund category, campaign, or campaign category from the list, click Find. For example, you want to select Membership Fund as your Current Operation, but are having trouble locating it in the list. Enter Membership Fund in the box, and click Find. The program locates the fund and displays it alone in the box.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

Include these <Funds, Fund Categories, Campaigns, or Campaign Categories>. Move all funds, fund categories, campaign, or campaign categories you want to include in your report into this box. Highlight the fund and click the single right arrow to move it into the Include these Funds box.

Show inactive <funds, categories, or campaigns>. To include inactive funds, campaigns, and categories in the list, mark Show inactive <funds, categories, or campaigns>.

Section III Tab

Note: The list of VSE Sources is a standard list that cannot be edited by the user.
Only the **VSE Survey** report has the Section III tab. Use this tab to define the source of a gift. This section of the report is where you report 100% of gift income. Sources are the individuals and organizations that transmit the gift to the institution, or its foundation or affiliated organization. The constituent codes you select on this tab determine which constituents are included in Section IIIA and Section IIIB of your report.

**VSE Sources.** In this frame, select the gift sources on which you want to base your report. Your choices depend on your selection in the **Process the Report Using the Rule For** frame on the General tab. If you select **Private Elementary and Secondary School**, your sources options are Alumni, Parents, Grandparents, Other Individuals, Foundations, Corporations/Businesses, Religious Organizations, Fundraising Consortia, and Other Organizations. If you select **College**, your sources options are Alumni, Parents, Other Individuals, Foundations, Corporations/Businesses, Religious Organizations, Fundraising Consortia, and Other Organizations. The frame title on the right side of the screen changes based on the source you select. For example, if you want to base your report on alumni gifts, select Alumni in the **VSE Sources** frame.

**Warning:** If you select multiple constituent codes for a single **VSE Source**, you receive an error message when you attempt to save or process the report.

**Note:** On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

The frame title on the right side of the screen changes to **Alumni**. In this frame, select the constituent code, identifying the constituents in your database you want to include in the report. For example, if you are working with alumni gifts, you may want to include only alumni in your report. Move Alumnus from the **Constituent Codes** box into the **Include these Constituent Codes** box, using the single right arrow.

You can choose more than one code per source (for example, the source of Parent could include the conservation Current Parent, Middle School Parent etc.) as long as the codes are not selected under another VSE source.

If you do not select a constituent code, the program calculates nothing for this section of the report. The report displays all zeros.

When you generate your report, the program counts all gifts based on the VSE source code information. This does not include pledges, continuous pledges, or recurring gifts. Pledge payments and recurring gift payments are counted.
Show inactive codes. To include inactive constituent codes, mark Show inactive codes.

Section IIIA Tab

Warning: The information on this tab is unique to this section. Choices made on this tab do not apply to any other sections of the report.

Only the VSE Survey report has the Section IIIA tab. Use this tab to include gifts given specifically for current operations. The gift amounts are distributed based on the Current Operations categories.

Funds for Current Operations. In this frame, the term “funds” refers to actual money, not the fund record. So select the funds on which you want to base your report. Your choices depend on your selection in the Base Report On frame on the General tab. If you select Campaign in the Base Report On frame, campaign information appears on this tab.

The options available in the Funds for Current Operations box depend on what you selected in the Base Report On frame on the General tab. For example, if you select Private Elementary and Secondary School, your choices are Unrestricted or Restricted. If you select College, your choices are Unrestricted, Academic Divisions, Faculty & Staff Compensation, Research, Public Service & Extension, Library, Op & Maint. of Plant, Student Financial Aid, Athletics, and Other.

The frame title on the right side of the screen changes based on the fund you select. For example, if you want to base your report on unrestricted money and select Unrestricted in the Funds for Current Operations frame, the frame title on the right side of the screen changes to Unrestricted. In this frame, select the funds, fund categories, campaigns, or campaign categories (depending on your selection in the Base Report On frame on the General tab) you want to include in the report. For example, if you want to include all unrestricted money in the 2003 Annual Fund, select 2003 Annual Fund in the box on the left side of the screen and move it into the Include these Funds box on the right side of the screen, using the single right arrow.
Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

If no fund, fund category, campaign, or campaign category is selected, nothing is calculated for this section of the report, and the report displays all zeros.

Include. To select the records you want to use when calculating this section of your report, click Include. You can choose All Records, Selected Records, or One Record. If you choose Selected Records or One Record, the Open screen appears, and you can locate and select the gift query file or specific gift record you want to include. If the gift query includes any records with the gift type of pledge, the program excludes those gifts from this section. All pledge gifts are counted in Section IA.

Note: For more information about working with queries, see the Query chapter in the Query & Export Guide.

Find. To help you locate a specific fund, category, or campaign from an extensive list, click Find. For example, you want to select Annual Fund as your Current Operation, but you have trouble locating it in the list. Enter Annual Fund in the box and click Find. The program locates the fund and displays it alone in the Include these Funds box.

Show inactive funds. To include funds that are not active, mark Show inactive funds.

Section IIIB Tab

Only the VSE Survey report has the Section IIIB tab. Use this tab to include gifts given specifically for capital purposes. The gift amounts are distributed based on the Capital Purposes categories.

Funds for Capital Purposes. In this frame, the term “funds” refers to actual money, not the fund record. So select the capital purpose money on which you want to base your report. Your choices depend on your selection in the Base Report On frame of the General tab. If you select Campaign in the Base Report On frame, campaign information appears on this tab.
Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

The options available in the Funds for Capital Purposes box are the same, regardless of what you select in the Base Report On frame on the General tab: Property, Building and Equipment; Endowment Funds-Unrestricted; Endowment Funds-Restricted; and Loan Funds.

The frame title on the right side of the screen changes based on the fund you select. For example, if you want to base your report on unrestricted endowment money and select Endowment Funds-Unrestricted in the Funds for Capital Purposes frame, the frame title on the right side of the screen changes to Endowment Funds-Unrestricted. In this frame, select the funds, fund categories, campaigns, or campaign categories (depending on your selection in the Base Report On frame on the General tab) you want to include in the report. For example, if you want to include all unrestricted endowment money in the Annual Campaign, select Annual Campaign from the box on the left side of the screen and move it into the Include these Campaign box on the right side of the screen, using the single right arrow.

If no fund, fund category, campaign, or campaign category is selected, nothing is calculated for this section of the report, and the report displays all zeros.

Note: For more information about working with queries, see the Query chapter in the Query & Export Guide.

Include. To select the records you want to use when calculating this section of your report, click Include. You can choose All Records, Selected Records, or One Record. If you choose Selected Records or One Record, the Open screen appears, and you can locate and select the gift query file or specific gift record you want to include. If the gift query includes any records with the gift type of pledge, the program excludes those gifts from this section. All pledge gifts are counted in Section IA.

Find. To help you locate a specific fund, category, or campaign from an extensive list, click Find. For example, you want to select Annual Fund as your Current Operation, but you have trouble locating it in the list. Enter Annual Fund in the box and click Find. The program locates the fund and displays it alone in the Include these Funds box.

Show inactive funds. To include funds that are not active, mark Show inactive funds.

Section IV Tab

Note: The list of VSE Sources is a standard list that cannot be edited by the user.
Only the VSE Survey report has the Section IV tab. Use this tab to analyze the same gifts reported in Section III but include selected details about the gifts. All gifts reported in this section should be reported somewhere in Section III (VSE Sources).

**Warning:** If you select multiple constituent codes for a single VSE Source, you receive an error message when you attempt to save or process the report.

**VSE Source.** Select the VSE gift source for which you want to include additional information in your report. Remember, the gift source must also be included in your selections on the Section III tab. Your choices depend on your selection in the Process the Report Using the Rule For frame on the General tab. If you select Private Elementary and Secondary School, your source options are Alumni, Parents-Current, Parents-Past, Grandparents, Faculty and Staff, Students, Other Individuals, Bequests, Direct Governing Board, Foundations-Personal and Family, Foundations-Other Foundations, Corporations. If you select College, your source options are Alumni-Undergraduate, Alumni-Graduate, Alumni-Non degree, Parents, Faculty and Staff, Students, Other Individuals, Bequests, Direct Governing Board, Foundations-Personal and Family, Foundations-Other Foundations, Corporations. The frame title on the right side of the screen changes based on the source you select. For example, if you want to add details about alumni undergraduates to your report, select Alumni-Undergraduates in the VSE Sources frame.

**Note:** On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

The frame title on the right side of the screen changes to Alumni-Undergraduates. In this frame, select the constituent codes, identifying the constituents in your database you want to include in the report. For example, if you are working with alumni gifts, you may want to include only alumnus in your report. Move Alumnus from the Constituent Codes box into the Include these Constituent Codes box, using the single right arrow.

**Show inactive codes.** To include inactive constituent codes, mark Show inactive codes.
Section IV Part 1 Tab

Only the VSE Survey report has the Section IV Part 1 tab. Use this tab to determine gifts given from Individuals, based on the selections made in Section IV. Depending on the option selected in the Base Report On frame on the General tab, you can determine which fund, campaign, or category applies to each Contribution from Individuals category.

Contributions from Individuals. In this box, select the individual contributions you want to include in your report. The options available in the box are the same, regardless of what you selected in the Process the Report Using the Rule for frame on the General tab: All Purposes, Current Operations, Bequests-Current Operations, Bequests-Capital Purposes, Direct Governing Board Giving, Appeals-All Purposes, Appeals-Current Operations.

Note: On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

The frame title on the right side of the screen changes based on the individual contributions you select. For example, if you want to include Current Operations contributions in your report, the frame title on the right side of the screen changes to Current Operations. In this frame, select the funds, fund categories, campaigns, or campaign categories (depending on your selection in the Base Report On frame on the General tab) you want to include in the report. For example, if you want to include all current operations money given by individuals in the 2003 Annual Fund, select 2003 Annual Fund in the box on the left side of the screen and move it into the Include these Funds box on the right side of the screen, using the single right arrow.

Note: Current Operations and Capital Purposes must be defined on the Section 1 tab in order for the gift to show up on the Section IV Part 1 tab.

The results of options selected on this tab appear in Section IV Part 1A on the report. This section includes all gifts for individuals.
**Find.** To help you locate a specific fund, category, or campaign from an extensive list, click **Find.** For example, you want to select Annual Fund as your **Current Operation,** but you have trouble locating it in the list. Enter Annual Fund in the box and click **Find.** The program locates the fund and displays it alone in the **Include these Funds** box.

**Show inactive funds.** To include funds that are not active, mark **Show inactive funds.**

### Section IV Part 2 Tab

Only the **VSE Survey** report has the Section IV Part 2 tab. Use this tab to determine the gifts given from Organizations (based on selections made in Section IV), you want to include in your report. Depending on the option selected in the **Base Report On** frame on the General tab, you can select which fund, categories, or campaigns apply to each **Contribution from Organizations** category.

**Contributions from Organizations.** In this box, select the organization contributions you want to include in your report. The options available in the box are the same, regardless of what you select in the **Process the Report Using the Rule for** frame on the General tab: Foundations-Personal and Family, Foundations-Other Foundations, Corporations-Cash and Securities, Corporations-Company Products, Corporations-Other Company, Corporations-Matching Gifts.

**Note:** On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.
The frame title on the right side of the screen changes based on the organization contributions you select. For example, if you want to include matching gift contributions made by corporations in your report, select Corporations-Matching Gifts in the Contributions from Organization box and the frame title on the right side of the screen changes to From Corporations-Matching Gifts. In this frame, select the funds, fund categories, campaigns, or campaign categories (depending on your selection in the Base Report On frame on the General tab) you want to include in the report. For example, if you want to include all corporate matching gifts in the Annual Campaign, select Annual Campaign in the box on the left side of the screen and move it into the Include these Campaigns box on the right side of the screen, using the single right arrow.

Find. To help you locate a specific fund, category, or campaign from an extensive list, use the Find button. For example, you want to select Annual Fund, but you have trouble locating it in the list. Enter Annual Fund in the box and click Find. The program locates the fund and displays it alone in the Include these Funds box.

Show inactive funds. To include funds, categories, or campaigns that are not active, mark Show inactive funds.

Section IV Part 3 Tab

Only the VSE Survey report has the Section IV Part 3 tab. This tab is present only if you select College in the Process the Report Using the Rule For frame on the General tab. Use it to select the endowments and athletic gifts you want to include on your report.

Gift to Endowments and Athletics. In this frame, select the endowment or athletic gifts you want to include in your report: Academic Division, Faculty and Staff, Research, Public Service & Extension, Library, Op & Maint. of Plant, Student Financial Aid, Athletics, Other, Athletics-Current Operations, Athletics-Capital Purposes. Your choices on the right side of the screen depend on your selection in the Base Report On frame. If you select Campaign in the Base Report On frame, campaign information appears. Also, the frame title on the right side of the screen changes based on the Gifts to Endowments and Athletics option you choose.
For example, if you want to include research money in your report and in the Gifts to Endowments and Athletics box select Research, the frame title on the right side of the screen changes to Research. In this frame, select the funds, fund categories, campaigns, or campaign categories (depending on your selection in the Base Report On frame on the General tab) you want to include in the report. For example, if you want to include all research money in the Annual Campaign, select Annual Campaign the box on the right side of the screen and move it into the Include these Campaign box, using the single right arrow.

Note: For more information about working with queries, see the Query chapter in the Query & Export Guide.

Find. To help you locate a specific fund, category, or campaign from an extensive list, click Find. For example, you want to select Annual Fund, but you have trouble locating it in the list. Enter Annual Fund in the box and click Find. The program locates the fund and displays it alone in the Include these Funds box.

Show inactive funds. To include funds, categories, or campaigns that are not active, mark Show inactive <funds, categories, campaigns>.

Solicitors Tab

The Solicitors tab appears in some report parameter files. On the Solicitors tab, you select solicitor information to include in the report.

Note: Constituents appear on the Solicitors tab list if on the Bio 1 tab of their constituent record the Is a solicitor checkbox is marked.
To base the report on solicitors associated with a specific campaign goal, fund goal, or unspecified goal, mark the **Base report on a specific** checkbox, and select Campaign goal, Fund goal, or Unspecified goal in the accompanying field. The screen changes slightly based on your selection.

In the box, solicitor names or teams representing the selected campaign, fund, or category appear. Mark the checkbox for the solicitors or teams you want to include.

**Note:** Options available for the **Campaign**, **Fund**, and **Category** fields are based on the information entered on the Solicitor Information screen accessed from the **Details** button on the Bio 1 tab of the constituent record. For more information, see the Solicitors chapter of the **Constituent Data Entry Guide**.

For example, if you base the report on a campaign goal, a **Campaign** field appears, and you must select the campaign to use for the report. If you base your report on a fund goal, a **Fund** field appears, and you must select the fund to use for the report. If you base the report on an unspecified goal, a **Category** field appears, and you must select the category to use for the report.

In the box, solicitor names or teams representing the selected campaign, fund, or category appear. Mark the checkbox for the solicitors or teams you want to include.
If you want to view a list of all the available solicitors in your database, mark **Pick Solicitor from list**.

A list of all solicitors in your database appears. To include the solicitor in your report, mark the checkbox next to the solicitor’s name. You can select as many solicitors as you like to include in your report.

**Note**: For more information about creating and working with queries, see the Query chapter of the *Query & Export Guide*.

Or, you can base the report on a query of solicitors by marking the **Choose solicitor query** checkbox. Click the binoculars to access the Open Query screen. From this screen, you can select an existing query and click **Open**, or create a new query by clicking **Add New**.
Report Tutorial

Gift Detail and Summary Report ................................................................. 280
Comparison Report ................................................................................. 313

Procedures
Creating a Gift Detail and Summary Report ........................................... 281
Creating a Comparisons and Summaries Report ................................... 313
With *The Raiser’s Edge*, you can create hundreds of reports, using information stored in your database. The parameter tabs included in each report type, help you select the information you want to include in the report and determine exactly how you want the information arranged. The end result is comprehensive reports, telling your users exactly what they need to know, in an easy-to-read format.

However, because *The Raiser’s Edge* is a large program, storing vast amounts of varied information, you must take your time when creating a report. Make sure you know what you want to include in the report and where the information you want is stored in the program. Before marking a checkbox or selecting an option, look up the functionality in “Parameter Tabs” on page 135. The Parameter Tabs chapter includes an alphabetized list of all tabs found in reports. Under each tab is an alphabetized list of the fields, buttons, checkboxes, and options included on the tab and explanations about what each does and where the information comes from in *The Raiser’s Edge*.

Data entry also plays a large role in reports. Instituting effective and comprehensive data entry protocols is very important to many areas of *The Raiser’s Edge*. This is especially true in Reports. For example, you cannot filter records based on an attribute if attributes are haphazardly entered in the constituent records. For instance, when creating attribute categories in Configuration, several mailing categories were created and each one is used inconsistently by your data entry volunteers. Therefore, it is difficult to filter records based on one attribute category. The same is true of including address information in your report. If you want to include constituent business addresses in your reports, but several of your data entry volunteers do not know to enter this information when creating the constituent record, you will have a number of constituents in your report with no address information.

This chapter takes you step-by-step through the process of running two report types: Gift Detail Summary Report and Comparisons and Summaries Report. Although every report in *The Raiser’s Edge* is different, working through the reports included in this chapter will help you understand how the reporting process works for all reports.

For a general overview of all the reporting procedures, including exporting and deleting report parameter files, see “Report Basics” on page 105.

**Gift Detail and Summary Report**

The *Gift Detail and Summary Report* is one of several Financial Reports available in *The Raiser’s Edge*. The *Gift Detail and Summary Report* provides details about constituent giving during a time period you select. You can run a summary version of the report, and view totals of gifts received within the date range for each campaign, fund, appeal, or constituent code. You can also choose to graph the results of this report if you run the summary format. The detail version of the report includes everything the summary version contains plus constituent name and address information.

In this section, you complete the parameter tabs necessary to run *Gift Detail and Summary Report*, using both the detail and the summary versions of the report.
Creating a Gift Detail and Summary Report

Scenario: At next month’s annual board meeting, the director of a nonprofit organization wants to present a report detailing the gifts given by last year’s Board of Trustees. Before starting the report, the director created a constituent query containing the trustees constituent records. The director wants to include all gifts with a gift date of last year.

1. On the Raiser’s Edge bar, click Reports. The Reports page appears.

Note: If you want to see a sample of the Gift Detail and Summary Report, at the bottom of any reports page, click View Samples. For a detailed description of the report and a list of available columns, click “Click here for more information about these reports”.

Welcome to The Raiser’s Edge!
2. Click the Financial Reports link. The Financial Reports page appears. A list of all financial report types appears on the left side of the page.

3. For this scenario, select Gift Detail and Summary Report.

   Note: On the General tab, you decide the general criteria you want to govern what goes into your report. For example, you can tell the program to include all records satisfying your specific criteria, selected records you saved in a query file, or one record. The General tab appears on all reports; however, the fields, buttons, checkboxes, and options change slightly, depending on the report type you select.

5. Click the **Include** button. From this button, you determine what records you want to include in your report: **All Records** in your database, **Selected Records** you saved in a query file, or **One Record**. For this scenario, select **Selected Records**. The Open Query screen appears.

6. Click **Find Now**. All existing relevant queries appear.

7. In the **Include Gifts with these Dates** frame, you can specify a gift date to use to filter records included in your report.
   - For this scenario, you are interested in the gifts given, not posted, so in the **Date to use** field, select Gift date. Selecting the Gift date gives you all gifts with a Gift date satisfying the parameters you enter in the **Date** field. You enter gift date information on the Gift tab of the gift record.

**Note:** In **Include Gifts with these Dates**, leave the **Start** field blank to indicate all records with dates up to and including the report **End** date. Leave the **End** field blank to indicate all records with dates on or after the report **Start** date.
• In the **Date** field, you define acceptable date parameters. For this scenario, you want all gifts given last year, so in the **Date** field select Last calendar yr.

8. You can refine your report criteria using the **Soft Credit Gifts To** frame. When you add a new gift, you use soft credits to credit multiple constituents for the same gift without duplicating the gift in your database. When you run a report containing gifts, you need to specify how the program should report this information. You can credit the **Donor**, **Soft credit recipients**, or **Both**.

**Warning:** If you select **Both** in the **Soft Credit Gifts to** frame, the gift appears twice on the report and total gift amounts may not be accurate.

For this scenario, you are interested in only the donors’ gifts. Select **Donor**, and in your report, the donor receives full credit for the gift. The soft credit recipients receive no credit for the gift.

9. In the **Include these Constituents** frame, you can select specific constituent records to include or exclude in your report.

**Note:** If in the **Include** button, you select to include **One Record** in your report, all checkboxes in the **Include these Constituents** frame are disabled.

• **Inactive constituents** includes constituents with the **Is inactive** checkbox marked on the Bio 1/Org 1 tab of their constituent record.

• **Deceased constituents** includes constituents with the **Deceased?** checkbox marked on the Bio 1/Org 1 tab of their constituent record.

• **Constituents with no valid addresses** includes constituents with the **Has no valid addresses** checkbox marked on the Bio 1/Org 1 tab of their constituent record.

For this scenario, because you are using a query of trustee records, you are relatively certain none of the constituents are marked as inactive, deceased, or not having a valid address. But, just in case one of the records is mistakenly marked, you do not want the record excluded from the report. Also, because you are using a query of records, marking all three of the checkboxes does not add records you do not want to include in the report. Mark all three checkboxes.

10. In the **Credit Matching Gifts To** frame, select how you want matching gifts handled in your report. Matching gifts are gifts donated by a business, matching a constituent’s (usually an employee of the business) donation. When you run reports containing gifts, you need to specify how the program should report this information. You can credit the **Donor**, **MG Company**, or **Both**.
For this scenario, because you are interested in gifts given specifically by the trustees, you selected MG Company. If you select MG Company, in your report, the matching gift company receives credit for the matching gift, not the donor.

Note: For more information about matching gifts, see the Matching Gifts chapter in the Gift Records Guide.

11. In the Report Type frame, select the type of report you want to run. The Detail option adds the Ind. Address and Org. Address tabs and the Name formats category on the Format tab. You can then include name and address information on the report.

The Summary option does not include address information or the constituent names in the report. You can, however, include a graph of your report.

For this scenario, because you want a graph and you also want name and address information included in the report, you selected Both. The program generates two reports. One with name and address information, and the other without name and address information but with a graph.

12. In almost all reports, you can choose to create an output query of all records included in a report. An output query saves these records in a query file, and you can use the file in other Raiser’s Edge applications.

For this scenario, because you already have a query of the records included in the report, do not mark the Create output query checkbox.

13. In the Pledge type field, select the pledge type you want included in your report: Master or Installment.

Note: For more information about pledges, see the Pledges chapter in the Gift Records Guide.
Because a master pledge is a gift record containing the entire gift amount a constituent agrees to donate and the installment schedule for the pledge payments, you selected Master for this scenario. The Installment would give us only a scheduled payment toward the balance of the master pledge.

14. When you finish the General tab, move to the Filters tab by clicking **Next**.

The Filters tab helps you further refine your report criteria based on fields, buttons, checkboxes, and options available on records in *The Raiser's Edge*. You can also choose not to filter reports based on criteria available on this tab. Leave the Include All default and select another tab.
15. For this scenario, you want to include donations to all Appeals, Campaigns, and Funds, so do not change the Include All default in these three rows.

In the Constituent Codes row, you want only constituents with the “Trustee” code. Even though on the General tab, you included only records in the “2003 Trustee” query you created, you decided to add this filter to the Filters tab. This just further ensures the records included in the report are those of trustees.

16. In the Filter Option column in the Constituent Codes row, select Include Selected.

17. In the Selected Filters column in the Constituent Codes row, click the binoculars. The Selected Constituent Codes screen appears.

18. In the box on the left, select Trustee, and click the single right arrow. Trustee appears in the Include these Constituent Codes box.

19. To return to the Filters tab, click OK.

Trustee now appears in the Selected Filters column.
20. When you finish the Filters tab, move to the Gift Types tab by clicking Next.

On the Gift Types tab, you must select the gift types you want to include in your report. In *The Raiser's Edge*, gifts can be classified as Cash, Pledge, Gift-in-Kind, Stock/Property, Other, and Recurring Gift. The checkboxes available on this tab vary, based on the types of gifts you include. You can also select the gift types you want in each column of your report, and name the column.

**Note:** For more information about the Gift Types tab, see “Gift Types Tab” on page 213.

21. For this scenario, you want a column for cash gifts. In the **Report column** field at the top of the tab, select the column of your report for which you want to define gift types. Select Column 1. In Column 1 of our report, you want only cash gifts. Using the arrow keys, move all cash gift types from the **Gift Types** box into the **Include these Gift Types** boxes. Then, in the **Column name** field at the top of the tab, enter “Cash”. Now, all cash gift types appear in the first column of the report, under the column name of *Cash*. Because you do not want the report to include cash gifts entered or adjusted to zero, mark the **Exclude zero amount gifts** checkbox.

22. You also want a column for stock gifts. In the **Report column** field at the top of the tab, select Column 2. In Column 2 of our report, you want only stock gifts. Using the arrow keys, move all stock gift types from the **Gift Types** box into the **Include these Gift Types** boxes. Then, in the **Column name** field at the top of the tab, enter “Stock Gifts”. Now, all stock gift types appear in the second column of the report, under the column name of *Stock Gifts*. Because you do not want the report to include stock gifts entered or adjusted to zero, mark the **Exclude zero amount gifts** checkbox. You want the report to use the date the stock was sold as the gift date, so mark the **Use sale date for sold stock/property** checkbox. You want
stock and property gifts reported based on the worth of the stock and property at the time of the sale instead of at the time the organization acquired the gifts, so mark the **Use sale amount for sold stock/property** checkbox. Also, marking this checkbox enables the **Subtract broker fee from sold stock/property** checkbox. You want the report to calculate the gift amount of sold stock and property gifts minus broker fees, so mark the **Subtract broker fee from sold stock/property** checkbox.
23. You also want a column for pledge balances. In the **Report column** field at the top of the tab, select Column 3. In Column 3 of our report, you want only pledge balances. Using the arrow keys, move Pledge from the **Gift Types** box into the **Include these Gift Types** boxes. Then, in the **Column name** field at the top of the tab, enter “Pledge Bal”. Now, all pledge balances appear in the third column of the report, under the column name of **Pledge Bal**. Because you do not want the report to include gifts entered or adjusted to zero, mark the **Exclude zero amount gifts** checkbox. Also, mark **Use gift balance instead of gift amount** because you want to see the balance remaining for gifts.
24. Finally, you want a column for matching gift pledge balances. In the **Report column** field at the top of the tab, select Column 4. In Column 4 of our report, you want only pledge balances for matching gifts. Using the arrow keys, move MG Pledge from the **Gift Types** box into the **Include these Gift Types** boxes. Then, in the **Column name** field at the top of the tab, enter “MG Pledge Bal”. Now, all pledge balances for matching gifts appear in the fourth column of the report, under the column name of **MG Pledge Bal**. Because you do not want the report to include gifts entered or adjusted to zero, mark the **Exclude zero amount gifts** checkbox. Also, mark **Use gift balance instead of gift amount** because you want to see the balance remaining for gifts.

25. When you finish the Gift Types tab, move to the Attributes tab by clicking **Next**.
26. The Attributes tab helps you refine your report criteria, using attribute information included on the record type for which you are running the report. You can choose to include or exclude information based on attributes.

To use the tab to locate records you want to include in your report, mark the **Include Records with these Attributes** checkbox. The frame is activated, and you can select the attributes you want to use to locate acceptable records. For example, you can filter the report to include only constituent records with an attribute **Category** of Special Mailing Types and a **Description** of Do Not Phone. This information is entered on the Attributes tab of the constituent record.

You can similarly exclude constituent records from your report by marking **Exclude Records with these Attributes**. When you mark this checkbox, the frame is activated, and you can select the attributes you want to use to prevent certain records from being included in your report.

For this scenario, you are not interested in including or excluding any records based on attributes. you want to include all records included in our query, so leave this tab blank.

27. When you finish the Attributes tab, move to the Columns tab by clicking **Next**.

Using the Columns Tab, you can select the data columns you want to appear on your report.

28. In the **Report View**, you choose a detail or summarized view. The summarized view includes several options: Summarized by Campaign, Summarized by Fund, Summarized by Appeal, and Summarized by Constituent Code.

When you select a view, the **Available Fields** list and the **Selected Columns** default information changes based on your selection. For this scenario, because we want a broader view of the gift information, select **Detail**.

29. The **Available Fields** box lists all column information you can include in your report. Use the arrow button to add columns to the **Selected Columns** grid.
The **Selected Columns** grid displays all column information you selected to include in your report. The **Default Column Name** column displays the program-name for the column. In the **Custom Column Heading** column, you can change the program-name used in your report. In the **Width (in)** column, you can set the column width you want used in your report. For this scenario, keep the default columns and column heads.

30. Select the page orientation — **Portrait** or **Landscape** — you want to use for the report. For this scenario, keep the default orientation **Landscape**.

31. When you finish the Columns tab, move to Ind. Address tab by clicking **Next**.

![Image of New Gift Detail and Summary Report](image_url)

On the Ind. Address tab, you select the address information you want to include. The program selects an address for each individual constituent included in your report, using the three steps detailed on this tab. The program can consider seasonal addresses, address attributes, and specific address types when selecting an address. Using this tab, you can even select an alternate address for the program to use, should it fail to find a valid preferred address for a constituent.

32. In the **What would you like to print** field, you can select one of the following criteria: Address, Phone, Address & phone, or None.

For this scenario, select **Address & phone**.

33. If you include phone numbers, select a phone type, such as Home, E-mail, or Cellular Phone in the **Phone type** field.

For this scenario, select **Home**.

34. In Step 1, you can choose to include seasonal addresses in your report. If the program considers seasonal addresses, it selects the first valid seasonal address it finds. If it does not find a valid seasonal address, the program uses your selections in Step 2 and attempts to locate a valid address.

To allow the program to consider seasonal addresses when generating your report, mark the **Consider addresses with seasonal dates as of** checkbox. In the corresponding field, select the as of date you are willing to accept seasonal addresses.
For this scenario, mark the **Consider addresses with seasonal dates as of** checkbox and select Include all dates.

35. In Step 2, specify the address types to consider if a valid seasonal address is not found.

   To select the address types you want the program to look for when generating your report, highlight address type in the **Addresses** box and click the single right arrow to move it to the **Addresses to use** box. If you list multiple address types in the **Addresses to use** box, arrange them in order of preference. To arrange the address types in the **Addresses to use** box, highlight the address type and click the up or down arrow.

   For this scenario, you want to use Preferred address or Business address. If a constituent has both addresses on his constituent record, you want the program to use the Preferred address first.

   ![Step 2: Specify, in the order of importance, the address types to consider if a valid seasonal address is not found.](image)

**Note:** For information about the Address Attributes to Consider screen, see “Ind. Address Tab” on page 223.

36. In Step 3, you can further refine the address information included in your report using attributes. For example, to avoid outdated or incorrect addresses, you can select to include only NCOA (National Change of Address) confirmed addresses. To select address attributes you want to consider for your report, click the **Address Attributes** button. The Address Attributes to Consider screen appears.

   ![Address Attributes to Consider](image)

   **Note:** NCOA is an address correction service that works with Blackbaud’s **NCOA On-Demand**. For more information, see the Address Correction Services chapter in the **Data Enrichment Services Guide**.

   For this scenario, you want address information included only if you know it is NCOA confirmed. You do not want out-dated addresses.

   37. In the **Category** column, select “NCOA Confirmed?”.
38. In the **Description** column, select “Yes”. This information is based on the Attributes tab of the Address screen.

39. Click **OK** to return to the Ind. Address tab.

40. In Step 4, select the address type you want the program to use if it cannot find an address type satisfying any of your selections in Steps 1 through 3. You can choose to Print with no address or Print specific address.

   For this scenario, you want to make sure address information prints with the report, so select “Print specific address”.

41. If you select Print specific address, the **Address to print** field appears. Select the alternate address you want.

   For this scenario, select “First address found”. The program then includes in the report the first valid address located on the constituent record, if it fails to find an address satisfying steps 1 or 2.
42. When you finish the Ind. Address tab, move to the Org. Address tab by clicking **Next**.

On the Org. Address tab, you select organization constituent address information you want to include in your report. You can select to print contact address information or only the organization address information. The program selects an address for each organization constituent included in your report, using the three steps detailed on this tab. The program can consider address attributes and specific address types when selecting an address. Using this tab, you can even select an alternate address for the program to use, should it fail to find a valid preferred address for a constituent.

43. In the **What would you like to print** field, you can select one of the following criteria: Address, Phone, Address & phone, or None.

   For this scenario, select Address & phone.

44. If you include phone numbers, select a phone type, such as Home, E-mail, or Cellular Phone in the **Phone type** field.

   For this scenario, select Business.

   ![New Gift Detail and Summary Report](image)

   **Note:** For information about the **Print only the organization** option, see “Org. Address Tab” on page 226.

45. In Step 1, select whose address information you want to include in your report: the address of the organization’s contact or only the address of the organization. If you select **Print contacts**, step 2 includes buttons from which you can define the contact types you want to include in your report.

   For this scenario, you are using the **Print contacts** options.
46. In Step 2 you must identify the contact types to include, using the Contact Information button. The Contacts to Print screen appears.

![Contacts to Print screen]

You can include all contact types or selected contact types. To select specific contact types, mark the Include Selected Contact Types Only checkbox. In the Contact types box, highlight the contact type you want to include and click the single right arrow to move it to the Contact types to include box.

If you list multiple contact types in the Contact types to include box, make sure you list the contact types in order of your preference. The program begins searching for the first type listed in the Contact types to include box. When it finds the first type listed, it includes that contact type in your report.

If you do not mark the Include Selected Contact Types Only checkbox, the program considers all contact types for the report. It selects the first type located on the record to include in your report.

For this scenario, mark the Include Selected Contact Types Only checkbox. Our first contact choice is “Primary”. If a primary contact is not available on the constituent record, you want the “Volunteer Coordinator”. If neither a primary nor volunteer coordinator contact type is available, you want “Board” contact.

47. To return to the Org. Address tab, click OK. The contact information you just selected appears next to the button.

![Contact Information button]

48. Also in Step 2, you can further refine the address information included in your report using attributes. For example, to avoid outdated or incorrect addresses, you can select to include only NCOA (National Change of Address) confirmed addresses.

Note: NCOA is an address correction service that works with Blackbaud’s NCOA On-Demand. For more information, see the Address Correction Services chapter in the Data Enrichment Services Guide.
To select address attributes you want to consider for your report, click the **Contact Address Attributes** button. The Contact Address Attributes to Consider screen appears.

**Note**: For more information about the Attributes tab on the constituent Address screen, see the Constituent Records chapter in the *Constituent Data Entry Guide*.

For this scenario, you want address information included only if you know it is NCOA confirmed. you do not want out-dated addresses.

49. In the **Category** column, select “NCOA Confirmed?”.

50. In the **Description** column, select “Yes”. This information is based on the Attributes tab of the Address screen.

51. When you finish entering address attributes, click **OK**. You return to the report parameter screen. “Yes” appears next to the **Contact Address Attributes** button.

52. In Step 3, select the address type you want the program to use if it cannot find an address type satisfying any of your selections in Steps 1 or 2. You can choose to Print the Organization name with no address or Print the Organization name with a specific address.

For this scenario, you want to make sure address information prints with the report, so select “Print the Organization name with a specific address”.

53. If you select Print the Organization name with a specific address, the **Organization Address to print** field appears. Select the alternate address you want.
For this scenario, select “First address in list”. The program then includes in the report the first valid address located on the constituent record.

54. When you finish the Org Address tab, move to the Graph tab by clicking Next.

Use the Graph tab to view report results in a bar or pie graph format. A graph may prove more user-friendly, helping volunteers and board members understand complicated data. When printing a report with the graph option, you can select to print only the report, only the graph, or both the report and the graph.

55. For this scenario, select Report and Graph. The rest of the tab is activated.
56. In the **Available graph types** box, select **Bar**.

57. In the treeview on the far left of the tab, select **Data Source**.

In the **Data source** category, you tell the program what data from your report you want included in your graph.

58. The **Columns to Include** box lists all the columns available for the selected report. Unmark the checkbox next to any column you do not want to include in the graph.

For this scenario, you want all the data sources included, so do not unmark any checkbox.
59. In the treeview on the far left of the tab, select **Detail**.

In **Detail**, you can enter title information for your graph, name the graph axis, choose to include a legend, and more.

60. In the **Chart title** field, enter a title you want to appear at the top of your graph. For this scenario, enter "Gift Detail and Summary Report".

61. In the **Subtitle** field, enter a subtitle you want to appear under the **Chart title** in your graph. For this scenario, enter "2003 Trustees".

62. Enter **X-axis title** information. The x-axis of your report is the bottom axis. If you want to title this axis, enter the title in this field.

63. Enter **Y-axis title** information. The y-axis of your report is the left side axis. If you want to title this axis, enter the title in this field.

64. To include a legend in your report, defining what each color represents, mark the **Show legend** checkbox. The legend box appears in the upper right corner of your report. For this scenario, a legend may prove helpful to our users. Mark the **Show legend** checkbox.

65. To include values, such as dollar amounts, reflecting what each colored section of your graph represents, mark the **Show data values** checkbox. If you do not mark this checkbox, the color-coded graph appears, with no values. For this scenario, data values will help our users read the graph. Mark the **Show data values** checkbox.

66. Had you selected the **Bar** graph type, you could include a network of uniformly spaced horizontal and perpendicular lines in to locate points on the graph, by marking the **Show grid lines** checkbox.
67. In the treeview on the far left of the tab, select Location.

In the Location category, if you select to print the report and graph, you can tell the program where in the report you want the graph included.

68. In the Location field, select Bottom and the graph prints at the bottom of the last page of your report, select Top and the graph prints at the top of the first page of your report, or select Separate page and the graph prints on a separate page from your report.

For this scenario, select Separate Page.

69. When you finish the Graph tab, move to the Format tab by clicking Next.
Your settings on the Format tab determine the appearance of your report. The treeview on the left of the screen lists all formatting options available for the report type. Not all report types include every treeview category.

When you select a treeview category, the right side of the screen changes, displaying all the fields, checkboxes, and options available for that category.

70. For this scenario, in the **Heading Format** frame, accept the default **Title** — “Gift Detail and Summary Report”. The title appears at the top of your report.

71. Because the report is on the 2003 Trustees, in the **Subtitle** field, “2003 Trustees”. The subtitle appears under your title.

72. In the **Align** field, select where on the report page you want the title information to appear. For this scenario, select Center.

73. Because the report will be used internally, you do not need to include the organization’s name on the first line in the heading. Do not mark the **Print Organization name in header** checkbox.

74. Displaying page numbers at the top of the report pages is helpful if your report is several pages long. For this scenario, mark **Print Page Number in Heading**. The fields available in the frame are enabled.

---

**Warning:** If in the **Page Footer** category on the Format tab, you select to include page numbers and dates with your footers, you may not want to repeat this information in your heading. If you do, the information appears in both places on your report.

75. In the **Format** field, select a format for your page number. For this scenario, select “Page 1”.

76. In the **Align** field, select how you want your page numbers aligned. For this scenario, select “Right”.

77. Displaying date information on your report helps track the age of the data. For this scenario, mark **Print Report Date in Heading**. The fields available in the frame are enabled.

78. In the **Format** field, select a format for your date information. For this scenario, select “Short Date” (03/03/2003).

79. In the **Align** field, select how you want your date information aligned on the report page. For this scenario, select “Left”, so it is not on the same side of the page as the page number.

---

**Note:** For more information about the Format tab, see “Format Tab” on page 156.

80. Displaying the heading information, including the date, at the top of every page in the report, may prove helpful to your users. For this scenario, mark **Print report heading on each page**. If you leave the checkbox unmarked, the heading information prints on only the first page.
81. Select the **Criteria** category from the treeview on the left. All criteria options available for the report appear on the right side of the screen.

In this category, you can choose to print your report parameter settings with the report. This helps you remember the data you used to create the report.

82. For this scenario, you want the criteria printed. To enable the frame, mark the **Print Report Criteria** checkbox.

83. In the **Criteria to print** box, mark all the criteria you want to print with your report. Unmark any information you do not want to print with your report. For this scenario, leave all of the checkboxes marked.

84. You specify where the program should print this information in the **Include on** field at the bottom of the screen. You can choose to print the criteria on **A separate page** or the **First page of the report**. For this scenario, select **A separate page**. The criteria prints on a separate page at the end of your report.

**Warning:** For more information about the **Detail** category, see .“Detail” on page 159.
85. Select the **Detail** category from the treeview on the left. The fields, checkboxes, and options available with **Detail** vary, based on the report type you select.

86. For this scenario, you want the information summarized by all four, so mark all the checkboxes.

87. If you mark **Include maiden name**, the maiden name appears between parenthesis under the constituent’s name. You enter maiden name information in the **Maiden name** field on the Bio 1 tab of the constituent record.

   For this scenario, you are not interested in the maiden names of our trustees, so do not mark the checkbox.

88. You can include a total given prior to the **Date to Use** you entered on the General tab if you mark **Include brought forward total from**. For example, if on the General tab you entered the report start date as of 06/01/2000, but you want to calculate the amount received from January to June, enter 01/01/2000 in the **Date** field that activates when you mark this checkbox. The brought forward amount is calculated using the start date minus one as the end date.

   For this scenario, you are interested in gift information only from the last calendar year, so this check mark does not apply. Leave it unmarked.
89. Select the **Sort/Break** category from the treeview on the left.

![Image showing New Gift Detail and Summary Report window](image)

Use **Sort/Break** to select the order in which records appear on the report.

90. If on the General tab you choose **Selected Records** from the **Include** button and you want records in your report sorted based on the order of the query you selected, mark **Sort by query order**. The remainder of the screen is then disabled. Records appear in your report in the order they appear in the query file.

For this scenario, you do not want to use the query order, so leave this checkbox unmarked.

91. To sort records in your report, select the field in the **Available Fields** box on which you want to base the sort order of your report. Use the right arrow to move the field from the **Available Fields** box to the **Sort Fields** box.

   ![Image showing sorting process](image)

For this scenario, you want to sort the report alphabetically by constituent last name. Select “Constituent” in the **Available Fields** box, and click the right arrow to move it into the **Sort Fields** box. Then click the **Desc** button on the bottom right of the **Sort Fields** box. The report is then arranged based on the alphabetical order of the constituent last name.

92. To break the report at the sort field that appears first in the **Sort fields** box, mark the **Break Report by <Sort Field 1>** checkbox. The first field automatically appears as the header at each break on the report. In the **Text before value** and **Text after value** fields, enter the text to appear before or after each break. The sample display below the fields show you how the break header will look on the report.

   ![Image showing break display](image)

**Note:** On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

For this scenario, you want to sort the report alphabetically by constituent last name. Select “Constituent” in the **Available Fields** box, and click the right arrow to move it into the **Sort Fields** box. Then click the **Desc** button on the bottom right of the **Sort Fields** box. The report is then arranged based on the alphabetical order of the constituent last name.

93. For this scenario, mark **Print count of records** to include a count of records included with each sort field.
94. For this scenario, mark **Print count as % of total** to include data showing you what percent of the total records included in your report this sort field makes up.

95. For this scenario, you want to insert a page break with each sort field, so mark **Page break on each new <Sort Field 1>**.

96. Select the **Page Footer** category from the treeview on the left.

![Image of Report Tutorial 30](image.png)

Use **Page Footer** to create a footer to appear at the bottom of every page in the report. You can also select to print the page number or the date in the footer of each page, instead of in the heading.

97. In the **Text** field, enter the text you want to appear in your page footer. This text prints at the bottom of every page of the report.

For this scenario, because you are running this report to present at the organization’s annual board meeting, you want this noted in the footer. Enter “Annual Board Meeting”.

98. In the **Align** field, specify the alignment for the page footer.

For this scenario, choose Center.

**Note**: For more information about the Format tab, see “Format Tab” on page 156.

99. You can also include page numbers and date information in your page footer.

For this scenario, because you included page number and date information with our headings, do not include the information again in the page footer.
100. Select the **Report Footer** category from the treeview on the left.

Use **Report Footer** to include a footer that appears only on the last page of the report.

101. In the **Text** field, enter the text you want to appear in your report footer.

   For this scenario, you want to know the author of the report and decide to put this information in the report footer. Enter “Report generated by Robert Fink” in the **Text** field.

102. In the **Align** field, specify the alignment for the report footer.

   For this scenario, choose Right.

103. Select the **Miscellaneous** category from the treeview on the left.
Use **Miscellaneous** to specify how to display numerical amounts, select page orientations, and select line spacing. The fields, checkboxes, and options available in the **Miscellaneous** category vary based on the report type.

104. In the **Amount Display Options** frame, select how you want monetary amounts displayed in your report.
   - To see the dollar sign ($) in front of monetary values, mark the **Show currency character** checkbox.
   - To include commas in numeric values (1,000), mark the **Show 1000’s separator** checkbox.
   - To display monetary values with two decimal places ($12.03), mark the **Show decimals** checkbox. If you unmark this checkbox, amounts and numbers are rounded to the nearest dollar ($12).
   - To display the percent symbol (%) with numbers that are percentages, mark the **Show percent sign** checkbox.
   - To leave a blank in place of amount fields that are zero, mark **Show blanks instead of zero amounts**.
   - In the **Negative amount format** field, you can change how negative amounts print in your report. The program defaults to parentheses (20). You can change it to a minus sign (-20).
   - As you make selections in the **Amount Display Options** frame, you can view how the selections affect what prints in your report in the **Sample Display** frame.

For this scenario, mark all of the checkboxes, except **Show blanks instead of zero amounts**. Zero amounts are easier to identify than blank spaces on the report. In the **Negative amount format** field, select the minus sign.

**Note:** For information about **Name Formats**, see “Name Formats” on page 183.

105. To double-space your report, mark the **Double-space report** checkbox. If left unmarked, the report prints single-spaced.

   For this scenario, to make the report easier to read, mark the **Double-space report** checkbox.

106. Select the **Name Formats** category from the treeview on the left.

   **Note:** For information about setting up addressees and salutations for your constituents, see the Configuration chapter in the **Configuration & Security Guide**.

   Use the subcategories available under **Name formats** to select addressee and salutation formats for **Individual** and **Organization** names included in your report. Because addressee/salutation formats for individuals differ from those for organizations, **Name Formats** is divided into two selections — **Individual** and **Organization**.
107. Select Individual in the treeview under Constituent.

For this scenario, on the right side of the screen, select From individual. The report prints the name format listed on the Addressees/Salutations tab of a constituent record.

108. In the Use this addressee/salutation if present on the Individual field, select an addressee/salutation to use for individuals in your report.

For this scenario, select Primary Addressee.

109. Select an alternative addressee/salutation in the Otherwise use field. If your first choice is not present on the constituent record, this option is used.

For this scenario, select Full Name.
110. Select **Organization** under **Constituent** in the treeview.

![Image of New Gift Detail and Summary Report]

111. To include the constituent ID in the organization's name, mark the **Include Constituent ID** checkbox. For this scenario, mark the **Include Constituent ID** checkbox. **Sample** displays how your selection will look in the report.

**Note**: For information about **Name Formats**, see “**Name Formats**” on page 183.

Because you are not including solicitor information in our report, there is no need to enter **Name Formats** for **Solicitor**.
112. Select the **Color Scheme** category from the treeview on the left.

Use **Color Scheme** to select colors for report headings. If you leave the **Apply a Color Scheme** checkbox unmarked, the report prints in black and white.

113. For this scenario, mark the **Apply a Color Scheme** checkbox.

You like all the default heading colors except the **Column heading back color**. You want to use blue instead.

114. Click on the color box next to the **Column heading back color**. The Color screen appears.

115. Click on the blue box.
116. Click OK.

You return to the Color Scheme screen. Blue appears as the Column heading back color.

Note: For information about previewing your report, see “Previewing a Report” on page 122.

117. After you complete all the report parameter tabs, you are ready to print your report. For information about printing a report, see “Printing a Report” on page 125.

118. When you generate this report, because in the Detail category of the Format tab, you said you want the report summarized by campaign, fund, appeal, and constituent code, four summary reports print.

A detailed version of the report also prints.

To view this report, see the Gift Detail and Summary Report section in the Sample Reports Guide.

Comparisons and Summaries Report

The Comparisons and Summaries Report is one of the several Demographic and Statistical Reports available in The Raiser’s Edge. The Comparisons and Summaries Report gives you two reporting options. You can compare two time periods or summarize of up to five time periods. You define the time periods you want to use and select the Raiser’s Edge fields you want to include. Both reports include the variance between the time periods as either a percentage or a dollar amount, depending on what you select.

In this section, you complete the parameter tabs necessary to run a Comparisons and Summaries Report. You run the summary version of the report.

Creating a Comparisons and Summaries Report

Your organization wants to view giving histories based on constituent codes over the past 5 years for the International Relief fund.

Note: If you want to see a sample of the report type you selected, at the bottom of any reports page, click View Samples. For a detailed description of the report and a list of available columns, click “Click here for more information about these reports”.

1. On the Raiser’s Edge bar, select Reports. The Reports page appears.

2. Click the Demographic and Statistical Report link. The Demographic and Statistical Report page appears.

A list of all demographic and statistical report types appears on the left side of the page.

3. For this scenario, select Comparisons and Summaries.

Note: On the General tab, you decide the general criteria you want to govern what goes into your report. For example, you can tell the program to include all records satisfying your specific criteria, selected records you saved in a query file, or one record. The General tab appears on all reports; however, the fields, buttons, checkboxes, and options change slightly, depending on the report type you select.
4. Click **New**. The New Comparisons and Summaries Report screen appears, displaying the General tab.

![New Comparisons and Summaries Report](image)

5. Click the **Include** button. From this button, you determine what records you want to include in your report: **All Records** in your database, **Selected Records** you saved in a query file, or **One Record**.

**Note:** For information about the other **Include** button options, see “Include” on page 195.

   For this scenario, select **All Records**.

6. You can refine your report criteria, using the **Soft Credit Gifts To** frame. When you add a new gift, you use soft credits to credit multiple constituents for the same gift without duplicating the gift in your database. When you run a report containing gifts, you need to specify how the program should report this information. You can credit the **Donor**, **Soft credit recipients**, or **Both**.

**Warning:** If you select **Both** in the **Soft Credit Gifts to** frame, the gift appears twice on the report and total gift amounts may not be accurate.

   For this scenario, you are interested in only the donors’ gifts. Select **Donor**, and in your report, the donor receives full credit for the gift. The soft credit recipients receive no credit for the gift.

7. In the **Include these Constituents** frame, you can select specific constituent records to include or exclude in your report.

**Note:** If in the **Include** button, you selected to include **One Record** in your report, all checkboxes in the **Include these Constituents** frame are disabled.

- **Inactive constituents** includes constituents with the **Is inactive** checkbox marked on the Bio 1/Org 1 tab of their constituent record.
- **Deceased constituents** includes constituents with the Deceased? checkbox marked on the Bio 1/Org 1 tab of their constituent record.

- **Constituents with no valid address** includes constituents with the Has no valid addresses checkbox marked on the Bio 1/Org 1 tab of their constituent record.

For this scenario, because you are using all records in our database, there is a good chance constituent records marked as inactive, deceased, or not having a valid address may be included in our report. You do not want these records included, so unmark all three of the checkboxes.

8. In the Credit Matching Gifts To frame, select how you want matching gifts handled in your report. Matching gifts are gifts donated by a business, matching a constituent’s (usually an employee of the business) donation. When you run reports containing gifts, you need to specify how the program should report this information. You can credit the **Donor**, **MG Company**, or **Both**.

For this scenario, because you are interested in gifts given specifically by the constituents, select **MG Company**. If you select **MG Company**, in your report, the matching gift company receives credit for the matching gift, not the donor.

9. In the Report Type frame, select the type of report you want to run. If you select **Comparison**, the program generates summaries for two report periods and also shows the variance, or difference, between the periods as a percentage or a dollar amount. If you select **Summary**, the program generates summaries for up to five report periods. Constituent names do not appear on these reports.

For this scenario, you want to generate information from five report periods, so select **Summary**.

---

**Note:** For more information about matching gifts, see the Matching Gifts chapter in the *Gift Records Guide*.
10. When you finish the General tab, move to the Fields tab by clicking **Next**.

11. From the list on the left of the screen, select **Field**.

12. For this scenario, because you want to summarize constituent codes, on the right side of the screen, in the **Field to use** field, select Constituency Codes. A checkbox and two boxes appear on the bottom half of the tab.
13. If you do not want a summary using all constituent codes in the *Raiser's Edge* database, on the bottom half of the screen, mark *Use Selected Field Values Only*. In the *Field Values* box, select the codes you want to use in your report and, using the right arrow key, move your selection into the *Include These Field Values* box.

**Note:** On a screen with a selection box, you can use the single right and left arrows to move one entry back and forth between the two boxes. You can use the double left or right arrows to move all entries at once.

For this scenario, you want to include all constituent codes, so do not mark *Use Selected Field Values Only*.

14. From the list on the left of the screen, select *Columns*. A grid appears on the right side of the screen.

15. In the *Information* column select the information associated with the field (selected in step 13) you want to include in your report. For example, do you want to know the number of donors, number of gifts, or number of constituents associated with each constituent code? You can include up to four information columns.

For this scenario, you want to include the following information.

- In the first row of the *Information* column, select Number of donors. Tab over to the *Heading 1* column, and enter “Number of”. Then tab over to the *Heading 2* column and enter “donors”. The *Heading 1* information appears on top of *Heading 2* information in your report.

- In the second row of the *Information* column, leave the default entry “Total given”. You can also leave the *Heading 1* and *Heading 2* column defaults.

- In the third row of the *Information* column, leave the default entry “Average given per donor”. You can also leave the *Heading 1* and *Heading 2* column defaults.
• In the forth row of the Information column select Average given per gift. Tab over to the Heading 1 column, and enter “Avg given”. Then tab over to the Heading 2 column and enter “per gift”. The Heading 1 information appears on top of Heading 2 information in your report.

16. When you finish the Fields tab, move to the Filters tab by clicking Next.

The Filters tab helps you further refine your report criteria based on information available on records in The Raiser's Edge. You can also choose not to filter reports based on criteria available on this tab by accepting the Include All defaults and selecting another tab.

For this scenario, you want to include only gifts to the International Relief Fund.

17. In the Filter Option column across from the Funds row, select Include Selected.
18. In the **Selected Filters** column across from the **Funds** row, click the binoculars. The Selected Funds screen appears.

![Selected Funds Screen](image)

19. In the box on the left, select International and click the single right arrow. International appears in the **Include these Funds** box.

20. To return to the Filters tab, click **OK**.

![New Comparisons and Summaries](image)

International Relief Fund now appears in the **Selected Filters** column.
21. When you finish the Filters tab, move to the Gift Types tab by clicking Next.

On the Gift Types tab, you must select the gift types you want to include in your report. In *The Raiser's Edge*, gifts can be classified as Cash, Pledge, Gift-in-Kind, Stock/Property, Other, and Recurring Gift. The checkboxes available on this tab vary, based on the types of gifts you include.

In the summary version of the Comparisons and Summaries Report, you can define up to five periods for which you want to view information. On this tab, you select the gift information you want to include in each period. You define the report periods on the Report Periods tab. If you define the periods before you select the gift types, the Period name appears next to the Report period field.

For this scenario, you want to include all gift types. Also, because you want to compare the funds performance in each period, you want the same gift types used in all five reporting periods.

**Note:** For more information about the Gift Types tab, see “Gift Types Tab” on page 213.

22. Move all gift types you want to include in your report from the Gift Types box into the Include these Gift Types box, using the right arrow. In the Comparisons and Summaries Report, all gift types default in the Include these Gift Types boxes.

23. For this scenario, you do not want the report to include cash gifts entered or adjusted to zero, mark the Exclude zero amount gifts checkbox.

24. For this scenario, you want to see the balance remaining for gifts. To include this in our report, you included Recurring Gift is in Include these Gift Types box, and you must mark Use gift balance instead of gift amount.
25. When you finish the Gift Types tab, move to the Attributes Types tab by clicking Next.

26. The Attributes tab helps you refine your report criteria, using attribute information included on the record type for which you are running the report. You can choose to include or exclude information based on attributes.

To use the tab to locate records you want to include in your report, mark the Include Records with these Attributes checkbox. The frame is activated, and you can select the attributes you want to use to locate acceptable records. For example, you can filter the report to include only constituent records with an attribute Category of Special Mailing Types and a Description of Do Not Phone. This information is entered on the Attributes tab of the constituent record.

You can similarly exclude constituent records from your report by marking Exclude Records with these Attributes. When you mark this checkbox, the frame is activated, and you can select the attributes you want to use to prevent certain records from being included in your report.

For this scenario, you are not interested in including or excluding any records based on attributes. Leave this tab blank.

Note: For more information about the Attributes tab, see “Attributes Tab” on page 141.
27. When you finish the Attributes tab, move to the Report Periods tab by clicking **Next**.

On the Report Periods tabs, you select start and end dates you want to use to define information to include in your report. You also enter report headings for the information you define. With this breakdown of reporting periods, you get a clearer picture of activity during a smaller time frame.

28. Enter start and end dates for the periods you want to include in the report. One column appears for each pair of start and end dates entered.

   For this scenario, you want to view constituent code information for the past five years. On this tab, you must define the five years. The earliest year you want is 1999. In the **Start Date** column, enter “01/01/1999” and in the **End Date** column, enter “12/31/1999”.

29. Once you define one period, click **Autofill Dates**. The Autofill Dates screen appears.

   Based on the data information you entered in the first row of the Report Periods tab, this screen fills in the remaining rows.

30. For this scenario, you want five reporting periods, so in the **Enter number of periods** field, enter “5”.

31. For this scenario, the reporting periods are years, so in the **Autofill by** field, select **Year**.
32. Click OK. You return to the Report Periods tab, and the remaining four period rows are complete.

33. In the **Heading 1** and **Heading 2** columns, you can enter a heading title to use on your report to represent the data you selected in the row. The **Heading 1** title appears first in the report. **Heading 2** appears under the **Heading 1** title.

For this scenario, you want to use the start and end dates as our report headings. Click the **Default Heading Values** button. The program enters the report period start date in the **Heading 1** column and the end date in the **Heading 2** column.
34. When you finish the Report Periods tab, move to the Graph tab by clicking **Next**.

Use the Graph tab to view report results in a bar or pie graph format. A graph may prove more user-friendly, helping volunteers and board members understand complicated data. When printing a report with the graph option, you can select to print only the report, only the graph, or both the report and the graph.

35. For this scenario, select **Report and Graph**. The rest of the tab is activated.

36. In the **Available graph types** box, select **Bar**.
37. In the treeview on the far left of the tab, select **Data Source**.

![Image of the New Comparisons and Summaries window with Data Source highlighted]

In the **Data source** category, you tell the program what data from your report you want included in your graph.

38. The **Columns to Include** box lists all the columns available for the selected report. Unmark the checkbox next to any column you do not want to include in the graph.

For this scenario, you want all the data sources included, so do not unmark any checkbox.

39. In the treeview on the far left of the tab, select **Detail**.

![Image of the New Comparisons and Summaries window with Detail highlighted]

In **Detail**, you can enter title information for your graph, name the graph axis, choose to include a legend, and more.
40. In the **Chart title** field, enter a title you want to appear at the top of your graph. For this scenario, enter “Comparisons and Summaries”.

41. In the **Subtitle** field, enter a subtitle you want to appear under the **Chart title** in your graph. For this scenario, enter “1999-2003”.

42. Enter **X-axis title** information. The x-axis of your report is the bottom axis. If you want to title this axis, enter the title in this field.

43. Enter **Y-axis title** information. The y-axis of your report is the left side axis. If you want to title this axis, enter the title in this field.

44. To include a legend in your report, defining what each color represents, mark the **Show legend** checkbox. The legend box appears in the upper right corner of your report. For this scenario, a legend may prove helpful to our users. Mark the **Show legend** checkbox.

45. To include values, such as dollar amounts, reflecting what each colored section of your graph represents, mark the **Show data values** checkbox. If you do not mark this checkbox, the color-coded graph appears, with no values. For this scenario, data values will help our users read the graph. Mark the **Show data values** checkbox.

46. Had you selected the **Bar** graph type, you could include a network of uniformly spaced horizontal and perpendicular lines in to locate points on the graph, by marking the **Show grid lines** checkbox.

47. In the treeview on the far left of the tab, select **Location**.

![New Comparisons and Summaries](image)

In the **Location** category, if you select to print the report and graph, you can tell the program where in the report you want the graph included.

48. In the **Location** field, select **Bottom** and the graph prints at the bottom of the last page of your report, select **Top** and the graph prints at the top of the first page of your report, or select **Separate page** and the graph prints on a separate page from your report.

For this scenario, select **Separate Page**.
49. When you finish the Graph tab, move to the Format tab by clicking **Next**.

Your settings on the Format tab determine the appearance of your report. The treeview on the left of the screen lists all formatting options available for the report type. Not all report types include every treeview option.

When you select a treeview category, the right side of the screen changes, displaying all the fields, checkboxes, and options available for that category.

50. For this scenario, in the **Heading Format** frame, enter “Constituent Code Summaries Report”. The title appears at the top of your report.

51. Because the report is for the year 1999 to 2003, in the **Subtitle** field, “1999 to 2003”. The subtitle appears under your title.

52. In the **Align** field, select where on the report page you want the title information to appear. For this scenario, select Center.

53. Because the report will be used internally, you do not need to include the organization’s name on the first line in the heading. Do not mark the **Print Organization name in header** checkbox.

54. Displaying page numbers at the top of the report pages is helpful if your report is several pages long. For this scenario, check **Print Page Number in Heading**. The fields available in the frame are enabled.

**Warning:** If in the **Page Footer** category on the Format tab, you select to include page numbers and dates with your footers, you may not want to repeat this information in your heading. If you do, the information appears in both places on your report.

55. In the **Format** field, select a format for your page number. For this scenario, select Page 1.

56. In the **Align** field, select how you want your page numbers aligned. For this scenario, select Right.

57. Displaying date information on your report helps track to age of the data. For this scenario, mark **Print Report Date in Heading**. The fields available in the frame are enabled.

58. In the **Format** field, select a format for your date information. For this scenario, select Short Date (03/03/2003).

59. In the **Align** field, select how you want your date information aligned on the report page. For this scenario, select Left, so it is not on the same side of the page as the page number.
60. Displaying the heading information, including the date, at the top of every page in the report, may prove helpful to your users. For this scenario, mark **Print report heading on each page**. If you leave the checkbox unmarked, the heading information prints on only the first page.

61. Select the **Criteria** category from the treeview on the left. All criteria options available for the report appear on the right side of the screen.

62. For this scenario, you want the criteria printed. To enable the frame, mark the **Print Report Criteria** checkbox.

63. In the **Criteria to print** box, mark all the criteria you want to print with your report. Unmark any information you do not want to print with your report. For this scenario, leave all of the checkboxes marked.

64. You specify where the program should print this information in the **Include on** field at the bottom of the screen. You can choose to print the criteria on a **separate page** or the **First page of the report**. For this scenario, select **a separate page**. The criteria prints at the end of your report.

**Warning:** For more information about the **Detail** category, see . “Detail” on page 159.
65. Select the **Detail** category from the treeview on the left. The fields, checkboxes, and options available with **Detail** vary, based on the report type you select.

66. Select how to you want to handle constituents who have more than one of the field values you selected on the Fields tab. If you want the constituent counted on the report only one time based on the primary, or first, field value met select **Include constituent for the primary field value**. If you want the constituent counted on the report for all matching field values, mark **Include constituent for all field values**. This frame activates only if you enter field information on the Fields tab.

For this scenario, you want to know how many constituents are in each constituent code category, regardless of repeats, so select **Include constituent for all field values**.

**Warning:** If in the **Heading** category on the Format tab, you select to include page numbers and dates with your headings, you may not want to repeat this information in your footers. If you do, the information appears in both places on your report.
67. Select the **Page Footer** category from the treeview on the left.

![Page Footer screenshot](image)

Use **Page Footer** to create a footer to appear at the bottom of every page in the report. You can also select to print the page number or the date in the footer of each page, instead of in the heading.

68. In the **Text** field, enter the text you want to appear in your page footer. This text prints at the bottom of every page of the report.

For this scenario, you want to make sure all users understand this information is confidential. In the **Text** field, enter “For Internal Use Only”.

69. In the **Align** field, specify the alignment for the page footer.

For this scenario, choose Center.

**Note:** For more information about the Format tab, see “Format Tab” on page 156.

70. You can also include page numbers and date information in your page footer.

For this scenario, because you included page number and date information with our headings, do not include the information again in the page footer.
71. Select the **Report Footer** category from the treeview on the left.

Use **Report Footer** to include a footer that appears only on the last page of the report.

72. In the **Text** field, enter the text you want to appear in your report footer.
   
   For this scenario, you want to know the author of the report and decide to put this information in the report footer. Enter “Report generated by Robert Fink” in the **Text** field.

73. In the **Align** field, specify the alignment for the report footer.
   
   For this scenario, choose Right.

74. Select the **Miscellaneous** category from the treeview on the left.
Use **Miscellaneous** to specify how to display numerical amounts, select page orientations, and select line spacing. The fields, checkboxes, and options available in the **Miscellaneous** category vary based on the report type.

75. In the **Amount Display Options** frame, select how you want monetary amounts displayed in your report.
   - To see the dollar sign ($) in front of monetary values, mark the **Show currency character** checkbox.
   - To include commas in numeric values (1,000), mark the **Show 1000’s separator** checkbox.
   - To display monetary values with two decimal places ($12.03), mark the **Show decimals** checkbox. If you unmark this checkbox, amounts and numbers are rounded to the nearest dollar ($12).
   - To display the percent symbol (%) with numbers that are percentages, mark the **Show percent sign** checkbox.
   - To leave a blank in place of amount fields that are zero, mark **Show blanks instead of zero amounts**.
   - In the **Negative amount format** field, you can change how negative amounts print in your report. The program defaults to parentheses (20). You can change it to a minus sign (-20).
   - As you make selections in the **Amount Display Options** frame, you can view how the selections affect what prints in your report in the **Sample Display** frame.

For this scenario, mark all of the checkboxes, except **Show blanks instead of zero amounts**. Zero amounts are easier to identify than blank spaces on the report. In the **Negative amount format** field, select the minus sign.

76. To double-space your report, mark the **Double-space report** checkbox. If left unmarked, the report prints single-spaced.

For this scenario, to make the report easy to read, mark the **Double-space report** checkbox.

77. Select the **Color Scheme** category from the treeview on the left.

Use **Color Scheme** to select colors for report headings. If you leave the **Apply a Color Scheme** checkbox unmarked, the report prints in black and white.

78. For this scenario, mark the **Apply a Color Scheme** checkbox.

   you like all the default heading colors except the **Column heading back color**. you want to use a green instead.

79. Click on the color box next to the **Column heading back color**. The Color screen appears.
80. Click on the green box.

81. Click **OK**.

You return to the Color Scheme screen. Green appears as the **Column heading back color**.

**Note**: For information about previewing your report, see “Previewing a Report” on page 122.

82. After you complete all the report parameter tabs, you are ready to print your report. For information about printing a report, see “Printing a Report” on page 125.

To view this report, see the Comparisons and Summaries Report section in the *Sample Reports Guide*. 
Custom Reports

Sample Custom Reports ................................................................. 336
Creating Custom Reports.......................................................... 338

Procedures
Creating/opening a custom report ........................................... 338
**Custom Reports** make it easy for you to share report files you create using Seagate *Crystal Reports*. Using **Custom Reports**, you can link a *Crystal Reports* file with its *Raiser’s Edge* export file. You then save the linked report in your database, where all users have access.

**Sample Custom Reports**

**Note:** To open and change the sample report parameters, you must have *Crystal Reports 8.5* or higher installed. *Crystal Reports 8.5* is included with your update/installation package. For instructions about installing *Crystal Reports 8.5*, see the *Installation Guide*.

To help you get started using **Custom Reports**, some sample reports install with the program when you update your software. You access the sample reports from the Custom Reports screen. The sample reports appear in the grid on the right side of your screen.

[Image of Custom Reports screen]

**Warning:** In order for a Custom Report to work for all users, you must save the report on a network drive. All users must also have the exact same path to the network drive.

**Note:** You can open the sample .rpt files through *Explore*. In RE7 folder, click rpt to access the .rpt files.
To open the sample report, select the report and click **Open**. The report parameter screen appears displaying the General tab.

The file names default in the **Select Export** and **Select Crystal Report** fields. To open and edit the export file in the **Select Export** field, click the **Click to edit export** button next to the binoculars in the field. The export file appears, displaying the General tab.
If you have *Crystal Reports 8* installed, you can open and make changes to the sample .rpt files, accessed through *Explore*.

**Creating Custom Reports**

**Note:** For information about installing *Crystal Reports for Blackbaud*, see the Installing Crystal Reports chapter in the *Installation Guide*. For information about working with *Crystal Reports for Blackbaud*, see the *Crystal Reports Tutorial*.

*Custom Reports* reduces the steps required to run an export-based *Crystal Report*. It also makes it easy for you to share your reports with others in your organization because the *Crystal Report* file is stored in your database. However, the export and *Crystal Report* files must be created before you can use them in *Custom Reports*.

You create custom reports in *Reports*, accessed by clicking *Reports* on the Raiser’s Edge bar.

**Warning:** Every time you run a saved *Custom Report, The Raiser’s Edge* checks to see if the fields present on the report are still part of the export file. You can add more fields to the export file without messing up the report. However, you cannot remove fields. If you do, a validation error appears, informing you the export file is no longer compatible with the *Crystal Report*.

- **Creating/opening a custom report**

  For information about installing *Crystal Reports for Blackbaud*, see the Installing Crystal Reports chapter in the *Installation Guide*. For information about working with *Crystal Reports for Blackbaud*, see the *Crystal Reports Tutorial*.

  1. On the Raiser’s Edge bar, click Reports. The Reports page appears.
2. Click the **Custom Report** category link in the **Reports** column. The Custom Reports screen appears.

![Custom Reports Screen](image)

A list of all saved report parameter files appears on the right half of the screen.

3. To open an existing report, select the report parameter file, and click **Open**. The report parameter file appears, displaying the General tab. You can make changes to the file and click **File, Save** from the menu bar.

4. To create a new parameter file, click **New**. The Custom Report screen appears displaying the General tab.

![New Custom Report](image)

---

**Note:** Only exports based on a Microsoft Access database appear on the Exports screen.
5. In the Select Export field, select the export file you want to use as a data source for your custom report. To access a list of all export files created for use with *Crystal Reports*, click the binoculars. The Open screen appears.

6. From this screen you can select an existing export file or create a new export file.
   - To select a file, highlight the file name and click Open. You return to the Custom Report screen and the selected export file name appears in the Select Export field.

   **Note:** For information about working in Export, see the Export chapter in the *Query & Export Guide*.

   - To create a new export file, click Add New. The Create a New Export screen appears. From here you can create an export file to use with *Custom Reports*. After you create and save your export file, you return to the Custom Report screen and the selected export file name appears in the Select Export field.

   **Warning:** Every time you run a saved Custom Report, *The Raiser’s Edge* checks to see if the fields present on the report are still part of the export file. You can add more fields to the export file without messing up the report. However, you cannot remove fields. If you do, a validation error appears, informing you the export file is no longer compatible with the *Crystal Report*. 
Once you select an export file, you can edit the file from the Custom Report screen by clicking the **Click to edit export** button next to the binoculars in the **Select Export** field. The export file appears, displaying the **General tab**.

Make any necessary changes and save the export file to return to the Custom Report screen.

7. In the **Select Crystal Report** field on the Custom Report screen, select the **Crystal Report** file you want to link to the selected export file. To search for a saved **Crystal Report** file, click the icon at the end of the field. The **Open** screen appears.

**Warning**: If the export file you associate with a **Crystal Report** parameter file does not contain all the fields used in the report, an error message appears, telling you fields required by the report are not present in the export file.
8. Locate the Crystal Report file you want to link to the selected export file and click Open. You return to the Custom Report screen. The selected report name appears in the Select Crystal Report field.

9. If you want the selected export file to automatically refresh every time you view the report, mark Refresh Export. If you do not mark this checkbox, the program checks to see if the export file exists on your machine. If it does, the program uses the existing export file; if it does not, the program generates the export file, regardless of the settings.

All the Raiser’s Edge fields included in the selected Crystal Report must be included in the selected export file. If not, an error message appears.

Warning: You cannot delete fields from an export field if the export file is associated with a Custom Report. The Remove button is disabled in Export. You also cannot delete an export file associated with a Custom Report. If you try, an error message appears.

10. Click Preview to view a copy of the report on your screen before printing it out. A screen appears tracking the export process.

11. A copy of the report appears on your screen. If the report appears to be in order, you can click the Print icon at the top of the preview screen and print the report.

Note: If the designer of the original Crystal Report selected the Save Data with Report option in Crystal, the option is turned off before the report is saved in The Raiser’s Edge database. However, the original copy of the report is left in tack. Only the definition of the report is saved to The Raiser’s Edge database.
12. To save the report parameter file, click File, Save from the menu bar. The Save report as screen appears.

![Save Report As dialog box](image)

13. Enter a **Report name** and a **Description**. You can also choose to allow other users to run or modify this report parameter file.

14. Click **Save**. You return to the Custom Reports screen.

15. To return to the Reports page, select **File, Close** from the menu bar.
Report Instructions in the Knowledgebase

Searching in the Knowledgebase ................................................................. 346
Accessing the Knowledgebase ................................................................. 346
Knowledgebase Solution IDs for Reports .................................................. 347

Procedures
Accessing the Knowledgebase ................................................................. 346
The Knowledgebase provides answers to your frequently asked questions and software issues. It contains thousands of solutions written by our customer support analysts, addressing everything from how-to questions to troubleshooting steps.

This appendix includes instructions on how to use the Knowledgebase and a list of reporting solutions available through the Knowledgebase.

Searching in the Knowledgebase

To search the Knowledgebase, ask complete questions and avoid using boolean operators, such as “and” or “or.” You do not need to use confusing symbols or terms required by most keyword searches.

If you want to know how to complete a particular function, the best way to query the Knowledgebase is through the Quick Search field. Start your question with the words “How to”. The Knowledgebase provides solutions based on your specific search requests. If a specific request fails the first time, try a more general request. For example, if you fail to find a solution for “How to create a Pledge Status Report using specific dates” try “How to create a Pledge Status Report”.

The Knowledgebase works best when you ask one search question or phrase at a time, and it can correct some spelling errors. Capitalization does not affect your search.

The Knowledgebase recognizes word order, so search with the same word order you use in everyday conversation. For example, enter “How to create a Pledge Status Report”, not “create Pledge Status Report”.

Also, include a space between the words in your search phrase.

Accessing the Knowledgebase

The Knowledgebase is housed on the Blackbaud Web site and maintained by our customer support analysts.

- **Accessing the Knowledgebase**
  1. From your Web browser, open the Knowledgebase Web page:
     kb.blackbaud.com.
The Knowledgebase screen appears.

a. If you know the solution ID, click the Open Solution ID link available on the left side of the page. The Explorer User Prompt screen appears. For a list of the most popular report solution IDs currently available through the Knowledgebase, see “Knowledgebase Solution IDs for Reports” on page 347.

b. If you do not know the solution ID, you can search the database.

In the first (1) step, enter your question. For example, if you want to know how to create a New Donors Report, enter “How to create a new donors report”.

In the second (2) step, select the Blackbaud product in which you are working: The Raiser’s Edge 7. When you complete the Knowledgebase screen, click Search. A list of possible solutions appears. If your solution does not appear, refine your search criteria and run a new search. If one of the options appears to answer your question, click the link to access the instructions.

Knowledgebase Solution IDs for Reports

This section includes a list of Reports solutions available through the Knowledgebase. For instructions on how to access the solutions, see “Accessing the Knowledgebase” on page 346.

Action Reports
• Tickler Report - BB70833
Analytical Reports
• Actual vs. Target Report - BB93468
• Appeals Analysis - BB80876
• Comparative Report - BB56450
• Consecutive Years Report - BB56739
• Donor Category Report - BB13743
• New Donors Report - BB76760
• Solicitor Performance Analysis - BB47840
• SYBUNT Report - BB123476
• Top Donors Report - BB23869

Campaigns, Funds, and Appeals Reports
• Appeal Cost Breakdown - BB5892
• Appeal Performance Analysis - BB74072
• Campaign Progress Report - BB56452

Demographic and Statistical Reports
• Statistical Report - BB260660

Event Management Reports
• Dinner Preferences - BB32126
• Seating Validation Report - BB172899

Financial Reports
• Annual Statement Report - BB77534
• Cash Receipts Journal - BB79821
• Constituent Giving History - BB128919
• Gift Detail and Summary Report - BB27407

Membership Reports
• Comparative Membership Statistics - BB87226
• Membership Statistics by Category - BB136964
• Month/Year Statistical Analysis - BB69816

Pledge and Recurring Gift Reports
• Pledge Status Report - BB58922

Profiles, Lists, and Directories
• Alumni Class List Report - BB5891
• Constituent Directory - BB116606
Reports Glossary

A .......................................................... 286
B .......................................................... 287
C .......................................................... 288
D .......................................................... 289
E .......................................................... 290
F .......................................................... 290
G .......................................................... 291
H .......................................................... 292
I .......................................................... 292
J .......................................................... 293
L .......................................................... 293
M .......................................................... 293
O .......................................................... 294
P .......................................................... 294
Q .......................................................... 296
R .......................................................... 297
S .......................................................... 298
T .......................................................... 301
U .......................................................... 302
V .......................................................... 302
W .......................................................... 303
This section defines words and phrases you need to know as you work with reports. If you come across an unfamiliar term when reading this or any other book in *The Raiser's Edge* documentation, make sure you check the online glossary in the help file.

**A**

**Acknowledgee.** An acknowledgee is a family member, friend, associate, or honoree that should be notified or thanked when a gift is donated to honor, memorialize, or celebrate an honor/memorial constituent. For example, you create a tribute honoring William Smith on his 50th birthday. William Smith and his wife Margaret want to know when gifts are donated to the tribute so they can thank their friends personally. William and Margaret Smith are the acknowledgees for the tribute. An acknowledgee does not have to be a constituent in your database, but must be a relationship of the honoree.

**Action.** An action is a specific step you take towards securing a donation from a constituent. It may include meetings, mailings, telephone calls, and e-mail messages. Actions allow you to build a history of the contacts and communications involved in creating a successful relationship with a constituent.

**Action category.** An action category defines the nature of the action. The categories are *Phone Call, Meeting, Mailing, E-mail,* or *Task/Other.* The action record has varying available fields depending on the category you choose. For example, if you choose *Phone Call,* you have a field to track the desired phone number and if you choose *Meeting,* you can specify the location.

**Action notification reminder.** A notification reminder allows *The Raiser’s Edge* to remind you days, weeks, or months before an action is scheduled to occur. You can easily keep track of when to phone a constituent, send out a mailing, or meet a prospect for lunch. The notification can be set up to remind any user in your database.

**Action record.** An action record contains all the pertinent information surrounding an action. Every action in the database has its own record, which can be accessed from a constituent or event record, or directly through the Actions page.

**Action status.** Action status is a user-defined field that indicates the condition of the action. Examples are Open, Closed, Pending, Completed, and Not Completed. These statuses are used in building Action Tracks, creating queries, and generating reports.

**Action track.** An action track is a predefined sequence or series of actions assigned to a constituent or event record. Tracks are usually a combination of independent and dependent actions. The creation of dependent actions is based on the completion of a previous independent action. Tracks in essence simulate a hierarchal process or checklist for a constituent or event.

**Action type.** An action type is a user-created table that further defines the action category. Examples for *Mailing* are Follow-up letter, Welcome letter, Inquiry, and Birthday card.

**Addressee.** An addressee is a format defining how you want a constituent’s name to appear on envelopes, reports, and labels. It is usually formal, such as Ms. Joan Johnson or Mr. Thomas F. Stewart.

**Adobe Acrobat Reader.** *Adobe Acrobat Reader* is a third-party software application that enables electronic distribution of formatted documents. *Adobe Acrobat Reader* can be downloaded free from the Adobe Web site.

**Appeal.** An appeal is a solicitation that brings in your gifts. Solicitations can include auctions, direct mailings, and phonathons. Because some of your gifts can be unsolicited, you do not have to associate an appeal with a gift. You can set goals for your appeals and run reports showing how close you are to reaching those goals. Additionally, you can create packages to track historic and statistical information for different facets of an appeal.
Assignment interest. An assignment interest is a task a volunteer expresses a desire to perform. For example, your organization is an aquarium. Rosa Shapiro lets you know she would like to help feed the seals or penguins. Because Rosa lets you know the tasks she is interested in, you can assign her to the jobs she enjoys. You can track volunteer assignment interests on the Volunteer tab of a constituent record.

Attribute. An attribute adds flexibility to your record keeping by giving you the ability to define and store special information about a wide variety of record types. You can identify a category for the attribute and then store an entry specific to that category. You can later use these attributes for narrowing and defining the records you use in a report.

Attributes can be information you want to track, but for which no field exists in The Raiser’s Edge. For example, you can set up an attribute category called “Dietary Preference”. In the Description table, you can have such entries as “Low Fat”, “Vegetarian”, and “Diabetic”. You can also add comments to an attribute, such as “Constituent does eat eggs.”

Be sure not to confuse attributes with information such as constituent codes. For more information about constituent codes, see the Constituent Data Entry Guide.

Award. An award is something you present to a volunteer in recognition of outstanding service and loyal commitment. For example, you may present your volunteers with an engraved pen and pencil set when they complete 200 hours of service.

Benefit. A benefit is a gift your organization gives to the participants of an event when they donate a certain amount of money. You can set up default benefits for each unit (level) of registration fee prices on the Prices tab of an event record. For example, if you are hosting a golf tournament, you may give out a golfing cap to individual players, a t-shirt to those who are participating as a team, and a $25 pro shop gift certificate to your hole-in-one sponsors.

Business rule. A business rule is a system-wide preference you set in Configuration to customize standard procedures and requirements. With business rules, you can control functions and displays affecting all users in the program.

Campaign. A campaign is your overall objective for raising money. For example, a museum can have a New Building Campaign with the objective of raising money for a new location. Of campaigns, funds, and appeals, campaigns are the broadest type of record. Campaigns act as an umbrella over funds and appeals.

A single campaign can have any number of funds and appeals under it. For example, the museum can have both a Moving Fund and a Computer Equipment Fund under the New Building Campaign. The overall objective is to raise money for the new building. Within this objective, gifts to the specific funds go toward covering expenses for moving and toward purchasing computer equipment to use in the new building. Another example is a Disaster Relief Campaign for the National Red Cross. Within the overall objective of raising funds to assist victims of all types of disasters, the National Red Cross can have a Hurricane Relief Fund and the somewhat broader General Relief Fund. If your organization has many designated purposes for gifts, you can have numerous funds with only a few campaigns.

Campaign goal. The campaign goal is the overall goal amount for each campaign. Solicitors affiliated with the campaign are assigned to constituents for specific amounts. Reaching a campaign goal depends on the success of solicitors attaining their individual goal amounts for the campaign. You can view the solicitor hierarchy for a campaign goal from the campaign record.
Captain. The captain is the solicitor team member responsible for coordinating the team’s efforts, keeping team members informed, offering assistance or advice to the team, and encouraging members to reach their goals. For example, Anne Sinclair has been a solicitor for your organization for the past five years. Because of her experience, you make Anne the captain of your Annual Fund team. As the team’s representative, Anne works as the go-between for your organization and her team members. Because Anne needs to keep everyone informed, as well as to advise and encourage her team, you may not want to assign her a solicitor goal. Although captains can improve the efficiency and effectiveness of a team by coordinating the team’s efforts, you are not required to have a captain for each team.

Checklist. A checklist is a “to do” list you assign to a volunteer. The list you create on the Volunteer tab of a constituent record contains the individual items you require a volunteer to complete before he can start a job. For example, your organization is an aquarium. Before a volunteer can start work at the aquarium, he must attend a volunteer training class, attend the Preserving Our Aquatic Environment seminar, and have a TB test. Checklists are important when determining the jobs a volunteer can actually be assigned. If the volunteer has not completed the checklist items, he should not be assigned to jobs listing these same checklist requirements.

Configuration. Configuration is a shared area of The Raiser’s Edge you use to set up your system and define settings to customize the program for individual users.

Contact. A contact is the name of the primary person with whom you conduct business. For example, you can enter contact information about a vendor on the Vendor tab of a vendor record, or you can enter contact information on the Banks tab of an open bank record.

Constituent. A constituent is an individual or business who supports your organization by contributing time, money, and resources.

Constituent code. A constituent code defines the relationship a constituent has with your organization. In other words, a constituent code tells you why the individual is in your database. Examples of constituent codes are Board Member, Alumnus, Trustee, Current Parent, and Friend. Each constituent record in your database should have at least one constituent code listed. If you list more than one constituent code, always list the most important active constituent code first. The Raiser’s Edge recognizes the first code listed as the primary constituent code.

Constituent record. A constituent record is a record that maintains all aspects of an individual or organization, including biographical, relational, address, employment, and gift information.

Criteria Field. A criteria field is a filter you use to determine which records appear in query results. For example, if you use the statement “category equals expense” as a criterion and select account as the query type, the program finds and lists only records categorized as “expense”.

Criteria Operator. A criteria operator is a value used in conjunction with criteria fields, that defines specific conditions a record must meet to be included in query results. For example, if you use the statement “category equals expense” as a criterion, “equals” is the operator and only accounts with an expense category appear. Other operators are: does not equal, greater than, greater than or equal to, less than, less than or equal to, one of, not one of, between, not between, begins with, does not begin with, contains, does not contain, like, not like, blank, not blank, sounds like, and <ask>.

Database. A database is a collection of information organized so that a computer program can quickly select desired pieces of data. It works much like an electronic filing system. Traditional databases are organized by fields, records, and files. A field is a single piece of information; a record is a set of fields; and a file is a collection of records.

Default. A default is a field entry you select on the Options screen to help increase the ease and speed of data entry by providing a preset value.
**Default Set.** A default set is a record of default transaction information you can create and load in a batch. Once loaded, the defaults appear on the record.

**Dropped membership standing.** When a member informs you she know longer wants to be a member of your organization, you can change the membership standing to Dropped. Dropping a membership allows you to keep a record of her past membership activity, but no longer includes her as an active member. If the member later decides to become a member of your organization again, you can Rejoin the member.

**Dynamic query.** A dynamic query is a query that refreshes and updates results automatically each time the query is run, providing the most current results.

**E**

**Embedded Addressee/Salutations.** With embedded addressee/salutations, you define in Configuration the **Const Addr/Sal** field each time you use the addressee or salutation. For example, you can select Constituent Addr/Sal and attach it to another field such as Position. This creates an embedded addressee/salutation.

When you select this embedded addressee/salutation on a constituent record, you can then select any other defined addressee or salutation, and the program automatically places the entry from the **Position** field of the constituent’s Business record behind it. So you could have an addressee/salutation of “Mr. William Smith, President”.

**EFT (Electronic Funds Transfer).** EFT is a general banking system in which transactions, such as deposits and bill payments, are made through computer databases and electronic files. Money does not physically change hands; it transfers electronically from one account into another account. This is often referred to as “direct deposit”. **EFT** is also an optional module you use to send and receive electronic fund transfers.

**Expense.** An expense is the result of using assets in the course of conducting operations. Examples are telephone charges, gasoline purchases, and repairs. Expenses are deducted from revenues on the income statement of financial activities report to arrive at net income or net surplus.

**F**

**Field.** A field is a data entry box in which you add and store information on records in your database.

**Filter.** A filter is criteria that records must meet to be included in a report. For example, if you apply the filter “Profession Codes”, the report includes only the profession codes you select. Select filters to apply to a report from the Filters tab.

**Fund.** A fund identifies where gifts and pledges should be recorded for financial purposes. Funds are key to managing your gifts. Because funds are so closely linked with gifts, the **Fund** field is required when you enter gifts. On the fund record, you can specify the bank accounts to which you want gifts associated with the fund to apply. We strongly recommend you consult with your business department to ensure that these account numbers are entered accurately. If you have Blackbaud’s **General Ledger**, the databases of the two programs can be linked so you can enter gifts once for both programs. This cuts your data entry time in half. When you enter gifts into **The Raiser’s Edge**, selected accounts in **General Ledger** are automatically debited and credited based on the gift type. Gifts can also be distributed among multiple **General Ledger** accounts and projects.

**Fund goal.** The fund goal is the overall goal for each fund. Because your campaigns may be composed of several funds, you can assign a goal for each fund. The goal amounts of solicitors for each fund contribute to the fund goal. Like the campaign goal, you can view the solicitor hierarchy for a fund goal from the fund record.
**Future award.** A future award is the next award a volunteer will potentially receive, if he completes the service requirements for that award. For example, Jack Weber, a volunteer at your organization, received the 200 Hours Award at the last volunteer meeting. The next award Jack will receive is the 400 Hours Award, if he completes 400 hours of volunteer service. Because this is Jack’s next tentative award in the future, it is termed a “future award.”

**Gift.** A gift in *The Raiser’s Edge* is revenue from donations.

**Gift of membership.** A gift of membership describes a situation in which a constituent is the primary beneficiary of membership benefits, but is not responsible for the membership dues. For example, a parent can give a gift of membership to a child. The parent pays the membership dues and the child benefits from the membership. The donor, or person paying the membership dues, and the member receiving the benefits must have a constituent record in your database.

**Goal.** A goal is the amount of money you want a solicitor, campaign, fund, or other category to bring into your organization. Large goals, such as a campaign goal, are usually broken down into smaller goals. For example, your Capital Campaign goal is $1,000,000. This is the overall amount you want to reach by the end of the campaign. This campaign contains several funds, and each fund has an overall fund goal. For each fund goal, you have a solicitor hierarchy and each solicitor in the hierarchy has a goal. These solicitor goals contribute to the overall fund goal, and the fund goal contributes to the overall Capital Campaign goal.

**Group (Membership Record).** A group specifies a series of related events. For example, your organization holds three training classes for new volunteers during the summer. Although each training class has a unique name, you group the three classes together with the common name, “Summer Volunteer Training.” You enter the common name in the Group field on the General tab of the event record.

**Group (Profile Content tab).** A group includes bits of similar information, usually stored in the same section of *The Raiser’s Edge*. For example, the Addresses group adds to your report address information entered on the constituent record. The Appeal Information group, includes information entered on an appeal record, such as start and end dates, overall goal, and number solicited.

**Guest.** A guest is an individual or organization attending an event as an invitee (guest) of a registrant. For example, you enter Jane Cothran as a registrant of your organization’s golf tournament. Jane decides to bring a friend, George Cone. You enter George Cone in your database as a guest for the golf tournament. On the General tab of George’s guest record, you enter Jane Cothran in the Guest of field because George is Jane’s guest.

**Home page.** The Home page is a feature common to all *The Raiser’s Edge* programs that provides a central location for quick and easy access to all areas of the program. Using links and tabs, you can customize your Home page to display records and functions you use most frequently.

**Honor/memorial (honoree).** An honor/memorial is a constituent who is being honored, memorialized, or celebrated by gifts donated to your organization. For example, Rebecca Lawrence has passed away and her family requests that your organization receive gifts on her behalf. To receive gifts on Rebecca’s behalf, you need to designate Rebecca Lawrence as an honor/memorial on her constituent record. For more information about designating a constituent as an honor/memorial, see the *Tribute Data Entry Guide*.

**Note:** Organization constituents can also be an honor/memorial.

When you designate a constituent as an honor/memorial, the constituent is now an honoree in your database. You can refer to the constituent as an honor/memorial or as the honoree receiving gifts.
**Inactive action.** An inactive action is no longer current or valid. We recommend this option in lieu of deleting the action record.

**Inactive solicitor.** You can make a solicitor inactive to indicate the solicitor is not currently available for new assignments. By making a solicitor inactive, you save all the constituent’s solicitor information in your database. You can always make an inactive solicitor active again. The program excludes inactive solicitors from solicitor searches, unless you select to include them, so you cannot accidentally create a new assignment for these solicitors. Because you can continue to query and report on solicitor information for inactive solicitors, we recommend you make a solicitor inactive rather than hiding the solicitor information in your database.

**Installment.** An installment is a scheduled payment that reduces the balance of a master pledge. For example, Susan McDonald pledges $100 to your organization. She plans to pay this pledge in two installments due on June 1 and July 1. When you add Susan’s pledge, you set up a payment schedule on the Installments/Payments tab. Installments can be paid on a weekly, biweekly, semi-monthly, monthly, bimonthly, quarterly, semi-annual, or annual schedule. Installments can also be paid in one payment or on an irregular schedule.

**Job.** A job is a task, or miscellaneous piece of work, assigned to a volunteer of your organization. For example, your organization is a hospital and you run a gift shop. You have volunteers who come in to run the cash register and volunteers who come in to stock shelves. You have several volunteers who come in to create gift baskets and another volunteer who helps with computer data entry. Each of these tasks, performed by a volunteer, is a volunteer job.

**Job assignment.** A job assignment is a record you create when you assign a volunteer to a job. You can manually find a job and assign it to a volunteer by using the New Job Assignment button on the Volunteer tab of his constituent record or you can automatically find jobs and assign them to a volunteer by using the Find Jobs button on the same tab. For added convenience, you can also automatically find volunteers and assign them to a job by using Tools, Find Volunteers from the menu bar of the job record itself.

**Lapsed membership.** If a members fails to renew a membership before the date the membership expires, the membership standing becomes Lapsed until you Upgrade, Downgrade, Renew or Drop the membership. For example, Derrick Baker’s membership expires on April 15, 2003. This date passes without any changes made to his membership record. By default, Derrick’s membership standing changes to Lapsed. The membership standing remains Lapsed until you Upgrade, Downgrade, Renew or Drop the membership.

**Master pledge.** A master pledge is a gift record containing the gift amount a constituent agrees to donate and the installment schedule for the pledge payments. You create a master pledge by selecting Pledge in the Gift type field on a gift record. For example, Susan McDonald pledges to donate $100 to your organization. She wants to pay this pledge in two installments due on June 1 and July 1. To record Susan’s gift in your database, you need to create a new gift record with a gift type of Pledge. On the Installments/Payments tab of this gift record, you can enter the installment schedule Susan plans to use to pay her pledge.
Membership transaction. A membership transaction is used to describe the separate membership activities comprising a membership record. The activities can include adding, renewing, rejoining, upgrading, downgrading, and dropping a membership. For example, in February 2001, you add an individual membership for Mr. David Murphy. In January 2002, David decides to renew his membership. In this case, you made two separate transactions for David’s membership record.

Mandate. A mandate is an official order from a court or public agency requiring that an individual serve some type of volunteer duty. If your organization accepts volunteers who need to fulfill mandates, you can track such information as the date the volunteer starts his mandate service, how many hours he was ordered to serve, the date the volunteer fulfills the order, the agency’s name who ordered the mandate, and the person at the agency you should contact with questions or concerns about the volunteer or the mandate. If you mark the Apply time sheet toward required mandate hours checkbox on each of the volunteer’s time sheets, the program automatically keeps track of how many hours the mandated volunteer has served. Mandate information is tracked on the Volunteer tab of a constituent record.

Option. An option is a preference you select that specifies defaults in The Raiser’s Edge. Options are password-specific and follow the user, regardless of the workstation he logs into.

Other donation. An other donation is a gift, other than a registration fee, given to an event. For example, Bill Walker, decides to donate $1,000 to your annual silent auction. He is not participating in or attending your event. He just believes in your cause and wants to donate some money. Other donations can come only from constituents in your database. You can link gifts as other donations on the Registration Fees/Donations tab of a participant record.

Output field. An output field determines the information that appears on the Results tab of a query. For example, create a query of all gifts over $500. For all records meeting this requirement, you want to see only the last name and constituent ID on the report. For this query, Last Name and Constituent ID are the output fields.

Package. A package gives you the ability to track and analyze the profitability of different solicitations within a single appeal. For example, if you have a Summer Phonathon in which low-level donors are called with a prerecorded message while major donors are contacted personally, you can create a separate package for each. By doing so, you can break down summaries to pinpoint the effectiveness and expense of each type of call, instead of running a single summary for the entire phonathon. Packages let you analyze the effectiveness of your appeals in a precise manner. Packages can be analyzed during or after an appeal.

Parameter. A parameter is any field, option, or checkbox that narrows information included in an import, mailing, report, or global change. By specifying parameters, you define the output of the process. You can save parameter files to use again.

Parameter file. A parameter file is a set of saved parameters you can reuse in Reports, Mail, and other areas of The Raiser’s Edge.

Parameter tabs. The parameter tabs make up a parameter file and contain the fields, checkboxes, buttons, and options used to define the parameter file. For example, in Reports, you use the Format parameter tab to select how you want your report formatted.

Participant. A participant is an individual or organization associated with an event. A participant can be a registrant, guest, or sponsor. All your volunteers, vendors, speakers, coordinators, and instructors are also considered participants and you must enter each as a registrant, guest, or sponsor. You should enter anyone associated with an event as a participant, but a participant does not have to actually take part in the event. An example of this situation is if you are hosting a Holiday Ball. You hire a catering service. The catering service
attends the event as a necessary element to supply the food, but does not actually take part in the ball itself. You need to add the catering service as a participant of the event so you can track the expenses you pay out to them. Another example is if you are holding a golf tournament. You invite a golf celebrity to be the guest speaker. Even though the celebrity is not playing golf in the tournament, you still need to add him as a participant, so you can track him as a speaker for the event.

- **Registra**
  A registrant is an individual or organization attending an event or providing a service or product for an event. A registrant may or may not actually take part in the event. For example, you are giving a CPR class. You enter students of the CPR class as registrants because they actively participate by paying registration fees and taking the class. By tracking the students as registrants, you can track their names, addresses, attendance, registration fees, seating arrangements, and other important information. For the same CPR class, you invite a local doctor to come and give a speech on strokes. The doctor is a guest speaker, but he does not actively take the class as a student. You still need to enter the doctor in your database as a registrant so you can track him as a speaker for the event and track any expenses you pay out for his services.

- **Guest**
  A guest is an individual or organization attending an event as an invitee (guest) of a registrant. For example, you enter Jane Cothran as a registrant of your organization’s golf tournament. Jane decides to bring a friend, George Cone. You enter George Cone in your database as a guest for the golf tournament. On the General 1 tab of George’s guest record, you enter Jane Cothran in the Guest of field because George is Jane’s guest.

- **Sponsor**
  A sponsor is an individual or organization sponsoring, or representing, a registrant. For example, your organization is holding a tennis tournament. Southern Corporation sponsors a team to play in the tournament. Southern Corporation represents the team and pays the registration fee for each player. You enter Southern Corporation as a sponsor. You enter the individual players as individual registrants. In the Sponsored by field on the General 1 tab of each registrant record, you enter “Southern Corporation”.

**Parameter.** A parameter is any field, option, or checkbox that narrows information included in an import, mailing, report, or global change. By specifying parameters, you define the output of the process. You can save parameter files to use again.

**PDF (Portable Document Format).** A PDF is a type of document viewed with Adobe® Acrobat® Reader that maintains its formatting and displays correctly on any output device. For example, The Raiser’s Edge user guides are saved as PDFs and can be printed or accessed from the Help file, Online Manual page of the program, or the installation CD. PDF files contain hyperlinks so you can jump from topic to topic.

**Pledge.** A pledge is a promise to make a gift in the future and can be paid in single or multiple installments. After a constituent makes a pledge to your organization, you need to create a gift record with the gift type of Pledge. When you receive a payment for a pledge, you create a new gift record and apply it toward the pledge to reduce the balance. Every gift type except Pledge can be applied to a pledge to reduce the balance. When a constituent does not pay the amount owed for a pledge, you can write off the pledge so it does not appear as expected income.

**Pledge overpayment.** Occasionally, a constituent may overpay a pledge, which means he sends in more than the total of the pledge. When this happens, you can either create a cash gift for the difference or increase the amount of the original pledge. If you create a cash gift, you are adding a new gift for the constituent. When you increase the amount of the original pledge, you are changing the original pledge gift record.

**Pledge write-off.** When a constituent defaults or cannot make payments on a pledge, you can write off the pledge so the balance no longer appears as expected income. For example, a constituent pledges $500 to your organization. He calls you six months later to inform you he is no longer employed, and cannot make any payments on this pledge in the future. You can write off the $500 pledge so that the gift record does not have a pledge balance. Once you write off a pledge, you can change or delete the write-off.

**Plug-in.** A plug-in is a program designed to run as extensions of the programs in The Raiser’s Edge.
Post. Posting is the process of transferring transaction amounts from a journal to general ledger accounts and updating account balances. Posting commits transactions to the account record.

Preferences. See “Option” on page 356.

Qualification. A qualification is a skill, experience, course, or training a volunteer must have to qualify, or be accepted, as a volunteer for the jobs at your organization. For example, your humanitarian organization is looking for people with certain talents to help build homes for families in need. You are looking for volunteers with carpentry, plumbing, roofing, and painting skills. Your organization runs a health clinic and you are looking for volunteers with medical experience. Your organization requires that volunteers take a Health and Sanitation class before they start work in your soup kitchen or attend a Volunteer Orientation training session before they start any job. All these things are qualifications.

Query. Query is the means by which you flag, group, and list selected records from your database. You can create dynamic and static queries specific to key areas of The Raiser’s Edge based on a set of criteria you define. Although queries group entire records, you can limit and sort the output information included in query results. You can use saved queries to limit the information processed in Records, Mail, and other areas of The Raiser’s Edge. Using queries in this manner reduces data processing time.

Query format. Queries can be created in one of two formats: Dynamic and Static. Static queries search the database and generate a list of records that match the specified criteria at a specific point in time. Dynamic queries search the database and return records that match the criteria using the current database of information.

Query type. Query types correspond to specific application records. These vary according to the program you are using. Your selection identifies the record type you want to query and makes a list of that record’s fields available for filtering, output, and sorting.

Record. A record is a page in The Raiser’s Edge from which you add, edit, and delete information such as names, addresses, relationships, gifts, memberships, events. Records is also an area in The Raiser’s Edge where you can manage records.

Relationship. A relationship is defined as a familial or social association with a constituent. In The Raiser’s Edge, you can track five different types of relationships for a constituent. These relationships are individuals (friends, family members, associates), organizations (businesses, clubs, employers), bank/financial institutions (credit, financial, and lending institutions), education/schools (schools, colleges, and universities), and assigned solicitor (individuals or organizations assigned to secure donations from the constituent).

Registrant. A registrant is an individual or organization attending an event or providing a service or product for an event. A registrant may or may not actually take part in the event. For example, you are giving a CPR class. You enter students of the CPR class as registrants because they actively participate by paying registration fees and taking the class. By tracking the students as registrants, you can track their names, addresses, attendance, registration fees, seating arrangements, and other important information. For the same CPR class, you invite a local doctor to come and give a speech on strokes. The doctor is a guest speaker, but he does not actively take the class as a student. You still need to enter the doctor in your database as a registrant so you can track him as a speaker for the event and track any expenses you pay out for his services.
Registration fee. A registration fee is an amount of money your organization charges for a level (or unit) of participation in an event. For example, if you are hosting a Holiday Ball, you can have two units of registrations fees, one for couples and one for singles. If you are hosting a golf tournament, you can have several units, such as a single, a foursome, or a hole sponsor. When you set up an event where you are going to charge registration fees, you need to establish prices. Later, when you add participants to the event, their registration fees are calculated using these prices. Only the prices you add on the Prices tab of the event record can be specified on the participant (registrant, guest, or sponsor) records when you add participants.

Rejoin. A rejoin is a membership that fails to renew before being dropped. You cannot renew a membership that has been dropped. Once a membership is dropped, the member must rejoin.


Reporting Hierarchies. Reporting Hierarchies group funds in The Raiser’s Edge into hierarchical arrangements independent of any campaign giving hierarch. You create reporting hierarchies in Configuration.

Report Parameter File. A parameter is any field, option, or filter that narrows information in a report and determines the appearance of the report’s output. By specifying parameters, you customize the output results of the report. For example, you can apply filters, create a header and footer, or choose a color scheme for the report’s results.

Report Type. A report type is the specific report included in a report category. For example, the Tickler Report is a report type. It is one of three report types in the Action Reports category.

S

Salutation. A salutation is a format defining how you want to greet a constituent in correspondence. Depending on your relationship with the constituent and the type of mailing, a salutation can be formal or informal. For example, you may greet Mr. Thomas F. Stewart as Mr. Stewart in an appeal letter and as Tom in an alumni mailing.

Security. Security is a shared area in The Raiser’s Edge in which you establish access rights for users. With Security you can control what specific groups of users are allowed to view, add, edit, or delete information.

Security group. A Security group is a group of users you define in Administration. You control security in The Raiser’s Edge by creating groups with specific rights and assigning users to groups based on how much system access you want them to have. You can edit the rights of existing groups.

Server. A server is a powerful computer or processor dedicated to managing disk drives, printers, or network traffic. Servers are often dedicated, meaning they perform no tasks other than server tasks. For example, a dedicated database server for processing database queries has no other functions besides processing the queries.

Shared component. A shared component is a feature shared by all The Raiser’s Edge programs and modules.

Shared table. A shared tables is a table common throughout The Raiser’s Edge.

Shell. The shell is a central area from which you can access all areas of The Raiser’s Edge. When you click a link to access an area, it appears as a page in the shell.

Shortcut menu. A shortcut menu is a list of commonly used commands you can select to quickly perform actions or to display properties. Open, Delete, Print, and Properties are common shortcut menu items. To access shortcut menus, place your cursor in a field or grid and click the right mouse button.

Sort field. A sort field determines the order in which records appear in query results. You can sort in ascending or descending order.
Special need. A special need indicates a volunteer’s special consideration or request that can prevent her from being assigned to a job. For example, Rebecca Schmidt, a volunteer at your organization, lets you know she needs you to provide a baby-sitting service before she can volunteer at your upcoming phonathon. You are not providing a baby-sitting service at this event. On the Details tab of the phonathon job records, you enter Baby-sitting Service so you can eliminate any volunteer having this special need. On the Volunteer tab of Rebecca’s constituent record, you enter Baby-sitting Service as a special need. When you assign volunteers to the phonathon jobs, Rebecca will potentially be eliminated because the special needs match. Special needs are beneficial for you and your volunteers because they help you schedule volunteers’ work appropriately.

Sponsor. A sponsor is an individual or organization sponsoring, or representing, a registrant. For example, your organization is holding a tennis tournament. Southern Corporation sponsors a team to play in the tournament. Southern Corporation represents the team and pays the registration fee for each player. You enter Southern Corporation as a sponsor. You enter the individual players as individual registrants. In the Sponsored by field on the General 1 tab of each registrant record, you enter “Southern Corporation”.

Solicit code. A solicit code provides a convenient method for identifying constituents as “exceptions to the rule” for your solicitors. These codes tell your solicitors that a constituent has certain rules or conditions the solicitors should follow. An example is “Do not phone at work”.

Solicitor. A solicitor is a member of your organization assigned to seek donations from constituents. Solicitors play a vital role in your fund-raising efforts. Your solicitors can have duties ranging from calling, visiting, and dining with prospective donors, to organizing campaigns and funds. In The Raiser’s Edge, your solicitors must be entered in the database as constituents. For information on how to make a constituent a solicitor, see the “Solicitors” chapter of the Constituent Data Entry Guide.

Solicitors are assigned to a specific campaign or fund on the General tab of the campaign or fund record. The solicitors for a particular campaign or fund can be organized in a hierarchy with solicitors reporting to other solicitors. They can also be arranged into teams, with appointed captains. You can assign solicitors a goal and analyze their success using a Solicitor Performance Analysis report. From the General tab of a campaign or fund record, you can access the Solicitors screen which contains a treeview listing all solicitors for a campaign or fund by individual and team in hierarchical order. On this screen, you can view, add, edit, or delete solicitors who contribute toward your campaign or fund goal.

Solicitor assignments. You can assign solicitors to constituents in your database, to actions you create for constituents, and actions associated with events. When you assign a solicitor to a constituent, you can determine the length of the assignment and the amount a solicitor will ask a constituent to contribute. You can also decide if the solicit amount is associated with a campaign or fund goal. Constituent assignment information appears on both the solicitor’s constituent record and the constituent record of the individual or organization to which the solicitor is assigned. When a constituent contributes a gift, you can determine the amount of credit a solicitor receives.

By assigning a solicitor to an action, such as a phone call or dinner meeting, you make the solicitor responsible for following the action through to completion. You can view action assignment information from the constituent record of the individual or organization receiving the action. If you have the optional module Event Management, you can also assign a solicitor to an action associated with an event. For example, you want Kathleen Bentley to contact all participants in your spring tennis tournament. From the Actions tab of the Spring Tennis Tournament event record, you assign Kathleen to the action of calling the participants of the event. You can view information about the phone call Kathleen is assigned to make for the tournament from the Actions tab.

Solicitor goal. In The Raiser’s Edge, a solicitor goal is the amount of money a solicitor is responsible for raising for a particular campaign, fund, or other category goal. For example, the campaign goal for your Annual Campaign is $500,000. Joseph Diresta is responsible for obtaining $10,000 in contributions for this campaign. Therefore, Joseph’s solicitor goal for the Annual Campaign is $10,000. You can also assign solicitors to unspecified goals, which are goals not related to a specific campaign or fund.
**Sponsoring pledge.** A sponsoring pledge is a donation made on behalf of a registrant, guest, or sponsor participating in a sporting event. For example, your organization is holding a walk-a-thon for breast cancer awareness. All proceeds are going to breast cancer research. The participants of your event ask as many people as possible to donate a certain amount of money if they complete the walk. Another example is when your organization holds its annual golf tournament. Dynamic Engineering, a sponsor of your tournament, asks each of its employees to donate a certain amount of money for each participant playing on Dynamic Engineering’s team. These sponsoring pledges bring in extra donations for the tournament. The donors of sponsoring pledges must be entered as constituents in your database. Sponsoring pledges are tracked on the Sponsoring Pledges tab of a participant record.

**Static query.** A static query is a query that provides a record of query output that existed at the time you established the query. If you run a report two months later using the same query, the system restricts the new output to only the records from the original query. Data entered after the original query is disregarded.

**Status bar.** The status bar is a horizontal strip at the bottom of a screen that displays important messages to assist you in the program. For example, when the cursor is in a field with a table lookup available, “Press F7 for Table Lookup” appears in the status bar.

**Tab.** A tab is a design element that appears at the top of some screens in *The Raiser’s Edge*. Tabs work to separate options into themed groups. For instance, you will find formatting options on various system Format tabs.

**Table.** A table is a field in which you can pre-define entries to save time and promote consistency for your data entry.

**Table lookup.** A table lookup is a table from which you can select and enter information into fields to speed data entry. To access a table lookup, place your cursor in a lookup field and press F7.

**Team.** Once you determine which constituents in your database should be associated with a specific campaign or fund, you can organize the solicitors into teams. A team is a group of solicitors working toward a common campaign or fund goal. Each team member works to reach an individual goal which contributes to the overall team goal. Many organizations offer a reward to teams who reach or surpass their goals, which is an additional incentive for team members to encourage each other to attain their individual goals to meet the team’s goal.

**Time sheet.** A time sheet summarizes the hours a volunteer worked at a particular job on a particular date. You can add Volunteer time sheets by using the **New Time Sheet** button on the Volunteer tab of a volunteer’s constituent record. From a time sheet, you can search your database for the job you assigned a volunteer. Once you find the job, the job name, category, position, and volunteer type appear automatically on the time sheet. This information defaults on the time sheet from the job record itself. On the time sheet, you can also track job information such as the department under which the job falls, the location where the job took place, and the particular task performed. The time sheets you create for a volunteer list in a grid on the Volunteer tab of his constituent record.

**Title bar.** A title bar is a horizontal strip at the top of a screen that identifies a program or file.

**Toolbar.** A toolbar is a horizontal strip with buttons that, when clicked, perform specific tasks. It is located under the title bar at the top of a screen. Common toolbar buttons include New, Open, Save, and Print.

**Treeview.** A treeview is a hierarchical selection list used extensively in *The Raiser’s Edge*. A treeview differs from a standard list in that some, or all, of the items in a treeview contain branches represented by dotted lines. A treeview is usually found on the left side of the screen. When you select an item or branch from a treeview, the options for that item appear in a screen on the right. The Relationships tab has a good example of a treeview.
Tribute. A tribute explains the reason why you are honoring, memorializing, or celebrating a constituent. For example, Jane McBeth is participating in a walk-a-thon to support your organization. Many of her friends are donating gifts to your organization to support Jane’s participation in the walk-a-thon. On Jane’s constituent record, you can create a tribute “in support of” Jane’s efforts so you can record the gifts received on her behalf.

Unspecified goal. For goals that are neither campaign nor fund goals, you can select an unspecified goal. If you have the proper user rights, you can create categories of unspecified goals. For example, your organization may have solicitors whose primary responsibility is to find prospects or to attend organization functions. These individuals may not be expected to raise money. Rather, these solicitors may be concerned with making valuable contacts for your organization. You want to keep track of all solicitors and their activities. Therefore, you can create different categories of unspecified goals for solicitors who are not associated with a campaign or fund goal.

User option. See “Option” on page 356.

Variance. The variance is the difference or variation between two or more things. For example, when working in reports, the variance could be the difference in total gifts between five reporting periods.

Vendor. A vendor is an individual or organization providing a service or product for an event. For example, you are hosting a dinner event and hire a catering service. The catering service is the vendor. You can enter vendors into your database as registrants, guests, or sponsors.

Volunteer. A volunteer is a person who voluntarily undertakes a task, or a specialized piece of work, for an organization and expects no pay in return. For example, your organization holds a Spring Gala every year. Several members of the community help you plan the gala. Others help you decorate, send out invitations, and hire entertainment. You hold a golf tournament and two individuals offer to take event photos for your newsletter. A group of people come to your organization on a weekly basis to help with office work and computer data entry. You are sending out a membership mailing and a group of people volunteer to fold letters and stuff envelopes. The individuals who give their time to your organization and request no pay in return are volunteers.

Volunteer availability. The dates, days, and times each volunteer is available to work is the volunteer availability. For example, James Rooney, a volunteer at your animal shelter, lets you know he is available to work every Friday this year, from 8:00 a.m. until noon. You can track volunteer availability on the Volunteer tab of a constituent record.

Volunteer status. Volunteer status denotes whether a volunteer is active or not. A volunteer can have multiple statuses. For example, Shannon Thompson, a volunteer at your organization, is assigned two volunteer types: Gift Shop Staff and Business Office Staff. Shannon is currently working in the gift shop and has discontinued working in your business office. She worked in your business office regularly last year. In the Volunteer Types grid, you can assign the status of Active in the Status column on the same row as the Gift Shop Staff type and a status of Inactive on the same row as the Business Office Staff type.

Volunteer type. Volunteer type denotes the capacity in which a volunteer can serve your organization. For example, Ashley Ziegler, a volunteer with your organization, works in your gift shop. You assign a Type of “Gift Shop Staff” in the Volunteer Types grid on the Volunteer tab of her constituent record. A volunteer can be multiple types. For example if Ashley also starts volunteering in your business office, you can add another Type of “Business Office Staff” in the Volunteer Types grid.
Write-off. When a constituent defaults or cannot make payments on a pledge, you can write off the pledge so the balance no longer appears as expected income. For example, a constituent pledges $500 to your organization. He calls you six months later to inform you he is no longer employed, and cannot make any payments on this pledge in the future. You can write off the $500 pledge so that the gift record does not have a pledge balance. Once you write off a pledge, you can change or delete the write-off.
# Index

<table>
<thead>
<tr>
<th>A</th>
<th>amendment history, group 236</th>
</tr>
</thead>
<tbody>
<tr>
<td>accessing a report 107</td>
<td>amendments, include these 204</td>
</tr>
<tr>
<td>account distribution report 48</td>
<td>amount display options 182</td>
</tr>
<tr>
<td>account distribution report columns 48</td>
<td>analytical reports 10</td>
</tr>
<tr>
<td>acknowledge, include 166</td>
<td>annual statement report 49</td>
</tr>
<tr>
<td>action</td>
<td>annual statement report columns 49</td>
</tr>
<tr>
<td>attributes, include 166</td>
<td>appeal</td>
</tr>
<tr>
<td>groups 234</td>
<td>attributes, include 166</td>
</tr>
<tr>
<td>include based on date 196</td>
<td>groups 236</td>
</tr>
<tr>
<td>include for associated events and appeals 166</td>
<td>inactive, include 199</td>
</tr>
<tr>
<td>include from 195</td>
<td>include with date range containing 196</td>
</tr>
<tr>
<td>notes, include 166</td>
<td>notes, include 166</td>
</tr>
<tr>
<td>priorities 189</td>
<td>summary, group 236</td>
</tr>
<tr>
<td>progress 189</td>
<td>with no activity, include 166</td>
</tr>
<tr>
<td>action detail report 6</td>
<td>zero amounts, include 167</td>
</tr>
<tr>
<td>action detail report columns 6</td>
<td>appeal comparison summary 22</td>
</tr>
<tr>
<td>action reports 6</td>
<td>appeal comparison summary columns 22</td>
</tr>
<tr>
<td>action summary report 7</td>
<td>appeal cost breakdown 23</td>
</tr>
<tr>
<td>action summary report columns 7</td>
<td>appeal cost breakdown columns 23</td>
</tr>
<tr>
<td>activity report 7</td>
<td>appeal detail report 23</td>
</tr>
<tr>
<td>activity report columns 75</td>
<td>appeal detail report columns 23</td>
</tr>
<tr>
<td>actual vs. target report 10</td>
<td>appeal goal summary 24</td>
</tr>
<tr>
<td>adding favorites 110</td>
<td>appeal goal summary columns 24</td>
</tr>
<tr>
<td>address</td>
<td>appeal performance analysis 25</td>
</tr>
<tr>
<td>attributes 225</td>
<td>appeal performance analysis columns 25</td>
</tr>
<tr>
<td>contact 227</td>
<td>appeal profile 90</td>
</tr>
<tr>
<td>groups 235</td>
<td>appeal summary list 25</td>
</tr>
<tr>
<td>individual 223</td>
<td>appeal summary list columns 25</td>
</tr>
<tr>
<td>organization 226, 230</td>
<td>appeals analysis 13</td>
</tr>
<tr>
<td>addressees/salutations, groups 235</td>
<td>appeals analysis columns 13</td>
</tr>
<tr>
<td>adjusted gift report 48</td>
<td>apply a color scheme 188</td>
</tr>
<tr>
<td>adjusted gift report columns 49</td>
<td>as of date 190</td>
</tr>
<tr>
<td>adjustment history, show 173</td>
<td>assigned solicitors, groups 236</td>
</tr>
<tr>
<td>advocacy actions, include these dates 196</td>
<td>assignment</td>
</tr>
<tr>
<td>advocacy detail report 8</td>
<td>include based on specific date 200</td>
</tr>
<tr>
<td>advocacy detail report columns 8</td>
<td>job, include with status of 200</td>
</tr>
<tr>
<td>advocacy tallies 32</td>
<td>attribute, groups 237</td>
</tr>
<tr>
<td>advocacy tallies columns 32</td>
<td>attributes tab</td>
</tr>
<tr>
<td>all cash, defined 215</td>
<td>defined 141</td>
</tr>
<tr>
<td>all gifts-in-kind, defined 215</td>
<td>excluding records with specific attributes 142</td>
</tr>
<tr>
<td>all others, defined 215</td>
<td>including records with specific attributes 142</td>
</tr>
<tr>
<td>all planned gifts, defined 215</td>
<td>availability tab 143</td>
</tr>
<tr>
<td>all pledges, defined 215</td>
<td>available fields 177</td>
</tr>
<tr>
<td>all stocks, defined 216</td>
<td>available sections 190</td>
</tr>
<tr>
<td>alumni class analysis 11</td>
<td>award, include with these dates 196</td>
</tr>
<tr>
<td>alumni class analysis columns 11</td>
<td></td>
</tr>
<tr>
<td>alumni class list 90</td>
<td></td>
</tr>
<tr>
<td>alumni information to use 189</td>
<td></td>
</tr>
</tbody>
</table>
back button 109
bank, groups 237
bank, include on report 171
base analysis on 190
base funding on 190
base report on 159, 191
base report on maiden name 160
base report processing on 191
begins with 208
benefit, groups 237
between 208
biographical information, group 238
blackbaud analytics scores list 90
blank 208
break report by 161, 178
breakdown by packages 160
breaks 178
brought forward total, include 167
budget amounts, include 167
business rules 116
business, groups 238
buttons 108

calculate gift balance based on selected date range, campaign, fund, and appeal 217
calculating income 194
campaign
  attributes, include 167
groups 239
inactive, include 199
include with date range containing 196
information, groups 238
notes, include 167
summary, groups 239
zero amounts, include 167
campaign comparison summary 26
campaign comparison summary columns 26
campaign detail report 26
campaign detail report columns 26
campaign goal summary 27
campaign goal summary columns 27
campaign performance analysis 27
campaign performance analysis columns 27
campaign profile 91
campaign progress report 28
campaign progress report columns 28
campaign report 76
campaign report columns 76
campaign summary list 29
campaign summary list columns 29
campaigns, funds, and appeals reports 22
cancel button 109
card recipient 194
cash flow report 77
cash flow report columns 77
cash gifts
  defined 214
cash receipts journal 50
cash receipts journal columns 50
changing a report 119
chart title 220
children 161
class, print each on separate page 172
color scheme 188
column totals, include 167
columns tab
  defined 144
comments, including on report 159
comparative membership statistics 64
comparative membership statistics columns 64
comparative report 13
comparative report columns 14
comparisons and summaries 33
comparisons and summaries columns 33
condensed format 161
consecutive payments missed as of 192
consecutive years report 14
consecutive years report columns 14
consecutive years, minimum number of 171
columns tab
  defined 144
comments, including on report 159
comparative membership statistics 64
comparative membership statistics columns 64
comparative report 13
comparative report columns 14
comparisons and summaries 33
comparisons and summaries columns 33
condensed format 161
consecutive payments missed as of 192
consecutive years report 14
consecutive years report columns 14
consecutive years, minimum number of 171
constituent
code, groups 239
  include these 205
name, groups 239
  with multiple field values, for 163
constituent directory 91
constituent giving history columns 52
constituent giving history. 52
constituent profile 91
contact
  address information, print 227
groups 240
contains 208
contributors, include with these gift dates 197
coordinator, groups 240
count consecutive years up to this period 192
counts to include 192
course, include based on expiration dates 197
courses and training report 99
courses and training report columns 99
create output query 192
creating a report 116
credit gifts of membership to 193
credit matching gifts to 193
criteria operators
  begins with 208
  between 208
  blank 208
  contains 208
does not begin with 208
does not contain 208
does not equal 208
equals 208
greater than 208
greater than or equal to 208
less than 208
less than or equal to 208
like 209
not between 208
not blank 208
not like 209
not one of 208
one of 208
sounds like 209

data source 219
data values, show on graph 220
delete button 109
deleting a report parameter file 133
demographic and statistical 32
detail
  additional information to display on report 159
  appeals to include 159
  base report on 159
  base report on maiden name 160
  break report by 161
  breakdown by packages 160
  children 161
  condensed format 161
  defined, format tab 159
  detail order 162
  display options for membership types 162
  display variance as 162
  fields box 163
  fields to include box 163
  for constituent with multiple field values 163
  funds to include 163
  gift distribution frame 163
  gift reporting 166
  graph tab 220
  group by first initial of last name 166
  group by first initial of org name 166
  include acknowledgee information 166
  include action attributes 166
  include action information for associated events
    and appeals 166
  include action notes 166
  include appeal attributes 166
  include appeal notes 166
  include appeals with no activity 166
  include appeals with zero amounts 167
  include breakdown by income type 167
  include brought forward total from 167
  include budge amounts 167
  include campaign attributes 167
  include campaign notes 167
  include campaigns with zero amounts 167
include column totals 167
include expense information 167
include first gift 167
include fund attributes 167
include fund description 167
include fund ID 168
include fund notes 168
include funds with zero amounts 168
include general ledger account numbers 168
include gifts 168
include GL account numbers on summaries 168
include greatest gift 168
include inactive packages 168
include latest gift 168
include maiden name 168
include major information 168
include minor information 169
include name to print from seating
  arrangements grid 169
include non-givers 169
include package information 169
include receipt amount 169
include report period totals 169
include solicitors with no activity 169
include spouse 169
include spouse employment information 170
include students who left 170
include these recurring gifts 170
include tributes 170
include unassigned seats 170
include zero activity funds 170
limit report results 170
linked gifts 171
minimum number of consecutive years 171
order, format tab 162
phone types 171
primary summary for report 171
print availability 171
print bank information 171
print blank line after each participant 172
print each class on a new page 172
print each on a separate page 171, 172
print on report 158
print one honor/memorial per page 172
print one solicitor/notified user per page 172
print one tribute per page 172
report format 172
report order 173
secondary summary for report 171, 173
settings for break 2 178
show adjustment history 173
show upgrade, downgrade, and same
  breakdown for rejoins 173
sponsors 174
summarize by 174
top donor detail 174
use donor category table 175
variance to include 175
what would you like to print 175
dinner preferences columns 42
dinner preferences. 41
display
  information for 193
  options for membership types 162
  variance as 162
does not begin with 208
does not contain 208
does not equal 208
donor category
  print each on separate page 171, 172
table, use 175
donor category report 14
donor category report columns 15
double-space 183
downgrade breakdown for rejoins, show 173
dropped member report 65
dropped members report columns 65
duplicate button 232

eediting a report 119
education, groups 240
EFT include based on dates 197
EFT participation report 53
eft participation report columns 53
e-mailing a report 130
employee, groups 241
equals 208
event
  categories to include 194
class schedule, groups 241
detail, groups 241
inactive, include 199
include based on dates 198
report on 210
event expense report 42
event expense report columns 42
event income report 43
event income report columns 43
event lists 43
event lists columns 43
event management reports 41
event profile. 91
event summary report 44
event summary report columns 44
exclude zero amount gifts 216
excluding records with specific attributes 142
expected maturity year report 54
expected maturity year report columns 54
expense
  groups 241
  include 167
  include based on dates 198
types 148

exexpense calculation tab
  defined 146
  expense types 148
  include expenses with these dates 147
  include these expense types 148
  invited vendors as of 148
  registered vendors as of 148
  vendors who have attended 148
  experience, with expiration dates on or before,
  include 204
expired membership report 65
expired membership report columns 65
exporting a report 127

F
favorites
  add report to list of favorites 110
  organizing 112
field to use 150
field values box 150
fields box 163
fields tab
  columns 150
  defined 149
  field to use 150
  field values box 150
  include these field values 150
  information column 150
  selecting a field to use 150
  use selected field values only 150
fields to include box 163
filter option 154
filters tab
  defined 153
  filters 154
filters, location 207
financial
  data, group 242
  institutions, groups 237
  summary, group 242
financial reports 48
first/greatest/latest gift report 15
first/greatest/latest gift report columns 15
footer, see report footer or page footer
for calculating income 194
for constituents with multiple field values 163
format tab
  color scheme 188
  criteria 158
  defined 156
detail 159
  fonts 176
headings 157
miscellaneous 182
name formats 182
optional columns 183
include actions from 195
include actions with these dates 196
include advocacy actions with these dates 196
include appeals with date range containing 196
include awards with these dates 196
include campaigns with date range containing 196
include contributors with these dates 197
include courses and training with these expiration dates 197
include EFTs with these dates 197
include events starting within these dates 198
include expenses with these dates 198
include funds with date range containing 196
include gifts made after 198
include gifts with these adjustment dates 198
include gifts with these dates 199
include inactive appeals 199
include inactive campaigns 199
include inactive events 199
include inactive funds 200
include inactive proposals 200
include job assignments with a status of 200
include job assignments with these dates 200
include jobs with these start dates 200
include memberships as of 201
include memberships dropped within these dates 201
include memberships that are within these dates 201
include memberships that expire within these dates 202
include memberships with these dates 202
include only active memberships in membership as of count 203
include pledges made after 203
include proposals with no date asked 203
include records with these dates 203
include recurring gifts with these amendment dates 203
include scores with these dates 204
include skills and experience with expiration dates on or before 204
include these amendments 204
include these constituents 205
include these membership categories 209
include these memberships 205
include these participants only 205
include these tributes 206
include tributes with no gift activity 206
include volunteers with these dates 206
include volunteers with these start dates 206
include volunteers with these total hours 207
include write-offs within these dates 207
lapsed on or before 207
location filters 207
membership categories 209
pledge types 209

G
general ledger
include account numbers 168
general ledger audit report columns 55
general ledger, account numbers, include 168
general tab
action progress 189
available sections 190
base analysis on 190
base funding on 190
base report on 191
base report processing on 191
consecutive payments missed as of 192
count consecutive years up to this period 192
counts to include 192
create output query 192
credit gifts to membership to 193
credit matching gifts to 193
defined 188
event categories to include 194
for calculating income 194
group by 194
include 195
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>print each section on a separate page</td>
<td>209</td>
</tr>
<tr>
<td>priorities</td>
<td>189</td>
</tr>
<tr>
<td>process the report using the rules for</td>
<td>210</td>
</tr>
<tr>
<td>projected renewal targets</td>
<td>209</td>
</tr>
<tr>
<td>report on</td>
<td>210</td>
</tr>
<tr>
<td>report on event</td>
<td>211</td>
</tr>
<tr>
<td>report only on group</td>
<td>211</td>
</tr>
<tr>
<td>report types</td>
<td>210</td>
</tr>
<tr>
<td>selected sections</td>
<td>211</td>
</tr>
<tr>
<td>soft credit gifts to</td>
<td>212</td>
</tr>
<tr>
<td>sort order</td>
<td>212</td>
</tr>
<tr>
<td>sort report by</td>
<td>212</td>
</tr>
<tr>
<td>gift</td>
<td></td>
</tr>
<tr>
<td>history, group</td>
<td>243</td>
</tr>
<tr>
<td>include</td>
<td>168</td>
</tr>
<tr>
<td>include based on adjustment dates</td>
<td>198</td>
</tr>
<tr>
<td>include based on specific date</td>
<td>199</td>
</tr>
<tr>
<td>include first</td>
<td>167</td>
</tr>
<tr>
<td>include greatest</td>
<td>168</td>
</tr>
<tr>
<td>include latest</td>
<td>168</td>
</tr>
<tr>
<td>include made after</td>
<td>198</td>
</tr>
<tr>
<td>matching, credit to</td>
<td>193</td>
</tr>
<tr>
<td>membership, credit to</td>
<td>193</td>
</tr>
<tr>
<td>print each on separate page</td>
<td>171, 172</td>
</tr>
<tr>
<td>reporting</td>
<td>166</td>
</tr>
<tr>
<td>soft credit to</td>
<td>212</td>
</tr>
<tr>
<td>summary, groups</td>
<td>244</td>
</tr>
<tr>
<td>gift detail and summary report</td>
<td>55</td>
</tr>
<tr>
<td>gift detail and summary report columns</td>
<td>55</td>
</tr>
<tr>
<td>gift distribution, reporting</td>
<td>163</td>
</tr>
<tr>
<td>gift entry validation</td>
<td>57</td>
</tr>
<tr>
<td>gift entry validation columns</td>
<td>57</td>
</tr>
<tr>
<td>gift types</td>
<td></td>
</tr>
<tr>
<td>all cash</td>
<td>215</td>
</tr>
<tr>
<td>all others</td>
<td>215</td>
</tr>
<tr>
<td>all planned gifts</td>
<td>215</td>
</tr>
<tr>
<td>all pledges</td>
<td>215</td>
</tr>
<tr>
<td>all stocks</td>
<td>216</td>
</tr>
<tr>
<td>all write offs</td>
<td>216</td>
</tr>
<tr>
<td>cash</td>
<td>214, 215</td>
</tr>
<tr>
<td>gift-in-kind</td>
<td>214</td>
</tr>
<tr>
<td>other</td>
<td>214</td>
</tr>
<tr>
<td>pledge</td>
<td>214</td>
</tr>
<tr>
<td>recurring gift</td>
<td>214, 216</td>
</tr>
<tr>
<td>stock/property</td>
<td>214</td>
</tr>
<tr>
<td>gift types tab</td>
<td></td>
</tr>
<tr>
<td>calculate gift balance based on selected date</td>
<td></td>
</tr>
<tr>
<td>range, campaign, fund, and appeal</td>
<td>217</td>
</tr>
<tr>
<td>defined</td>
<td>213</td>
</tr>
<tr>
<td>exclude zero amount gifts</td>
<td>216</td>
</tr>
<tr>
<td>subtract broker fee from sold stock/property</td>
<td>217</td>
</tr>
<tr>
<td>use gift balance instead of gift amount</td>
<td>217</td>
</tr>
<tr>
<td>use sale amount for sold stock/property</td>
<td>216</td>
</tr>
<tr>
<td>use sale date for stock/property</td>
<td>216</td>
</tr>
<tr>
<td>gift-in-kind, defined</td>
<td>214</td>
</tr>
<tr>
<td>gifts to other organization, groups</td>
<td>244</td>
</tr>
<tr>
<td>gifts-in-kind report</td>
<td>59</td>
</tr>
<tr>
<td>gifts-in-kind report columns</td>
<td>59</td>
</tr>
<tr>
<td>giving history, groups</td>
<td>245</td>
</tr>
<tr>
<td>GL distribution, groups</td>
<td>245</td>
</tr>
<tr>
<td>goal summary, groups</td>
<td>246</td>
</tr>
<tr>
<td>grandparent directory</td>
<td>92</td>
</tr>
<tr>
<td>graph tab</td>
<td></td>
</tr>
<tr>
<td>data source</td>
<td>219</td>
</tr>
<tr>
<td>defined</td>
<td>217</td>
</tr>
<tr>
<td>detail</td>
<td>220</td>
</tr>
<tr>
<td>graph type</td>
<td>218</td>
</tr>
<tr>
<td>location</td>
<td>221</td>
</tr>
<tr>
<td>graph type</td>
<td>218</td>
</tr>
<tr>
<td>greater than</td>
<td>208</td>
</tr>
<tr>
<td>greater than or equal to</td>
<td>208</td>
</tr>
<tr>
<td>grid lines, show</td>
<td>220</td>
</tr>
<tr>
<td>group by</td>
<td>194</td>
</tr>
<tr>
<td>group by first initial of last name</td>
<td>166</td>
</tr>
<tr>
<td>group by first initial of org name</td>
<td>166</td>
</tr>
<tr>
<td>group, report only on</td>
<td>211</td>
</tr>
<tr>
<td>headings</td>
<td></td>
</tr>
<tr>
<td>defined</td>
<td>157</td>
</tr>
<tr>
<td>format</td>
<td>157</td>
</tr>
<tr>
<td>print date in heading</td>
<td>158</td>
</tr>
<tr>
<td>print on each page</td>
<td>158</td>
</tr>
<tr>
<td>print page number in heading</td>
<td>157</td>
</tr>
<tr>
<td>honor/memorial</td>
<td></td>
</tr>
<tr>
<td>gift summary, groups</td>
<td>247</td>
</tr>
<tr>
<td>giving history, groups</td>
<td>246</td>
</tr>
<tr>
<td>information, groups</td>
<td>247</td>
</tr>
<tr>
<td>print one per page</td>
<td>172</td>
</tr>
<tr>
<td>honor/memorial contributors list</td>
<td>97</td>
</tr>
<tr>
<td>honor/memorial contributors list columns</td>
<td>97</td>
</tr>
<tr>
<td>honor/memorial directory</td>
<td>97</td>
</tr>
<tr>
<td>honor/memorial directory columns</td>
<td>97</td>
</tr>
<tr>
<td>honor/memorial gift report</td>
<td>97</td>
</tr>
<tr>
<td>honor/memorial gift report columns</td>
<td>98</td>
</tr>
<tr>
<td>honor/memorial profile</td>
<td>92</td>
</tr>
<tr>
<td>honor/memorial summary list</td>
<td>98</td>
</tr>
<tr>
<td>honor/memorial summary list columns</td>
<td>98</td>
</tr>
<tr>
<td>I</td>
<td></td>
</tr>
<tr>
<td>inactive</td>
<td></td>
</tr>
<tr>
<td>appeals, include</td>
<td>199</td>
</tr>
<tr>
<td>campaigns, include</td>
<td>199</td>
</tr>
<tr>
<td>events, include</td>
<td>199</td>
</tr>
<tr>
<td>funds, include</td>
<td>200</td>
</tr>
<tr>
<td>proposals, include</td>
<td>200</td>
</tr>
<tr>
<td>include</td>
<td></td>
</tr>
<tr>
<td>acknowledgee information</td>
<td>166</td>
</tr>
<tr>
<td>action attributes</td>
<td>166</td>
</tr>
<tr>
<td>action notes</td>
<td>166</td>
</tr>
<tr>
<td>actions from</td>
<td>195</td>
</tr>
<tr>
<td>actions with these dates</td>
<td>196</td>
</tr>
</tbody>
</table>
advocacy actions with these dates 196
appeal attributes 166
appeal notes 166
appeals with date range containing 196
appeals with no activity 166
appeals with zero amounts 167
awards with these dates 196
breakdown by income type 167
brought forward total from 167
budget amounts 167
button 195
campaign attributes 167
campaign notes 167
campaigns with date range containing 196
campaigns with zero amounts 167
column totals 167
contributors with these gift dates 197
courses and training with these expiration dates 197
EFTs with these dates 197
events starting within these dates 198
expense information 167
expenses with these dates 147, 198
first gift 167
fund attributes 167
fund description 167
fund ID 168
fund notes 168
funds with date range containing 196
funds with zero amounts 168
general ledger account numbers 168
gifts 168
gifts made after 198
gifts with these adjustment dates 198
gifts with these dates 199
greatest gift 168
inactive appeals 199
inactive campaigns 199
inactive events 199
inactive funds 200
inactive packages 168
inactive proposals 200
job assignments with status of 200
job assignments with these dates 200
jobs with these start dates 200
latest gift 168
maiden name 168
major information 168
memberships as of 201
memberships dropped within these dates 201
memberships that are within these dates 201
memberships that expire within these dates 202
memberships with these dates 202
minor information 169
name to print from seating arrangements grid 169
non-givers 169
only active memberships in memberships as of 201
count 203
package information 169
pledges made after 203
proposals with no date asked 203
receipt amount 169
records with specific attributes 142
records with these dates 203
recurring gifts with these amendment dates 203
report period totals 169
scores with these dates 204
skills and experience with expiration dates on or before 204
solicitors with no activity 169
spouse 169
spouse employment information 170
students who left 170
these amendments 204
these constituents 205
these expense types 148
these field values 150
these membership 205
these membership categories 209
these participants only 205
these recurring gifts 170
these tributes 206
tributes 170
tributes with no gift activity 206
unassigned seats 170
volunteers with these dates 206
volunteers with these start dates 206
volunteers with these total hours 207
write-offs within these dates 207
zero activity funds 170
income
calculating 194
type, breakdown by 167
income calculation tab
defined 222
for calculating income 223
for calculating income, include these participants only 222
include these constituents 223
ind address tab
address attributes 225
address types 225
consider addresses with seasonal dates as of 225
defined 223
print two address on report 224
what would you like to print 224
individual
name formats 184
relationship, groups 248
individual profile 92
information column 150
instructor, groups 248
invited vendors as of 148
is not blank 208
J

job assignment
include based on specific dates 200
include based on status 200
job assignment summary 100
job assignment summary columns 100
job, include based on start date 200
joint member 194
joint member names, including on report 159
joint member/card list report 66
joint member/cardlist report columns 66
journal columns 78
journal. 78

L

lapsed member report 66
lapsed member report columns 66
lapsed on or before 207
layout button 109
legend, show 220
less than 208
less than or equal to 208
like 209
limit report results 170
linked gifts 171
location 221
location filters 207
location, groups 248
lodging information columns 45
lodging information.
LYBUNT report 16
LYBUNT report columns 16

M

maiden name
base report on 160
include 168
maiden name, including on report 159
major, include 168
MatchFinder Organization Summary 92
matching gift report 59
matching gift report columns 59
matching gift, credit to 193
media, groups 248
membership
card recipients 194
categories 209
dropped within these dates 201
expiring within these dates 202
gift, credit to 193
history, groups 248
include as of 201
include only active in Memberships as of count

N

name formats
defined 183
individual 184
organization 187
navigate
buttons 108
open a report 107
toolbar 109
new button 108
new donors report columns 17
new member report 71
new member report columns 71
new report, creating 116
next button 109
no expected maturity year column, add 263
non-contributors report 17
non-contributors report columns 17
non-givers, include 169
not between 208
not like 209
not one of 208
not paid report 79
not paid report columns 79
| note, groups 250                                                                 |
| notified user, print one per page 172                                           |
| one of 208                                                                      |
| Online Vs. Offline Giving Report 60                                             |
| open a report 107                                                               |
| open button 108                                                                 |
| optional columns 183                                                           |
| org address tab                                                                 |
| defined 226                                                                     |
| phone type 227                                                                  |
| print contacts 227                                                              |
| print only the organization address 230                                         |
| what would you like to print 227                                               |
| organization profile 93                                                         |
| organization, name formats 187                                                  |
| organizing favorites 112                                                        |
| orientation, report 182                                                         |
| other donation                                                                  |
| calculating income 223                                                          |
| including 194                                                                  |
| other gifts report 63                                                           |
| other gifts report columns 63                                                   |
| other payment method, defined 214                                               |
| output query, creating 192                                                     |
| outstanding proposal report 94                                                  |
| outstanding proposal report columns 94                                          |
| package                                                                        |
| breakdown report by 160                                                         |
| groups 251                                                                      |
| inactive, include 168                                                           |
| information, include 169                                                        |
| page break on each new 179                                                      |
| page footer                                                                    |
| defined 180                                                                    |
| print page number in footer 180                                                 |
| print report date in footer 181                                                 |
| text 180                                                                       |
| page numbers, adding to headings 157                                            |
| parent class analysis 17                                                        |
| parent class analysis columns 17                                                |
| parent directory 93                                                             |
| participant                                                                    |
| calculating income 222                                                          |
| groups 251                                                                      |
| include these only 205                                                          |
| participant, print blank lines after each 172                                   |
| past due report 80                                                              |
| past due report columns 80                                                      |
| phone types 171                                                                 |
| planned gifts report 60                                                         |
| planned gifts report columns 60                                                 |
| pledge 214                                                                      |
| made after, include 203                                                         |
| type 209                                                                        |
| pledge reports 74                                                               |
| pledge status report 81                                                         |
| pledge status report columns 82                                                 |
| preview button 109                                                              |
| previewing a report 122                                                         |
| price, groups 252                                                               |
| primary summary for report 171                                                 |
| print                                                                          |
| availability 171                                                                |
| bank information 171                                                            |
| blank line after each participant 172                                           |
| button 109                                                                      |
| count as % of total 178                                                         |
| count of records 178                                                            |
| date in report heading 158                                                      |
| each class on a new page 172                                                    |
| each on a separate page 171, 172                                                |
| one honor/memorial per page 172                                                 |
| one solicitor/notified user per page 172                                        |
| one tribute per page 172                                                       |
| page number in footer 180                                                       |
| report date in footer 181                                                       |
| report heading on each page 158                                                 |
| reports 125                                                                    |
| two addresses on report 224                                                     |
| print each section on a separate page 209                                      |
| process the report using the rules for 210                                     |
| professional directory report 93                                               |
| profile contents tab                                                            |
| defined 232                                                                    |
| duplicate button 232                                                            |
| groups in reports 233                                                           |
| actions 234                                                                    |
| addressees/salutations 235                                                      |
| addresses 235                                                                   |
| amendment history 236                                                           |
| appeal summary 236                                                              |
| appeals 236                                                                    |
| assigned solicitors 236                                                         |
| attributes 237                                                                  |
| banks/financial institutions 237                                                |
| benefits 237                                                                   |
| biographical information 238                                                    |
| businesses 238                                                                  |
| campaign information 238                                                       |
| campaign summary 239                                                           |
| campaigns 239                                                                   |
| constituent codes 239                                                           |
| constituent name 239                                                            |
| contacts 240                                                                    |
| coordinators 240                                                                |
| education/schools 240                                                           |
| employees 241                                                                   |
| event class schedule 241                                                        |
profiles, lists, and directories 90
projected renewal targets 209
proposal
  attribute, groups 252
  groups 253
  inactive, include 200
  media, groups 253
  with no date asked, include 203
proposal analysis report 94
proposal analysis report columns 94
proposal follow-up report 95
proposal follow-up report columns 95
proposal pipeline summary 96
proposal pipeline summary columns 96
prospect
  chronology, groups 254
  information, groups 253
  rating, groups 254
prospect research reports 93
Q
  query, output 192
R
  receipt amount, include 169
  record with these dates, include 203
  recurring gift 214, 216
  recurring gift amendment report 85
  recurring gift amendment report columns 85
  recurring gift missed payment report 86
  recurring gift statistical report 34
  recurring gift statistical report columns 34
  recurring gifts missed payment report columns 87
  recurring gifts with these amendment dates, include
  203
  recurring gifts, include 170
  registered vendors as of 148
registration fee
  calculating income 223
  include 194
registration fees due columns 45
registration fees due report 45
rejoin report 72
rejoin report columns 72
removing a report parameter file 133
renewal
  history, groups 254
  information, groups 255
  targets, projected 209
renewal projection report 73
renewal projection report columns 73
renewal report 73
renewal report columns 73
report footer
defined 181
text 181
report format frame 172
report on 210
report on event 211
report only on group 211
report order 173
report orientation 182
report period totals, include 169
report periods tab
  autofill dates 262
defined 261
end date 262
end days 263
heading 1 262
heading 2 262
headings 263
information 262
insert column for No Expected Maturity Years 263
start date 262
start days 263
report results, limit 170
report type
  both 210
  comparison 210
detail 210
summary 210

S
same breakdown for rejoins, show 173
school, groups 240
score, with these dates include 204
scores tab 263
seasonal address 225
seating arrangements columns 46
seating arrangements. 46
seating, groups 255
seats unassigned , include 170
secondary summary for report 171, 173
section IA tab 265
section III tab 266
section IIIA tab 268
section IIIB tab 269
section IV part 1 tab 272
section IV part 2 tab 273
section IV part 3 tab 274
section IV tab 270
selected filters 154
selected sections 211
sending a report by e-mail 130
setting for break 1 178
setting for break 2 178
show
  adjustment history 173
data values 220
grid lines 220
legend 220
upgrade, downgrade, and same breakdown for
rejoins 173
skill, with expiration dates on or before, include 204
soft credit gifts to 212
solicit code, groups 255
solicitor
  assignment, groups 255
goal, groups 256
groups 256
  print one per page 172
  with no activity, include 169
solicitor comparision report columns 19
solicitor comparison report 19
solicitor goal summary 19
solicitor goal summary report columns 19
solicitor performance analysis 20
solicitor performance analysis report columns 20
solicitors tab 275
sort by query order 177
sort fields 177
sort order 212
sort report by 212
sort/break
  available fields 177
  break report by 178
defined 177
  page break on each new 179
  print count as % of total 178
  print count of records 178
  settings for break 1 178
  sort by query order 177
  sort fields 177
sounds like 209
sponsoring pledge
  calculating income 223
include 194
sponsors 174
sporting event roster columns 47
sporting event roster. 47
spouse
  employment information 170
include 169
  information, groups 256
see also maiden name 169
statistical report columns 40
statistical reports 40
stock gain/loss report 63
stock gain/loss report columns 63
stock/property 214
students who left, include 170
subtitle, graph 220
subtract broker fee from sold stock/property 217
summarize by 174
summary for report
  primary 171
  secondary 171
SYBUNT report 20
SYBUNT report columns 21

T

tallies 41
tallies columns 41
tickler report 9
tickler report columns 9
time sheet report 100
time sheet report columns 101
toolbar 109
top donor criteria 174
top donors report 21
top donors report columns 21
totals column, include 167
training, include based on expiration date 197
tribute
  include 170
  include these 206
  print one per page 172
  with no gift activity, include 206
tribute reports 96

U

unassigned seats, include 170
upgrade breakdown for rejoins, show 173
use donor category table 175
use gift balance instead of gift amount 217
use sale amount for sold stock/property 216
use sale date for stock/property 216
use selected field values only 150
user options 115

V

variance to include 175
vendors
  invited vendors as of 148
  registered vendors as of 148
  who have attended 148
volunteer
  assignment, groups 257
  availability, groups 257
  availability, include 171
  award, groups 258
  checklist, groups 258
  course, groups 258
  include based on these dates 206
  information, groups 259
  job assignment schedule 102
  mandate information, groups 259
  medical information, groups 259
  skill, groups 260
  skills and experience 103
  special need, groups 260
  start date, include based on 206
  summary, groups 260
  time sheets, groups 261
  total hours, include based on 207
volunteer awards columns 101
volunteer awards report 101
volunteer job assignments columns 102
volunteer match list 103
volunteer reports 99
volunteer skills and experience columns 103
volunteer summary 104
volunteer summary columns 104
VSE survey report 21

W

what would you like to print 175, 224
write-off report columns 89
write-off within these dates, include 207
writer offs, defined 216
written-off report 89

X

x-axis 220

Y

y-axis 220

Z

zero activity funds, include 170
zero amounts, include 167
Blackbaud is the leading global provider of software and related services designed specifically for nonprofit organizations. Approximately 16,000 organizations use one or more of Blackbaud products and consulting services for fundraising, financial management, Web site management, school administration, and ticketing. Blackbaud’s solutions include The Raiser’s Edge®, Team Approach®, The Financial Edge™, The Education Edge™, The Patron Edge®, Blackbaud®NetCommunity™, The Information Edge™, WealthPoint™, ProspectPoint™, and donorCentrics™, as well as a wide range of consulting, analytical, and educational services. Founded in 1981, Blackbaud is headquartered in Charleston, South Carolina and has operations in Cambridge, Massachusetts; Toronto, Ontario; Glasgow, Scotland; London, England; and Sydney, Australia.